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Chapter 1: Getting Started

Welcome to ACDSee Photo Studio Home 2026

Welcome to ACDSee, the industry-leading digital photo and document management software.

The Benefits of ACDSee

l Total workflow control. Build your photography workflow around ACDSee and notice the difference.
With flexible cataloging capabilities, unrivaled viewing speed, and a powerful photo editor, ACDSee is
the choice of busy professional and advanced amateur photographers worldwide. Add vastly improved
RAW processing, a full set of metadata tools, and unparalleled viewing speed, and you have a fully
integrated photography editing and management solution.

l Patented editing features including Light EQ™. The Patented Light EQ™ technology single-exposure
HDR algorithms powering ACDSee's Light EQ™ tool accurately and intelligently stretch the dynamic
lighting range of your photos, making them incredibly realistic or atmospheric.

l Wide variety of editing and processing tools. Create, edit, and touch-up your digital images. Use tools
such as red eye reduction, crop, sharpen, blur, and photo repair to enhance or correct your images.
Image editing tools, such as exposure adjustment, convert, resize, rename, and rotate, can be
performed on multiple files at the same time.

l Completely customizable UI. The user interface is completely customizable, and provides quick access
to tools and features. You can customize the screen layout, the order of images, toolbar display, and
many other options to suit your preferences.

l Impressive organizational capabilities. With ACDSee you can import your photos from your camera to
your computer, categorize and rate your files, and manage photo collections of any size—from a few
hundred to a few hundred thousand. Choose to view thumbnail previews of any size, or use a detailed
list of file properties to sort your files. Can't find a particular photo? No problem. ACDSee includes a
variety of powerful searching tools and a Compare Images feature to eliminate duplicates.

l Context-sensitive help. ACDSee contains extensive context-sensitive help materials to assist you as you
move through the application. Press F1 when using any feature to open the relevant online help page.

Using the User Guide

This user guide is here to help you get the most out of your ACDSee software. It is categorized by
mode and by function. Throughout the guide, you will find icons that help you best use ACDSee.

Notes are things to consider when performing an action.
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Tips are ways to optimize your work.

Warnings are things to take into account when making an action.

Thank you for choosing ACDSee, the complete photography management solution for professional
photographers.

Automatically Imported Settings

If you have installed a previous version of ACDSee Home, some settings will automatically be imported
into your new version when launched for the first time.

ACDSee Photo Studio Home 2026 will import the following settings from your most recently
installed version:

l Import Options: Automatically imports your saved Options settings. For more information see Import
Options.

l Metadata Views: Use Metadata Views to save frequently used metadata fields and keep the most
relevant information visible. For more information see Metadata Views.

l Label Presets: Create label sets so you can quickly select and assign specified labels. For more
information see Assigning Color Labels.

l Quick Category Sets: Use Quick Categories to keep order by creating categories of different events or
areas of interest. For more information see Creating Categories.

l Quick Keyword Sets: Use Quick Keywords to keep organized and to streamline your workflow by
creating a group of related keywords that hold an association for you. For more information see
Creating and Assigning Hierarchical Keywords.

l Batch Convert File Format Presets: Save frequently used file format settings as a preset, allowing you to
convert multiple images to specific file formats quickly. For more information, see Converting Multiple
Images to Another File Format.

l Batch Rename Presets: Save frequently used renaming settings as a preset. Use Batch Rename presets
to rename multiple files with specific formatting applied. For more information, see Renaming Multiple
Files.

l Batch Resize Presets: Save frequently used resizing parameters to resize multiple images at once with
specific formatting applied. For more information, see Resizing Multiple Images.

l Advanced Search Pane Search Presets: Save search results and bring them back with a single click. For
more information, see Using the Advanced Search Pane.

l Advanced Search Pane Search History: Displays search history when searching by Filename, Text, or
Filename > Pattern Match. For more information, see Choosing Criteria in the Advanced Search Pane.
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l Customized Keyboard Shortcuts: Customizing keyboard shortcuts allows you to modify default key
combinations to better suit your workflow, improving efficiency and ease of use. For more information
see Customizing Keyboard Shortcuts.

l External Editor Settings: Open images in external editing applications from within ACDSee, configure
ACDSee Home to work with a variety of image editors, and specify which image editor ACDSee Home
uses by default. For more information see Configuring External Editors.

Some settings may not import from all older versions of ACDSee Home. (e.g. Options are only
imported from 2022 or newer.)

The import tool will only import from an older version and within the same product model.
(e.g. ACDSee Photo Studio Home 2026 can only import options from an older version of
ACDSee Photo Studio Home.)

The import tool will always import from the most recent previous version that can be found.
(e.g. If ACDSee Photo Studio Home 2022 and ACDSee Photo Studio Home 2023 are both
installed, only the settings from ACDSee Photo Studio Home 2023 will be imported.)

About the ACDSee User Interface

The ACDSee Home user interface provides easy access to the various tools and features you can use to
browse, view, edit, and manage your photos and media files. ACDSee Home consists of seven modes:
Manage, Media, View, Edit, People, 365, and Dashboard.

Manage Mode

Manage mode is the main browsing and managing component of the user interface, and is what you
see when you start ACDSee Home using the shortcut icon on your desktop. In Manage mode, you
can find, move, preview, and sort your files, and access organization and sharing tools.

Manage mode consists of 15 panes, most of which can be closed when not in use. The File List pane
is always visible, and displays the contents of the current folder, the results of your latest search, or
the files in your database that match your filtering criteria. A status bar at the bottom of the Manage
mode window displays information about the currently selected file, folder, or category. The current
state of the Activity Manager can also be viewed from the status bar by hovering over the icon. For
more information, see the ACDSee Activity Manager.

You can open and close panes, move them to different areas of your screen, and stack them on
other panes or dock them to the edge of the window. Most panes also have additional options you
can set to further customize their behavior and appearance.

Manage mode also features a toolbar and a set of drop-down menus. The toolbar provides buttons
for your home folder, and for navigating forwards and backwards through your folders. The drop-
down menus provide quick access to the most common tasks.
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Media Mode

Media mode is ACDSee’s database-driven powerhouse for viewing and accessing the folders you have
either browsed inManage mode or cataloged into the ACDSee database. This streamlined, uncluttered
view of the media assets managed by ACDSee offers sorting, grouping, and filtering in any combination.

View Mode

In View mode you can play media files and display images and documents in full resolution, one at a
time. You can also open panes to view image properties, display areas of an image at varying
magnifications, or examine detailed color information.

You can open View mode by selecting an image or document and clicking on the View mode tab,
and you can use the Filmstrip in View mode to flip quickly between all of the files in a folder. View
mode contains a toolbar with shortcuts to commonly-used commands, and a status bar at the
bottom of the window, which displays information about the current image or media file.

Edit Mode

Edit mode works on the image data already rendered to RGB. Edits are independently applied to the
converted RGB data in the order that you do them. This chain editing gives you full control over the
pixels, allowing creative freedom to apply precise adjustments. This makes operations such as selec-
tions and blend modes possible.

People Mode

People mode is born of a union between ACDSee’s industry-leading Face Detection & Recognition
feature and a keen application of machine learning. Photographers from all walks of life will enjoy
the dedicated space for distinguishing by client, family member, or person of interest, allowing for
the management of people by merging, renaming, or deleting faces, or taking labeling suggestions
from the AI assistant for grouping similar unnamed people.

365 Mode

365 mode provides an easy way to upload images to seedrive.acdsee.com to share with your contacts
or the public. In 365Mode, you can select the images on your computer and then drag and drop them
directly into seedrive.acdsee.com.

Dashboard Mode

Dashboardmode allows you to quickly access and browse file, camera, and database statistics based
on your ACDSee database and EXIF information. As Dashboardmode relies on information derived
from your database, it is important to catalog in order to get the most out of it.
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Switching Modes in ACDSee

In ACDSee Home, you can quickly switch between the seven modes—Manage, Media, View, Edit,
People, 365, and Dashboard.

The mode buttons are located at the top right of the ACDSee Home window:

To Switch from One Mode to Another:

Click one of the following mode buttons:

l Manage: import, browse, organize, compare, find, and publish your photos.

l Media: view your entire image collection by date.

l View: display and examine photos at any magnification.

l Edit: fix and enhance photos using the pixel-based Edit tools.

l People: view faces identified through ACDSee's Facial Recognition.

l 365: upload images to seedrive.acdsee.com to share with your contacts or the public.

l Dashboard: quickly access and browse file, camera, and database statistics.

Using Manage Mode

In Manage mode, you can browse, sort, catalog, manipulate, and share your files and images. You can
combine different tools and panes to perform sophisticated searching and filtering operations, and
view thumbnail previews of images and media files.

You can also switch very quickly to the other modes by clicking the mode buttons in the top right
corner.

The panes in Manage mode are fully customizable, and can be moved, resized, hidden, docked, or
closed. You can also stack the panes together for easy reference and accessibility, and to maximize
your screen space.

If the pane you want to view is not visible, click Panes from the top left main toolbar and select a pane.

About the Manage Mode Panes

Manage mode consists of the following panes:
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File List This pane displays the contents of the currently selected folder, the results of your
latest search, or the files and folders that match your selective browsing criteria. The
File List pane is always visible, and cannot be hidden or closed. You can customize the
File List pane by changing the way the files are displayed, or the size of the thumbnails.

Folders This pane displays the directory structure of your computer, much like the directory
tree in Windows Explorer. You can use the Folders pane to browse through the
folders and display their contents in the File List pane. You can also display the
contents of multiple folders in the File List by clicking the Easy-Select indicator
opposite each folder, on the left side of the pane.

Calendar This pane displays a calendar that you can use to organize and browse your files
according to their associated dates.

Shortcuts This pane stores shortcuts to your favorite images, files, folders or even applications.
Dragging an image, file, or folder into the Shortcuts pane creates a shortcut to the
original without affecting it in any way.

Advanced Search This pane provides access to a powerful advanced search utility. You can specify the
type of search you want to perform, and enter your search criteria into the fields
provided in the Advanced Search pane.

You can also save a search and give it a name. Search presets are listed on the
Advanced Search pane and the Catalog pane. On the Advanced Search pane, can select
Search Presets from the drop-down list to run again. On the Catalog pane, Search
Presets are listed below Auto Categories, where you can run them again by clicking
once on the Search Preset name.

Preview This pane displays a thumbnail preview of any image or media file currently selected
in the File List pane. You can adjust the size of the thumbnail by resizing the Preview
pane, and also specify whether you want the Preview pane to play media files or just
display the first frame.

Selective
Browsing

This panel combines input from the Folders, Catalog, and Calendar panes to limit the
list of files in the File List pane to those that match a specific set of criteria. You can
include or exclude files by adjusting the different criteria in the Selective Browsing
pane. You can access the Selective Browsing panel from the View menu.

Catalog This pane lists the categories, auto categories, people, ratings, color labels, keywords,
and search presets to help you sort and manage your files. You can also use the Special
Items area in the Catalog pane to quickly view all the images on your computer or see
any files not get categorized in the current folder.

Task This pane displays menus of commonly-used buttons and commands from the menus
and toolbars. The menus change dynamically based on your current location and
selections in ACDSee.

Properties This pane displays file properties and metadata for any file or folder you select in the
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File List pane. You can use the Properties pane to view and edit metadata for your
files, and the EXIF metadata included in digital photos.

Map This pane displays marked locations on a map for any file you select in the File List
pane. You can use the Map to view and mark the geographic location of your files.

Image Basket While browsing through your files and folders, you can place images in an Image
Basket to hold them temporarily. You can then edit, print, or share those images
without moving them all into a single folder.

Activity Manager The Activity Manager has three sections: Queued Activities, Idle Activities, and Activity
History.

Queued Activities: Importing images into ACDSee will display their progress in the
Queued Activities section. You can pause or cancel them at any time.

Idle Activities: Running Face Detection will display a counter indicating how many files
remain to be scanned.

History: View history of Queued Activities completed since you last launched ACDSee.

Manage Mode Drop-Down Menus

The drop-down menus in Manage mode give you quick access to often-used tasks. The drop-down
menus include the following:

l Import: where you can import photos from cameras and other devices.

l Batch: where you can run all the batch editing processes.

l Create: where you can create slide-show files, PDFs, PowerPoint presentations, online albums, or
archives.

l Slideshow: where you can configure and run a slideshow.

l Send: where you can upload to photo sites, an FTP, or share photos by email.

l Editors: where you can list external editors for easy access.

Working with Manage Mode Panes

You can open and close panes in Manage mode to suit your preferences, and move, float, or stack any
of the panes to customize the layout of the Manage mode window.

To Open or Close Panes in Manage Mode:

Click Panes and select the pane you want to open or close.
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Moving Panes

You can move a pane from a docked or floating position to a new location. You can move one pane at
a time, or several stacked panes.

To Move a Pane:

1. Drag the pane's title bar and hold your cursor over any of the arrows of the Docking Compass.

2. When the shaded marquee displays the position of the pane you want, release the mouse button.

3. To return a pane to its previous location, double-click its title bar.

To Move a Docked or Floating Pane:

Do one of the following:

l Drag the pane's tab to a new location. Only one pane moves.

l Drag the pane's title bar to a new location. Any panes stacked beneath it also move.

If you use dual monitors, you can move the panes to your second monitor to free up space on
your main monitor.

Docking Panes

When you select a pane in the Manage mode, the Docking Compass activates to help you place the
pane precisely. The Docking Compass consists of an outer and inner ring of arrows. When you hold
your cursor over any of the arrows, a shaded marquee displays the potential position of the pane.

To Dock a Pane in Manage Mode Window:

1. Drag the pane's title bar or tab to activate the Docking Compass.

2. To dock a pane around the outer edge of the window, hold your cursor over any of the outer arrows of
the Docking Compass, and then release the mouse button.

3. To dock a pane around the outer edge of the File List pane, or any another pane, hold your cursor over
the inner arrows of the Docking compass, and then release the mouse button.

Stacking Panes

You can stack panes and reorder their tabs to suit your needs.

To Stack Panes:
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1. Do one of the following:

l Drag one pane's title bar onto the title bar of another pane until the shaded marquee appears,
and then release the mouse button.

l Drag one pane inside another, hold your cursor over the center of the Docking Compass, and
then release the mouse button.

2. To reorder the panes, drag a tab to the left or right in the tab order.

3. To separate a tabbed pane, drag the pane’s tab to another location on the screen.

Resizing Panes

You can resize all the panes in Manage mode, whether they are docked or floating.

To Resize a Docked Pane:

1. Hold your cursor over the edge of the pane until the cursor changes to arrows and lines.

2. Drag the edge of the pane to the size you want.

To Resize a Floating Pane:

Hold your cursor over the edge or corner of the pane and then drag the pane to the size you want.

Resetting the Layout

All panes can be restored to their default positions at any time inManage, Media, Edit, and People
modes.

To Reset the Layout:

Click View | Reset Layout.

Using Media Mode

Mediamode offers a streamlined, database-driven approach to Digital Asset Management. Only the
folders browsed inManagemode and that have been cataloged into the ACDSee database will be
displayed inMediamode, offering a clutter-free view of photographs and videos managed by ACDSee.

TheMediamode interface is divided into four separate functional areas:

1. Header Button Bar

2. My Folders

3. Display Area

4. Group By and Properties
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Header Button Bar

Located directly below the main menu, the Header Button Bar contains three buttons described
below:

l Refresh
l Catalog
l Show Orphan Files

Header Button Bar Options

Refresh Refreshes the My Folder pane's folder tree and the Display Area pane.

Catalog For more about cataloging files, please see Cataloging Files in the Data-
base.

Show Orphan Files Displays missing files flagged as orphans. Orphans will be displayed in
sepia.
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My Folders

Located along the left side of the screen, theMy Folders pane is a simple folder tree populated with all
folders browsed while inManagemode. To add additional folders to theMy Folders pane without
leavingMediamode, use the Catalog Files tool.

TheMy Folders pane is hidden by default. To display theMy Folders pane, click the Hide/Show icon
in the lower left of the Display Area.

Clicking a folder containing media in theMy Folder pane will filter the Display Area's contents to
display the selected folder's media.

Display Area

The Display Area pane occupies the large central portion of the screen and is used primarily to display
images and videos that can be filtered, sorted, or grouped.

Double-click any image or video to display them in full screen. Videos displayed in full screen can be
played without leavingMediamode. Double click the full screen image or video to return to the grid
view.

Right-click individual media assets to produce a context-sensitive help menu containing the following
options:

l View: Opens media asset in View mode.

l Edit: Opens media asset in Edit mode.

l Rotate Left: Press Ctrl + L to rotate left.

l Rotate Right: Press Ctrl + R to rotate right.

l Show in File Explorer: Opens to the media asset file's location in File Explorer.

Toggle Between Grid and Full Screen View

You can swap between Grid and Full Screen view by selecting the toggle button in the top left of the
display, found directly to the left of the Filter option.

Filter By

When enabled, the tools in the Filter By toolbar are very powerful for tailoring the results displayed in
the Display Area pane by filtering the results based on specific metadata.

To filter media assets in the Display Area pane, choose from a combination of any of the following:

l Enable the Tagged checkbox to display only those images with a tag.

l Make a selection from the ratings to display media with a specific rating. The button to the left of the rat-
ings lets you choose whether the results will include media with a Rating less than or equal, greater than
or equal, or matching the chosen rating.

l Make a selection from the color labels to display media tagged with a specific label.
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Changes made to the Filter By tools will affect the results displayed in the Group By pane.

Sort and Group

Located directly above the media asset and to the right-side of the Display Area pane, the Sort and
Group drop-downs are used to alter how the contents of the Display Area pane are presented. Unlike
the Filter By field which refines the number of media assets displayed, the Sort and Group drop-downs
do not change the number of media assets displayed. Both the Sort and Group drop-down results can
be sorted forwards or backwards.

Selections made in the Group field will affect the results displayed in the Group By pane.

Group By and Properties Panes

Located along the right side of the screen, the Group By pane lists groups of media assets based on
the selection made in the Filter By drop-down and the Group drop-down. The Properties pane
displays key details such as IPTC, EXIF, and important ACDSee metadata. To display the Group By and

Properties pane, click the Hide/Show icon in the lower right of the Display Area.

The Group By pane results can be grouped forward and backwards.

The blue bar within each group tab is representative of the number of media assets in the group.

Clicking a tab in the Group By pane changes the display in the Display Area pane to reflect the group
selected.

Navigation Buttons in Media Mode

When viewing an image in full screen, you can navigate between images by hovering over to the left or
right side of the window and clicking on the navigational arrow that appears.

Deleting Images in Media Mode

There are three ways of deleting images in Media Mode:

l Right click on an image and select delete from the context menu

l Click on the Edit dropdown at the top of the screen and select Delete

l Click once on the image and press the Delete key

Using View Mode

You can use Viewmode to display your images, documents, and media files using their actual
dimensions or at a variety of magnifications. You can also display a group of images in sequential



ACDSee Photo Studio Home 2026

Page 31 of 532

order.

Viewmode contains four main areas:

l View area: This is the main viewing area, which displays the current image, document, or media file.
You can customize the view, and zoom in or out on your images and media files.

l Bottom toolbar: Located below the main viewing area, the Bottom toolbar provides shortcut buttons to
commonly-used tools and commands, such as the zoom and scroll tools. You can customize the toolbar
to use large or small icons, or you can choose to not display the toolbar.

l Filmstrip: This is an area below the main viewing area, which displays thumbnails of the images in the
current folder or in the group of images you selected in Manage mode. It provides a scroll bar along the
bottom, so that you can scroll through your images, and buttons for moving to the next or previous
image.

l Status bar: Located at the bottom of the window, the Status bar displays information and properties for
the current image or media file. It also displays icons for rating, color labels, and tagging that you can
click to edit.

Viewmode can also display the Properties pane to show EXIF, IPTC and ACDSeeMetadata information
about the image or file. Viewmode also has the Navigator, Magnifying Glass, and Histogram panes,
each of which show detailed image information.

To Open an Image, Document, or Media File in View Mode:

InManagemode, in the File List pane, do one of the following:

l Select a file and press Enter.

l Select a file and click the View mode button.

l Double-click a file.

l Right-click an image, document, or media file, and then select View.

To Open a Group of Images in View Mode:

1. In Manage mode, in the File List pane, select a group of images.

2. Press Enter.

3. To navigate through the images, do the following:

l To view the next image in the sequence, click Next.

l To view the previous image in the sequence, click Previous.

Viewing Images in Full Screen Mode

You can use the entire screen of your monitor to display images. In full screen mode, the window
borders, menu bar, status bar, and toolbars are hidden, and only the image is visible. If you want to
always view your images in full screen mode, you can set this option as the default for Viewmode.
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To View Images in Full Screen Mode:

1. Open an image or a group of images in View mode.

2. Click View | Full Screen.

3. Right-click the image to access the View mode tools and options via a context menu.

To Exit Full Screen Mode:

Do one of the following:

l Press the F key.

l Right-click the image and select View | Full Screen.

Use the keyboard shortcut F in Viewmode to toggle in and out of a full screen view.

Using the View Mode Panes

To Open the View Mode Panes:

1. Open an image in View mode.

2. Do one of the following:

l Click Panes | Histogram to display the histogram for the image.

l Click Panes |Magnifying glass to display a pane which shows the area of the image under your
cursor at a higher magnification.

l Click Panes | Navigator to display a thumbnail overview of a magnified image.

l Click Panes | Page View to open the Page View panel for multi-page images.

l Click Panes | Properties to display the IPTC, EXIF and ACDSee Metadata for the image.

l Click Panes | Face Detection to display and name the detected faces.

Using the Bottom Toolbar

Use the Bottom toolbar to access commonly-used tools.

These tools are only available when viewing image files.

Bottom Toolbar
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Add to Image Basket Adds the image to the active
Image Basket.

Rotate left Rotates the image to the left.

Rotate right Rotates the image to the right.

Face Tool Uses ACDSee Face Detection to
detect people in images.
Identified faces can be assigned
names.

Scroll Pans or scrolls the image when
the image is zoomed to a larger
size than the View mode area.

Select Selects a rectangular area of the
image.

Zoom Zooms in or out on the image.
Click to zoom in or right-click to
zoom out.

Full Screen Displays the image on a full
screen. Press F to view full
screen.

External Editors Opens the file in an external
editor of your choosing.

Actions Browser Pane Opens the Actions Browser pane
that allows for the recording of
all Edit mode adjustments and
the application of edits to other
images by "playing" the edits
back. Use this method to batch
edit multiple photos with any
adjustment available in Edit
mode. In addition, after applying
a recording with adjustment
layers, open the image in Edit
mode and continue tweaking and
adjusting the adjustment layers
in the Layered Editor, allowing
for non-destructive image
editing.
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Auto Light EQ Automatically previews a Light
EQTM adjustment of the image.

Auto Lens Previews a number of filters for
the image without applying the
filters to the file.

Snapshots Saves adjustments made to an
image. The snapshot save point
in the editing process can be
returned to at any time. Unlike
presets, snapshots save directly
to the image, which allows
switching between snapshot
saves.

Auto Advance Turns on Auto Advance to
quickly move through images
while adding tags, ratings, labels,
categories, or keywords.

Show Face Outlines Places a box around faces
contained in an image.

Toolbar Options Produces a menu containing the
Add or Remove Buttonsmenu
item.

Hide Bottom Panels Hides the bottom filmstrip from
view.

Navigator Displays the Quick Navigator
pane so you can see a thumbnail
overview of a magnified image.
(Only visible for images that are
zoomed in to a size larger than
will fit on the screen.)

Zoom slider Controls the size of the image in
the View mode area. Drag the
slider to adjust the size.

Zoom drop-down list Displays a list of zoom sizes to
select.

Zoom Lock Displays all images at the zoom
option of the current image. If
the zoom level is adjusted, the
new zoom level is applied to all



ACDSee Photo Studio Home 2026

Page 35 of 532

images that you view.

Actual Size Returns the image to its actual
size.

Fit Image Reduces the image to fit within
the View mode area.

Using Windows Touch Gestures™ with View Mode

If you have a Windows Touch Gestures™-enabled device, you can use it with Viewmode for quick, easy
viewing of photos.

To Use Windows Touch Gestures™ with View Mode:

Open an image in Viewmode.

l Swipe on the image to scroll through images one at a time. You can also use this method on the Filmstrip
at the bottom of View mode.

l Hold and swipe slowly in one direction to go through all of the images in the folder.

l Hold down on an image, and then let go to achieve the same results as right-clicking with a mouse.

l Double-tap the image to return to Manage mode in ACDSee.

l Move two fingers apart to zoom in, and toward each other to zoom out.

l After zooming in further than 100%, you can pan the image with your finger.

Switching to Manage Mode

You can return to Manage mode at any time.

To Return to Manage Mode from View Mode:

Do one of the following:

l Double-click the image.

l Click the Manage mode button.

Using Edit Mode

Edit mode is where you can apply changes to your images. You can edit the overall look of your images
by changing the lighting and color, or you can crop, flip, resize, or rotate your images. You can use
selections to fix specific parts of your images. And you can also add final touches to your images, such
as red eye removal, borders, and special effects.
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In Edit mode, you can:

l Use the Selection tools or Edit Brush to select and apply edits to a specific part of the image.

l Remove flaws or red eye.

l Add text, watermarks, borders, a vignette, a tilt-shift, special effects, or drawings.

l Crop, flip, resize, or rotate your images.

l Adjust lighting using the exposure, levels, auto levels, tone curves, and lighting filters.

l Adjust color using the White Balance, Color EQ, Color LUTs, Split Tone or Convert to Black & White
filters.

l Add details to your image using Sharpen, Clarity, Remove Noise, Add Noise or Blur filters.

Using 365 Mode

You can use 365mode to upload your images to seedrive.acdsee.com. seedrive.acdsee.com is an
image sharing and storage service available to ACDSee Home users. With 365mode and
seedrive.acdsee.com, you can upload and browse through your online images without having to
launch an Internet browser.

365mode has two parts: seedrive.acdsee.com and Transfer. In seedrive.acdsee.com, you can browse
through your images in your seedrive.acdsee.com account and modify your account settings. In
Transfer, the screen splits into two. The bottom part of the screen displays the images in your
computer, and the top part of the screen displays your seedrive.acdsee.com. You can simply click
images in your computer displayed in the bottom part of the screen, and drag them into the top part
of the screen to upload the images to your seedrive.acdsee.com account.

You cannot take an image from 365mode and open it in Edit mode. To edit an image, select an
image in Manage or Viewmode and open it in Edit mode.

Uploading Images

To Upload Photos to Your seedrive.acdsee.com Account:

1. In 365 mode, click Sign In.

2. Log in to your account.

3. Click Transfer.

Your screen splits in two, with the bottom part of the screen displaying images in your
computer.

4. Select an image to upload. To select multiple photos, press Shift or Ctrl on your keyboard.

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/About_Special_Effects.htm
file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/Adjusting_Split_Tone.htm
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5. Click and drag the image into the top part of the screen to upload it to your seedrive.acdsee.com
account.

There is no upload size limit when uploading your images to your seedrive.acdsee.com
account.

Using Dashboard Mode

Dashboard mode provides an easy way to monitor your file, camera, and database statistics in one
place. Camera data is gathered from your image metadata, and file information is analyzed from your
ACDSee database. To see the most accurate information, make sure your files are cataloged.

Cataloging Files

To catalog your files, do one of the following:

l Go to Tools | Database | Catalog.

l Browse your folders in Manage mode.

Dashboard Mode Tabs

Dashboard mode is organized into four tabs, each giving you a different view of your data:

l Overview tab: Provides a high-level summary of your photo activity and database status.

l At the top, a graph shows your photo counts by month or year. Use the drop-down menu to
switch between Yearly and Monthly views, and the Prev and Next buttons to move through
time.

l Below the graph, you will find:

l Database Summary: Total Database Size, Total # of Files and Folders, and Last Backup
Date.

l Cameras Summary: Camera Most Used, Total # of Cameras, and Favorite ISO Setting.

l File Summary: # of Image and Video Files, Favorite File Format, and Favorite Image
Resolution.

This tab is useful for a quick health check of your photo collection and
database.

l Database tab: Displays detailed information about your database so you can track its size, structure, and
backup status.
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l Total Database Size: Includes the database file path.

l File Information: A breakdown of Image Files, Video Files, and Other Files.

l Folder Information: Counts for Folders Browsed, Remote Folders Browsed, and Removable
Folders Browsed.

l Orphan Assets: Shows the number of orphaned Files and Folders.

l ACDSee Database Backup: Displays your last backup date, so you can confirm your data is safe.

l Thumbnail Information: Includes the size of the Thumbnail Cache and how many images have
thumbnails.

Use this tab to monitor database performance and ensure your backups and
thumbnails are up to date.

l Cameras tab: Shows how you use your cameras and lenses.

l The Cameras Summary panel (on the left) highlights your Most Used Camera, Lens, Focal
Length, Aperture, Shutter Speed, and ISO.

l The main display includes:

l Circle graphs showing the number of photos by Camera, Lens, and Focal Length, with
percentage breakdowns.

l Bar graphs showing the number of photos by Aperture, Shutter Speed, and ISO.

l You can toggle these graphs on or off from View | Graphs.

This tab helps you understand your shooting habits, such as which lenses or
settings you use most often.

l Files tab: Displays information about your image and video files.

l The File Summary section (upper left) shows the total number of files, your favorite file format,
and your most common image resolution.

l Two circle graphs provide a breakdown of File Formats and Bit Depths, with percentages
displayed in a legend.

l A bar graph displays the Top 20 Image Resolutions in your collection.

This tab gives you insight into the types of files you work with most frequently.
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Chapter 2: Getting Help

Using the Quick Start Guide

The Quick Start Guide is designed to give you a brief orientation of the most important features in
ACDSee. The first two intro pages allow you to configure some settings to facilitate your future
workflow. After the first two intro pages, the Quick Start Guide contains a set of links on the left side
that you can click to get a tour of the main features in ACDSee. You can also use the Next button.

To Close the Quick Start:

Uncheck the Always show at start-up option in the bottom left corner of the dialog box and click
Close.

To Re-Open the Quick Start Guide:

On theMenu bar, click Help | Quick Start Guide.

To Use the Quick Start Guide:

Click the links on the left side of the Quick Start Guide or the Next button for a high-level tour.

To Set Preferences:

1. On the first page, click the Browse button to select the folder ACDSee will open to in the future.

2. On the second page, click the Select button to choose which folders you would like the ACDSee
database to keep track of.

3. Also on the second page, you can choose an interval from the drop-down menu on the right side to
specify how often ACDSee should remind you to backup your database.

Finding Other Resources and Support

Using the Help Menu

The Help menu on the ACDSee menu bar contains links to open plug-in help files and options that link
you to the ACDSee website where you can find updates, newsletters, and system requirements. Other
links take you to the registration page, or the forum homepage where you can join the community
and participate in the ACDSee forums. The Help menu is also where you can convert a trial version of
ACDSee to a full version by entering a license code.

Clicking Help displays a menu of links to online and offline help materials including our online help file,
that you can open any time you are online by clicking Help Contents. From the help menu, you can
also access in-app resources such as in-build plug-in help, the Quick Start Guide, and About, which
gives you information about your software, your license, and your version.
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Press F1 to open related help file pages from within the application.

You will also find a link to Customer Support.

Online Help and ACDSee Connect

As well as the links to online help found on the in-app help menu, we also have comprehensive
tutorials on our YouTube channel, and have an online forum where you can discuss the software with
other ACDSee users. When you visit ACDSee Connect, you will find tutorial videos and online lessons.

https://r.acdsee.com/FFQIo
https://r.acdsee.com/DB3KN


ACDSee Photo Studio Home 2026

Page 41 of 532

Chapter 3: Manage Mode
Manage mode is the main browsing and managing component of the user interface, and is what you
see when you start ACDSee Home using the shortcut icon on your desktop.

In Manage mode, you can:

l The ACDSee Home Page provides quick and easy access to searches and key functions.

l Import your photos from a device, CD or DVD, or disk.

l Browse files and folders.

l Catalog files by tagging them, adding categories, color labels, ratings, keywords and other metadata.

l Search for files and create search presets.

l Publish and share files, including emailing files, creating slideshows, and uploading images to your
favorite photo website.

l Print images.

l Manage your Queued and Idle Activities with ACDSee Activity Manager.

l Edit batches of files.

l Manage and maintain your ACDSee Home database.

l Automatically advance to the next image in the folder when you apply metadata.

l Detect faces in images.

ACDSee Home Page

The ACDSee Home Page appears by default when you launch the program. This behavior can be
changed in the Startup Options. The Home Page provides quick and easy access to searches and key
functions, making it simple to start working on your projects.

Browsing folders or running searches will open in a new tab. For more information, see
Browsing with ACDSee Tabs.

There are three areas to the ACDSee Home Page:

1. Quick Search Bar

2. Search Buttons

3. Action Buttons

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23quick-search-bar
file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23searching-buttons
file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23action-buttons
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Quick Search Bar

Use the Quick Search Bar at the top of the Home Page to quickly locate files or folders. You can refine
or expand your search using the Quick Search options and view the results in the File List pane.

There are three ways to control the Quick Search Bar:

l Clearing Text: Quick Search allows you to type in your search criteria. Clicking X will remove the text
currently in the Quick Search bar.

l Starting Search: Click the magnifying glass or press the Enter key.

l Adjusting Search Parameters: Use the options menu to set the search parameters.

For more information, see Using the Quick Search Bar.

Search Buttons

The Home Page includes five predefined searches for quick access:

l Recently Modified: Displays files modified within the last week by default. This search uses the
Windows Recently Modified field.

l Recently Added: Displays files added within the last week by default. This search uses Date Taken by
default, or can be changed to Date Added to Database in the Home Page options.
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The timeframe for Recently Modified and Recently Added files can be adjusted using the
option menu in the upper-right corner of the button, or in the ACDSee Home Page
options.

l Tagged: Displays files that have been tagged. For more information, see Tagging Images.

l Embed Pending: Displays files with ACDSee Metadata applied that has not yet been embedded. For
more information, see Embedding ACDSee Metadata in Files.

l Unnamed Faces: Displays files that contain detected faces without assigned names. For more
information, see Detecting Faces in Manage Mode.

Action Buttons

Below the search buttons, the Home Page includes five action buttons:

l Customize Shortcut: Opens the Customize Shortcuts dialog, allowing you to customize the keyboard
shortcuts throughout the program. For more information, see Customizing Keyboard Shortcuts.

l Import: Opens the Import Window for adding images. Use the Options menu to select a source such
as device, scanner, disk, or CD/DVD to import from. For more information, see Importing Files with
ACDSee.

Import will only run based on which Import Source you've selected.

l Database: Opens the Back Up Database dialog by default, or can be changed to open either the ACDSee
Database Optimization Wizard, or the Database Maintenance window by changing the setting in the
Options menu . For more information, see Backing Up Your Database, Optimizing the Database and
Maintaining the Database.

l Find Duplicates: Opens the Duplicate Finder dialog, allowing you to locate duplicate files in your
database. For more information, see Finding Duplicate Files.

l Catalog Files: Opens the Catalog Files dialog for cataloging new files. For more information, see
Cataloging Files in the Database.

Importing Files with ACDSee Home

You can use ACDSee Home to download images from devices like your digital camera, flash drives,
CD/DVDs, or other removable devices. In Manage mode, you can also use the File | Import | From
Disk option to import files from a network, and any kind of disk or drive that can be mapped, while
preserving the original folders and subfolders.

Import Status

When importing assets into ACDSee Photo Studio Home 2026, you can track their status, pause, or
cancel them from the Activity Manager. For more information see ACDSee Activity Manager.
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Importing Files Using the Windows AutoPlay Dialog Box

When you connect your digital camera or other device to your computer, theWindows AutoPlay
dialog box prompts you to choose one of the following:

l Import pictures using ACDSee: select this option to open the Import dialog box. You can then select
settings to rename, backup, and place the files. You can save your import settings and give them a name
so that you can re-use them later. You can also create advanced settings for import dates and RAW +
JPEG options if your camera takes both file formats. You can also create a file renaming template to use
with specific kinds of files or projects.

l Manage pictures using ACDSee: select this option to browse the files in ACDSee. You can then choose
to import the files or simply copy and paste the files from the device.

l Import pictures and videos using Windows: select this option if you prefer to use Windows to import
the files.

Depending on the other applications installed on your computer, there may be additional options.

If you experience difficulties with your computer recognizing your device as a drive, explore
your device's manual about mounting the device as a drive. Or use your computer's card
reader to access your memory card.

Importing Files from Specific Types of Devices

For more specific instructions, select the type of device you connected:

l Importing Photos from a Device

l Importing Photos from a CD or DVD

l Importing Photos from a Disk

RAW + JPEG Options

Regardless of which type of device is being used to import photos, if the original camera takes both
RAW and JPEG file formats, options are available to tailor the image import to a desired workflow.

To set the RAW + JPEG import options:

1. In the ACDSee Import dialog, click the Advanced... button at the bottom left.

2. In the Advanced Import Options dialog, navigate to the RAW+JPEG field set.

3. Enable one of the following:

l Place both in chosen destination folder: Places both the RAW and JPEG files in the same
folder determined in the Location field set of the ACDSee Import dialog.
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l Place JPEG in subfolder: Places only the JPEG files in a subfolder identified in the Subfolder
name field.

l Place RAW in subfolder: Places only the RAW files in a subfolder identified in the Subfolder
name field.

4. If either the Place JPEG in subfolder or Place RAW in subfolder radio buttons are enabled, enter a name
in the Subfolder name field.

5. Click OK in the Advanced Import Options dialog.

6. Click Import in the ACDSee Import dialog.

If Place JPEG in subfolder is enabled, all JPEGs will be placed in the subfolder whether there
are matching RAWs or not. The same also holds true when enabling Place RAW in subfolder.
All RAW images will be placed in the subfolder whether there are matching JPEGs or not.

About Removable Devices

With ACDSee, there are several ways to obtain images from your digital camera, scanner, or memory
card. For more information about how your device communicates with your computer, please consult
your device's Help file or manual. Some different types of removable devices are:

l USB Removable device: removable devices include memory cards that you can attach to your
computer using a USB card reader, camera memory cards that insert directly into slots on the
computer, or flash drives. USB removable devices are detected by your computer and are shown in the
structure as a removable drive.

l Windows Image Acquisition (WIA): cameras and scanners that use Windows Image Acquisition (WIA)
drivers to communicate with the computer. Some cameras, including Canon cameras, use WIA. ACDSee
Home automatically detects the WIA protocol.

You require DirectX 9.0c and QuickTime to copy and view audio or video files.

Importing Photos from a Device

The Import From dialog box gives you multiple options for importing your files from cameras, card
readers, flash drives, and other mass storage devices. If you want to simply import files with a few
clicks, you can. Or you can select from several options to streamline your workflow and perform
multiple tasks with each import.

In the Import From dialog box, you can view the thumbnails of the files on the device by their date or
file type. You can change the size of the thumbnails to make it easier to select those you want to
import or leave on the device, and then view only those you have selected.

You can also choose the destination folder or subfolders for the files, create a backup set of files as you
import, and rename the files during the import process, automatically rotating them if your camera



ACDSee Photo Studio Home 2026

Page 46 of 532

has this option. Advanced settings give you options to change the date you want to use, and where to
place RAW and JPEG files if your camera creates both file formats.

You can even organize your files as you import by adding Categories, IPTC and ACDSeeMetadata.

Then you can save all these settings as a preset to use or adapt later.

If your camera connects to the computer as a removable drive, you can also simply copy
photos directly from the File List and Folders pane because ACDSee Home detects and displays
the removable device in the Folders pane. If you are not sure how your camera connects to
your computer, please see About Removable Devices in Importing Files with ACDSee.

Some cameras, for example, Canon, useWindows Image Acquisition (WIA) to communicate
with a computer. If your devices use these protocols, you can import by clicking From Device
on the File | Importmenu. ACDSee Home automatically detects these protocols.

To Download Photos Using the "Import From" Dialog Box:

1. Connect your camera or device to the computer. Make sure your camera is turned on, and the cable is
properly connected to your computer.

2. Do one of the following:

l If the Windows AutoPlay dialog box opens, select Import pictures using ACDSee.

l If you have more than one device connected to your computer, select the device you want to
use from the list, and then click OK.

l In Manage mode, click File | Import | From Device.

l Press Alt + G on the keyboard.

3. In the Import From dialog box, select from the import options as described below.

4. Click Import.

5. To browse your imported photos, click Yes when the Import Complete dialog box displays. A new tab
will open displaying your results. For more information, see Browsing with ACDSee Tabs.

You may require Direct X 9.0c and QuickTime to download audio and video files from your
camera.

Import From Options
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Select items to import

Select items to import You can control which items are imported by choosing one of the
following:

l New: only imports files that have not been imported in the past.
l All: imports all files.
l Custom: imports the selected files. You can control which files are

imported by checking or unchecking their checkboxes.

View by

Date Displays all the files grouped by the dates they were created. To deselect a
date, check the checkbox beside the date. To deselect all dates, uncheck
the All Dates checkbox.

File Type Displays all the files grouped by their file type. To deselect a file type,
check the checkbox beside the file type. To deselect all file types, uncheck
the All File Types checkbox.

View all Displays all the thumbnails of the files on the device.

View selected Displays only the files selected for import.

Choose import preset

Import settings drop-
down menu

Displays the names of recently used import settings to use again, or you
can select one of the following:

l Current: uses the current settings to import.
l Last used: uses the import settings from the last import.
l None: clears all the current import settings.

Save import settings Saves all the current import settings with a name so that you can use them
again. To save (or edit) import settings, select the Save icon and type in
new name (or re-save existing settings).

The new name for the import settings appears in the drop-down menu.

Delete import settings Deletes the saved import settings currently selected in the Import settings
drop-down menu.

Location

Choose Destination
drop-down menu

Displays the names of recently used destinations to use again, or you can
select one of the following:

1. Last used: Uses the destination from the last import.
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2. None: Clears all the current destination settings.

Place in Subfolders drop-
down menu

Displays the following pre-defined subfolder options to select:

l Single folder by name: Creates a new subfolder with the name you
type into the Name field, which activates when you select this option.
All the files are placed into a folder with the new name.

l Single folder by today's date: Creates one folder using today's date
as the name and places all the files into the folder.

l Nested folder by today's date: Creates a series of nested folders,
one below the other, based on today's date and the format you
select in the Format field. The folders are created as the sample
shows and all the files are placed in the lowest folder.

l Nested folders by file's date: Creates multiple sets of nested folders
based on the files' dates and on the format you select in the Format
field, which activates when you select this option. The folders are
created as the sample shows and the files are imported into the
lowest folders on each date.

l Separate folders by file's date: Creates separate folders based on
the individual file dates in the format selected from the Format drop-
down options.

l Preserve subfolder names: Preserves existing folder names when
you use the From Disk option to import. For example, if you have a
flash drive or CD containing images in a complex set of subfolders,
the whole folder tree is imported intact.

Format Displays date format options for the Nested folder options (see above).

Sample Displays a sample of the nested folders that will be created using the
current settings (see above).

Backup to drop-down
menu

Creates a backup set of files using an exact duplicate of the subfolders you
have selected under Place in.

You can also do one of the following:

l Click Browse and then navigate to an existing folder to use as a
backup destination.

l Click Browse and then Make New Folder to create a new folder as a
backup destination.

While existing ACDSeeMetadata is included in the backup
copy, any Catalog settings (IPTC or ACDSeeMetadata)
added during import will not be included.
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File

Rename files to drop-
down menu

Renames each file as it imports according to these predefined renaming
templates:

l Date/time - filename: Creates each filename using the file date and
time the file was created plus the original filename.

l Date/time: Creates each filename using the file date and the time it
was created.

l Camera - sequence number: Creates each filename using the
camera name and a sequential number starting at one.

l Date/time - sequence number: Creates each filename using the file
date and the time it was created plus a sequential number starting at
one.

l Camera - filename: Creates each filename using the camera name
and the original filename.

When you create and save your own renaming templates, they also appear
in this list for you to select.

Edit Opens the Rename Templates dialog box where you can create and save
your own renaming templates.

Apply Metadata drop-
down menu

Select the names of saved metadata presets or select Manage presets to
open the Manage Metadata Presets dialog box of options.

Customize Properties pane Metadata tab: enter ACDSee and IPTC Metadata into to
the fields to add to the files you are importing.

Properties pane Categories tab: assigns the imported files to any category
selected in this tab. You can select multiple categories.

Automatically rotate
images

Rotates your images automatically if your camera creates the information
needed for this option to work.

Delete items from
source after import

Deletes the imported items from their original location or locations after
import.

Advanced

ACDSee database date Opens the Advanced Import Options dialog box where you can change the
date settings for files and specify where to place RAW and JPEG files.

To set the ACDSee Home database, use one of the following as the file
date:

l Exif date: uses the EXIF date embedded in the image by the camera.
l File modified date: uses the date the file was last modified.
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l Specific date: uses the date you select by clicking the in the calendar
drop-down arrow.

RAW+JPEG To specify where to place RAW+JPEG files select one of the following:

l Place both in chosen destination folder: Places RAW and JPEG files
in the folder you have selected under Choose destination on the
Import From dialog box.

l Place JPEG in subfolder: places the JPEG files in the folder you have
selected under Choose destination on the Import From dialog box.
Then creates a new subfolder with the name you type into the
Subfolder name field, which activates when you select this option. All
the JPEG files are placed into the new subfolder.

l Place RAW in subfolder: places the RAW files in the folder you have
selected under Choose destination on the Import From dialog box.
Then creates a new subfolder with the name you type into the
Subfolder name field, which activates when you select this option. All
the RAW files are placed into the new subfolder.

The values set in the IPTC fields are reflected in their corresponding EXIF field.

Importing Photos From a Scanner

You can scan images using ACDSee and import them to specific, accessible locations.

To Specify a Destination for Your Scanned Images:

1. Click Tools | Options |Manage Mode.

2. On the Manage mode page, in the Scanning Destination section, click the Browse For Folder button.

3. In the Browse For Folder dialog, select a destination folder for your scanned images.

4. Press OK.

To Scan Images:

1. In Manage mode, click File | Import | From Scanner.

2. Configure your scanning settings as desired. As the scanning dialog is controlled by Windows, these
settings will vary, depending on your OS and version of ACDSee.

3. Navigate to the location you set as the destination for your scanned images using the Folders pane.
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Importing Photos From a CD or DVD

You can download photos from a CD or DVD using the Import From dialog box, or the Folders pane.
Before you import photos, you can browse to the CD and view them just like any other folder and
then simply copy and paste them into a new location.

If you use the Import From dialog box, you can set the subfolder options to import complex folder
structures intact, including all the folder names. You can also organize your files as you import them,
as well as create a duplicate backup folder, simultaneously.

To Import Photos from a CD or DVD:

1. Insert the CD or DVD into the drive.

2. Do one of the following:

l If the Windows AutoPlay dialog box opens, select Import pictures using ACDSee.

l If you have more than one CD or DVD drive connected to your computer, select the device you
want to use, and then click OK.

l In Manage mode, click File | Import | From CD/DVD.

3. In the Import From dialog box, select the Import From options you want to use, and then click Import.

4. To browse your imported photos, click Yes when the Import Complete dialog box displays. A new tab
will open displaying your results. For more information, see Browsing with ACDSee Tabs.

Importing Photos From a Disk

ACDSee Homemakes it easy to import photos from any other storage device, computer, network,
flash drive etc. In fact, any device that your computer can map to. When you connect a removable
drive, or to a network, disk or another computer, ACDSee Home sees it as a removable drive and you
can browse to it, and around it, using the Folders pane. You can just copy and paste the files into
ACDSee.

If the files in the disk or drive have a complex folder structure or you want to organize, rename, and
back up the files as you import them, it is worth using the Import From dialog box, which has import
settings do all these tasks simultaneously.

To Import Photos from a Disk:
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1. Connect the disk to the computer.

2. Do one of the following:

l If the Windows AutoPlay dialog box opens, select Import pictures using ACDSee.

l If you have more than one disk or drive connected to your computer, select the device you
want to use, and then click OK.

l In Manage mode, click File | Import | From Disk.

3. In the Browse for Folder dialog box, navigate to the removable drive or device in the folder tree, and
then click OK.

4. In the Import From dialog box, select the options you want to use, and then click Import.

5. To browse your imported photos, click Yes when the Import Complete dialog box displays. A new tab
will open displaying your results. For more information, see Browsing with ACDSee Tabs.

Creating a Renaming Template

In the Import From dialog box, you can create, name, and save a template that gives each file a unique
name as they are imported and placed on your hard drive. You can then re-use the template each time
you import photos. Renaming templates can have a numerical sequence, custom text, and file-specific
information in each new file name. You can create and save different renaming templates for different
sorts of files. For example, you could have a different renaming template for a different camera, or a
different type of file.

To Create a Renaming Template:

1. In the Import From dialog box, select Rename files to.

2. From the drop-down list, select one of the following system templates:

l Date/time - filename: Renames the files using the date and time each file was created and the
original file name.

l Date/time: Renames the files using the date and time each file was created.

l Camera - sequence number: Renames the files using the camera name and a sequential
number.

l Date/time - sequence number: Renames the files using the date and time each file was created
and a sequential number.

l Camera - filename: Renames the files with the name of the camera and each file's original
name.

3. To create your own renaming template, or add to a system template, click Edit.

4. In the Rename Templates dialog box, select from the options as described in the table below.

5. Click OK.
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If you check the Skip video and audio files checkbox, the rename process will not rename
video and audio files.

Rename Templates Options

System template drop-down
list

Click the drop-down list to select a different pre-defined system template.

New rename template Click to open the New Rename Template dialog box where you can type
in a name for your own renaming template. Give the renaming template a
name that clearly identifies how you plan to use the template, or what
kind of information the name will contain. For example, Camera name_
photographer.

When you click Save, the name of your new template is added to the
drop-down list of system templates.

Delete Deletes the renaming template currently selected in the drop-down list
unless it is a pre-defined system template, which cannot be deleted.

Rename Template Use this field to create the renaming template. You can type in the
photographer's name and an underscore between each element of the
template to make it easier to read.

Use the following placeholders to ensure that each filename is unique:

l Insert an *. When your files are renamed, the * will be replaced
by the original file name.

l Insert a #. When your files are renamed, each # will be replaced
by a sequential number. If you have copious amounts of files,
insert several ##s. For example, if you enter ###, the first file
renamed will be numbered 001, the next 002, and so on. If you
have over 1000 files, insert ####.

l Insert a metadata placeholder < > and the data inside these
brackets is replaced with whatever data you have chosen. For
example, if you choose <Camera:Model>, the model of the
camera is inserted into each file name.

Insert Metadata Click to open the Choose Properties dialog box, where you can select
from a long list of metadata to insert into your template.

Sample As you type, or add placeholders in the Rename Template field, the same
updates to show you a sample of how renaming template will look.

Skip video and audio files Skips the renaming of video and audio files during the rename process.
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Importing a Lightroom® Database

You can use the Adobe® Lightroom® Database Importer to import your collections, keywords, ratings,
and color labels from Lightroom® into ACDSee. Your keyword hierarchies will import independent of
whether they are embedded in the images selected for import.

You cannot import smart collections or Lightroom CC catalogs, only Lightroom Classic
catalogs.

You cannot begin importing while Lightroom® is open.

If you have a hierarchy in your Collections in ACDSee Home that is identical to your hierarchy
in Lightroom®, these collections will merge.

To Import Your Lightroom® Database:

1. In Manage mode, choose Tools | Database | Import | Lightroom Database.

2. In the Adobe Lightroom Database Importer, press Next.

3. Check the checkboxes of the database information you would like to import into ACDSee, including
Ratings, Labels, Collections, and Keywords.

4. Use the Browse button next to the Location field to navigate to the location of your Lightroom®
database file.

By default, the field displays the default location where Lightroom® stores its database, so
you will only need to browse if you have moved your database.

5. Press Next.

6. Check the summary to ensure that the displayed information is correct. If you see a mistake, use the
Back button to return to the previous page to make any corrections.

7. Press Next. Green checkmarks will display next to the items that are successfully completed, and red
crossmarks will display next to items that failed.

8. Press Finish.

Lightroom is a registered trademark of Adobe Inc.

Working with Images on Mobile

You can access, browse, view, delete, and copy and paste images on your mobile phone with ACDSee.
To edit images on your mobile device, you will need to copy them to a local folder.

To Access the Images on Your Phone Using ACDSee:
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Make sure that file sharing is enabled on your mobile device.

1. With your phone plugged in, open ACDSee.

2. In Manage mode, using the Folders pane, navigate to your phone under This PC/Computer.

3. Using the Folders pane or File List pane, navigate to your images. They are usually stored in a folder
called DCIM.

ACDSee displays file information supplied by your device in the Properties pane.

To View an Image from Your Mobile Phone:

In the File List pane, double-click the image.

You can use the Filmstrip to navigate through the images in the folder.

To Copy Images from Your Mobile Phone to Another Folder Using ACDSee:

In the File List pane, select the images and do one of the following:

l Right-click and choose Copy. Browse to another folder, right-click and choose Paste.

l Right-click and choose Copy To Folder... In the Copy To Folder dialog, select the destination folder and
click OK.

l Go to Edit | Copy, or press Ctrl + C. Then, in the destination folder, go to Edit | Paste, or press Ctrl + V.

To Delete Images from Your Mobile Phone Using ACDSee:

It may be necessary to change settings on your mobile device to allow files to be deleted using
your PC.

In the File List pane, select the images and do one of the following:

l Right-click and choose Delete.

l Press DEL.

l Go to Edit | Delete.

Sending Images to ACDSee from Your Mobile Device Using ACDSee
Mobile Sync

You can use the ACDSeeMobile Sync app to send photos and videos directly from your mobile device
into ACDSee Photo Studio on your PC. This free app is available on iOS from the Apple App Store and
for Android on the Google Play Store.



ACDSee Photo Studio Home 2026

Page 56 of 532

ACDSeeMobile Sync will keep track of which photos have been sent to ACDSee Home and
indicates new and unsent items using a colored border.

In Manage mode, you will be able to access images you have sent to ACDSee Home by clicking the
ACDSeeMobile Sync node icon in the Folders pane.

Getting Started

To download the app, you can:

l Download it in the Apple App Store, for iOS. In the App Store, type ACDSee Mobile Sync in the Search
bar.

l Download it in the Google Play Store, for Android. In the Play Store, type ACDSee Mobile Sync in the
Search bar.

https://r.acdsee.com/yLrIz
https://r.acdsee.com/91TWv
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After installation, open the ACDSeeMobile Sync app on your device. Follow the prompts to give the
app access to your photos and to assign the target (ACDSee on your PC). If your app doesn't find the
target, you can scan the Quick Response (QR) code found on your PC.

To open the QR code, do one of the following:

l Open Tools | Show ACDSee Mobile Sync Details...

l In the Notification Area, right-click on the ACDSee app icon and select Show ACDSee Mobile Sync
Details...

Then scan the QR code using your mobile device camera to add your ACDSee software as a target.

If you cannot scan the QR code, you can also add your ACDSee software as a target using your host
name or IP address.

To add your ACDSee software as a target using your host name or IP address:

1. Make sure you are on the same WiFi network as your PC.

2. On the Mobile Sync app, on the QR scanner page, select Add Without QR Code.

If you skipped the intro, or want to add an additional target, you can reopen the
scanner page by going to Settings and selecting Add Target.

3. Enter your Host name or IP Address and enter the Port. This information can be found above the QR
code when you select Show ACDSee Mobile Sync Details... on your PC.

4. The name of your target will appear. Select Add this Target.

5. This will add your ACDSee software as a target, allowing you to send photos and videos to it.

You must be connected to the sameWiFi network as the PC that is running ACDSee Home in
order to use ACDSeeMobile Sync to send photos and videos.

Sending Images and Videos

You can send images and videos from the ACDSeeMobile Sync app to ACDSee. ACDSeeMobile Sync
keeps track of which items have already been sent. ACDSee Home will notify you with a pop-up in the
lower right corner when it has received your sent items. You can then click on the ACDSeeMobile Sync
node icon in the Folders pane in Manage mode to view the received files.

To send all new items, press the Send button. If you press and hold the Send button, it will send the
selected photos and videos to the default target.

To send specific items, select them and press the Send button.

You can use context menus within the app for more specific selection options.
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You can customize the location of your ACDSeeMobile Sync folder on your hard drive. See
Setting the ACDSeeMobile Sync Options.

Troubleshooting for Mobile Sync

If you have any issues connecting your device to use Mobile Sync, check out our troubleshooting
guide on the ACDSeeMobile Sync webpage.

Browsing Files in the File List Pane

The File List pane is the large pane in the center of the Manage mode window. The File List pane
displays the contents of the currently selected folder, the results of your latest search, or the files and
folders that match your selective browsing criteria. The File List pane is always visible, and cannot be
hidden or closed.

Files display as thumbnails in the File List pane by default. However, you can change the File List pane
view from thumbnails to details, list, icons, tiles, or Filmstrip. You can sort your files according to
name, size, properties, and more. You can also use filters to control which files display in the File List
pane.

Using the File List Pane

There are three sections in the File List pane: the Contents bar, the File List drop-down lists, and the
File List toolbar. The overlay icons, which appear on the thumbnails, allow you to rate, tag, and label
your images or documents and indicate additional information, such as if the file has been processed
or geotagged.

The Contents Bar
The Contents bar is located at the top of the File List pane and describes what you are currently
browsing. When you are using the Folders pane, the Contents bar will display the path or paths to the
folders you are browsing, as in the following example:

If you are browsing files by category or rating with the Catalog pane, the Contents bar displays the
selected classifications, as in the following example:

The Contents bar also displays a date range when browsing with the Calendar pane, and a summary of
your search criteria when you use the Advanced Search pane.

File List Drop-Down Lists

https://r.acdsee.com/2Vsuu
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Filter Displays a list of filter options such as rating and category. You can also select
Advanced Filters and create a custom filter.

Group Displays a list of file attributes that you can use to group files in the File List
pane.

Sort Displays a list of file attributes that you can use to sort the files in the File List
pane.

View Displays a list of view options for viewing files in the File List pane.

Select Displays a list of file selection options.

File List Toolbar

Add to Image Basket Adds selected images to the
Image Basket.

Rotate left Rotates selected images to the
left.

Rotate right Rotates selected images to the
right.

Compare images Opens selected images in the
Compare Images Viewer.

Auto Advance Turns on Auto Advance to quickly
move through images while
adding tags, ratings, labels,
categories, or keywords.

Zoom slider Controls the size of the
thumbnails in the File List pane.
Drag the slider to adjust the
thumbnails.

Photos Displays the contents of the selec-
ted folder as thumbnails.

List View Displays the contents of the selec-
ted folder as a file list.

Overlay Icons
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Icon Name Description Instructions

Sound / Playing Sound Appears if the
file contains
embedded or
associated
audio. The
second icon
appears if you
click on the
sound icon and
the embedded
sound begins
playing.

Left-click to play
embedded
audio.

Rating Appears if the
file has been
rated in the
ACDSee Home
database.

Color Label Appears if the
file has been
assigned a
color label.

Embed Pending Appears if the
file has
ACDSee
Metadata
stored in the
ACDSee Home
database that
has not yet
been written
to the file.

Right-click and
choose either:

l Embed
ACDSee
Metadata:
writes the
metadata
to the file.

l Clear
Embed
Pending
Icon...:
clears this
overlay
icon, but
does not
write the
metadata
to the file.
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Icon Name Description Instructions

File format Displays the
file format.

Left-click to
display the File
Information,
Image
Attributes, and
EXIF Metadata
(summary) on
the File tab of
the Properties
pane.

Category Appears if the
file has been
categorized.

Left-click to
open the
Categories
section on the
Organize tab of
the Properties
pane.

Collection Appears if the
file has been
added to a
collection.

Shortcut Appears if the
item is a
shortcut to
another file.

Offline Appears if the
file is stored
on an offline
device.

Excluded items Appears if the
file has been
excluded from
the ACDSee
Home
database.

Tagged items Appears if the
file has been
tagged.
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Icon Name Description Instructions

Untagged items Appears if the
file has not
been tagged.

Geotagged items Appears if the
file has been
geotagged.

Left-click to
open the Map
pane.

Auto-rotate Appears if the
file has been
automatically
rotated.

Left-click to
rotate the image
original
permanently
and update the
EXIF
information.

Edited Appears if the
file has been
edited.

Changing Overlay Icon Visibility

You can change whether overlay icons are visible, visible in color, and which icons are in color.

To Change Overlay Icon Visibility:

In ManageMode, at the top of the File List pane, do one of the following:

l Click View | Toggle Overlay Mode to control whether the overlay icons are invisible, visible in grayscale,
or visible in color. Toggle the (]) key to move through the available modes.

l Click View | Highlight Overlay to select which icons appear in color. Toggle the ([) key to select from the
available options.

Note that this does not apply to all overlay icons. For more control over which icons are
visible, see Setting the Thumbnail Info Options.

Maximizing the File List Pane

To make the most of your available screen space, you can choose to maximize the File List pane and
hide the rest of the Manage mode panes. The only parts of the Manage mode window that remain
visible are the File List pane and whichever toolbars you are currently using.
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To Maximize the File List Pane:

1. Click View |Maximize File List.

2. To show only the File List pane and its toolbar, click View | Full Screen.

3. Click the Close Full Screen button in the upper right corner to return to Manage mode.

To Manage Your Files:

Do one of the following:

To delete a file, in the File List pane, right-click the file and choose Delete from the context menu, or
press Delete.

To rename a file, right-click the file and choose Rename from the context menu, or press F2. You can
also Type a new name for the file and press Enter.

Browsing Using the Folders Pane

The Folders pane displays a directory tree of all the folders on your computer in the same style as they
appear in Windows Explorer. You can select one or more folders in the Folders pane to display their
contents in the File List pane. The Folders pane also displays your Cloud Drives as a node, allowing you
to navigate your cloud content like any other folder.

You can also use the Folders pane to create shortcuts to your favorite files, folders, or applications.
Then, instead of having to search for a specific file, you can quickly access it in the Shortcuts pane.

Whenever you browse to a folder using the Folders pane, the ACDSee Home database catalogs any
images, documents, or media files in the folder.

To Open or Close the Folders Pane:

In Manage mode, click Panes | Folders.

When you connect a removable device, such as a mass storage device or digital camera, the Folders
pane displays the device as another drive, and assigns it a drive letter automatically.

You can access the device, and its contents, by clicking on it in the Folders pane.

Selecting Multiple Folders

Easy-Select bars are indicators on the left side of the Folders and Catalog panes, they look like this:
. You can use the Easy-Select bars to select multiple folders, categories, or ratings, and display their

contents in the File List pane.

To Use the Easy-Select Bar:

In the Folders pane, select the indicator to the left of each folder with contents you want to display.

You can also use the Easy-Select bars with the Selective Browsing pane.
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Creating and Managing Folders

You can use the Folders and File List panes to create, delete, rename, and move folders on your hard
drive to help organize your files.

To Manage Your Folders:

1. In the Folders pane, browse to where you want to add, delete, or rename a folder.

2. Do one of the following:

l To create a folder, click File | New, and then select Folder. Type a name for the new folder and
press Enter.

l To delete a folder, select a folder and press Delete.

l To rename a folder, right-click the folder you want to rename and select Rename. Type a new
name for the folder and press Enter.

You cannot rename a drive or any folder on a read-only file system, such as a CD-ROM.

Browsing Using ACDSee Tabs

ACDSee Tabs inManage Mode allow you to open and manage multiple folders, search results, and
more—all within a single window. You can easily open folders in new tabs, retain search results for
later reference, and conduct multiple searches, switching between them as needed.

When working with assets inManage Mode, you can open up to 25 different tabs.

Startup Behavior

To set the Startup Behavior, go to Tools | Options, then selectManage Mode.

You can configure ACDSee to launch with one of four startup behaviors:

l Open ACDSee Home Page: Displays the ACDSee Home Page on launch.

l Open Start Folder: Opens a new tab showing your designated Start Folder. Also determines where a
new tab will start.

l Reopen Last Active Tab: Re-opens the last active tab you were using before closing ACDSee.

l Reopen All Previous Tabs: Restores all tabs that were open prior to closing the application.

Managing ACDSee Tabs

Opening a New Tab to the Start Folder

To open a new tab to the Start Folder, perform one of the following:
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l Click the + to the right of the currently visible tab(s).

l Right-click on the tab-bar and select New Tab, or press Ctrl + T.

l Right-click on any folder and select Open in New Tab.

The Home folder can be changed in the Manage mode options. See Setting the ManageMode
Options.

Opening a New Tab to a Specific Folder

To open a new tab to a specific folder, perform one of the following:

l Right-click on a folder and select Open in New Tab. You can open folders this way from the File List
pane and the Folders pane.

l Middle-click a folder.

l Right-click a tab-bar and select Duplicate, or press Alt + D. This duplicates the currently selected tab.

Closing Tabs

Closing a Single Tab

When you have more than one tab open, individual tabs can be closed by performing one of the
following:

Click the X on the tab. Appears when two or more tabs are open.

Middle-click on a tab. Closes the clicked tab.

Right-click on a tab and select Close Tab, or press Ctrl + W. Closes the currently selected tab.

Closing Multiple Tabs

When you have more than one tab open, multiple tabs can be closed by performing one of the
following:

Right-click a tab and select Close Other Tabs. Closes all tabs except the selected one.

Right-click a tab and select Close Tabs to the Left. Closes all tabs to the left of the selected tab.

Right-click a tab and select Close Tabs to the Right. Closes all tabs to the right of the selected tab.

Manage Modewill always have at least one tab open.
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Tab Navigation

Tabs can be navigated quickly using keyboard shortcuts:

Activate Next Tab Press Ctrl + Page Down or Ctrl + Tab.

Activate Previous Tab Press Ctrl + Page Up or Ctrl + Shift + Tab.

Transferring Files Between Tabs

You can drag and drop files between tabs by selecting the assets you want to move. Drag the files up
to the target tab and hover briefly to switch to that tab, then drop them into the file list.

Managing Panes and Options in ACDSee Tabs

InManage Mode, many options and panes can be customized independently per tab. This includes
settings for Filter, Group, and View options, as well as the Folders, Catalog, Calendar, and Advanced
Search panes. When a new tab is opened, its options and panes are duplicated from the previously
selected tab. When ACDSee closes, all tabs close, but the program restores the options from the last
active tab upon restart.

Performing Searches Using ACDSee Tabs

Searches are performed within tabs, allowing you to retain results by opening a new tab and
continuing your work. You can easily return to your original search tab at any time. Searches in the
Advanced Search, Catalog, or Calendar panes, as well as selections within those panes, are specific to
each tab—enabling multiple searches and comparisons across tabs.

Using Microsoft OneDrive™

You can use Microsoft OneDrive™ directly from Photo Studio, allowing you to access all of your photos
without the need to migrate.

Local and Cloud Access:

When browsing in OneDrive™, you'll have the option to select whether or not files automatically
download to your PC, or remain stored on the cloud.

File Context Menu:

Right clicking on either a OneDrive™ folder in the folders pane, or any individual file will provide the
following context menu options:

l Always Keep on this Device: This option will tell the selected files or folders to download and keep local
copies of the items on your PC.
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l Free Up Space: This option will tell OneDrive™ to not download the selected files or folders, and
remove any local copies. This will limit what data is visible, but will free up space on your PC.

OneDrive™ will store and display files in three ways:

l Local: Files with the unfilled green checkmark circle indicate that they have temporarily downloaded
from OneDrive™ onto your PC. OneDrive™ may offload the files automatically when syncing back to the
cloud at a later time.

l Always Local: Files that have been set to always keep on this device are indicated by the filled in
green checkmark circle. OneDrive™ will retain a copy of the file locally when it syncs with the server,
ensuring that the file is always available on your PC.

l Cloud: Files with the cloud icon indicate that they presently exist within the cloud only, and are
available for downloading/viewing.

Cloud files will be downloaded automatically when taken to View or Edit mode. When
accessing a large file, it may take longer than usual to switch modes or switch between files if it
is still being downloaded.

OneDrive™ Status Column:

You can see the status of your files in OneDrive™ in a variety of ways:

In Manage mode you'll see the status of your files in Filmstrip, Thumbnails, and Tiles view
automatically. Thumbs & Details, and the Details views can have OneDrive status added.

To add OneDrive status to Thumbs & Details or Details:

1. Click on View directly above your image files, and select Thumbs & Details, or Details

2. Right click the Details Header bar and select Choose Details...

3. Click File Properties, then OneDrive Status, and click the Add -> button.

4. Select Ok.

List and Icons views do not display OneDrive status.

Viewing and Embedding Metadata to Your Files on OneDrive™

EXIF and IPTC metadata is not visible until the file has been downloaded to your PC.

You can still add new ACDSee metadata to the file even while it's only on the cloud.

If you'd like to embed ACDSee metadata to the file, please see Embedding ACDSeeMetadata in Files.

Moving Files to OneDrive™:

Select one or more files outside of OneDrive™ and right click to open the context menu and select
Move to OneDrive. Files will be moved to your root OneDrive™ folder.
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If you have both a personal and business OneDrive™ connected, you'll be able to select from
either one.

Browsing Files By Date or Event

With the Calendar pane you can browse your collection of image and media files using the dates
associated with each file. The Calendar pane includes Events, Year, Month, Day view and the Photo
Calendar, which shows thumbnails per day within a month. You can click any date in the Calendar
pane to display a list of files associated with that date.

To Open the Calendar Pane:

In Manage mode, click Panes | Calendar.

The Calendar pane opens in the center File List pane area.

Your images will not display in the Calendar pane until you have either browsed the folder
containing the images or used the Catalog Files wizard to catalog your images so they are in
the ACDSee Home database.

If you are using the Photo Calendar, you only see thumbnails if there are photos on a
particular day in that month. Days that have no photo, are blank.

Calendar Pane View Options
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Events View Switches the Calendar pane to Events view. In the Events view
you see only those months during which images or media files
are available. Next to the month you see the number of dates
on which images or media files are available. Expand the
month to see the dates and the number of pictures available
for those dates. You can add a description and a thumbnail
image to help you remember the event.

Year View Switches the Calendar pane to Year view. In Year view you see
a series of tables. Each table represents a specific year. Next
to the year you see how many images or media files are
associated with that year. The months during which images or
media files are available are highlighted.

Month View Switches the Calendar pane to Month view. In Month view you
see a series of tables. Each table represents a specific month.
Next to the month you see how many images or media files
are associated with that month. The dates on which images or
media files are available are highlighted.

Day View Switches the Calendar pane to Day view. In Day view you see a
series of tables. Each table represents a specific day. Next to
the date you see how many images or media files are
associated with that date. The time at which the images or
media files are available are highlighted.

Photo Calendar Switches the Calendar pane to the Photo Calendar. In the
Photo Calendar, you see a single month with thumbnails for
any day that contains photos. A pop-up of the first four images
opens if you hover your cursor over a thumbnail. Click on a
thumbnail and all the pictures for that date display in the File
List. The total number of photos belonging to that month is in
the top right corner of the calendar. Drag the title bar to float
this pane onto another monitor and drag a corner to resize it
and make the thumbnails bigger or smaller.

Options Use the Calendar pane options to specify which date you want
to use to organize your files. For example, you can quickly
change the setting so that the photos are displayed by the
following:

l Date the ACDSee Home database cataloged the file

l Date the image was taken

l Date the file was modified

l Date the file was loaded to your computer
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Select Options to open the Calendar dialog, where you can set
filter options, choose the day to start the week, and set clock
formats.

Table of Contents Opens a list of event dates.

Only available in Events View.

In all views apart from Events View, you can use Shift + Left Arrow or Shift + Right Arrow to
navigate between dates with images. For example, in Month View, if you had taken pictures in
August, September, and November, by using Shift + Right Arrow, you will skip the empty
month of October.

Adding Descriptions and Thumbnails in Events View

You can add a description and a thumbnail image to dates in Events view to help you remember the
event.

Try right-clicking the Calendar Title bar and select Floating to move the pane to a new location.

To Add a Description to a Date in Events View:

1. Expand the month to see the dates on which images or media files are available.

2. Click Enter event description here and replace the highlighted text with a new description.

3. Press Enter or click outside of the description area. The description is saved.

To Select a Specific Thumbnail in the Events View or Photo Calendar:

1. Expand the month to see the dates on which images or media files are available.

2. Click on a date to display the images or media files in the File List pane.

3. Click and drag an image or media file and drag it to the thumbnail area for the date.

When you release the mouse button the thumbnail is saved. You can reset the default
thumbnail by right-clicking the thumbnail and selecting Restore Default Thumbnail.

To Navigate a Long List of Dates in Events View:

1. To expand and collapse specific groups click the +/- signs which are located on the left side of the group
header.

2. To expand and collapse all groups right-click a group header and select either Open All Groups or Close
All Groups.
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3. To scroll through multiple groups click the Next Group and Previous Group buttons, which are located at
the bottom of the File List scroll bar.

4. At the bottom of the Calendar pane scroll bar, click the Table of Contents button and select a date.

Browsing Your Favorite Files

You can create shortcuts to your favorite files for easy access.

Accessing the Shortcuts Pane

Click Panes | Shortcuts.

Creating a Shortcut

You can create shortcuts to folders and files, and even run executable files, from inside the Shortcuts
pane. Favorite shortcuts can be copied, renamed, moved, or deleted just like a folder. You can even
use an executable shortcut to start another application from inside ACDSee. You can also create a
shortcut by dragging a file, folder, or executable file directly from the File List pane to the Shortcuts
pane.

To Add Files to the Shortcuts Pane:

1. In the File List pane, select a file, folder, or executable file.

2. Do one of the following:

l Right-click the item you selected, and then select Add to Shortcuts.

l Click File | Add to Shortcuts.

3. Type a name for the new shortcut and click OK.

Creating a New Folder

You can create a folder, or an entire directory tree, in the Shortcuts pane to help organize your
favorites.

To Create a New Folder:

1. In the Shortcuts pane, right-click the Shortcuts folder, or a folder you previously created, and then select
New | Folder.

2. Type the name of the folder and press Enter.

If you move a file or a folder that is a shortcuts, you break the link and the shortcut no longer
works.
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Deleting a Shortcut or Folder

You can delete a shortcut or folder from within the Shortcuts pane.

To Delete a Shortcut or Folder:

In the Shortcuts pane, right-click the shortcut or folder, click Delete, and then click Yes to confirm
that you want to delete the shortcut or folder.

Detecting Faces in Manage Mode

ACDSee automatically adds file information and thumbnails to the database as you browse. This
process is called cataloging. Once the folder you are browsing has been cataloged, ACDSee begins the
process of detecting faces in your images. As you open other folders, ACDSee will prioritize scanning
faces in the most recently viewed folder, placing them at the front of the queue, before continuing to
process the remaining images. You can view the scanning progress in the Idle Activities section of the
Activity Manager. You can find the Activity Manager pane on the right side of the application by
default, press Ctrl + Shift + 6, or go to Panes | Activity Manager. ACDSee will continue scanning until
Face Detection is complete, or has been manually paused or turned off.

Scanning for Faces:

In the Idle Activities section of the Activity Manager, you will see a display of the number of images
queued for scanning.

If your queue has become too large and you wish to reset it, you can clear it using the options gear in
the top-right corner of the Idle Activities section. You can also flip the toggle on the right side of the
Face Detection section to turn it off at any time.

You can also detect faces on an image by image basis in Viewmode. Face Detection will scan
each image for faces as you open it.

After Face Detection has run on the folders you have browsed, you can open the images in Viewmode,
where the faces will be outlined. You can assign names to the detected faces in Viewmode.

To Enable or Disable Face Detection:

Choose Tools | Options | Face Detection and check or uncheck the Enable Face Detection checkbox.

Once you have assigned names to detected faces in Viewmode, you can use the People group of the
Catalog pane to find photos based on the individuals in them. You can also search by name in the
Quick Search bar and the Advanced Search pane. You can manage the names assigned to faces
through Face Detection using the People mode.

To Remove Face Detection and Recognition on Selected Images:

You can remove face detection and recognition data on images selected in Manage mode.
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1. In Manage mode, select one or more images.

2. Choose AI | AI Face Detection | Remove Faces, or right-click an image select AI Features | AI Face
Detection | Remove Faces.

These images will remain marked as having been scanned for faces, and Face Detection will not re-scan
them, unless triggered by the Redetect Faces command, or enabling the option to rerun Face
Detection.

To Rerun Face Detection on Selected Images:

You can force Face Detection to re-scan selected images in Manage mode.

1. In Manage mode, select one or more images.

2. Choose AI | AI Face Detection | Redetect Faces, or right-click an image and select AI Features | AI
Face Detection | Redetect Faces.

To Rerun Facial Recognition on Selected Images:

In order to correct names mistakenly assigned to faces by ACDSee, you can rerun facial recognition on
faces you have not manually named within the selected image or images. This clears all names
assigned by ACDSee's facial recognition, but leaves manually entered names. ACDSee will then attempt
to recognize unnamed faces based on names you have entered manually.

1. In Manage mode, select one or more images.

2. Choose AI | AI Face Detection | Rerun Recognition, or right-click an image select AI Features | AI Face
Detection | Rerun Recognition.

Faces can only be auto named if the Enable Auto Naming option is enabled.

Embedding, Retrieving, and Importing Face Data

Any interaction you make with the Face Detection feature will create "face data", which is added to the
database, and will, therefore, trigger the Embed Pending icon. Face data is embedded in your image's
XMP file, just like any ACDSeeMetadata. By embedding this face data into your files as well, you can
share it, restore it, or make it available in a new database.

To Embed Face Data:

You can embed your face data using the Embed ACDSeeMetadata dialog. See Embedding ACDSee
Metadata in Files.

To Retrieve Face Data Embedded in Files:

Do one of the following:

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23enable-auto-faces


ACDSee Photo Studio Home 2026

Page 74 of 532

l Choose AI | AI Face Detection | Import ACDSee Face Data.

l Choose Tools | Database | Catalog Files. In the Catalog Files dialog, in the Import from Cataloged Files
section, check the ACDSee Face Data checkbox. Press Start.

To Import Embedded Face Data From Lightroom or Picasa :

1. In Manage Mode, select the images for which you have embedded face data in another application.

2. Select AI | AI Face Detection | Import Lightroom or Picasa Face Data.

3. A warning dialog will pop up asking if you want to overwrite any existing face data and add face data
from another program to the files. Select OK if so.

4. Your face data will import and the face data will be added to your database.

Changing Views

You can select different views to display your files in the File List pane, including thumbnail previews
and file details. You can also customize the appearance and size of thumbnails, and specify the
information displayed in the Details view.

To Change the File List View:

In Manage mode, in the File List pane, under View, select from the following:

Views
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Thumbs+Details Displays file names and details in a list, and adds a thumbnail preview to the
Filename column.

Filmstrip Displays thumbnail previews of your files in a single row across the bottom of
the File List pane, and displays the currently selected file in an expanded
Preview pane.

Thumbnails Displays thumbnail previews of all image and media files (and some
document types) in the File List pane. You can customize the appearance of
thumbnails, and specify what information to display with them.

Tiles Displays each file in the File List pane on a "tile" that includes a thumbnail
preview and file information. You can resize the tiles using the Zoom slider.

Icons Displays files in a list, represented by large default system icons for each file
type.

List Displays a list of file names and extensions.

Details Displays a list of file names and details about each file, such as size, format,
and creation date. You can customize the appearance of the Details view
mode, as explained below, and specify what information it displays.

Toggle Overlay Mode Controls whether overlay icons are invisible, visible in grayscale, or visible in
color. Use the (]) key to choose.

Highlight Overlay Controls which overlay icon is colored. Use the ([) key to rotate through.

Customizing the Details View

You can set the Details view to automatically resize columns, display or hide grid lines, and select an
entire rowwhen you select a column entry in that row. You can also change the appearance of the
Details view, select which columns to display, and customize the column order.

To Select Columns and Set Column Order:

1. In Manage mode, from the File List drop-down, click View | Choose Details.

2. In the Choose Details dialog box, do one or more of the following:

l To add a column, select a folder or detail name in the Available Details pane, and then click Add.
Adding a folder adds all detail names within the folder.

l To remove a column, select a detail name in the Currently Displayed Details pane, and then click
Remove.

l To move a column to the left in the File List pane, select its name in the Currently Displayed
Details pane and clickMove Up.
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l To move a column to the right in the File List pane, select its name in the Currently Displayed
Details pane and clickMove Down.

3. Click OK.

You can click Reset to display only the default column names in the Currently Displayed Details
pane, and you can also move a column in the File List pane by dragging its header to a new
position. A vertical line indicates where the column will be inserted.

Filtering Files

You can use the Filter By options to identify the types of files and folders you want to display in the File
List pane.

To Filter Files in the File List Pane:

Do one of the following:

l Click View | Filter By and select a filter option.

l Click the Filter drop-down and select a filter option.

If all your thumbnails seem to disappear, click Filter | All and they reappear.

To Create a Custom Filter:

1. Do one of the following:

l Click View | Filter By | Advanced Filters.

l Click the Filter drop-down and select Advanced Filters.

2. Select Apply filtering criteria.

3. Select or clear one or more of the following options to show or hide that file or folder type in the File
List pane:

l Show image files

l Show media files

l Show folders

l Show archive files

l Select Show hidden files and folders to show files and folders that are normally hidden by your
operating system.
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l Select Show THM files to show thumbnail files.

l Select Show XMP files to show the XMP sidecar files.

4. Click OK.

Grouping Files

If you have to browse a lot of images in the File List you should consider using Group By to organize
images into different groups. You may find it easier to find images when they are organized into
groups. For example, if you use more than one camera, you can quickly organize your images
according to the camera you used to capture the images. Similarly, if you save your images into
different file formats you can quickly organize your images according to their file format.

Group By only works in the Thumbs, Thumbs + Details, Details, Tiles, and Icons views.

The Edited State group is particularly useful for finding images that you have edited.

To Group Files in the File List:

1. Browse to the folder or folders containing your files.

2. Do one of the following:

l Click View | Group By and select a group option.

l Click the Group drop-down and select a group option.

Navigating Through Groups in the File List

To Expand and Collapse Specific Groups:

Click the Expand or Collapse arrows, on the left side of the group header.

To Expand and Collapse All Groups:

Right-click a group header, and then select either Open All Groups or Close All Groups.

To Display a Preview of the Images in a Closed Group:

Hover your cursor over the group header.

To Scroll Through Multiple Groups:

Click the Next Group and Previous Group buttons at the bottom of the File List scroll bar.
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To Display the Table of Contents:

Do one of the following:

l Click View | Group By | Table of Contents.

l Click the Group drop-down list and select Table of Contents.

l At the bottom of the File List scroll bar, click the Table of Contents button.

To Quickly Jump to a Specific Group:

1. Display the table of contents.

2. Click the group that you want to display.

To Change the Sort Order of the Groups:

Do one of the following:

l Click View | Group By and select either Group Forward or Group Backward.

l Click the Group drop-down and select either Group Forward or Group Backward.

Removing Groups from the File List

To Remove a Group:

Do one of the following:

l Click View | Group By | None.

l Click the Group drop-down list and select None.

Selecting Files in One or More Groups

To Select Files in Groups:

Do one of the following:

l Click the group header to select all of the files in that group.

l Press and hold the Ctrl key and click two or more group headers to select all of the files in those groups.

Sorting Files

In Manage mode, you can sort your files according to different file properties to quickly organize your
images, find specific files, and create a range of files with similar attributes for easy selection.

To Sort Items in the File List:



ACDSee Photo Studio Home 2026

Page 79 of 532

1. Click View | Sort By, and then select a sort option:

l Filename

l Size (KB)

l Image Type

l Modified Date

l Image Properties

l Caption

l Rating

l Tagged

l More (sort by metadata, EXIF, file properties, image attributes, IPTC information, or multimedia
attributes)

2. To set the direction of the sort, click View | Sort By, and then select a direction:

l Sort Forward

l Sort Backward

Your sort settings are saved until you change them. For example, if you sort images in the File
List pane according to Rating, the images will remain sorted according to Rating until you
change the sort settings.

Sorting Files Using Column Headers

You can quickly sort files in Details viewmode using column headings.

To Sort Files Using a Column Header:

1. Click a column header. An arrow appears, indicating the sort direction.

2. Click the column header again to change the sort direction.

Custom Sorting Files

You can use custom sorting to customize the order of files in the File List pane. After custom sorting
your files, ACDSee Home automatically saves the file order for the selected folder until you change it or
delete the custom sort order.

To Customize the Sorting Order of Your Files:
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1. Select one or more files.

2. Drag the selected files to a new location in the File List.

To delete a custom sort order, click View | Sort By, and then select Delete Custom Sort.

Selecting Files

In the File List pane, you can select all of your files and folders at once, select all of the files in the
current folder, select only the image files, or clear your selection entirely.

You can also set an option to automatically select new files whenever you add them to the File List.
Click Tools | Options | File List to set this option.

To Select Your Files or Folders:

l Click a thumbnail to select the file.

l Ctrl + click to select more than one file.

l Shift + click to select a number of files in a row.

Click off to the side in the file list pane to clear your selection.

To Select Your Files or Folders Using the Menu:

1. In Manage mode, click Edit.

2. Select one of the following:

l Select All: selects all files and subfolders in the current folder.

l Select All Files: selects all files in the current folder.

l Select All Images: selects all image files in the current folder.

l Select Tagged: selects all tagged image files regardless of their folder.

l Select by Rating: displays a list of ratings, and selects all files currently assigned to the rating you
select.

l Clear Selection: clears your selection.

l Invert Selection: selects all files except for your original selections.

Previewing Images

You can preview image, audio, and video files in the Preview pane. By default, the Preview pane
displays a thumbnail of the currently selected image or media file. You can resize the pane to adjust
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the thumbnail dimensions, and reposition the pane anywhere on your screen. You can set the Preview
pane to display highlights of the image's EXIF information for quick reference.

To Open or Close the Preview Pane:

Do one of the following:

l Click Panes | Preview.

l Press Ctrl + Shift + P.

To Show or Hide What Displays in the Preview Pane:

You can customize the options displayed in the Preview pane when you have an image displaying.
Right-click the image in the Preview pane, select Image and Information, and then select one of the
following:

l Show Image: displays only a preview of the image.

l Show Information: displays EXIF information about the image. This is called the Information palette.

The Information Palette

The Information palette is located in the bottom left of ACDSee and provides immediate access to the
most useful elements of an image's EXIF information. It includes:

l Camera Name and Lens Model

l Dimensions

l File Size

l Exposure Program

l White Balance

l Metering Mode

l Flash

l RAW (will be blank for files that are not RAW)

l ISO

l F-Stop

l Shutter Speed

l Exposure Compensation

l Focal Length
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If you are unsure what a certain symbol means, you can hover your mouse over it for a pop-
up explanation.

To Customize the Preview Info:

You can customize what information displays at the bottom of the Information palette section of the
Preview pane. The date and time that the image was taken is selected by default.

1. Right-click the date and time at the bottom of the Information palette in the Preview pane.

2. Click Choose Preview Info...

3. In the Choose Details dialog box, select the item listed under Currently Displayed Details and press the
Remove button.

4. From the Available Details column, choose an item by checking the checkbox next to it and pressing the
Add button.

5. Click OK.

To Preview Audio or Video Files:

1. Click Tools | Options | Preview.

2. Check the Preview audio and video clips checkbox.

3. Click OK.

The Information palette also displays in View and Edit mode. To turn off the Information
palette, deselect Info Palette under the Viewmenu in Edit mode, or Panes menu in View
mode.

Rotating Images

You can rotate images in Manage and Viewmodes using the Rotate icons in the bottom toolbar.

When you rotate unedited JPEG images, ACDSee performs a lossless rotation, meaning no
information is lost.

To Rotate Images:

1. In Manage mode or View mode, select one or more images.

2. Click the Rotate Left or Rotate Right icon in the bottom toolbar.

Rotate Icons
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Rotate Left Rotates the image 90° to the left.

Rotate Right Rotates the image 90° to the right.

Comparing Images

You can use the Compare Images feature to compare a group of images. The tool highlights both the
similarities and the differences in the properties, metadata, and pixel intensity levels of images you
select. You can save your preferred images to a new location on your hard drive, or tag images you
would like selected in Manage mode, and then delete, move, rename, or alter the images.

To Compare Images:

1. In the File List pane, select the images that you want to compare.

2. Click Tools | Compare Images.... Up to four images display in the Compare Images Viewer.

3. To change which image displays in the comparison view, do one or more of the following:

l In the Comparison List, right-click an image and click Send to Active View (indicated by a pale
box).

l In the Comparison List, drag an image to a box in the Compare Images Viewer.

l In the Compare Images Viewer, right-click an image and click Next Image or Previous Image.

l In the Compare Images Viewer, right-click an image and click File | Remove From View or click
the Remove icon in the image toolbar.

4. To tag images, do one of the following:

l In the Comparison List, check the checkbox that is located at the bottom of the image on the
right side.

l In the Compare Images Viewer, right-click an image and click Tag or click the Tag icon in the
image toolbar.

l Click the Tag All button in the bottom left corner to tag all of the images, or click Untag All to
untag all of the images.

5. To rate images, right-click an image, click Set Rating, and then select an appropriate rating.

6. To categorize images, right-click an image, click Set Categories, and then select an appropriate category
(or create an appropriate category).

7. Click OK, located in the bottom right corner.

Compare Images Toolbar
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Previous Swaps the selected image with the previous image in the
Comparison List.

Next Swaps the selected image with the next image in the Comparison
List.

Zoom In Increases the magnification of the selected image.

Zoom Out Reduces the magnification of the selected image.

Zoom menu Opens a menu of zoom options. Select from the following options:
l Actual Size: displays the image at its original size.
l Fit Image: displays the image at the largest magnification
that fits in the Compare Images Viewer.

l Fit Width: displays the image to fit between the left and right
sides of the Compare Images Viewer.

l Fit Height: displays the image to fit between the top and bot-
tom of the Compare Images Viewer.

l Zoom Lock: displays all images at the zoom option of the cur-
rent image. If the zoom is adjusted, the new zoom level is
applied to all images that you view.

l Zoom To: opens a dialog box where you can select a zoom
option.

Pan Lock Locks the panned image area, so that when you zoom and pan an
image to a specific area, the Compare Images Viewer displays the
same area for all images you view.

Exposure warning Indicates pixels that may be over or underexposed.

Properties Displays properties for each image in the Compare Images Viewer.
Click the Metadata Setup button to specify which file properties
are displayed.

The Compare Images tool displays the file properties in a field
below each image. Differences in properties are bolded, while
similarities are displayed in regular font.

Histogram Displays a histogram for each image in the Compare Images Viewer.

Metadata Setup Opens a dialog box where you can select the metadata to display for
each image in the Compare Images Viewer (ensure Properties

is toggled to on).
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One Image Displays one image in the Compare Images Viewer.

Two Images Displays two images in the Compare Images Viewer.

Three Images Displays three images in the Compare Images Viewer.

Four Images Displays four images in the Compare Images Viewer.

Properties Pane If one image is displayed, this button opens the Properties,
Histogram, Magnifying Glass, and Navigator panes.

Help Opens the Help file.

Image Toolbars
Each image in the Compare Images tool has a toolbar located below it. You can use this toolbar to
adjust each image individually.

Save Opens a dialog box where you can save the image with a different
file name and a different file format.

Previous Swaps the displayed image with the previous image in the
Comparison List.

Next Swaps the displayed image with the next image in the Comparison
List.

Zoom In Increases the magnification of the image.

Zoom Out Reduces the magnification of the image.

Delete Deletes the image from your hard drive.

Remove Removes the image from the Comparison List.

Tag Tags the image so that it will remain selected when you close the
Compare Images tool.
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Gathering Images in an Image Basket

You can use image baskets to gather and hold images and media files from different locations or
folders. Once you have placed items in an image basket, you can use any of the tools or features in
ACDSee Home to edit, share, or view those files. You can create up to five image baskets and use them
simultaneously.

To Open an Image Basket:

In Manage mode, click Panes | Image Basket | New Image Basket or press Ctrl + Shift + 9. Repeat
this step to open up to five image baskets.

To Add Files to an Image Basket:

Do one of the following:

l In the File List pane, select the files you want to add. Drag the items to the Image Basket.

l In the File List pane, right-click selected files and choose Add to Image Basket from the context menu.
You can also use this method in View mode.

l In the File List pane, select the files you want to add and press Ctrl + B. You can also use this method in
View mode.

The last image basket that you interacted with is considered the "active" basket. This will be
indicated with a star next to the basket's name. The active basket is the one that images will be
added to when using the context menu or keyboard shortcut in Manage or Viewmode.

You can also add images to an image basket by dragging them from Windows Explorer.

To Remove Files from an Image Basket:

In the Image Basket, right-click the files, and select Remove from Image Basket or press Alt + X. To
remove all files, right-click the Image Basket, and then select Clear Image Basket.

To Rename an Image Basket:

In the Image Basket, right-click and choose Rename Image Basket from the context menu. In the
Rename Image Basket dialog, enter a name in the field and press OK.

To Delete an Image Basket:

In the Image Basket, right-click and choose Delete Image Basket from the context menu or press
Ctrl + Shift + -. Deleting an image basket will not delete the images within it.
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Using the ACDSee Activity Manager

The ACDSee Activity Manager allows you to monitor and manage background activities including:

Queued Activities:

l Import

l Resize

l Convert File Format

Features that run using the Activity Manager are shown in the menu with a + next to
them.

Idle Activities:

l Face Detection

Opening the Activity Manager

To open the Activity Manager do one of the following inManage mode:

l Click Panes | Activity Manager.

l Click the Activity Manager icon in the Status bar.

Queued Activities

View your imports and other running activities from theQueued Activities section of the Activity
Manager.

When an Activity is queued, it will begin immediately, or may start in theQueued state if you already
have activities in progress. The bar represents the Activity progress, while the number represents the
number of images left to scan.

Activities that are currently running can be paused by clicking the Pause button.

Activities that are currently paused can be restarted by clicking the Play button.

Activities that are either running or paused can be canceled at any time by clicking the Cross
button.

Pausing an Activity will cause the next Queued Activity to start right away, unless Pause All Queued
Activities has been selected.
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MultipleQueued Activities can run concurrently with a maximum of 6. The number that can
run concurrently depends on your CPU.

When clicking the Play button for a Queued Activity, one or more running Activities will pause, and
the Activity that was clicked on will immediately jump to the top of the list and begin.

Completed Activities can be found in the History section where you can view a list of files completed
by each Activity. For more information see History.

To see a list of options available in Queued Activities, click on the gear button to the right side of
Queued Activities. See Queued Activities Options.

Currently running activities will always be at the top of the list in Queued Activities. As these activities
are completed and move to History, the next Queued Activity will move to the top of the list and
begin. Paused Activities can be dragged and dropped within Queued Activities to rearrange the order
that they are processed in.

Paused Activities cannot be dragged above any currently running Activity.

Preventing Conflicts or Loss of Data

Because activities run in the background, ACDSee Home uses specific methods to prevent file conflicts
when multiple activities access the same files.

l If an image is queued for an activity and is taken to Edit mode, the image is skipped by the queued
activity.

l Multiple activities that modify the same files cannot run at the same time.

l Activities that create new files cannot run alongside other activities on the same folders.

l Commands that read or write files in Manage, View, or Media mode pause activities until the command
is complete. Paused activities then resume automatically.

l Options or commands that restart ACDSee Home (such as resetting the layout) are blocked while
activities are running.

l Database and licensing commands require you to cancel activities before ACDSee Home restarts.

Notifications

Activity Manager notifications appear in the bottom-right corner of the screen when activities are
queued and completed.

l Click Show to open the Activity Manager.

l Click Browse to open a new tab to the folder containing the activity’s output files.

l To customize which notifications are muted, go to Tools | Options… | Activity Manager.
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l Each notification includes aMore Options ... menu next to the X, allowing you to adjust notification
settings directly from the notification.

l Notifications will display the activity Status. For more information about Activity Status please see
History.

Notification Status

There are 4 possible Notification Statuses:

l Completed: If an activity completes successfully, the notification will display Completed.

l Completed with errors: If an activity completes, but there is an error for any of the files, the notification
will display Completed with errors.

If an error occurs in an activity, the notification will always display error, even if files
produce a warning, or are skipped.

l Completed with skipped files: If an activity completes, but one or more files have been skipped, the
notification will display Completed with skipped files.

If a file is skipped by an activity and no error has occurred, the notification will always
display as skipped.

l Completed with warnings: If an activity completes, but there is a warning for any of the files, the
notification will display Completed with warnings.

If any activity completes with errors, skipped files, or warnings, a Caution icon will display on the
notification.

Idle Activities

When assets are being scanned for AI Face Detection, their progress can be viewed within the Idle
Activities section of the Activity Manager. Here, you can see the current status, howmany assets are
left to be completed, and quickly disable each tool with the switch on the right side.

Idle Activity States:

Idle Activities can be in one of four different states:
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Waiting:
When in the Waiting state, the number of assets remaining will increase
as files are added to the queue. This occurs while browsing, cataloging, or
importing files.

Scanning:
When in the Scanning state, the tool is actively detecting Faces, and the
remaining number will decrease as files are completed.

Disabled:
When in the Disabled state, the tool has been manually deactivated and
will not run until turned back on.

Completed: When in the Completed state, the tool has finished its queued files.

To see a list of options available in Idle Activities, click on the gear button to the right side of Idle
Activities in the Activity Manager. See Idle Activities Options.

History

When a Queued Activity has been completed, or an Advanced Search has run, it will appear in the
History section of the Activity Manager.

For Advanced Searches that have run, click its entry in the History to open the Advanced Search pane
with the criteria preloaded.

The History section will be cleared automatically when Home is shut down.

For Queued Activities that have completed, click the Details View button to view a
comprehensive list of assets for each completed Activity.

The Details View for each History entry shows the following fields:

l Status: Status includes 4 possible states: Success, Error, Warning, and Skipped.

l Success: The action has successfully completed.

l Error: The action has completed, but one or more files have not been created/modified due to
an error.

l Skipped: The action has completed, but one or more files were skipped due to being in use
elsewhere.

l Warning: The action has completed but one or more files have a warning issued.

Activities that complete with either errors, or files skipped, will display the Caution

icon in the History.

l Filename: Displays the source file's filename.

l Details: Displays the outcome of the action.
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l Source: Displays the source location of the file that was modified.

l Destination: Displays the destination location of the file that was modified.

Clearing History

Items in History can be cleared either individually, or all at once.

To Clear One Item at a Time:

Click on the Cross to the right side of the item in History.

To Clear the Entire History at Once:

Click on the Clear Activity History button on the right side in History.

Activity Manager Options:

Click on the gear icon to the right ofQueued and Idle Activities to display the list of available options:

Queued Activities Options:

Pause/Resume All Queued
Activities

Pauses or resumes all activities within Queued Activities.

Pausing all activities with Pause All Queued Activities will
disable the Play button for each activity until Resume All
Queued Activities has been enabled.

Clear All Queued Activities Clears Queued Activities of all active or paused activities.

Idle Activities Options:
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Disable/Enable AI Face Detection

Click to disable or enable the AI Face Detection tool.
AI Face Detection can also be manually disabled or

enabled by clicking the switches from on to off

or vice versa.

Clear AI Face Detection Queue Removes all items from the AI Face Detection queue.

Cataloging and Managing Files in ACDSee Home

In addition to its browsing, viewing, and editing capabilities, ACDSee Home features integrated
management tools you can use to organize and sort your images and media files. These tools include
batch functions (tools that can alter or adjust multiple files at the same time), category and rating
systems, and a powerful database to hold all of your important image information.

You can use the ACDSee Home batch functions to convert the file format, rotate, resize, rename, and
adjust the time stamp or the exposure of a single image, a group of images all at once. With the
category, color label, and rating systems, you can create a virtual folder structure, and use it to find
related images and media files with a single click.

ACDSee Home displays file properties and image information in an easily accessible Properties pane
that you can use to directly add and edit file information, including ACDSeeMetadata. You can add an
author, description, notes, and keywords to your files, and adjust the category and rating
assignments at the same time.

Organizing with the Catalog Pane

The Catalog pane is one of the most useful panes in Manage mode as it provides so many tools for
organizing, managing, and finding your files. You can drag files into the categories, ratings, keywords,
or color labels of the Catalog pane to assign and quickly organize your files. The Auto Categories
section can be used to find files with specific information such as file size, keywords, or shutter speed.
The Saved Searches section allows you to create and run custom searches. Special items such as the
ImageWell display all the images on the computer in one click, or you can click Uncategorized to
display only those that are not yet in a category.

To Open the Catalog Pane:

In Manage mode, click Panes | Catalog.

The Catalog pane opens on the left, tabbed with the Folders and Calendar panes.

Categories

Categories are an easy way to organize your files into context-related sections. When you assign a file
to a category, you do not move the file from its folder or create an extra copy. Your categories can be
simple or complex and use any names you choose. There are different icons to use for different
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categories to help you identify them at a glance. Once your files are in categories, you can search, sort,
group, and find them by category.

One way to assign files to a category is to select and drag one or more files from the file list and drop
them onto the category. You can choose colored icons to identify your categories, and cycle through
the available icons using the ] key. A file can belong to multiple categories, but it will only have one
icon. For comprehensive categories management, use the Organize tab of the Properties pane.

People

The People group in the Catalog pane will display the names of individuals you have assigned in the
Face Detection Pane in Viewmode. You can select a name to display all of the photos with that
individual in it, provided that they have been identified using Face Detection. You can also set Face
Search Options which allow you to choose whether to display Assigned Names, Suggested Names, or
both Assigned Names and Suggested names using the settings menu (gear icon) in the top right corner
of the People group.

To assign names to faces, use People mode.

Keywords

You can use keywords to organize your files into hierarchies. You can create and assign hierarchical
keywords in the Organize tab of the Properties pane. You can add keywords to images quickly using
drag and drop. You can also manage your keywords in the context menu, by using right-click.

Ratings

You can assign a numerical rating from 1 to 5 to your images and files. Once you have assigned ratings,
you can search, sort, and catalog your files based on the ratings, or a combination of ratings,
categories, auto categories etc. A file can have only one rating. When a file has a rating, the number
appears on top of the thumbnail in the File List pane. Ratings can be managed in Assigning and
Searching Categories and Ratings.

Color Labels

You can use color labels to catalog your files. You can use different colors to represent different stages
of your workflow. As you review your photos or documents, you can assign color labels and rename
them accordingly.

Auto Categories

Most digital cameras create and embed information about the file as you take a photo. This
information is called metadata and can include the name and model of the camera, the file size,
shutter speed, camera settings used in the shot and much more. ACDSee Home uses this information
to create auto categories. You can search using auto categories to find images containing that
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metadata. You can select one or more auto categories to find files, for example, photos of a certain
size, taken by a particular camera. You can also add to this data using the Properties panes.

Advanced Searches

If you find yourself creating the same search criteria frequently, you can save the search to use again
later. Search Presets appear at the top of the Advanced Search pane but they also appear in the
Catalog pane for you to re-run using a single click on the name or in the white checkbox of the Easy-
Select bar.

To Create a New Search Preset from the Catalog Pane:

1. In the Advanced Searches area of the Catalog pane, click the New Search Preset button.

The Advanced Search pane opens.

2. Enter your search criteria and then click the Save icon to save your preset.

The new search preset appears in the Advanced Searches area on the Catalog pane and in the
Search Presets drop-down list of the Advanced Search pane.

Search Presets that are saved with missing information such as blank criteria, will display as a
Search Template and display in the Catalog pane with a * at the end. Search Templates cannot
return results, as they are missing information. Instead they can be opened in the Advanced
Search pane to add the missing information. For example: If you regularly search for images
with Rating 5, but want to search a different Keyword each time, a saved Search Template
could be made with the Rating criteria set and the Keyword criteria to be filled in each time.

Special Items

You can use Special Items to quickly view all of the images in your database and any uncategorized
images. Select one of the following items:

l Image Well: displays all images cataloged in the ACDSee Home database. If you have a substantial image
collection, it may take a few moments to gather all of the information.

l Videos: displays all videos cataloged in the ACDSee Home database. This will return any video formats
supported by ACDSee. If you have a substantial file collection, it may take a few moments to gather all of
the information.

l Embed Pending: displays all the files with database data that has changed but has not yet been
embedded in the files.

l Uncategorized: displays any images cataloged in the database that have not been assigned to a category.

l No Keywords: displays any images cataloged in the database that have no ACDSee keywords assigned.

l Unnamed Faces: displays all photos in which one or more faces have been detected but not named.
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l Auto-Named Faces: displays all photos with one or more faces that have been automatically named by
ACDSee using facial recognition.

Faces can only be auto named if the Enable Auto Naming option is enabled.

l Suggested Names: displays all photos with suggested names using Face Search. You can use this item to
quickly confirm or deny suggestions across your image collection.

l Tagged: displays all the tagged images in your file collection.

The ACDSee Home Database and Embedded Data

When you assign a file to a rating, or category, this information is stored in the ACDSee Home
database. If you choose to, you can also embed this information in each individual file, making it easier
to relocate and share files, or retrieve the information from the file if you need to. In the database,
information is always associated with a particular file. If you move or rename files using an application
other than ACDSee Home (like Windows Explorer) the link between the file and the ACDSee Home
database will be broken. If this happens, and you have embedded the information in each file, you can
rebuild the database and retrieve all the information.

You can also use the Properties pane to add information to the ACDSee Home database like captions,
keywords and much more. Taking the time to assign categories and add keywords, notes, etc., makes
it much easier to find and organize your files. Learn more about organizing using the Properties Pane.

ACDSee uses XMP to embed ACDSeeMetadata into each file. Only some file formats and file
extensions support XMP. These include GIF, JPEG, DNG, PNG, PSD, TIF, AVIF, and JPEG-XL. In
the case of these file formats, the ACDSeeMetadata is embedded inside the file and so you
can rename or move the file outside of ACDSee and still be able to retrieve the ACDSee
Metadata. For formats that currently do not support XMP, including RAW and ABR, the
ACDSeeMetadata is written to a sidecar file that is stored in the same folder as its file. Because
a sidecar file is separate from the file itself, you need to rename or move them together, or
you could lose the ACDSeeMetadata permanently.

Easy-Select Bars

The Easy-Select bars are the indicators on the left side of the Folders and Catalog panes. They look like
this: . You can use these indicators to select multiple folders or categories, and display their
contents in the File List pane. In the Catalog pane you can also use the Easy-Select indicators to select
combinations of categories, ratings, auto categories, search presets, and special items. For example,
you could display all your photos with a rating of 1 that belonged to the category People.

You can also use the Easy-Select indicators with the Selective Browsing pane (View | Selective
Browsing).

When you use the Match Any/All buttons and the Easy-Select indicators together, the Catalog pane
becomes a powerful search tool for finding unique sets of files.

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23enable-auto-faces
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To Use the Easy-Select Bar:

In the Folders or Catalog pane, select the indicator to the left of each item with contents you want
to display. The indicator changes orientation to point to the item you have selected.

If you select a category, rating, or combination that does not have any files that match, the
File List displays a message and shows no thumbnails. The quickest way to return to a folder
with files is to click the back arrow.

To View Cataloged Files:

Select one or more categories, ratings, auto categories, search presets, or special items. Files
assigned to those classifications are displayed in the File List pane.

The Contents bar at the top of the File List pane displays whatever categories or items are currently
selected. You can browse through specific categories, ratings, or items within specific folders using
the Selective Browsing pane.

Match All Match Any

There are two Match All/ Match Any drop-down lists on the Catalog pane; one at the top of the pane
that affects categories and one that affects search presets. You can use the Match All and Match Any
options to affect the display of thumbnails in the File List in the following way:

l Match All: to be included, a file has to belong to all the categories or searches you select. So the file has
to be in both or all of the categories or searches before it will display in the File List. Match All is more
exclusive. You can use it to limit the number of files that display and narrow a search down.

l Match Any: to be included, a file can belong to any of the categories or searches you select. So any files
in the selected categories or searches will display in the File List. Match any is more inclusive.

Catalog Icons
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Category Identifies files that have been assigned to a category.

Ratings 1-5 Identifies file ratings.

New Search preset Opens the Advanced Search pane so that you can
create a new search preset.

Easy-Select indicator (selected) Selects the category, rating, auto category, or other
item for display in the File List pane.

Easy-Select indicator (not selected) Does not select the category, rating, auto category, or
other item for display in the File List pane.

Match Any/All Controls which images are displayed in the File List
pane.

To hide the icons in the Catalog pane, click Tools | Options, and then select Catalog. Uncheck
the Show Icons checkbox in the Options dialog box.

Creating Categories

Create and manage a system of categories for your files in the Organize tab of the Properties pane.
You can easily customize your category system in a way that makes sense to you.

Select the Organize tab in the Properties pane to create, rename, delete, and move your categories.
You can also access the Categories pane by choosing Panes | Categories.

To Create a Category:

1. Do one of the following:

l Right-click a category in the Catalog pane, and then select New Category.

l In Manage mode, click Edit | Set Categories | New Category.

2. Select one of the following:

l Create a new, top-level category

l Create a sub-category within the current selection

3. If you are creating a sub-category, select a top-level (or parent) category from the drop-down list. (If you
right-clicked a category in the Catalog pane, the new sub-category will be added below that category by
default.)

4. Type a name for the new category in the Name field.

5. Click OK.
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When you create a new top-level category, you can select an icon to help identify the
category. The Icon drop-down only appears if the Show Icons checkbox is checked on the
Catalog page of the Options dialog box. In Manage mode, click Tools | Options, and then
select Catalog.

Manage Categories

To Manage Your Categories:

Select a category in the Catalog pane, and do one of the following:

l To edit the category, right-click the selected category and select Edit.

l To delete the category, right-click the selected category and select Delete.

In the Categories group in the Catalog pane:

l To move the category, drag it to the new location.

To Delete Categories:

In the Properties pane, located to the right of the File List pane, do one of the following:

l In the Organize tab, right-click on the Category you wish to delete, and then select Delete from the
context menu.

l In the Organize tab, click on the Easy-Select bars to the left of any Categories you wish to delete, then
press Delete Selected Categories.

In the Catalog pane, located to the left of the File List pane, do one of the following:

l Right-click on the Category you wish to delete, and then select Delete from the context menu.

To Delete all Unassigned Categories:

Categories that do not have any assets assigned to them can be deleted quickly with the Delete all
Unassigned Categories option.

l Click Tools | Metadata | Delete All Unassigned Categories.

Filtering Categories:

In the Properties pane, categories can be filtered within theOrganize tab by clicking in the Filter
Categories text field and typing any word. The categories displayed will filter dynamically as you type.
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Quick Category Sets

If you have a long list of categories, or would like to break your categories up into different events or
areas of interest, you can use the Quick Category Sets feature.

To Create Quick Category Sets:

1. First create the categories you want in your set.

2. In the Properties pane, click the Quick Categories drop-down list and select New Quick Categories
Set....

3. Customize the number of rows and columns for your set by selecting values from the Rows and
Columns drop-down menus.

4. Enter your commonly used categories into the entry fields. For sub-categories, use the pipe key.
Example: A|B|C.

5. Click the Save button.

6. Click OK. This category set will be listed in the Quick Category drop-down list.

7. Select one or more files and click a button in the category set. The category will be assigned to the
selected files. The button text color will change to indicate that the category is assigned to currently
selected files, and will display in italics if assigned to only some (but not all) of the currently selected
files.

Make sure the category button namematches the category name in the category tree.

Assigning and Searching Categories and Ratings

You can assign files to a rating, or one or more categories, without moving the file or making an extra
copy.

If the Properties pane or Catalog pane is not visible in Manage mode, click Panes | Properties
or Panes | Catalog.

Quickly Assign Ratings in Thumbnail View

The rating number you select can be reflected as a star rating in other applications. Give your favorite
shots a high rating, and your least favorite shots a low rating.

To Assign Ratings:

1. Hover over a thumbnail to display the gray box with diagonal line through it.

2. Click the gray box to make your selection.

Example of Hovering Over a Thumbnail to Select a Rating:
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1.

2.

3.

Use the keyboard shortcut Ctrl + 0-5 to quickly rate a file.

Assign and Search Categories and Ratings in the Catalog Pane

The Catalog pane allows you to both assign categories and ratings as well as search them.

To Assign Files to Categories or Ratings in the Catalog Pane:

1. In Manage mode, do one of the following:

l Drag selected files to a category or rating in the Catalog pane.

l Drag the category or rating from the Catalog pane to selected files.

l Select one or more files, then right-click the categories/ratings. Select Assign items from the
context menu.

l Right-click the files, and then click Set Categories and click the category in the fly out, or click
Set Rating and click the rating.
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2. In View mode, do one of the following:

l Click Edit | Set Categories and then click the category to which you want to assign the file.

l Right-click the file, click Set Categories, and then click the category to which you want to assign
the file.

l Click Edit | Set Rating and then click the rating to which you want to assign the file.

l Right-click the file, click Set Rating, and then click the rating to which you want to assign the file.

l On the status bar, click the rating icon, and then click a new rating. This icon only appears once a
rating is set.

3. If you are comparing images and want to categorize them, do one of the following:

l Right-click one of the files, click Set Categories, and then click the category to which you want
to assign the file.

l Right-click one of the files, click Set Rating, and then click the rating to which you want to assign
the file.

Ratings embedded by ACDSee can be seen in other applications supporting xmp:rating and
vice versa. To embed metadata into one or more selected files click Tools |Metadata | Embed
ACDSee Metadata | Embed In Selected Files.

Use the Context Menu (Right-Click) in the Category Tree to Do the Following:

l Assign Items

l Unassign Items

l Create New Category

l Search

l Cut

l Copy

l Paste

l Delete

l Edit Category

To Search a Category or Rating in the Catalog Pane:

Click the Category name or Rating number to display all corresponding files in the File List pane.

Assign Categories and Ratings in the Properties Pane

The Properties pane provides another way to assign categories and ratings.
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To Assign Files to Ratings in the Properties Pane:

1. In the File List pane, select the files you want to assign a rating.

2. In the Properties pane, select the Metadata tab.

3. Click the rating you want these files to have from the numbers listed at the top of the Properties pane.

To Assign Files to Categories in the Properties Pane:

1. In the File List pane, select the files you want to assign a rating.

2. In the Properties pane, select the Organize tab.

3. Find the category you want these files to have from your Categories list and:

l Check the boxes you wish to apply.

l Click the Easy-Select bar on the left side of a Category to select it. Multiple Easy-Select bars can be
selected at the same time. Press Assign Selected Categories.

Assign files quickly with a category sets button. See Create Quick Category Sets.

Selecting All Categories:

Easily select all available categories at once with the Select All Categories button .

Unassigning Categories or Ratings from Files

You can remove a file from a category or rating without moving or deleting the original file, or affecting
any other files assigned to that classification.

To Unassign Categories or Ratings from Files:

1. In the File List pane, select the files you want to unassign the categories or ratings from.

2. Do one of the following:

l Right-click a selected file, and then click Set Rating | Clear Rating.

l Right-click a selected file, click Set Categories, and then click the name of the category from
which you want to remove the file, or to remove all categories, click Uncategorize All Selected
Items.

l In the Properties pane, within the Organize tab, find the categories you wish to unassign and
uncheck the checkboxes.

l Click the Easy-Select bars to the left of each Category you wish to unassign, and press Unassign
Selected.

l Uncheck a checkbox for a category or a radio button for a rating in the Catalog pane.
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l Right-click a category or rating in the Catalog pane, and then click Unassign Items.

l Click the Unassign All Categories button found in the Properties Pane to remove all
categories from your currently selected images.

You can reset ratings in the Properties pane by right-clicking on the rating.

Clear All Selected Categories:

Easily clear all categories currently selected with the Clear Selection button .

Assigning Color Labels

Color labels are useful for naming and quickly identifying your processing plans for your images and
documents. Different colors can be used to represent different stages of your workflow. For example,
as you review your photos or documents you can quickly label files to upload, print, reject, review, or
sharpen, or any other term that matches your workflow needs. Once your files have been labeled, you
can click a color label in the Catalog pane to instantly display all of the files assigned to that label.

You can also use color labels in combination with the Group by, or Filter By features to refine your list.
Color labels, like tagging, categories, and ratings, are a way to set aside, organize, and group your
photos or documents without moving them into different folders.

If the Properties pane or Catalog pane is not visible in Manage mode, click Panes | Properties
or Panes | Catalog.

Create a Color Label Set

Begin by creating a label set so you can quickly select and assign specified labels. Once you have a label
set in place, you can assign your images or documents to the appropriate labels corresponding to your
workflow.

To Create a Color Label Set:

1. In the Catalog pane, click the Labels settings button and select Edit Label Sets.

2. Enter names for your labels and click the Save icon.

3. Click Save As from the Save Label Set dialog box.

4. Enter a name for your new label set.

5. Click OK.

Once you have created color label sets, you can access them from the Catalog pane by clicking the
Labels settings button and selecting from the drop-down list. Before assigning a color label, make sure
the intended label set is active. The active label set name is shown in brackets in the label header.
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Assign Color Labels

You can assign Color Labels to files by using the following:

l Hover icons in thumbnail view

l Catalog pane

l Properties pane

l Edit menu in Manage and View mode

l Context menu

l Keyboard shortcuts

ACDSee uses XMP to embed ACDSeeMetadata into each file. Only some file formats and file
extensions support XMP. These include GIF, JPEG, DNG, PNG, PSD, TIF, AVIF, and JPEG-XL. In
the case of these file formats, the ACDSeeMetadata is embedded inside the file and so you
can rename or move the file outside of ACDSee and still be able to retrieve the ACDSee
Metadata. For formats that currently do not support XMP, including RAW and ABR, the
ACDSeeMetadata is written to a sidecar file that is stored in the same folder as its file. Because
a sidecar file is separate from the file itself, you need to rename or move them together, or
you could lose the ACDSeeMetadata permanently.

You can also set labels from the status bar in View and Edit mode.

To Assign a Color Label Using the Label Line Hover Icon in Thumbnail View:

1. Hover over a thumbnail to display the gray label icon.

2. Click the gray label icon to make your selection.

Example of Hovering Over a Thumbnail to Click and Select a Color Label:

1.
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2.

3.

Use the overlay icon on one of a number of selected files or images to assign the
label to all.

To Assign a Color Label to a File Using the Catalog Pane:

1. In Manage mode, do one of the following:

l Drag selected files to a color label in the Catalog pane.

l Drag the color label from the Catalog pane to selected files.

To Assign Files to Color Labels in the Properties Pane:

1. In the File List pane, select the files you want to assign a color rating.

2. In the Properties pane, select the color label from the boxes along the top.

To Assign Color Labels Using the Edit Menu in Manage and View Mode: 

l Click Edit | Set Label and then select a color.

To Assign Color Labels with the Context Menu: 

l Right-click the file, click Set Label, then select a label name.

To Assign Color Labels Using Keyboard Shortcuts: 
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l Keyboard shortcuts are available for the five color labels, plus Alt-0 to clear the label (exactly the same
as ratings, except Alt is used instead of Ctrl)

Alt-1

Alt-2

Alt-3

Alt-4

Alt-5

Alt-0

Search Files Assigned to a Label

To Search All Files in the Database Assigned to a Label:

l Click the color label in the Catalog pane to display all corresponding files in the File List pane.

l Use the Advanced Search pane.

l Use Quick Search.

To Search All Files in the File List Assigned to a Label:

Click the Filter drop-down above the File List pane and select a label name. All files assigned to that
label in the current file list will be selected.

To Select All Files in the File List Assigned to a Label:

Use Alt-1 through Alt-5 for the five colors, plus Alt-0 to clear the label, (exactly the same as ratings,
except it uses Alt instead of Ctrl).

Removing Color Labels and Color Label Sets

To Remove a Color Label from a File:

1. In the File List pane, select one or more files you want to remove a label from.

2. Do one of the following:

l Right-click a selected file, and then click Set Label | Clear Label.

l In the Properties pane, click the gray unlabeled icon.

l In the Properties pane, right-click on the color label.
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To Delete a Label Set:

1. In the Catalog pane, click the Labels settings button and select Edit Label Sets.

2. Select the set you want to delete from the Labels Sets drop-down list.

3. Click the delete button.

Creating Collections

Collections is a powerful grouping and search query tool. You can use the Collections pane to group
accumulated photos based on a common variable, such as the camera used, location, or size. You
could also use Collections to group photos for sorting, processing, sharing, and much more.

Collection

Collection Set

Smart
Collection

To Create a Collection:

1. In Manage mode, choose Panes | Collection. The Collections pane will appear tabbed in the Folders
pane.

2. In the Collections pane, right-click and select Create Collection... from the context menu.

3. In the Create Collection dialog box, configure the options as described below.

4. Press the Create button.

Create Collection Dialog Box Options



ACDSee Photo Studio Home 2026

Page 108 of 532

Name

Name Enter a name for your collection.

Location

Inside a Collection Set Check this checkbox if you would like to place this
collection inside of another previously-created
collection set, thereby developing a hierarchy.
Choose the collection set you would like to add your
image to from the drop-down menu.

Options

Include selected photos Check this checkbox to include any currently
selected photos in the collection.

Set as target collection Check this checkbox to designate this collection as
the target collection for images you will add photos
to. You will be able to quickly send images directly
to this collection by selecting images and pressing
Ctrl + Alt + C. To customize the keyboard shortcut,
see Customizing Keyboard Shortcuts.

To Add Photos to a Collection:

Do one of the following:

l In the File List pane, select the images before using the Create Collection command described above.
Then check the Include selected photos checkbox inside the Create Collection dialog box.

l In the File List pane, right-click the images and choose Collections | Add to | [name of the collection].

l Drag and drop the images from the File List pane to the collection inside the Collections pane.

l Select the image in the File List pane. In the Organize tab of the Properties pane, in the Collections
group, check the checkbox next to the collection.

To Set a Collection as Your Target Collection:

You can set a specific collection as the target collection, allowing you to quickly add images to it using a
keyboard shortcut. A target collection will display a blue circle icon next to it in the Collections pane.

You cannot set a smart collection as a target.

Do one of the following:

l When creating a collection, check the Set as target collection checkbox in the Create Collection dialog
box.
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l Right-click a collection in the Collections pane and choose Set as Target Collection.

To Add Images to Target Collections:

Select the image and press the Ctrl + Alt + C key.

You can customize this keyboard shortcut. See Customizing Keyboard Shortcuts.

To Search for Collections:

You can search for collections, collection sets, and smart collections in the Filter Collections field at the
top of the Collections pane.

l Enter the name, (or portion of the name), of the collection, smart collection, or collection set you are
looking for. If the collection you are searching for is part of a collection set, the search will return the
root collection set if one of the sub-collections contains the text you entered in the Filter Collections
field.

To Remove an Image from a Collection:

1. Select the collection.

2. Right-click the image and choose Collections | Remove from Selected Collection.

This will only remove the image from the collection and will not delete the image.

You can remove multiple images from a collection at once by selecting them all and then right-
clicking and choosing Collections | Remove from Selected Collection.

To Remove an Image from All Collections:

To remove an image from all collections, right-click the image and choose Collections | Remove from
all collections.

This will only remove the image from all collections and will not delete the image.

You can remove multiple images from all collections at once by selecting them all and then
right-clicking and choosing Collections | Remove from all collections.

Collections Sets

You can create a collection set and add other collection folders inside. You can use this method to
create a hierarchy for further organization. You cannot add images to collection sets themselves. You
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can only add images to folders (collections) inside of collection sets. Selecting the root of a collection
set will display all of the images in all of the collections inside of the root.

To Create a Collection Set:

1. In the Collections pane, right-click and select Create Collection Set... from the context menu.

2. In the Create Collection Set dialog box, enter a name for your collection set.

3. Check the Inside a Collection Set checkbox if you would like to add your collection set inside of another
collection set. Select the collection set from the drop-down menu.

4. Click Create.

To Add Collections to Collection Sets:

Do one of the following:

l Check the Inside a Collection Set checkbox while creating a collection inside the Create Collection dialog
box. Select the collection set from the drop-down menu.

l In the Collections pane, drag and drop the collection from the root level to the collection set.

Smart Collections

Smart collections are collections with queries built into them based on search criteria you specify.
These search queries get saved to the database. When you catalog new images in the future, those
that fit the criteria of your search query will automatically show up in your smart collection. You can
also create a search query to locate files based on the date they were cataloged.

To Create a Smart Collection and Add Search Criteria to Your Query:

1. In the Collections pane, right-click and select Create Smart Collection... from the context menu.

2. In the Create Smart Collection dialog box, configure the options as described below.

3. Press the OK button.

Create Smart Collection Dialog Box Options
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Name Enter a name for your smart collection.

It is recommended that you give your smart collection a name reflective of the
search query assigned to it. This will save you the time of having to open it to find
out what it contains.

Location Inside a Collection Set Check this checkbox if
you would like to
place this collection
inside of another
previously-created
collection set, thereby
developing a
hierarchy. Select the
collection set you
would like to add your
smart collection to
from the drop-down
menu.

Match Press the Add button to select search criteria for your query. In the Add Search Criteria
dialog box, choose criteria by clicking the plus + signs to expand the tree and
check/uncheck the checkboxes on and off to select your properties. Press OK. Your
chosen criteria will appear in the Match field box. Refine each item by clicking the
underlined variables and selecting an option from the drop-down, or entering a number
into the field.

For example, if you chose Size as your search criteria, click "is" and select "is not", "is less
than", "is less than or equal to", "is greater than", "is greater than or equal to", or "is
between". Then click the "0" and enter the size value.

To Remove Criteria from Your Search Query:

Select the criteria from theMatch field and select Remove.

To Edit Your Search Query:

1. Right-click your smart collection in the Collections pane and choose Edit.

2. In the Edit Smart Collection dialog box, add and remove search criteria as described above.

3. Click OK.

Using the Properties Pane

The Properties pane displays all the metadata for your files. It also displays file properties such as file
size, creation date, and read-only or hidden status. You can use the Properties pane to add, change,
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or delete the metadata for image and media files.

The Properties pane is open in Manage mode on the right of the File List pane by default. The
Properties pane is available in all modes except 365mode, People mode, and Dashboard mode.

To Open the Properties Pane in Any Mode:

Click Panes | Properties.

The Metadata panel offers adjustable width for metadata fields. Simply hover between a
corresponding label and field to display the double arrow cursor. Click and drag to adjust
width. Double-click to toggle between the width of the longest label in the group or the
longest label in the pane.

Properties Pane Areas

The Properties pane is divided into 3 tabs: Metadata tab, Organize tab, and File tab.

Use the overlay icons, which appear as you hover over a thumbnail, to tag, rate and add color
labels to your images. Alternatively, you can display these setting in the Properties pane by
clicking Tools | Options | Properties Pane and selecting Show Tagged, Rating, and Color
Labels.

Metadata Tab

TheMetadata tab displays the rating, category, IPTC, EXIF, and ACDSeeMetadata stored with a
photo. The ACDSeeMetadata fields are available for you to enter the caption for your photographs as
well as date, author, and notes. The keywords field is display-only and can be entered in the Organize
tab. The label field can be entered here or selected from the Labels section in the Catalog pane. IPTC
information is automatically embedded into your image, while ACDSeeMetadata is not embedded in
your files, but instead is held in the database. ACDSeeMetadata can be embedded into all your files
(or just selected ones) by clicking the Tools |Metadata | Embed ACDSee Metadata command.

The IPTC data fields provide a standard means for entering and storing information about your
photographs such as description, creator, and copyright information. ACDSee supports fields defined
in IPTC Core 1.1.

The EXIF data fields hold information captured by your camera such as shutter speed, camera model,
and GPS information.

Certain EXIF fields are no longer visible by default. The EXIF Artist, Copyright, Image Description, and
Date/Time Original fields are automatically modified when their matching IPTC fields are modified, (see
table below). This change reflects the recommendations of the Metadata Working Group (MWG). If
you need to have these fields visible in the EXIF section you can adjust your settings by clicking Tools |
Options | Properties Pane and clicking theManage Metadata Views button.

Matching IPTC and EXIF Fields
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IPTC EXIF

Description writes to Image Description

Creator writes to Artist

Copyright Notice writes to Copyright

Date Created writes to Date/Time Original

When ACDSee parses metadata from a file, the content of the field is displayed without
mapping.

Organize Tab

The Organize tab displays four groups of useful, quick access tools: ACDSeeMetadata, Categories,
Collections, and Keywords. Categories, Keywords, and Collections can be viewed in a file tree format
within the Organize tab. Right-clicking on any categories, keywords, or collections, will allow you to
add or remove them as you see fit. You can create category and keyword sets to quickly categorize
your files. Use the category, keyword, and collection trees to create a hierarchy to easily organize your
files in a way that holds meaning for you.

l ACDSee Metadata: Update your important ACDSee Metadata information from within the Organize tab,
such as Caption, Database Date, Imported Date, Author, and Notes. ACDSee Metadata can also be
updated on the Metadata tab.

l Categories: View, filter, and manage categories and quick categories associated with your selected files.
For more information see Creating Categories.

l Collections: View and access collections associated with your selected files. For more information see
Creating Collections.

l Keywords: View, filter, and manage keywords associated with your selected files. For more information
see Creating and Assigning Hierarchical Keywords.

File Tab

The File tab displays detailed file information and image attributes for a selected file or files. You can
set or change the Read-Only and Hidden properties of a file or folder, and view a summary of any EXIF
information contained in a file.

Embedding ACDSee Metadata into Files

If you have metadata in your files and they are copied, moved, or renamed, outside of
ACDSee, the link between the file and the database will be broken, but you can rebuild the
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database using the embedded data in the file.

ACDSee uses XMP to embed ACDSeeMetadata into each file. Only some file formats and file
extensions support XMP. These include GIF, JPEG, DNG, PNG, PSD, TIF, AVIF, and JPEG-XL. In
the case of these file formats, the ACDSeeMetadata is embedded inside the file and so you
can rename or move the file outside of ACDSee and still be able to retrieve the ACDSee
Metadata. For formats that currently do not support XMP, including RAW and ABR, the
ACDSeeMetadata is written to a sidecar file that is stored in the same folder as its file. Because
a sidecar file is separate from the file itself, you need to rename or move them together, or
you could lose the ACDSeeMetadata permanently.

Browsing and Cataloging with Auto Advance

You can use Auto Advance to quickly move through your images while adding tags, ratings, labels,
categories, or keywords. You can use Auto Advance in Manage and Viewmode.

To Turn on Auto Advance in Manage Mode:

At the bottom of the File List toolbar, toggle the Auto Advance button or press Ctrl + Q.

To Use Auto Advance:

When Auto Advance is enabled, adding (or clearing) a tag, rating, color label, keyword, or category will
advance the selection to the next image in the folder, allowing you to continue adding metadata. This
is particularly useful when paired with keyboard shortcuts, as you can organize entire folders without
moving your hands from the keyboard.

To select which types of applied metadata will trigger Auto Advance, see Setting the Auto Advance
Options.

Keywords and Categories are disabled by default.

Manage Mode

In Manage mode, using the keys on the numpad, apply the following keyboard shortcuts
to make the most out of Auto Advance:
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Turn on the numpad by pressing the Num Lock key before utilizing any of the following
keyboard shortcuts.

/ Tag

* Purple Color Label

9 Blue Color Label

8 Green Color Label

7 Yellow Color Label

6 Red Color Label

5 Rating of 5

4 Rating of 4

3 Rating of 3

2 Rating of 2

1 Rating of 1

0 Remove Rating

+ Next

- Previous

. Removes Color Label.

If the Num Lock key has not been activated, this will act as the
Delete button.

You can also customize keyboard shortcuts.

Keywords and Categories

You can streamline the process of adding keywords and categories to your images by combining
customized keyboard shortcuts and Auto Advance.

Keywords

In the Properties pane, on the Metadata tab, in the IPTC group, you can add keywords to the Keyword
field, press ENTER, and Auto Advance will move to the next image. You can also use the samemethod
in the Keywords field on the Organize tab of the Properties pane. In both locations, you can add
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multiple keywords at once, separating them with commas. You can continue the process for all images
without moving your hands from the keyboard.

Categories

In the Properties pane, on the Organize tab, expand the Categories group. Add categories to images
by checking the checkbox of your desired category. Or do one of the following:

l Right-click the image, and choose Set Categories | [your desired category] from the context menu.

l Choose Edit | Set Categories | [your desired category].

Use any of the these methods and Auto Advance will move to the next image.

To utilize this same type of convenience in all IPTC fields, see To Use Keyboard Shortcuts to Enter
Metadata into the Same Field of Multiple Photos.

View Mode

To Turn on Auto Advance in View Mode:

In the Bottom toolbar, toggle the Auto Advance button or press Ctrl + Q.

To Use Auto Advance in View Mode:

1. Choose Panes | Properties.

2. Add ratings, color labels, tags, categories, or keywords in the Properties pane and Auto Advance will
advance it to the next image in the Filmstrip, allowing you to continue adding metadata.

In View mode, use the following keyboard shortcuts to navigate your folder:

Home Selects the first image in the folder.

End Selects the last image in the folder.

Page Down Next

Page Up Previous

Using the Map Pane

Use the Map pane to add photo locations from anywhere in the world to your photos. You can then
recall and view that information for reference at any time. Use the map to select groups of files for
further workflow steps, and select photos for display in Viewmode.
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The location of files displayed in the Map pane is based on the latitude and longitude information in
the file properties. If you have a camera with geotagging capabilities, the geographic location is
automatically conveyed visually on the map. You can also add map coordinates to files by dragging
them directly onto the map and pressing the Save All button.

Geotagged images are indicated on the map with pins. You can click a pin on the map to select files
within a geographic location for viewing or processing. If your geotagged image pin is not displayed on
the map, try using the keyboard shortcut F5 to refresh the map.

The following file formats can be added to the map: JPG, TIFF, RAW, DNG, and PNG.

ACDSee automatically adds file information, including geographical tags, to the database as
you browse. However, if you have a large number of files, you may want to catalog those files
first to speed up the loading time for the pins on the map. To catalog your files, click Tools |
Database | Catalog Files.

To Open the Map Pane:

In Manage mode, click Panes |Map (Ctrl + Shift + M).

The Map pane appears above the File List pane in Manage mode by default. You can drag the Map
title bar to a new location and float the pane or dock it in another position like the other movable
panes in ACDSee.

You can toggle the Map on and off with the keyboard shortcut Ctrl + Shift + M in Manage
mode.

To Add Files to the Map by Dragging:

1. In Manage mode, drag one or more files onto the map.

2. Click Save All in the top left corner of the map.

Ideally images should be geotagged prior to processing. If an image is geotagged after it has
been edited and the Restore to Original command is used, then the geotag will be lost.

To Delete a Pinned Location on the Map:

Right-click the geotagged image thumbnail and selectMap | Remove from Map.

To View a Geotagged Image on the Map:

Right-click the geotagged image thumbnail and selectMap | View on Map.

To Find a Location:
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To find a specific location, enter a place or landmark into the Search for Location field at the top
right of the Map pane.

To Set Default Location, Zoom, and Map Type:

1. Pan to your preferred location on the map, then adjust the zoom-level and select your preferred map
type (Map, Satellite, or Terrain).

2. Click Tools |Map | Set default map location.

Note: the map reflects the current File list. If the File list has images mapped to a different
location from your default setting, then that location will be displayed.

To pan and zoom the map to a specific location, enter the location into the Map search field
and press Enter.

Reverse Geocoding:

The Reverse Geocoding command allows you to save location information into certain IPTC fields.
These include: Country, Country Code, State/Province, and Location.

1. In Manage mode, drag one or more files onto the map.

2. Click Save All in the top left corner of the map.

3. Press the Reverse Geocode button to preview the location information.

4. Click Save to save this information into the IPTC fields of the selected images.

If images with multiple different locations are selected, only one of those locations will be used
to do the reverse lookup.

Using the Map Pane to Further Your Workflow

With the images from a particular location all selected, here are a few possible workflow options:

l Enter Edit mode to process this selection together.

l Use the Batch tool to apply the same settings on photos from the same location.

l Click Slideshow to view and present a slideshow of the photos from this location.

l Send photos from this location via email.

If a geotagged image does not display, try using the keyboard shortcut F5 to refresh the map.

Pin Legend
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Indicates geotagged location.

Indicates more than one geotagged location in this area. (Zoom in to see locations)

Indicates selected geotagged location.

A dot on a pin of any color indicates unsaved image location.

Creating and Assigning Hierarchical Keywords

You can add keywords to your files, and build a hierarchy from those keywords. These groups are
maintained in the keyword tree. Select the Organize tab in the Properties pane to create, rename,
delete, and move your keywords.

You can also access the keywords pane by choosing Panes | Keywords.

You can view all images assigned to specific keywords by clicking specific keywords in the
Keywords group in the Catalog pane.

Creating Keywords

Creating New Keywords:

In the Properties pane, located to the right of the File List pane, do one of the following:

l In the Organize tab, at the bottom of the Keyword group, right-click Keywords, and then select New
Keyword from the context menu.

l Type a keyword into the field at the top of the Keyword group and press Enter.

Assigning Keywords to Files:

l Select one or more files, then check the boxes next to the appropriate keywords you wish to apply.

l Select one or more files, then click the Easy-Select bar on the left side of a Keyword to select it.
Multiple Easy-Select bars can be selected at the same time. Press Assign Selected Keywords.

l Select one or more files, then right-click the keyword. Select Assign items from the context menu.

l Select one or more files, then drag them onto the keyword.

l Select one or more files, then select a keyword from the Quick Keywords set. The keyword will be
assigned to your file and also added to the tree.

In the Keywords group in the Catalog pane, you can:
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l Select one or more files, then drag the keyword from the tree onto them.

To Establish a Hierarchy, Do One of the Following:

l In the keyword field, type the lesser or more specific keyword, followed by the less than symbol,
followed by the greater or more general keyword.

Example:

1. Owl < Bird

or

2. Madrid < Spain < Europe

l Right-click an existing keyword, then select New Keyword. The new keyword will automatically become
a child to the existing keyword.

When assigning multiple keywords to a file, it is important to note that separating keywords
with commas will not generate a hierarchy.

Managing Keywords

To Manage Your Keywords:

Select a keyword in the Organize tab, and do one of the following:

l Right-click the selected keyword and choose Unassign Item.

l Click on the Easy-Select bars to the left of any keywords you wish to unassign, then press Unassign
Selected Keywords.

l Click off the checkbox for any currently assigned keyword to unassign it.

l To edit the keyword, right-click the selected keyword and choose Edit.

l To delete the keyword, right-click the selected keyword and choose Delete.

l To duplicate a keyword, right-click the selected keyword and choose Copy, then Paste where desired.

In the Keywords group in the Catalog pane, you can do any of the management actions above, as well
as:

l To edit the keyword tree, click and drag the keyword to other parts of the tree.

To Unassign All Keywords:

You can unassign all Keywords assigned to your currently selected images by pressing Unassign All
Keywords in the bottom-right of the Keywords section.
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Selecting All Keywords and Clearing Selections:

All keywords can be selected at once by pressing Select All Keywords .

All keywords can be cleared at once by pressing Clear Selection .

To Delete Keywords:

In the Properties pane, located to the right of the File List pane, do one of the following:

l In the Organize tab, at the bottom of the Keyword group, right-click on the Keyword you wish to delete,
and then select Delete from the context menu.

l In the Organize tab, click on the Easy-Select bars to the left of any keywords you wish to delete, then
press Delete Selected Keywords.

In the Catalog pane, located to the left of the File List pane, perform the following:

l Right-click on the Keyword you wish to delete, and then select Delete from the context menu.

To Delete all Unassigned Keywords:

Keywords that do not have any assets assigned to them can be deleted quickly with the Delete all
Unassigned Keywords option.

l Click Tools | Metadata | Delete All Unassigned Keywords.

To Filter Keywords:

In the Properties pane, keywords can be filtered within theOrganize tab by clicking in the Filter
Keywords text field and typing any word. The keywords displayed will filter dynamically as you type.

Creating Quick Keywords

You can use Quick Keywords to keep organized and to streamline your workflow by creating a group of
related keywords that hold an association for you. This is ideal for keywords you would like to be easily
accessible, rather than buried in the hierarchical tree. You can create multiple groups and choose
between them based on the photos you are viewing at the time. ACDSee comes pre-loaded with a
variety of usable sample Quick Keywords sets. You can also add these keywords to your tree.

Example:

Italy

Florence Venice Lake Como

Rome Milan Verona

Genoa Bologna Naples
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To Assign a Keyword from Quick Keywords:

Select one or more files, then click the keyword.

To Create Quick Keywords Sets:

1. On the Organize tab, in the Keywords group, select New Quick Keywords Set... from the drop-down
menu. The Quick Keywords dialog box opens.

2. Customize the number of rows and columns for your set by selecting values from the Rows and
Columns drop-down menus.

3. Enter up to 250 associated or commonly-used keywords in the open fields. To create a hierarchy within
a field, use the pipe key. Example: A|B|C.

4. Click the OK button.

5. In the New Preset dialog, enter a name for your set. Click OK.

6. Apply keywords from your set by selecting a file and clicking the applicable keyword from the Quick
Keywords Table. The keyword will be added to the tree. If you specified a hierarchy in the keyword set,
the parent keyword will appear in the tree with the child under it. The text of the keywords in the table
will change color to indicate that the keyword is assigned to the currently selected files, and will display
in italics if assigned to only some (but not all) of the currently selected files.

Quick Keyword sets are saved in the Presets folder under ACDSee in your AppData folder,
which you can find using the following path: C:\Users\<Your Name>\AppData\Local\ACD
Systems\Presets

Importing and Exporting Keywords

You can import keywords into ACDSee from other users. You can also share your keywords by
exporting them. Keywords are imported and exported as .txt files.

You can import Adobe® Lightroom® keywords.

To Export Keywords:

1. Choose Tools |Metadata | Export Keywords...

2. Browse to the location of your keywords file.

3. Enter a name for your keywords file.

4. Press Save.

To Import Keywords:

1. Choose Tools |Metadata | Import Keywords...

2. Browse to the location of your keywords file.



ACDSee Photo Studio Home 2026

Page 123 of 532

3. Select your file and press Open. The keywords within your file will be loaded into the ACDSee keywords
tree and listed alphabetically. Conflicting keywords will be merged.

Copying and Moving Files

You can use the Copy To Folder and Move To Folder commands to relocate files and folders on your
hard drive, and specify how to handle overwriting existing files. You can also select from a list of
previously accessed folders to save time looking through your directory structure.

When you use ACDSee Home to relocate your files, by default any ACDSeeMetadata
associated with those files is copied to the new location. However, if you do not want to copy
the associated files, clear the Include related files for non-RAW images checkbox.

When you do NOT use ACDSee Home to move or copy your files, you break the link to any
database information you have added to those files. This is because ACDSee Home cannot
track the files. You will lose important categorizing and other database information. You can fix
this by clicking Change Binding and rebinding the database. If you have embedded the
database information in the files themselves, you can also retrieve this information using
Tools | Database | Catalog Files.

ACDSee uses XMP to embed ACDSeeMetadata into each file. Only some file formats and file
extensions support XMP. These include GIF, JPEG, DNG, PNG, PSD, TIF, AVIF, and JPEG-XL. In
the case of these file formats, the ACDSeeMetadata is embedded inside the file and so you
can rename or move the file outside of ACDSee and still be able to retrieve the ACDSee
Metadata. For formats that currently do not support XMP, including RAW and ABR, the
ACDSeeMetadata is written to a sidecar file that is stored in the same folder as its file. Because
a sidecar file is separate from the file itself, you need to rename or move them together, or
you could lose the ACDSeeMetadata permanently.

To Copy or Move Files:

1. Do one of the following:

l In the File List pane, select one or more files, and then click Edit | Copy To Folder or Move To
Folder.

l While viewing an image or media file in View mode, click Edit | Copy To Folder or Move To
Folder.

2. In the Copy To Folder or Move To Folder dialog box, do one of the following:

l Select the Folders tab, and locate the folder on your hard drive where you want to place the
files.



ACDSee Photo Studio Home 2026

Page 124 of 532

l Select the History tab, and select a folder from the list of recently-accessed folders.

l Select Create Folder and enter the name of a new folder.

3. In the Overwriting duplicate files drop-down list, select one of the following options to specify how
ACDSee Home should handle overwriting files:

l Ask: prompts you for confirmation when overwriting a file.

l Rename: prompts you to rename a file.

l Replace: overwrites any file with the same file name and extension.

l Skip: cancels the operation if there is a file with the same file name and extension.

4. Click OK.

Copying Images to the Clipboard

You can copy an image to the Clipboard and then paste it into another application. Using the Copy
Image command transfers only the image data to the Clipboard: no EXIF, IPTC or metadata
information is retained.

To Copy an Image:

1. In Manage mode or View mode, select the image file you want to copy.

2. Click Edit | Copy Image, right-click on the image and select Copy, or press Ctrl + Insert.

3. Paste the image into your other application.

To Copy an Image as a File Path:

1. In Manage mode or View mode, select the image file you want to copy the file path for.

2. Right-click on the image and select Copy as Path.

3. Paste the image file path in its desired location.

Pasting Files and Folders

You can cut or copy files to the Clipboard, and then paste them into another folder without losing
your ACDSeeMetadata.

To Cut and Paste Files:

1. In Manage mode, in the File List or Folders pane, select one or more files or folders.

2. Click Edit | Copy or Cut.
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3. In the Folders pane, browse to a new location.

4. Click Edit | Paste to place the files or folders into the new location.

Replacing or Overwriting Files

When copying or moving files from one location to another, a file name collision occurs if a file already
exists in the destination folder with the same file name and extension as a file you are relocating. In
ACDSee, you can view both of the files involved in the Confirm File Replace dialog box. If the files
involved are image files, ACDSee Home displays thumbnail previews of both files, and provides options
to replace the existing file, rename, delete, or skip the file you are moving, or cancel the operation
entirely.

To Use the Confirm File Replace Dialog Box:

1. If you are moving a number of files and want to handle all potential file name collisions in the same
manner, check the Apply to all checkbox.

2. To help determine any differences between the two files, use the toolbar between the two preview
fields to shrink or enlarge the size of the previews.

3. Do one of the following:

l To replace the destination file with the source file, click Replace.

l To rename the new file before moving it into the destination folder, type a new name for the
file in the Rename to field, and then click Rename.

l To skip this file, and leave both files intact, click Skip.

l To delete either the destination or source file, click Delete below the file you want to remove
from your hard drive.

l To cancel the operation and not move or copy any more files, click Cancel.

In the Confirm File Replace dialog box, destination file refers to the file that exists in the target
folder, and source file refers to the file you are moving or copying.

Renaming a File or Folder

You can rename a file or folder on your hard drive in the Folders and File List panes.

To Rename a File or Folder:

1. In Manage mode, in the File List or Folders pane, select the item you want to rename.

2. Click Edit | Rename.



ACDSee Photo Studio Home 2026

Page 126 of 532

3. Without removing or changing the file name extension, such as “.jpg”, type a new name for the file.

4. Press Enter.

You can renamemultiple files at the same time using the Batch Rename tool.

Storing Files in Private Folders

You can store confidential files in private, secure folders. When you add a file to a private folder, it will
disappear from its original location. Private folders are password-protected and you can only view the
files in them in ACDSee.

When you add files to a private folder, all information related to the file is deleted from the database.
This means that though the file can be restored, database information cannot. The only way to
preserve database information is to back up or export the database before you add files to a private
folder. There is also no way to restore images from a private folder if you forget the password, so make
sure it is memorable.

To Open the Private Folder Pane:

In Manage mode, click Panes | Private Folder.

To Create a Private Folder:

1. Close any open private folders.

2. Right-click the private folder icon in the Private Folder pane and select Create Private Folder.

3. In the Enter Password text box, type a password for the private folder. Your password must be less than
40 characters long.

4. In the Re-enter Password text box, type the password again to verify it.

5. Click OK.

A new folder will not display in the Private Folder pane. Private folders are hidden and are only
identified by their password. When you have a private folder open you will see any subfolders
that exist within the private folder, but do not confuse these subfolders with the private folder
itself.

To Open a Private Folder:

1. Close any open private folders.

2. Click Panes | Private Folder.

3. Click the Open button in the Private Folder pane header.
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4. In the Enter Password text box, type the password of the private folder that you want to open.

5. Click OK.

The contents of an open private folder remain visible until you close it. Remember to close
your private folder if you have to step away from your computer and do not want anyone to
see its contents.

To Close a Private Folder:

Do one of the following:

l Click the Close button in the Private Folder pane header.

l Click File | Exit to exit ACDSee. The private folder is closed automatically.

To Add Files to a Private Folder:

1. Open the private folder to which you want to add files.

2. Click and drag the files onto the private folder icon in the Private Folder pane. A warning
message displays.

3. Click Yes to move the files to the private folder.

When you add files and folders to a private folder they are removed from their original
location in the file system and added to the password-protected private folder. There is no
way to recover files and folders from a private folder if you have forgotten your password.
Ensure that you choose a password that you will be able to remember.

To Add an Existing Folder and its Contents to a Private Folder:

1. Open the private folder to which you want to add files.

2. Click and drag the folder onto the private folder icon in the Private Folder pane.

3. Click Yes to move the folder and its contents to the private folder.

To Restore Folders and Files from a Private Folder:

1. Open the private folder containing the folders or files that you want to restore.

2. Select the folders or files and click File | Restore from Private Folder.

3. Click the browse button, navigate to the folder where you would like to move the folders or files, and
then click OK.

4. Click OK.
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ACDSee Homemoves the folders or files from the private folder to the selected location. These
folders and files are now visible to anyone with access to the computer.

To Delete a Private Folder, or the Folders or Files in the Private Folder:

1. Open the private folder containing the folders or files that you want to delete.

2. Do one of the following:

l To delete the private folder, right-click the private folder icon and select Delete.

l To delete folders or files in a private folder, right-click them and select Delete.

A warning message displays.

3. Click Yes to delete the private folder and all of its contents, or the selected folders or files in the private
folder.

Use caution when deleting folders or files in private folders. If you delete folders or files in
private folders they are permanently destroyed. Restore the folders and files if you want to
move them from the private folder to a non-secure location on your computer.

Tagging Images or Files

You can tag images to identify certain characteristics. This could be your best photos from an event or
images you wish to review. You can use this samemethod for organizing and categorizing your
documents and other files.

The tagging checkbox is at the bottom right corner of the thumbnails. Check the checkbox to tag or
un-tag photos or documents. Photos remain tagged until you uncheck the checkbox.

You can display all your tagged photos or files with one click by clicking Tagged under Special items in
the Catalog pane. Tagging, like categories and ratings, is a way to set aside, organize, and group your
photos or files without moving the files into different folders.

Tagging is intended as a temporary means of separating your images and files. Once tagged,
you can move or apply categories and ratings to the images and files, and then clear all of the
tags. Categories, ratings, color labels, and folders are more effective for organizing and
grouping your images and files over a long period of time.

To Tag a Selected Image or File:

l Use the keyboard shortcut \ backslash key to apply the tag.

l Check the checkbox in the bottom right corner of the thumbnail.
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l Right-click on one or more thumbnails and select Tag.

l In the Properties pane, check the tag checkbox at the top left corner in the Metadata tab.

To Untag a Selected Image or File:

l Use the keyboard shortcut \ backslash key to remove the tag.

l In the Properties pane, uncheck the tag checkbox at the top left corner in the Metadata tab.

To Untag All Tagged Images or Files:

1. Click Tagged in the Catalog pane to display all tagged files in the File List pane.

2. Use the keyboard shortcut Ctrl + A to select all.

3. Click the backslash key \ to remove the tag.

To Display Tagged Images or Files:

In Manage mode, click Panes | Catalog to display the Catalog pane, then click Tagged in the Special
Items section.

Tagged photos or files from all your folders display in the File List pane.

To Tag an Image or File in View Mode:

Do one of the following:

l In View mode, check the checkbox in the bottom right corner of the status bar.

l In View mode, click Panes | Properties to display the Properties pane, click the Metadata tab, then
check the Tagged checkbox in the top left corner.

To Tag an Image When You Are Comparing Images:

1. In the Comparison List, check the checkbox in the bottom right corner of the image thumbnails.

2. Click OK. The Compare Images Viewer closes. You will see a checkmark in the checkbox of the images
that you tagged.

Managing Metadata Views

To Select a Metadata View:

1. Click Panes | Properties to open the Properties pane.

2. Select the Metadata tab of the Properties pane.



ACDSee Photo Studio Home 2026

Page 130 of 532

3. Click the Metadata View drop-down list in the Metadata tab to select one of the view options: Default
Metadata View (most commonly used fields), All EXIF, All IPTC, ACDSee Metadata, or saved custom
views.

You must have an image selected to view theMetadata tab.

Default Metadata Views:

There are 5 built-in Metadata Views to select from:

l Default Metadata View

l All EXIF Metadata

l All IPTC Metadata

l All Video Metadata

l ACDSee Metadata

Video files will only be played ifWindows can play them.Metadata for videos will only appear
if the video can be played.

To Create a Customized Metadata View:

1. Click the Metadata View drop-down list in the Metadata pane and selectManage Metadata Views....

2. In the Choose Metadata to Display dialog box, select New Metadata View from the drop-down list.

3. Click the plus + signs to expand the tree and check/uncheck the checkboxes on and off to select your
preferences. See Manage Metadata View options below.

4. Click the save button and enter a name for your customized view.

5. Click OK.

Manage Metadata Views Options

l When all items in a group are selected, the group checkbox is checked.

l When no items in a group are selected, the group checkbox is unchecked.

l When some, but not all items in a group are selected, the group checkbox is solid.

Check/uncheck the checkboxes to make your selections.
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You can choose whether or not to display maker notes by checking or unchecking the Display
Maker Notes checkbox.
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Adding ACDSee Metadata to Multiple Files

You can add information to your images using IPTC and ACDSeeMetadata. IPTC information is
automatically embedded into your image, while ACDSeeMetadata can be embedded into your file, or
stored in the database.

We recommend entering and editing metadata prior to processing your images.

You cannot set IPTC and EXIF information for read-only files, such as those on a CD-ROM.

If the Properties pane is not already open, select Panes | Properties.

To Add Metadata to One or More Files:

1. In Manage mode, select one or more files in the File List pane.

2. In the Properties pane, select the Metadata tab.

3. Enter information into the metadata fields.

4. Click Apply or press Enter to apply your changes.

When you click Apply or Enter in ManageMode, the focus is returned to the File List pane
allowing you to quickly make another file selection using your keyboard.

To include numbers in a sequence with your metadata, select the files and enter <#> as the
start number, in whichever field you want. Ex) Entering <5>will begin the sequence at 5.

Metadata Tab Keyboard Shortcuts

This Shortcut Has This Result

Tab Jumps focus forward from field to field.

Shift + Tab Jumps focus backwards from field to field.

Ctrl + K Places the cursor in the ACDSee Metadata Keywords field of the Organize tab in the
Properties pane.

Alt + K Places the cursor in the IPTC Keywords field of the Metadata tab in the Properties pane.

Enter Applies your changes.

Esc Discards your changes.

If you click away from the Properties pane, any metadata that you have just entered will be
lost. You must click Apply or press ENTER to apply your changes.
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To Use Keyboard Shortcuts to Enter Metadata into the Same Field of Multiple Photos:

1. Select the first photo in your list and enter content into a Metadata field.

2. Press the Page Down key to move to the next photo. The cursor remains in the same field of the
Properties pane for each photo, allowing you to quickly enter content for the same field for multiple
photos.

3. Enter content into the field and again press Page Down to move to the next photo.

4. Continue Step 3 until complete.

You do not need to click the Apply button when using this shortcut. 

You can use the Page Up key to move back to the previous photo.

Embedding and Importing Categories and Keywords between ACDSee and IPTC

There are quick commands to embed your ACDSee keywords and categories into IPTC metadata, as
well as importing from IPTC keywords and supplemental categories into your ACDSee keywords and
categories.

To Embed ACDSee Keywords and Categories to IPTC Keywords and Supplemental Categories

Select a file, Right-Click and chooseMetadata | Embed to IPTC | Embed Keywords to IPTC or Embed
Categories to IPTC.

or

Select a file, and choose Tools |Metadata | Embed to IPTC | Embed Keywords to IPTC or Embed
Categories to IPTC.

Merging or Overwriting IPTC Metadata

When embedding ACDSee Metadata into IPTC metadata, you can choose how the data is saved
alongside previously saved metadata.

l Merge: ACDSee Metadata will be added to any existing IPTC Keywords and/or IPTC Supplemental
Categories.

l Overwrite: ACDSee Metadata will replace any existing IPTC Keywords and/or IPTC Supplemental
Categories.

To Import Keywords and Supplemental Categories from IPTC to ACDSee Keywords and Categories

Select a file, Right-Click and chooseMetadata | Import from IPTC Keywords or Import from
IPTC Supplemental Categories.

or
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Select a file and choose Tools | Metadata | Import from IPTC Keywords or Import from
IPTC Supplemental Categories.

Importing from IPTC metadata to ACDSeeMetadata always acts as a merge.

Removing IPTC Keywords from Auto Categories

You can remove unused IPTC keywords from the ACDSee Home database. Once removed, the
IPTC keywords will no longer display under Keywords (IPTC) in the Photo Properties' Auto Categories
list of the Catalog Pane.

This process also applies for the Supplemental Categories field. This field is only visible if
selected from the Choose Metadata to Display dialog box found under Tools | Options |
Properties Pane by pressing theManage Metadata Views button.

To Remove IPTC Keywords and Supplemental Categories:

1. In Manage mode, select any image which supports IPTC.

2. If the Properties pane is not already displayed, click Panes | Properties.

3. To ensure the image is writable, do the following:

l Select the File tab and check to see if there is a checkmark in Read only.

l If there is a checkmark, the image is not writable. Uncheck the Read only checkbox to make the
file writable.

4. In the IPTC section of the Metadata tab, click the keyword picker button beside the Keywords field.

5. In the IPTC Keywords Picker dialog box, click Edit List.

6. Select the keyword you want to remove from the Value list.

To select more than one keyword, press and hold the Ctrl key while selecting the
keywords.

7. Click Remove.

8. Click OK.

9. Click OK again to confirm.

Only keywords that are not in use can be removed from the list. To find photos associated
with a keyword, click the keyword listed under Photo Properties in the Auto Categories list of
the Catalog pane.
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Changing the Date and Time Properties of Images

You can use the Batch Adjust Time Stamp tool to change the date and time properties of one or more
images in Manage mode or in Viewmode.

To Change the Date and Time Properties of a File:

1. Do one of the following:

l In Manage mode, select one or more images, and then click Tools | Batch | Adjust Time Stamp.

l In View mode, click Tools |Modify | Adjust Image Time Stamp.

2. On the Date to Change tab, choose from the following:

Date to Change

EXIF date and time EXIF date/time
original

The original
date/time the image
was captured.

EXIF date/time
digitized

The date/time the
image was converted
to a digital image
(usually the same as
original).

EXIF date/time The date/time the
image was lasted
edited.

File last-modified date and time The date/time the image or file was
lasted edited. For example, image editing
or updates to metadata.

File creation date and time The original date/time the file was
created.

ACDSee Database date and time The date and time held in the ACDSee
Database.

3.  On the Advanced Options tab, select the options for the Adjust Image Time Stamp tool described
below, then click Next.

Advanced Options
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Accept defaults and start conversion Accepts the default settings for the
new time stamp options. To start
changing the date and time of your
images, click Adjust Time Stamp.

Automatically close wizard when finished Closes the Adjust Image Time Stamp
wizard as soon as the process is
complete.

Save current settings as defaults Remembers the current settings
and applies them the next time you
change time stamps.

4. On the Choose new time stamp page, select one of the following options:

l Use different date and time: replaces the selected date and time with another time stamp
property from the same file. Select the file property you want to use from the Select date and
time drop-down list.

l Use specific date and time: changes the selected time stamp in each file to a specific date and
time. Type the new date and time for the time stamp in the Date and Time fields.

l Shift to a new starting date and time: replaces the earliest time stamp with a date and time
you specify, and shifts all later time stamps ahead accordingly. Specify the time stamp for the
earliest file in the Date and Time fields.

l Shift date and time by a specific number: shifts all the time stamps either forwards or
backwards by a specific number of hours (to adjust for time zones). Select either Shift forward
or Shift backward, and type a number into the Hours,Minutes, and Seconds spin boxes.

5. Click Adjust Time Stamp to begin adjusting your files.

6. When the wizard is finished, click Done to return to ACDSee.

Backing Up Your Files to Another Computer

The Sync wizard will guide you through the process of creating a synchronized copy of your files to
protect you from local hard drive failure. This is also known as a back up. You can synchronize your
local folders with a network drive, remote computer, or external hard drive. You can name the
synchronization, specify the actions you want to take each time you synchronize your files, schedule
the synchronization to run at specific intervals, and edit or remove the synchronization at a later time.

The Sync wizard does not backup your database when your files are copied to a new location.
To back up files with database information, use the ACD Database Backup wizard.

To Create a Synchronization:
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1. In Manage mode, click File | Sync | Create Sync.

2. On the Welcome page, click the Next button when you are ready to continue.

3. On the Synchronization Options page, do the following:

l In the Source folder field, specify the folder containing files you would like to copy.

l In the Backup destination field, specify a folder on a network drive, remote computer, or
external hard drive in which to place the backup files.

l In the Options area, specify how Sync should handle errors and logs.

l In the Confirmations area, specify how Sync should handle file duplication conflicts.

l Click Next when you are ready to continue.

4. On the Synchronization Schedule page, do the following:

l In the Name text box, type a name for your synchronization.

l In the Schedule area, specify whether you would like to run the synchronization immediately,
or schedule the synchronization.

l Click Finish when you are ready to complete the wizard.

Schedule: an account with no password cannot set up a schedule. You must set a password
for your account for schedules to work. A blank password will not work; you must have a real
password with more than one character.

Updating or Deleting a Synchronization

You can adjust the settings of a synchronization, schedule it to run at regular intervals, or delete the
synchronization from ACDSee.

To Update or Delete a Saved Synchronization:

1. In Manage mode, click File | Sync | Edit Sync.

2. In the Saved Synchronizations dialog box, select a synchronization from the list.

3. Do one of the following:

l To schedule the synchronization, click Schedule. Specify how often to run your synchronization,
and then click OK.

l To adjust the settings, click Edit. In the Edit Synchronizations dialog box, update the folder
containing files you would like to copy, and a folder on a network drive, remote computer, or
external hard drive in which to place those files. In the Options area, update how Sync should
handle errors and logs. In the Confirmations area, update how Sync should handle file
duplication conflicts. Click OK when you are finished.
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l To rename the synchronization, click Rename. Type a new name for the synchronization and
click OK.

l To delete the synchronization, click Delete.

4. Click Close.

Running a Saved Synchronization

After you create a synchronization, you can run it at any time, even if it is scheduled to run at regular
intervals.

To Run a Saved Synchronization:

In Manage mode, click File | Sync, and then select the name of the synchronization you want to
run.

Searching with ACDSee Home

ACDSee Home includes a number of ways to search your computer for files and folders. You can use
the Advanced Search pane to search by file name, keywords, or image properties. You can create
advanced searches to locate files that fall within a date or rating range and then save and name the
search to use later. You can also use the Duplicate Finder to locate and manage identical files.

For simpler searches, you can use the Quick Search bar to quickly locate files and folders, or search the
database for specific names and keywords. You can also customize the Quick Search bar to only search
for specific items or certain parts of the database.

Also, you can use the Catalog pane to quickly locate and list all images on your hard drive, or to locate
any files in a folder that have not been categorized. If you are working with larger image collections,
you can use Selective Browsing to specify broad or narrow criteria for the images you want to display
in the File List pane.

Using the Quick Search Bar

You can use the Quick Search bar in Manage mode to quickly locate files or folders. You can use the
Quick Search options to refine or expand your search, and view the results in the File List pane.

You can choose whether the Quick Search searches just the files currently in the file list, or the entire

database, by clicking this icon .

When performing a quick search, you can select the type of search to perform by clicking on the

magnifying glass icon found directly to the right of the Quick Search field.

Search types will utilize different separators: Delimiters, Operators, or none:
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l Delimiters are commas and spaces. Search types that use delimiters will separate search terms by
commas or spaces.

l Starts With and Ends With do not use any separators. All text typed is literal. For example: Cat, Dog will
search for "Cat, Dog", including the comma and space.

l Classic Quick Search uses the operators + , -, |, and space (which is treated the same way as a +).

Quick Search Types:
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Search Type Result Separators Examples

Contains Any Searches for items that contain any terms
specified within the search criteria. Includes
sub-string searches.

Delimiters Cat, Dog returns
all results
containing Cat
or Dog or any
combination of
the two. This
includes sub-
string searches,
for example:
Searching for
Cat would also
bring results for
words that have
cat in them,
such as catalog.

Contains All Searches for items that contain all terms
specified within the search criteria. Includes
sub-string searches.

Delimiters Cat, Dog returns
all results
containing both
Cat and Dog.

Contains
Words

Searches for items that contain whole words
specified within the search criteria.

Delimiters Cat, Dog returns
all results that
include the
whole words Cat
and Dog.

Does Not
Contain

Searches for items that do not contain any of
the terms specified within the search criteria.
Includes sub-string searches.

Delimiters Cat, Dog returns
all results that
do not include
the search terms
of Cat or Dog.

Starts With Searches for all items that begin with the
characters specified within the search criteria.
Includes sub-string searches.

None Cat returns all
results that
begin with Cat.
This includes
results that
include but are
not limited to
the searched
term, such as
catalog.
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Search Type Result Separators Examples

Ends With Searches for items that end with the
characters specified within the search criteria.
Includes sub-string searches.
Please note: If searching for a file name, you
must include the file extension.

None Sing returns all
results that end
with Sing. This
includes results
that may not
begin with the
term specified,
such as "rising".

Sing.jpg returns
all results that
end with
Sing.jpg. This
means only
results that
include sing,
with a file
extension of .jpg
will be returned.

Classic
Quick Search

Performs searches for items using ACDSee's
legacy Quick Search engine. If searching for a
file name, search will utilize the "Starts with"
search style. All other search fields search for
whole words.
Operators:

+: searches for all items containing both
search terms. Items that only contain one of
the terms are excluded. Spaces are also
treated as + operators.

-: searches for all items containing the first
search term, that don't also include the
second term.

|: Searches for all items containing either of
the search elements.

Operators Cat -Dog returns
all items that
contain Cat,
except those
that also contain
Dog. Be sure to
insert a space
before the
minus sign. If
you do not
insert a space,
ACDSee Home
will assume you
are searching for
a hyphenated
word.
Cat|Dog
includes all
items with either
Cat or Dog in the
search.

Cat+Dog+-
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Search Type Result Separators Examples

Kittens returns
items that
include both
Cat and Dog,
but not those
that include Cat
and Dog and
Kittens.
Cat+Dog or Cat
Dog returns
items
containing both
Cat and Dog.

Cat+Dog|Kitten
s includes items
that contain
both Cat and
Dog, and those
that contain
Kittens.

Running a Quick Search:

Do one of the following:

1. In the Quick Search bar, type the term or part of a term you want to search for.

2. Click the drop-down list beside the Quick Search field and select a previously entered search term.

You can use the keyboard shortcut Ctrl + F to put the focus in the Quick Search bar and
immediately begin typing.

Choosing Fields to be Included in Search:

l Select Tools | Options.

l Select Quick Search under Manage Mode.

l Toggle fields to be included or excluded from the search, then select Ok.
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Using the Advanced Search Pane

You can use the Advanced Search pane to search for your files and folders. You can search by a wide
variety of options such as file names, text strings, metadata fields, file properties, or image attributes.
You can also search for patterns in file names and find duplicate files.

You can even save a search and give it a name. Search Presets are listed on the Advanced Search pane
and the Catalog pane. On the Advanced Search pane, you can select Search Presets from the drop-
down list to run again. On the Catalog pane, Search Presets are listed below Auto Categories where
you can run them again by clicking once on the Search Preset name.

The Advanced Search pane will not return results for folders that are not cataloged in the
ACDSee Home database. Cataloging happens automatically when you browse to a folder. You
can also click Tools | Database | Catalog Files.

To Open the Advanced Search Pane:

In Manage mode, click Panes | Advanced Search.

Advanced Search Pane Areas

The Advanced Search pane contains several areas to help you manage your searches. When you
create a search, remember that the search tool will only return files that match all of the criteria that
you specify.

Search Presets

In the Search Presets area, you can save a complex search to use later, select a search to run again, or
delete a search preset.

Search Presets If you have a search preset, it is listed in this drop-down list for you to select
and run again. When you click Start at the bottom of the pane, the search
results are listed in the File List pane.

Search Presets are also listed on the Catalog pane, from where you can run
them with a single click on the Search Preset name.

Save a search preset Click the Save icon. When the Search Preset dialog opens, type in a name for
the search. If you use a descriptive name, it makes it easier to remember the
criteria in your search preset.

Delete a search preset Select a search from the drop-down list and then click the Delete icon. Click
Yes to confirm the deletion, when the prompt opens.
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Source

When searching for files, you can search three different source locations:

Database Searches using the Database source will look for files within the cataloged files in
Photo Studio.

Folders Searches using the Folders source will look for files within a selection of folders. You
can select one or more folders to be searched, or simply select Sync to the current
folder to use the folders currently selected in the Folders pane.

Current View Searches using the Current View source will look for files within your currently
selected file list in Photo Studio. This can include one or multiple folders, different
metadata from the Catalog pane, or even the results of your previous search.

Criteria

You can choose from a wide range of criteria and file types. In the header, use the File Type Selector
button to open the menu with different searchable file types.

Press the + button to open the Criteria Picker to display the full list of searchable criteria. Click a
criteria on the left side of the picker to add it to the right side. Once on the right side, criteria can be
managed by moving them up and down, changing their AND/OR state, or removing them with the
delete button. Click the OK button to update the Advanced Search pane with your selected criteria.
Most criteria search for a single metadata field, allowing you to fine-tune your searches. Each criterion
is divided by buttons displaying the AND/OR state on the Advanced Search pane, clicking the button
will change its state between AND & OR.

For more information and examples, see Choosing Criteria in the Advanced Search Pane.

When criteria have been added to the Advanced Search pane, many will include a gear icon.
Clicking on the icon will provide additional ways to customize your search.

History

When an Advanced Search has been run, it will appear in the History section of the Activity Manager.
Clicking on the Advanced Search entry in the History will open the Advanced Search pane with the
search criteria preloaded. For more information see Activity Manager.

Options

Folder Handling
You can choose how results are returned when folders match the search criteria:
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Return those folders Returns folders that meet the search criteria

Return those folders as well as
their contents

Returns folders that meet the search criteria as well as their
contents

Return only the contents of those
folders

Returns the contents of folders that meet search criteria, without
displaying the folders themselves

Searches will always return files that meet the search criteria regardless of this setting.

Choosing Criteria in the Advanced Search Pane

When using the Advanced Search pane, you can choose to search a large assortment of criteria from
ACDSeeMetadata, IPTC, EXIF, and other file information. See table below for commonly used criteria,
and examples of other criteria datatypes.
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Data Types Definitions and Examples

Filename Search for files or folders by name. Search terms can be separated
by semicolons for all the search types except Pattern Match. You
can select between Any of or All of for each search field to
determine how your search terms are handled. Any of will search
for items that include Any of your search terms, while All of will
search for items that include All of the search terms. Search
history is stored for Filename searches. Use the UP and DOWN
arrow keys to select different auto-complete suggestions from
your history, and press ENTER or TAB to enter the selected
suggestion. Change to the Pattern Match search type to make use
of Wildcards:
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Data Types Definitions and Examples

Wildcard Result Example

? Matches any single
character in the file
name.

ca?.jpg results in
cat.jpg, cap.jpg,
and car.jpg, but
not cats.jpg

* Matches zero or more
characters in the file
name.

cat* results in
cat.jpg, cats.jpg,
and cathy.jpg

[…] Matches any of the
enclosed characters.

ca[tr] results in
cat.jpg or car.jpg,
but not cap.jpg

[!…] Matches any character
not enclosed.

cat[!0] results in
cata.jpg and
catb.jpg, but not
cat0.jpg

[…-…] Matches any character in
the specified range.

cat[a-f0-9]
results in
cata.jpg, catb.jpg,
catf.jpg and
cat0.jpg, cat1.jpg,
…, cat9.jpg

\ Blocks the use of other
wildcard characters that
are also characters
permitted in a file name,
such as square brackets: [ 
]. The * and ? characters
are not permitted in file
names so this function
does not work with them.

Because square
brackets are
wildcards, if you
wanted to search
for a file name
that contains a
bracket, you
must precede
the bracket with
a backslash:

ACD\[123\]
results in ACD
[123].gif

Patterns are not case-sensitive. To use multiple
patterns, separate the names with spaces or
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Data Types Definitions and Examples

semicolons. To match a pattern containing a space or
semicolon, enclose the pattern in double quotation
marks. If you do not include the * wildcard in your
pattern, the pattern is matched as a sub-string. For
example, cat would match cat, cathy and bobcat, and
is equivalent to the pattern *cat*.

Text String-based search on several common fields. Choose from any or
all of: Keywords, Categories, People, Labels, Captions, and Notes.
Search history is stored for Text searches. Use the UP and DOWN
arrow keys to select different auto-complete suggestions from
your history, and press ENTER or TAB to enter the selected
suggestion.

People, Keywords, and Categories Combination string and lookup list searches. Open the Value Picker
to choose values from the database, or type custom strings in the
text field. Search terms can be separated by semicolons.

Rating Select the ratings you'd like to search.

Label Select the labels you'd like to search. Choose from any of your
label sets, or change to Text Search to search for custom values.

String Search for strings of text, can be separated by semicolons.
Example: Maker

Date/Time Search for a date and time. Set the precision to day or second.
Example: Date/Time Original

Lookup List Select one or more values from the Value Picker. Example: Image
Type

Integer Search an integer number. Example: ISO

Rational Search for a rational number as a fraction or decimal number.
Example: F-Number

When using a semicolon(;) to separate search terms, you can use two semicolons(;;) to search
for a literal semicolon instead.
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Using Selective Browsing

You can use selective browsing to browse for files that are located in a specific folder, assigned a
specific date, and/or assigned to a specific Catalog classification. By adjusting the selective browsing
criteria, you can quickly include or exclude files from the File List pane, and view only those files you
want to browse.

To get the most out of selective browsing, it is recommended that you catalog and organize your files
in the ACDSee Home database. The more information you enter for your files, the more helpful you will
find the selective browsing feature.

To Use Selective Browsing:

Open the Selective Browsing panel by clicking View | Selective Browsing. The panel appears on the
left side of the File List pane.

Setting Selective Browsing Criteria

The Selective Browsing panel is divided into three areas: Folders, Catalog, and Calendar, each of which
corresponds to the Manage mode pane of the same name. When the Selective Browsing panel is
open, the Contents bar in the File List pane is replaced by the Selective Browsing bar, which lists all of
the current browsing criteria.

When you add a folder, date range, or organize method to the Selective Browsing panel, ACDSee
Home excludes any files that do not match that criteria. You can add or remove criteria to narrow or
broaden your results.

To Add Selective Browsing Criteria:

With the Selective Browsing panel open, do any of the following:

l In the Folders pane, select one or more folders.

l In the Catalog pane, select one or more categories, and/or a rating.

l In the Calendar pane, select one or more date ranges.

As each criteria is added to the Selective Browsing panel, ACDSee Home searches its database for files
in that folder, that match the date range, and are assigned to the classification, and displays them in
the File List pane. You can then select those files and use the ACDSee Home features to edit, share,
move, and view them however you want.

You can also adjust or refine your criteria in the Selective Browsing panel:

l To remove a selected criteria from the Selective Browsing panel, right-click any of the criteria, and then
select Remove From Scope.
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l To exclude all of a certain type of criteria, click the bar above the list, and toggle the option to include
that type in the scope. For example, to exclude the listed folders from the scope, click the Folders bar,
and then click Include Folders in Scope. The folders you selected will still be displayed in the Selective
Browsing panel, but will not factor in the results.

l To remove all criteria of a certain type, click the bar above the list, and select Clear All.

The default behavior for categories in the Selective Browsing panel is to display files that match any of
the categories listed. You can refine your results by choosing to display only those files that are
assigned to all of the specified categories. To toggle between behaviors, right-click the bar above the
categories you selected, and selectMatch Any orMatch All.

Tips for Selective Browsing

When you add a criteria to the Selective Browsing panel, you are indicating that the files you want to
browse must have that attribute. For example, if you select a folder in the Folders pane, then ACDSee
Home displays only files in that folder. If you select a rating in the Catalog pane, ACDSee Home displays
only files assigned to that rating.

You can combine criteria to refine your selective browsing even further. For example, if you select a
category and a date range, then ACDSee Home displays only those files that belong to both the
category and date range you selected. ACDSee Home does not display items that fall within the date
range unless they are also assigned to the correct category, and does not display files assigned to that
category unless they also match the date range.

Hiding the Selective Browsing Panel

You can use the Auto Hide feature to automatically hide the Selective Browsing panel and increase
space for the File List pane. When the panel is set to auto-hide, it rolls away when you click outside it,
leaving only an edge displayed. You can access the panel again by moving the cursor over the edge.

Searching with Auto Categories

Auto categories can help you search for files. This is particularly useful if you tend to take a lot of
photos, or if you share your pictures with others.

You will find auto categories in the Catalog pane below Labels. Double-click or click the plus sign (+) to
expand auto category groupings. Double-click or click the minus sign (-) to collapse the auto category
groupings.

Some auto category information is added to images by your camera. This could include camera make
and model, white balance settings, focal length, and aperture. You can supplement that with
information you think is useful such as the location, keywords or copyright. To do this, you can enter
information in the Properties pane.
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When you click on an auto category, ACDSee Home searches for images belonging to that category.
For example, if you use more than one camera, you can use auto categories to search for pictures
taken using certain camera models. All images captured with that camera model will display.

Below are some tips for searching with auto categories.

Identifying Commonly Used Search Categories

If you use certain auto categories in the Photo Properties grouping frequently, you can save time by
adding them to the Commonly Used grouping. Some Photo Properties groupings are available in the
Commonly Used grouping by default. You can add and remove as many auto categories as you want
to the Commonly Used grouping.

To Add an Auto Category Grouping to the Commonly Used Grouping:

1. Expand the Photo Properties grouping.

2. Right-click the auto categories grouping that you want to add to the Commonly Used grouping, and
select Add to Commonly Used. The grouping is added to the Commonly Used grouping.

It remains visible in the Photo Properties grouping as well.

To Remove an Auto Category Grouping from the Commonly Used Grouping:

1. Expand the Commonly Used grouping.

2. Right-click the auto categories grouping that you want to remove from the Commonly Used grouping,
and select Remove from Commonly Used.

The grouping is removed from the Commonly Used grouping.

Refining Your Auto Categories Search

You can refine your auto categories search by selecting more than one auto category. For example,
you can find images with a certain aperture and shutter speed. If you click the Easy-Select indicator
beside the f/16 aperture auto category and the 1/30 s shutter speed auto category, ACDSee Home will
search for images that belong to both of those auto categories.

When you select more than one auto category you can further control the search by selectingMatch
All orMatch Any from theMatch Any/All drop-down list at the top of the Catalog pane. If you select
Match Any, ACDSee Home will display any images associated with the selected auto categories. If you
select Match All, ACDSee Home will display only those images that are associated with all of the
selected auto categories.

You can also refine your auto categories search by selecting a category or rating. For example, imagine
that you clicked on the Photographer auto category and found over 1000 images. However, you only
want to see the best images by that photographer. Click the Easy-Select indicator beside 1 in the
Ratings area of the Catalog pane. Only the images by that photographer with a rating of 1 will display.
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You can also use the Selective Browsing pane to refine your auto categories search. For example,
imagine that you clicked on the Camera Model auto category and ACDSee Home displayed over 1000
images. However, you only want to see the images that you took on a specific date. Display the
Selective Browsing pane by clicking View | Selective Browsing, then select the Calendar pane and
select the appropriate date. Only the images taken with that camera model on that day will be
displayed.

Finding Duplicate Files

You can use the Duplicate Finder to find duplicate files across a variety of folders on your hard drive.
Once duplicates are found, you can perform rename and delete functions to better manage your file
collection.

Note that identical images saved as different formats (i.e. different extensions, such as JPEG,
BMP, GIF), are not recognized as duplicates. If you have a JPEG and save a copy of it, the
image is recompressed. Therefore the original JPEG and the copy are a different file internally
and they are not recognized as duplicates.

To Find Duplicate Files:

1. In Manage mode, select a folder or images to search for duplicates. (Optional)

2. Click Tools | Find Duplicates...

3. In the Duplicate Finder dialog box, do one of the following:

l To find duplicates within the selected folder and any added files or folders, select Find
duplicates within this single list of files.

l To find duplicates by comparing the contents of two separate lists, select Find duplicates within
these two lists of files. (This will not search for duplicates within one of the two lists. It will only
search the two lists against one another.)

4. Add files to your list or lists with the Add Files... and Add Folder... buttons. Remove files by selecting
them in the list and pressing the Remove button. Switch out one file or folder for another by selecting it
in the list and pressing the Modify button. To include the contents of any subfolders you selected, check
the Include subfolders checkbox.

5. Below the File Lists, specify whether you want to find exact duplicates or just files with the same name.
Select Find images only if you only want to search for image files.

6. Press Search.

7. If no duplicates are found, click OK and refine your search or click Cancel to exit the Duplicate Finder.

8. If duplicates are found, select sets in the list for further actions.
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Deleting and Renaming Files

Once duplicates have been found, files can be renamed or deleted. If you are working with image files,
a preview is available.

If multiple sets of duplicates have been found, you may want to sort them for easier viewing.

To Sort Files:

1. Right-click in the upper-left list.

2. Select one of the following:

l Sort by Filename

l Sort by Path

l Sort by File Size

l Sort by File Type

l Sort by Number of Duplicates

To Delete Duplicates:

1. Select the desired file set in the upper-left list.

2. In the bottom field, do one of the following:

l Check the checkbox next to the file name. The file name changes to Delete File.

l Right-click on the file name and select Delete from the context menu. The file name changes to
Delete File.

3. If you searched using two file lists, you can choose Delete from File List 1/File List 2. This will save you
time by selecting all files from File List 1 or File List 2, as specified.

4. Click Next to review your changes, and then click Finish.

To Rename a File:

1. Select the desired file set in the upper-left list.

2. In the bottom field, right-click on the file name and select Rename from the context menu.

3. Type a new name for the file.

4. Click Next to review your changes, and then click Finish.

Finding Images Quickly

You can click on the name of a search preset to quickly re-run the search. You can select Special Items
in the Catalog pane to locate all of the images in your database, or list all of the images that you have
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not yet assigned to a category.

To Re-Run a Search Preset:

In Manage mode, in the Catalog pane, click the name of a search preset.

The results of the search display in the File List pane.

To Find All of Your Images at Once:

1. In Manage mode, click Panes | Catalog to open the Catalog pane.

2. In the Catalog pane, under Special Items, click Image Well.

To Locate Uncategorized Images:

1. In Manage mode, click Panes | Catalog to open the Catalog pane.

2. In the Catalog pane, under Special Items, click Uncategorized. The Image Well and Uncategorized
features only display images that have been cataloged in the database; they do not search your hard
drive for specific file types.

To Locate Images That Haven't Been Keyworded:

1. In Manage mode, click Panes | Catalog to open the Catalog pane.

2. In the Catalog pane, under Special Items, click No Keywords.

Sharing Files with ACDSee Home

ACDSee Homemakes it easy to share your images and other files with friends and family. You can
email files directly from ACDSee, upload images to a website, create your own webpages with the
HTML Album plug-in, or print a contact sheet. You can also create slideshows and screensavers that
you can give to anyone with a computer—they do not need ACDSee Home to view them.

Taking a Screen Capture

You can use the ACDSee Home Screen Capture utility to create images from different areas of your
screen. You can select what areas to capture, how you want to perform the capture, and where to
store the captured image.

To Take a Screen Capture:

1. In Manage mode or View mode, click Tools | Screen Capture...

2. In the Source area of the Screen Capture dialog box, identify the part of the screen you want to capture.
See the table below for a description of the Source options.

3. If you want to include your cursor in the output image, check the Include mouse cursor checkbox.
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4. In the Destination area, identify where you want to place the output image.

5. In the Initiate capture area, identify how you want to take the screen capture.

6. Click Start to launch the screen capture tool.

An icon appears in the Taskbar Notification area.

7. Prepare your screen to show the area you want to capture, and then follow the steps that appear in the
bubble above the Screen Capture icon.

8. To exit the Screen Capture utility without taking a screen capture, right-click the Screen Capture icon,
and then select Exit Screen Capture.

Screen Capture Options
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Desktop

Current monitor Captures an image of the entire area displayed on the
screen.

Window

Entire window Captures an image of the entire active window.

Content only Captures an image of the window contents (does not
include the frame or title bar).

Region

Fixed size Captures an image of a fixed area on the screen.

Click the drop-down button and select a dimension setting
or select Custom, and enter the dimension in pixels.

Selected region Captures a selected area of the screen. Click and drag your
cursor to surround the area you want to capture.

Object

Child window Captures an image of sections of the window. For example,
a toolbar or button.

Menu under cursor Captures selected menu commands.

Include mouse cursor

Include mouse cursor Includes the cursor in the screen capture.

Destination options

Clipboard Places a copy of the image on the Clipboard. From the
Clipboard you can paste the image in a new location.

File Displays the Save dialog box to save the file; you can
specify location, format, and file name.

Editor Opens the captured image in the default editor.

Initiate Capture options

Hot key Designates a keystroke combination to trigger the screen
capture.

To set the Hot Key, press a key or combination of keys
(e.g., Ctrl + S) on the keyboard; do not type in the box.
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Timer Takes a screen capture after a designated period. Choose
enough time to set up your desktop or window for the
screen capture. The maximum setting is 60 seconds.

Emailing Images

You can use the Send Email wizard to send images directly from ACDSee Home without opening an
external email application. To use the Send Email wizard, you will need an active email account, and
have a default email application set up on your computer, or have access to an SMTP server.

To Email Your Images:

1. In the File List pane, select the images you want to email, and then click File | Send | Email Images.

l If you want to add other images, click Add. When you have finished adding images, click OK.

l If you want to delete images, select an image and click Remove. The image is removed from the
wizard, but not deleted from ACDSee.

l If you want to set email and image options, such as the maximum size for emails or the
conversion of images to JPEG, click Options. When you have finished selecting options, click
Apply.

l If you want to change the email account settings, to use either your default email client or an
SMTP server, click Change. When you have finished changing your email account settings, click
OK.

2. In the Send Email wizard, click Next.

l If you selected Send using your default email client, the wizard adds your images and email
information to a new email message. You can edit the message and then send it as you normally
would.

l If you selected Send through an SMTP server, in the wizard, enter the email address you want
to send the email to, a subject for the email, and a message. Click Next.

3. When the images have been sent, click Finish to close the wizard.

Some Internet-based email applications such as Hotmail and Yahoo (free accounts) do not
support SMTP and cannot be used with the Send Email wizard. For others, such as Gmail,
Yahoo (upgraded accounts), and AOL, you must configure the account for POP/SMTP. To
learn how to configure these types of email accounts, visit their specific websites and search
for SMTP.

See also:
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Share/Email Using ACDSee 365

Once you have activated your account with ACDSee 365, you can share your images through
seedrive.acdsee.com.

To Email Your Images:

1. In the File List pane, select the images you want to share, and then click File | Send | Share/Email using
ACDSee 365.

2. In the Share/Email with ACDSee 365 dialog box, enter a Name for your album of photos and select a
Location from your existing online folders.

3. Enter one or more email addresses to send the images to.

You can click the Share with button to pull names from your address book.

4. Select an upload size from the drop-down list.

5. Click Upload.

6. A new window opens providing the option to enter a message, enable download of full sized JPG, and
create an access password.

7. Click OK.

Viewing and Configuring a Slideshow

You can view a slideshow of images and/or videos from Manage mode or from Viewmode. You can
also configure your slideshow to start automatically whenever you run it, and set the slideshow
options to adjust how long each image is displayed, set the background color, apply transition effects,
and add header or footer text.

To Start a Slideshow in Manage Mode:

1. Do one of the following:

l In the File List pane, select a group of images.

l In the Folders pane, select a folder.

l Use the Easy-Select bar to select multiple folders that contain images.

2. Click Tools | Slideshow. (Ctrl + S)

To Start a Slideshow in View Mode:

Click Tools | Slideshow.

To Configure a Slideshow:
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1. In Manage mode, do one of the following:

l In the File List pane, select a group of images.

l In the Folders pane, select a folder or use the Easy-Select bar to select multiple folders that
contain images.

2. Click Tools | Configure Slideshow.

3. In the Slideshow Properties dialog box, select or change the slideshow options as described below.

4. To save your settings as the default slideshow behavior, check the Save current settings as default
checkbox.

5. Click OK.

Slideshow Options
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File Selection

Slideshow contents Specifies which of the following media to include in the
slideshow:

l All media in current folder: displays all the files
(images or video) in the folder you have selected.

l All media in current folder and subfolders: displays
all the files in the currently selected folder and its
subfolders.

l Selected media: displays only the files that you
selected before opening the Slideshow Properties
dialog box.

Always use these contents for this
selection type and start slideshow
automatically

Retains the current Slideshow contents setting and starts
automatically the next time you launch the slideshow.

Basic

Select transitions Displays a list of transitions for you to select and plays each
transition, variation, or effect in the Preview as you select
it.

l Select all: selects all the transitions and displays
them randomly.

l Clear all: clears any selected transitions.

These transitions do not work with the 2-up, 4-
up and Collage variations.

Variations Click the drop-down list to select from the following:

l None: uses no variations.

l Pan and Zoom: zooms in and pans across each slide
during the time it is displayed.

l 2-up: displays two images at a time.

l 4-up: displays four images at a time.

l Collage: displays images as a collage where images
overlap each other.

Effects Click the drop-down list to select from the following:
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l None: uses no effects.

l Black &White: displays all images in grayscale.

l Sepia: displays all images in sepia.

l Vivid: increases the saturation of the images to
make colors brighter.

l Soft: blurs images slightly for a softening effect.

Background color Specifies the background color. Click the color picker to
select or change the color. Click Other to set a custom
color in the Color dialog.

Slide duration (sec) Specifies how long you want the slideshow to display each
image.

Advanced

General settings Select or clear any of the following options:

l Stretch images to fit screen: enlarges small images
to fill the entire screen.

l Play embedded audio: plays any audio clips
embedded in the images.

l Stretch video to fit screen: enlarges video files to
fill the entire screen.

l Autohide control bar: hides the slideshow controls
whenever the cursor stops moving for more than a
few seconds.

l Loop: repeats the slideshow after displaying the last
image.

Slide order Select one of the following options to specify the order to
display your images:

l Forward

l Shuffle

Music directory Displays music from the previously-selected folders, or you
can click Browse to find a new folder.

Text

Display header text Displays a text caption at the top of each image. Set the
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options to specify the text you want to display.

Display footer text Displays a text caption at the bottom of each image. Set the
options to specify the text you want to display.

Save current settings as default

Save current settings as default Retains the current settings on all of the tabbed pages and
applies them the next time you view a slideshow.

Slideshow Text Options

Alignment Specifies the alignment of the text captions.

Background color Specifies a background color for the caption text.

Text Specifies the text to display as a caption.

Font Opens the Font dialog box where you can select or change
the font options for your text.

Insert Metadata Tag Inserts file-specific information called metadata into the
caption.

Click to open the Choose Properties dialog box and select
the metadata you want to insert.

Sharing Slideshows and Screensavers

You can view a slideshow of your images from Manage or Viewmode at anytime by clicking Tools
| Slideshow (keyboard shortcut Ctrl + S in Manage mode). With ACDSee, you can also create
slideshows and screensavers of your favorite photos, and send them to friends and family, or display
them on your website. You can even save your slideshow or screensaver project to edit at a later time.

To Create a Slideshow:

1. In Manage mode, click Tools | Create | Slideshow File.

2. On the Welcome page, to create a new slideshow, select the Create a new slideshow radio button. To
specify what type of slideshow you want to create, select one of the following options:

l Standalone slideshow: creates a single executable file (.exe) containing all of your images and
everything needed to view them. You can share this type of file with anyone who has a
computer, even if they do not own ACDSee.

l Windows screensaver: creates a standard Windows screensaver file (.scr) that can be stored
and used on any Windows system.
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l Adobe Flash Player® slideshow: creates a compact Adobe Flash file (.swf) that you can display
on a website.

3. To edit an existing slideshow or screensaver project, select the Load an existing slideshow project radio
button, and then click Browse to locate your project (.asw file).

4. Click Next to continue.

5. On the Choose your images page, you can view the images included in your slideshow, in the default
order they will be displayed. Click Add or Remove to change the images, and use the arrow buttons to
reorder them. Click Next when you are ready to continue.

6. On the Set file specific options page, click the underlined words beside each thumbnail to set the
individual options for each image. These include transitions between photos, the duration of the
transition and slide, text captions, and audio files to play when the image is displayed. Note that the
options available depend on your choice of output file format, and not all formats support all options.
Click Next when you are ready to continue.

7. On the Set slideshow options page, set the timing for each slide to automatic or manual, the order to
display slides, and whether or not to hide the controls. You can also add audio files to play in the
background, and adjust the quality, or speed, of the transitions. Click Next when you are ready to
continue.

8. On the following pages, set the options for image size, location of your slideshow file and the project
file.

9. Finally, click Next, and wait a few moments while ACDSee Home generates your slideshow. When
complete, you can launch your slideshow and exit the wizard.

If you assign an audio file to an individual image, as well as to the whole slideshow on the Set
slideshow options page, then both audio files will play simultaneously when that slide
displays.

Creating a Desktop Slideshow

You can use ACDSee Showroom to create a slideshow of your photos and display that slideshow in a
small window on your computer desktop. You can run up to 16 different slideshows on your computer
at once.

You can configure the ACDSee Showroom window to always stay on top of other application windows.
You can also configure it to open when you start your computer. You do not have to open ACDSee
Home to use ACDSee Showroom.

To Create a Desktop Slideshow with ACDSee Showroom:
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1. In Manage mode, navigate to a folder containing images that you want to add to the desktop slideshow.

2. Do one of the following:

l Click Tools | Create | ACDSee Showroom.

l Click Start | Programs | ACD Systems | ACDSee Showroom.

The slideshow starts immediately and the ACDSee Showroom icon appears in the taskbar.

Using the ACDSee Showroom Slideshow Controls

There are a number of slideshow controls in the ACDSee Showroom window.

l Click the Back or Forward buttons to display the previous or next photos in the slideshow.

l Click the Pause button to pause the slideshow while a particular photo is displayed.

If you cannot see these slideshow controls in the ACDSee Showroom window, click anywhere
in the window. The controls disappear while the slideshow is playing so you can fully enjoy
your photos.

To Create More Than One ACDSee Showroom:

With ACDSee Showroom open, do one of the following:

l Right-click in the ACDSee Showroom window and select New Showroom.

l Click the ACDSee Showroom icon in the taskbar and select New Showroom.

To Close ACDSee Showroom:

Do one of the following:

l Click Close in the ACDSee Showroom window.

l Click the ACDSee Showroom icon in the taskbar and select Exit ACDSee Showroom.

If you have configured ACDSee Showroom to open when you start your computer, it will
automatically open the next time you start your computer.

Creating a PDF

You can use ACDSee Home to combine your images into PDF (portable document format) files. The
Create PDF wizard will guide you through the process of creating one or more PDF files from your
images, or adding images to a PDF slideshow.
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To Create a PDF:

1. In Manage mode, in the File List pane, select the images you want to share.

2. Click Tools | Create | PDF.

3. On the Welcome page of the Create PDF wizard, select one of the following options, and then click
Next:

l Create a PDF slideshow: combines all of your images into a single PDF file that you can view as a
slideshow.

l Create one PDF file containing all images: combines all of the selected images into a single PDF
file with multiple pages.

l Create one PDF file for each image: converts each image into a separate PDF file.

4. On the Choose images page, you can change the selected images, and use the arrow buttons to reorder
them. Click Next to continue.

5. Do one of the following:

l If you selected to create a PDF slideshow, set or change the transition options by clicking the
hyperlink next to each image. Click Next to set the order, color, and file name options for your
slideshow. Click Next when you are ready to continue.

l If you selected to create one or more PDF files, specify a file name and location, and then click
Next.

6. Click Finish to close the wizard and return to ACDSee.

Creating a PowerPoint Presentation

You can create a PowerPoint presentation quickly from inside ACDSee Home using the Create PPT
wizard. The wizard walks you through the process of creating or editing a presentation using your
photos. You can set slide duration, the location of the file, number of images per slide and whether or
not to use a design template as a background. You can also add captions, a title, or notes to each
slide.

This feature only works if you have Microsoft PowerPoint® installed on your computer. The
feature does not support RAW files, so you will need to convert RAW files to another format.
Your version of Microsoft PowerPoint® must be 64-bit.

To Create a PowerPoint Presentation:

1. In Manage mode, in the File List pane, select the images you want to share.

2. Click Tools | Create | PPT.

3. On the Choose images page of the Create PPT wizard, click Add if you want to add more images.
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4. Click Next.

5. On the Presentation Options page, do one or all of the following:

l In the Presentation Options area, if this is a new presentation, set the duration that you want
each slide to display.

l If you are editing a presentation, select Existing presentation to activate the Path field, and
browse to your presentation. Select whether you want to Insert slides at the beginning or end
of the presentation.

l Select the Number of images per slide from the drop-down list. (If you select more than one,
the Title and Notes options on the next page do not appear.)

l Select Link to Image file if you want your images to stay linked to ACDSee Home rather than be
embedded in the presentation.

l Click Use a design template if you want to use a background template and browse to the folder
on your computer to select it. (PowerPoint templates are usually under Microsoft Office |
Templates | Presentation Designs.)

6. Click Next.

7. On the Text Options page, do one or all of the following:

l On the Caption tab, type in a caption and select its background color and alignment. You can
also select a different font, or insert metadata like file name or picture dimensions. Captions
appear at the bottom of the slide.

l On the Title tab, type in a title for the slide and select its background color and alignment. You
can also select a different font, or insert metadata.

l On the Notes tab, type in any notes that you want to appear in the Notes section attached to
each slide. These notes do not appear on the slide itself.

8. Click Create.

The presentation opens in PowerPoint where you can edit it like any other presentation.

Creating an HTML Album

You can use the HTML Album wizard to prepare photo collections for posting online. The HTML album
includes slideshow controls and a thumbnail display. You can select from a list of gallery style
templates and then customize the gallery by adding your own logo as an image or text to the header
or footer. You can also change the fonts and colors used in the gallery.

To Create an HTML Album:

1. In Manage mode, in the File List pane, select the images you want to share.

2. Click Tools | Create | HTML Album.
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3. On the Style Settings page of the Create HTML Album wizard, select a Gallery Style from the webpage
styles box.

After you select a Gallery Style and other settings, you can click Preview Gallery to see how
those selections affect the appearance of your HTML album. You can also generate your HTML
album from any page in the HTML Album wizard by clicking Generate Album.

4. Click Next.

5. On the Gallery Customization page, do one or all of the following:

l In the Gallery Title text box, type the title that you want to display at the top of the webpage.

l Check Include header to display a header at the top of the webpage, or uncheck the Include
header checkbox to remove the header.

l Check Include footer to display a footer at the bottom of the webpage, or uncheck the Include
footer checkbox to remove the footer.

l If you want to display an image in the header or footer, select Use image and click Browse and
select a company logo, a photo of yourself, or another image to display in the header.

l If you want to display text in the header or footer, select Use information and click Set
Information and add enter the text that you would like to display.

l In the Folder settings section, click Browse and select the folder where you would like to save
the HTML album files.

6. Click Next.

7. On the Thumbnail and Image page, do one or all of the following:

l In the Thumbnail settings section, adjust the appearance and format of the thumbnails in the
album.

l In the Image settings section, adjust the appearance and format of full size images in the album.

l In the Slideshow duration section, specify how long to display full size images during a
slideshow.

l In the Color and font settings section, click Color and font, adjust the colors and fonts used in
the webpage, and then click OK.

Click Save Settings to save the settings that you select for specific webpage styles. If you save
the settings, you can quickly reapply them to a webpage style from the Style Settings page of
the Create HTML Album wizard.

8. Click Next to create your HTML album. You may need to wait a few moments while ACDSee Home
generates the thumbnails and creates the webpage.

9. Click Create Another Album to create another album, or click Finish to exit the wizard and return to
ACDSee.
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You will need to use FTP or another method to post the HTML album files to your website.

Uploading Images to Photo Websites

You can upload your photos or images directly from ACDSee to sites like Flickr, SmugMug, Zenfolio,
and FTP sites. You will need an account before you can upload pictures to these sites but if you do not
have one, you can create an account as part of the first upload process.

You can select almost any image file type, including RAW and TIFF, and ACDSee will convert
the file to JPG automatically before uploading.

To Upload Photos to a Photo Website:

You can quickly upload your photos to photo sharing websites without having to leave ACDSee.

1. In Manage mode, select one or more images and click File | Send | To <Photo Website>...

2. In the <Photo Website> Uploader dialog box, press the Help button in the lower right corner and follow
the instructions.

Welcome to the Flickr Uploader Plug-in

This plug-in makes it possible for you to upload your images directly to Flickr from ACDSee.

Authorizing

Before you can upload to Flickr, you need to authorize the ACDSee Flickr Uploader with the Flickr
website. Of course, you also need a Flickr account. Once that is done, you can upload your files quickly
and easily from within ACDSee.

Flickr uses Yahoo IDs as part of their registration process. If you do not have a Yahoo ID, you need to
create one too.

Summary of the Process:

1. Create a Yahoo ID if you do not have one.

2. Create a Flickr account if you do not have one.

3. Authorize ACDSee Flickr Uploader.

4. Upload photos.

Flickr only accepts certain file formats. If you try to upload files that Flickr does not support,
those files won't upload.
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Authorizing ACDSee with Flickr

Before you can upload to Flickr, you need to authorize ACDSee with the Flickr website.

You can authorize and upload your first set of pictures at the same time.

(The following procedure assumes that you already have a Flickr account. If you do not have an
account, see Creating a Flickr account.)

To Authorize the Uploader:

1. In Manage mode, in the File List pane, select the images you want to upload.

2. Click File | Send | Upload to.

3. In the Upload Manager dialog, select Flickr, and then click Next.

4. Click Remember me if you want this computer to keep a record of your authorization.

5. In the Flickr Uploader dialog, click Authorize.

The Flickr website opens.

6. Enter your Yahoo ID and password and click Sign In.

A message on a yellow background tells you that the uploader wants to link to your Flickr
account.

7. Click the Ok, I'll Allow it button.

A message tells you that you have authorized the ACDSee Flickr Uploader.

8. Close the web page by clicking the red X in the top right-hand corner.

Behind the web page is a small dialog.

9. Click Continue to begin uploading the photos you selected.

The ACDSee Flickr Uploader Settings dialog opens. You can adjust the settings to resize
your photos, select where you would like the title, description, and tags, for each photo
to come from, as well as privacy, safety, and content type. (See Editing default settings for
details.)

10. Adjust the settings and click Save Settings.

11. You can type in and add the tags for this set of photos.

12. When you are ready, click Next and then Upload now!.

A progress bar shows your photos uploading.
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Creating a Flickr Account

If you do not have a Flickr account, you need to create one before you use the Uploader. Once you
have created a Flickr account, you then authorize the ACDSee Flickr Uploader, and upload your
pictures.

(Flickr uses Yahoo IDs for their registration process. If you do not have a Yahoo ID, you need to create
one first. To create a Yahoo ID, click here.)

To go directly to Flickr, click here.

Uploading Images

To Authorize and Upload Images to Flickr for the First Time:

1. In Manage mode, in the File List pane, select the images you want to upload.

2. Click File | Send | Upload to.

3. In the Upload Manager dialog, in the Select a service to upload to box, select Flickr and then click Next.

The Flickr Uploader dialog opens.

4. Click Authorize.

You are asked if you have a Yahoo ID and Password.

5. Do one of the following:

l If you have a Flickr ID and password, enter the information, and then click Sign In.

l If you don't have a Flickr username and password, click on Register and create a Yahoo username
and Flickr account.

A Flickr page opens with a yellow banner asking if you want to authorize the ACDSee
Flickr Uploader.

6. Click Ok, I'll Allow It.

A check mark appears to tell you that you have authorized the ACDSee Flickr Uploader.

7. Close the web page by clicking the red X in the top right-hand corner.

Behind the web page is a small dialog.

8. Click Continue to begin uploading the photos you selected.

9. You can type in, and add the tags for this set of photos.

10. If you want to see your images in Flickr, ensure that the View images in Flickr checkbox is selected.

https://edit.yahoo.com/registration?
http://www.flickr.com/
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11. When you are ready, click Next and then Upload now!.

The ACDSee Flickr Uploader Settings dialog opens. You can adjust the settings to resize
your photos, select where you would like the title, description, and tags, for each photo
to come from, as well as privacy, safety, and content type. (See Editing default settings for
details.)

A progress bar shows your photos uploading.

12. Click Finish.

Flickr opens showing a message: "Your photos were uploaded successfully."

13. Click OK.

Your photos display on the Flickr site.

To Upload Images to Flickr Once You are Authorized:

1. In ACDSee, select the images you want to upload.

2. In the Browser, do one of the following:

l On the menu bar, click File | Upload to.

l On the toolbar, click Upload to.

l Right-click and select Upload to.

3. In the Upload Manager dialog, in the Select a service to upload to box, select Flickr and then click Next.

4. To select a set for your photos, click the down arrow and select the set you want. To create a new set,
click, Create Set, type in a name and description, then click Create.

5. To apply a tag to this group of photos, type in the tag, and click Add Tag.

These tags are applied to ALL the selected photos. You can apply tags to individual photos
in the next dialog.

6. When you are ready, click Next.

In this dialog, you can add individual titles, descriptions and tags to each photo, rotate
the photos, or apply batch information and resizing.

7. To rotate a photo, click the arrows to select it and then click Rotate.

8. To create individual titles, descriptions, and tags, click the arrows to select the picture, and then click the
Title/Description/Tags icon.

9. To rotate, resize or add information to the photos, adjust the settings.



ACDSee Photo Studio Home 2026

Page 172 of 532

10. Click Upload Now!

11. If you want to see your images in Flickr, ensure that the View images in Flickr checkbox is selected.

A progress bar shows your photos uploading.

12. Click Finish.

Flickr opens showing a list of your photos. You can add titles and descriptions or notes about
each photo.

To Upload Images to Flickr Privately:

To make uploaded photos visible only to yourself, ensure that your Flickr account has its privacy
settings set to Private, and then set your Privacy setting within ACDSee to Follow your Flickr account
settings. This will ensure your photos are uploaded privately. For more information, see Editing
Default Settings.

Tagging Images

Tagging makes it easier to find your photos or images as you can search for them by the tags. You can
tag batches of photos as you upload them to Flickr while you are in the Flickr Uploader dialog.

To Tag Photos:

1. In the Flickr Uploader dialog, type a tag into the box below Apply these tags to this batch.

2. Click Add Tag and the new tag appears in the box below.

3. To delete a tag, click the red [X] beside it.

Editing Default Settings

You can change many of the default settings in the uploader, including whether or not to resize your
photos as you upload, giving them a title, or changing the privacy, safety, and content type settings.
These settings are based on Flickr settings, which you can read about here.

http://www.flickr.com/help/filters
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Flickr Uploader Settings
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Revoke
Authorization

Click to revoke your authorization on the Flickr site.

Resizing Do not resize Select to upload your images as they are. (If a photo exceeds the
limit allowed by your account, you need to resize it to below this
limit. If you do not, a warning displays to ask if you want to resize
the file.)

Set max
horizontal or
vertical size
(pixels)

Select to resize your images to the following sizes:

l 800 pixels (suitable for web viewing)

l 1280 pixels (suitable for small prints)

l 1600 pixels (suitable for larger prints)

l 2400 pixels (suitable for archiving)

Title
Description,
and Tags

Get title from: Select to take the title of each picture from one of the following:

l Filename (default)

l IPTC Headline

l ACDSee Caption (works only if you have created these in
the ACDSee database.)

Get description
from:

Select to take the description of each picture from one of the
following:

l IPTC Caption (default)

l ACDSee Notes (works only if you have written
descriptions in the Notes field in ACDSee.)

l ACDSee Caption (works only if you have created these in
the ACDSee database.)

l EXIF Image Description

Get tags from: Select to include additional tags from the following:

l IPTC Keyword (always added)

l ACDSee Keywords

l IPTC Category

l IPTC Supplemental categories

Photo Privacy
Settings

Follow your
Flickr account
settings

Sets your privacy setting to follow your Flickr account's settings.

Visible to you
and friends

Sets your privacy setting to display your photos only to yourself
and friends.
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Visible to you
and family

Sets your privacy setting to display your photos only to yourself
and family.

Visible to you,
friends and
family

Sets your privacy setting to display your photos only to yourself,
friends, and family.

Visible to
anyone (Public)

Sets your privacy setting to display your photos to the public,
allowing anyone to view your photos.

To make uploaded photos visible only to yourself, ensure that your
Flickr account has its privacy settings set to Private, and then set your
Privacy setting within ACDSee to Follow your Flickr account settings.

Safety Level Safe Select if your images suitable for the general public.

Moderate Select if you are not sure if your images are suitable for the
public, but do not need to be actively restricted.

Restricted Select if your images should not be seen by children.

Content Type Photos Select to upload photos. This allows other users to filter their
searches, making it easier to find the content they need.

Screen shots Select to upload screen shots. This allows others to filter their
searches on screen shots specifically.

Art, Illustration,
CGI, or other
non-
photographic
images

Select to upload other types of images. This allows others to filter
their searches and find specific images types.

Hide my
uploaded
images from
public searches

Select if you do not want your photos to be included in public searches.

Adjusting and Adding Information to Your Photos

On the final screen of the uploader, there are several different adjustments that you can make to your
photos. These include:

l Rotating photos.

l Adding a title, description and tags.

l Adding batch information.

l Resizing photos.

To rotate photos:
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1. Use the arrows on the far right to find the photo you want to rotate.

2. Click the photo to select it.

3. Click the left or right Rotate arrows .

To add a title, description, and tags:

1. Use the arrows on the far right to move to the photo you want to adjust.

2. Click the photo to select it.

3. Click the Title/Description/Tags icon .

4. In the Title field, type in the title for this photo.

5. In the Description field, type in a short description.

6. In the Tags field, type in a tag and click Add. (Click the red [X] to delete a tag.)

Batch information and resizing

You can set up batch information by editing the default settings, or selecting settings in the final dialog
before you upload your photos. When you select these settings, the information for each photo is
taken from the file and displayed on Flickr. In most cases, you need to create the file information on
the Properties pane in ACDSee first.

You can also set batch resize information for your images in both the settings and the uploader
dialogs. As you upload, the images are resized.

To set batch information for each photo:

1. To set the source for the title of each image, click the Get title drop-down list and select from the
following:

l Filename - the title of each photo is taken from the filename.

l IPTC Headline - the title for each photo is taken from the IPTC Headline field on the IPTC tab of the
Properties pane. If you have not created this information, the title will be blank.

l ACDSee Caption - the title for each photo is taken from the Caption field on the Metadata tab of the
Properties pane. If you have not created the captions in ACDSee, the title will be blank.

2. To set the source for the description of each photo, click the Get description drop-down list and select
from the following:

l IPTC Caption - the title for each photo is taken from the Caption field in the Properties pane. If you
have not created the captions, the description will be blank.

l ACDSee Notes - the title for each photo is taken from the Notes field on the Metadata tab of the
Properties pane. If you have not created notes in ACDSee, the description will be blank.
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l ACDSee Caption - the title for each photo is taken from the Caption field on the Metadata tab of the
Properties pane. If you have not created the captions in ACDSee, the description will be blank.

l Exif Image Description - the title for each photo is taken from the Image Description field on the
EXIF tab of the Properties pane. If you have not created the EXIF Image Description in ACDSee, the
description will be blank.

3. To include tags from the ACDSee Keywords, IPTC Category, and IPTC Supplementary categories, click the
checkboxes.

To set batch resizing:

1. In the Batch Resize box, select Set max horizontal or vertical size (pixels).

2. Select the size you want your photos to be.

Creating a Contact Sheet

You can create contact sheets—thumbnail previews of your images arranged on pages — that you can
use to organize and share your images. You can use the Create Contact Sheet utility to save your
contact sheets in multiple image formats, and as HTML image maps. You can save your options as a
preset for future use.

The size of the thumbnails depends on howmany columns and rows the contact sheet displays, and
howmuch space is displayed between them.

To Create a Contact Sheet:

1. In Manage mode, in the File List pane, select the images you want to include.

2. Click Tools | Create | Contact Sheet.

3. In the Contact sheet format area, set the Contact sheet format options.

4. In the Output Settings area, set the Output Settings options.

5. If desired, add or change the text on the page.

6. Click OK.

If you do not specify an output file path, the Create Contact Sheet utility places a file named
Contact Sheet.<ext> in your default image folder. For multiple-page contact sheets, the utility
adds a number to the file name; for example, Contact Sheet3.bmp.

Contact Sheet Format Options
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Thumbnail settings

Size Specifies the number of columns and rows to create on each
page.

Spacing Creates a frame around each thumbnail. Specifies the
amount of space between rows or columns. In the
Horizontal and Vertical spin boxes, type a value to indicate
the amount of space to display.

Frame options

Use thumbnail frame Creates a frame around each thumbnail.

Margin Specifies the width of the frame.

Solid color Specifies the frame's color. Click the color picker to define a
color.

Tiled image Specifies an image to use as a frame. Click Browse to locate
the image you want to use.

Thumbnail options

Colored drop shadow Creates a drop shadow effect around each thumbnail. Click
the color picker to define a color.

Colored edge fade Creates a fading frame effect around the image. Click the
color picker to define a color.

Colored matte Uses a solid color as a background for the page. Click the
color picker to define a color.

Beveled edges Creates a beveled edge effect on each thumbnail. This effect
is not displayed in the Preview window.

Page background options

Solid color Uses a solid color as a background for the page. Click the
color picker to define a color.

Tiled image Uses a tiled image as the background for the page. Click
Browse to locate the picture you want to use.

Creating Archives of Your Files

You can use the Archive Creator plug-in to create archives of your images, documents, and media files.
Archive Creator supports multiple archive formats, and helps you manage your files using
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compression, encryption, and password protection tools.

To Create an Archive:

1. In Manage mode, in the File List pane, select a folder or group of files.

2. Click Tools | Create | Archive.

3. In the Create Archive dialog box, in the Options area, click the Archive Type drop-down list and select
the archive format you want to create.

Some archive formats have additional settings that you can adjust by clicking the Settings
button.

4. Do any of the following:

l To include the contents of any subfolders you selected, check the Include subfolders checkbox.

l To include any hidden files in your archive, check the Include hidden files checkbox.

l To remove the selected files and folders from your hard drive once they have been added to
the archive, check the Delete files after archiving checkbox.

l To protect the contents of your archive with a password, check the Password Protect Archive
checkbox, and type a password into the field beside it. Note that not all archive types support
passwords, and some formats require them.

5. Type a path and file name into the Output File field, or click Browse to locate a folder on your hard
drive.

6. Select one of the following:

l Add to existing archive: adds your files to an existing archive. This option is only available if the
archive specified in the Output File field already exists.

l Overwrite existing archive: replaces any existing archive with the archive you are creating. This
option is only available if the archive specified in the Output File field already exists.

7. When you are satisfied with your choices, click Create to begin archiving your files.

Extracting Archives

You can extract archives very quickly and easily without leaving ACDSee. You can either extract the files
to a folder or simply double-click and view them.

To Extract an Archive to a Folder:

1. In Manage mode, navigate to the folder containing the archive, using the Folders pane.

2. Click the archive in the File List.

3. Click Edit | Extract to Folder.



ACDSee Photo Studio Home 2026

Page 180 of 532

4. In the Extract to Folder dialog, navigate to, and select the folder where you want to keep the files.

5. To create a new folder, click Create Folder, type in the name of the folder and then press Enter.

6. Use the Overwriting duplicate files drop-down list if you want to specify what do so with files in the
folder that have the same name as those you are extracting. You can select any of the following:

l Ask: to be asked what to do about each individual file.

l Rename: duplicates are given a new name.

l Replace: duplicate files are overwritten.

l Skip: no duplicates are extracted.

7. Click OK.

To View Files Inside an Archive:

1. In Manage mode, navigate to the folder containing the archive.

2. Double-click the archive.

Thumbnails of the contents of the archive open in the File List pane.

Printing Images

With the ACDSee Home print utility, you can print your files on any size of paper, in any orientation,
and at any resolution your printer can support. You can also use the print utility to create and print
contact sheets, complete with headers, footers, and captions specific to each image.

As you change the options in the Print dialog box, you can view a dynamically updated preview of the
file and its position on the page. You can adjust the output size, print multiple copies of each file or
image, and change the orientation of images and documents on each page.

You can use the shortcut Ctrl + P to launch the print dialog.

To Print Your Images:

1. Select the images you want to print.

2. Do one of the following:

l In Manage mode, click File | Print.

l In View mode, click File | Print All Images. (If you want to print a single image in View mode,
select Print Image.)
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3. Under Print layout, do one of the following:

l Select Full page and then choose a print size from the Format list.

l Select Contact sheet and then set the Contact sheet format options to define the appearance
of your contact sheet.

l Select Layout and then choose one of the available layout options.

4. On the Printer Options tab, specify the printer you want to use, the paper size, the orientation, the
number of copies you want, the range of pages that you want to print, and image resolution.

5. On the Page Settings tab, specify the image position on the paper and the margin widths.

6. On the Adjustments tab, specify any adjustments you want to apply.

7. Specify the number of prints of each photo. If you are printing a Full page or a Contact sheet this option
is available on the Page Settings tab. If you are printing a Layout this option is available below the list of
layouts.

8. Add captions, headers, or footers. You can only add captions, headers, or footers if you are printing a
Full page or a Contact sheet.

9. Click Print.

Setting Printer Options

When printing your images with ACDSee, you can specify which printer you want to use, and set the
printer options on the Printer Options tab in the Print dialog box.

Printer Options
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Printer Specifies the printer you want to use. Select a printer from the drop-
down list and click the Properties button to set its options. Refer to
the printer manufacturer's Help file or manual for more information.

Paper size Specifies the size of the paper, e.g. Letter, Legal, A4.

Orientation Specifies Portrait or Landscape page orientation.

Copies Specifies the number of copies you want to print.

Print range Select one of the following options:
l All: prints all of the pages in the document.
l Pages from: prints a range of pages. Specify the first and last
pages of the range in the fields.

Resolution Specifies a resolution in pixels-per-inch (PPI) for the image. The
higher the value, the more dots per inch, and the higher the
resolution of the printed image. For example, 600 PPI is 360,000
(600 x 600) pixels per square inch.

Filter Specifies the resampling filter to use when printing images. Click the
drop-down list and select one of the following:

l Box: displays considerable tiling or jaggies when you resize an
image.

l Triangle: produces good results for image reduction and
enlargement, but displays sharp transition lines.

l Bicubic: produces good results with photo-realistic images
and with images that are irregular or complex. Uses inter-
polation to minimize the raggedness normally associated with
image expansion.

l Bell: smoothes the image.
l B-Spline: produces smooth transitions, but may cause excess-
ive blurring.

l Lanczos: produces the sharpest images, but may also intro-
duce some ringing artifacts.

l Mitchell: produces smooth transitions when enlarging photo-
realistic images. This filter is good compromise between the
ringing effect of Lanczos and the blurring effect of other filters.

Gamma Applies gamma correction to the printed images. Type a number
from 0.10 to 3.00 in the Gamma value field to adjust the gamma of
the image. Higher values make the image appear brighter, while
lower values make the image appear darker.

Use EXIF 2.2 printing when
available

Your camera may capture EXIF information that, when shared with
your printer, will optimize printing results. Select this option if your
camera and printer support EXIF 2.2 printing.

Creating Custom Print Layouts

You can create your own custom print layouts and store them as print options.
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To Create a Custom Print Format:

1. In the Print dialog box, select Full page.

2. In the Print format area, click Add.

3. In the Add Custom Format dialog box, select a measurement unit from the Measurement units drop-
down list.

4. Enter the dimensions for the new format in the Format width and Format height fields.

5. Click Add.

Setting Image Size and Positioning

You can use the Page Settings tab in the Print dialog box to adjust and control the size of the images
you are printing, and the positioning of images on each page.

Page Settings Options

Page position Specifies where to place the image on each page.

Margins Specifies the size of the margins. Type a value or click
the arrows in the Top, Bottom, Left, and Right spin
boxes.

Number of prints Specifies how many copies of each image to print.
The print utility adds pages as required.

Automatically rotate picture based on print
format

Specifies whether you want the print utility to
determine automatically which orientation to use for
each image. If you check the checkbox, the print
utility changes each page's orientation to best suit the
image you are printing.

Maintain aspect ratio Specifies whether you want the print utility to
maintain the original image's aspect ratio. Select one
of the following options to indicate how the print
utility should handle the aspect ratio for oversized
images:

l Crop image to fit print format: prints only
the part of the image that fits within the print
format.

l Shrink image to fit print format: prints the
entire image, reduced to fit inside the print
format.
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Setting Print Adjustments

You can use the settings on the Adjustments tab of the Print dialog to compensate for quirks specific
to your printer, such as the way your printer handles exposure.

It is recommended that you adjust these settings only after printing initially, when you know
what corrections your printer may require.

Please note that any adjustments made on the Adjustments tab will not be reflected in the
Previewwindow.

To Apply Adjustments to Images Prior to Printing:

1. Select the image or images you want to print.

2. Do one of the following:

l In Manage mode, click File | Print.

l In View mode, click File | Print Image or File | Print All Images.

3. In the Print dialog, on the Adjustments tab, adjust the Exposure, Contrast, or Sharpness sliders as
desired.

4. Click Print.

Adding Text to Pages

You can add headers and footers to pages, and captions beneath your images.

To Add Captions to Your Printed Images:

1. In the Print dialog box, click the Caption tab.

2. Select Use caption text.

3. Click Font to open the Font dialog box and set the font options.

4. In the text box, type the text you want the caption to display.

5. Click Insert Metadata to insert file-specific information into the caption for each image.

6. In the Text alignment drop-down list, select the caption positioning.

7. To set the maximum number of text lines for each caption to display, check the Number of lines
checkbox, and then specify a number in the field.

To Add Headers and Footers to Your Printed Pages:
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1. Do one of the following:

l Click the Header tab and select Use header text.

l Click the Footer tab and select Use footer text.

2. Click Font to open the Font dialog box and set the font options.

3. In the text box, type the text you want the header or footer to display.

4. To insert the current page number or the total number of pages into the text, click Insert Page Number,
and then select an option from the menu.

5. In the Text alignment drop-down list, select the header or footer positioning.

6. To set a maximum number of text lines, check the Number of lines checkbox, and then specify a
number in the field.

Setting Contact Sheet Printing Options

The Contact sheet format area of the print utility contains settings you can adjust to control the
appearance, layout, and size of your thumbnails. If you saved your format options as a preset you can
select the preset.

Contact Sheet Format Options
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Thumbnail settings

Size Specifies the number of columns and rows to create on
each page.

Spacing Specifies the amount of space between rows or columns. In
the Horizontal and Vertical spin boxes, type a number to
indicate the amount of space to display.

Frame options

Use thumbnail frame Creates a frame around each thumbnail.

Margin Specifies the width of the frame.

Solid color Specifies the frame's color. Click the color picker to define a
color.

Tiled image Specifies an image to use as a frame. Click Browse to locate
the image you want to use.

Thumbnail options

Colored drop shadow Creates a drop shadow effect around each thumbnail. Click
the color picker to define a color.

Colored edge fade Creates a fading frame effect around the image. Click the
color picker to define a color.

Colored matte Creates a matte effect around each thumbnail. Click the
color picker to define a color.

Beveled edges Creates a beveled edge effect on each thumbnail. This
effect is not displayed in the Preview window.

Page background options

Solid color Prints a solid color as a background for the page. Click the
color picker to define a color.

Tiled image Prints a tiled image as the background for the page. Click
Browse to locate the image you want to use.

About Batch Editing

In ACDSee you can make one type of edit to many images. For example, if you need to resize multiple
images you can use the Batch Resize tool. Or, if you need to rotate multiple photos by 90 degrees you
can use the Batch Rotate/Flip tool.
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You can speed up the batch editing workflow by tagging your files. For example, you can quickly tag
the files you want to change, then click Tagged in the Catalog pane to display all the tagged files in the
File List pane. Then you can select the files and choose a batch tool.

Using AI Super-Resolution

AI Super-Resolution enhances the quality of your images by using advanced algorithms to intelligently
upscale lower-resolution photos. This feature increases the resolution and detail of your images,
making them sharper and more defined without compromising quality. Whether you're enlarging a
small photo or improving the clarity of a digital image, AI Super-Resolution helps you achieve
professional results with ease.

DirectX 12 feature level 12_0 or higher is required for AI Features to run on your GPU. You can
check your GPU's support level by running the dxdiag.exe tool and reviewing the Display tab
or by looking up your device's official specifications. If your GPU doesn't meet the
requirements, AI Features will still run using your CPU instead. Aminimum of 4GB VRAM is
required for GPU acceleration for AI Super-Resolution.

How AI Super-Resolution Works:

AI Super-Resolution enhances image quality by analyzing patterns, textures, and colors in the image. It
then applies a complex algorithm to upscale the image, reducing noise and blurriness, removing
artifacts, and adding pixels where necessary to maintain clarity and detail. This feature is especially
useful for enlarging small images or zooming into cropped photos.

Examples of when to use AI Super-Resolution:

l Enlarging low-resolution images for large prints or displays

l Enhancing cropped images to improve their quality

l Increasing the size of older photos taken with lower-resolution cameras

How to apply AI Super-Resolution:

To enhance your images with AI Super-Resolution, perform the following:

1. Find the image you want to enhance in Manage mode or View mode and do one of the following:

l Right-click it and select AI Features | AI Super-Resolution.

l Press Shift + Alt + S.

2. In the AI Super-Resolution dialog, choose your preferred settings. The preview will automatically
generate a new preview whenever parameters are changed so you can always see what it looks like in
real-time.

3. Click Enhance to apply Super Resolution to your image. The enhanced image will be saved by default
into the same folder as the original. You can adjust this setting within Options at the bottom of the
AI Super-Resolution dialog.
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How to apply Batch AI Super-Resolution:

To enhance multiple images at once with AI Super-Resolution, perform the following:

1. Find the images you want to enhance in Manage mode and do one of the following:

l Select the images you want, right-click one of them and select Batch | AI Super-Resolution
| AI Super-Resolution.

l Select Tools | Batch | AI Super-Resolution | AI Super-Resolution.

l Right-click on an image and select Batch | AI Super-Resolution | AI Super-Resolution.

l Press Shift + S.
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2. In the Batch AI Super-Resolution dialog, choose your preferred settings. The preview will automatically
generate a new preview whenever parameters are changed so you can always see what it looks like in
real-time.

Only the first image selected will display in the Preview when applying AI Super-
Resolution to multiple images.

3. Click Enhance to apply Super Resolution to your images. The enhanced images will be saved by default
into the same folder as the originals. You can adjust this setting within Options at the bottom of the
Batch AI Super-Resolution dialog.

Settings:

There are five option settings that are available no matter which measurement mode you use:

Show Original Shows the original image before any modifications for quick comparison.

AI Strength
Adjust the slider to increase or decrease the amount of influence the AI has in the
enhancement.

Zoom Adjust the zoom of the current preview display.

Actual Size Sets the preview display to show the Actual Size of the image.

Fit Image Sets the preview display to fit the image within the preview window.

Resize Options:

There are five different resize options you can use to determine how big your image will become. For
more information, see Setting the AI Super-Resolution Options.

Percentage Includes Width (%), Height (%), and Preserve Original Aspect Ratio.

Size in Pixels
Includes Width (px), Height (px), Preserve Original Aspect Ratio, and Fit Within.

Fit Within includes: Width and Height, Width Only, Height Only, Width or Height (largest
image).

Print Size

Includes Width, Height, Units, Resolution (pixels per inch), Preserve Original Aspect Ratio,
and Fit Within.

Fit Within includes: Width and Height, Width Only, Height Only, Width or Height (largest
image).

Long Edge Includes Size (Pixels, Inch, cm, mm), and Resolution (pixels per inch).

Short Edge Includes Size (Pixels, inch, cm, mm), and Resolution (pixels per inch).



ACDSee Photo Studio Home 2026

Page 190 of 532

Converting Multiple Images to Another File Format

You can convert multiple images to any supported file format. You can set the options for each format
individually, specify how to handle multiple-page images, and apply the conversion defaults
automatically.

Conversion Status

When converting assets in ACDSee Photo Studio Home 2026, you can track their status, pause, or
cancel them from the Activity Manager. For more information see ACDSee Activity Manager.

To Convert Images to Another File Format:

1. Do one of the following:

l In Manage mode, select one or more images, and click Tools | Batch | Convert File Format |
Convert...

l In View mode, click Tools |Modify | Convert File Format | Convert...

l In Manage mode, select one or more images, and click Batch | Convert File Format | Convert...

l In Manage or View mode, select one or more images and press Ctrl + Alt + F.

2. In the Convert File Format dialog, select a new format for your image or images from the Output File
Format drop-down list. To configure format-specific options, select the file format and then press the
Settings button.

3. In the Output Location section, identify where you want to place the converted images.

4. In the File Options section, specify how you want the tool to handle any file name conflicts by selecting
one of the following options from the Overwrite existing files drop-down list:

l Ask: prompts you when overwriting a file.

l Skip: cancels the operation if there is a file with the same file name and extension.

l Replace: overwrites the file without prompting for confirmation.

l Rename: prompts you to rename the file.

5. You can set additional options in the File Options section:

l Preserve last-modified dates: Preserves the last-modified dates in the new files after
conversion.
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l Delete original files: Deletes the original files after conversion.

l Do not delete original files when output files cannot preserve metadata: Does not
delete the original files if the output is unable to preserve the metadata.

Metadata and color profiles can be permanently lost when converting to a file
format that does not support them if Do not delete original files when output
files cannot preserve metadata is disabled.

l Preserve metadata: Ensures the metadata from the original files remain in the converted files.

l Preserve database information: Ensures the database information from the original files remain
in the converted files.

6. To configure vector settings and how you want to handle any multi-page images, press the Advanced
Settings button. If you did not select any multi-page images to convert, and did not specify a multiple-
page image format as your output file format, you can skip the options in the Multi-Page Source section.

7. Click Convert.

You can save your settings as a preset for future use. After configuring the Convert File Format
dialog settings, press the Save icon next to the Preset field. You will be prompted to enter a
name for your preset. It is recommended that you give your preset an intuitive name. Saved
presets will be listed in the Convert File Format fly-out menu.

You can give your saved presets custom shortcuts for quick conversions. In the Customize
Shortcuts dialog, you can find your presets under the Preset - Convert File Format category.

Rotating or Flipping Multiple Images

You can rotate or flip multiple images at preset angles.

To Rotate or Flip an Image:

1. In Manage mode, select one or more images, and then click Tools | Batch | Rotate/Flip.

2. In the Batch Rotate/Flip Images dialog box, select the angle of rotation you want to apply. See below for
an explanation of each angle.

3. If you select an image with multiple pages and want to apply the selected angle of rotation to all of the
pages, check the Apply to all pages of the current image checkbox.

4. Do one of the following:

l Click Next Image to move on to the next selected image. The Next Image button is not
available if the Apply to all selected images box is checked.
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l If you select multiple images and you want to apply the same angle of rotation to all of them,
check the Apply to all selected images checkbox.

l Click Options to specify how you want to save and store the images.

5. When you are ready to apply the rotations to your images, click Start Rotate.

Rotate / Flip Angles

Rotates the image counter-clockwise 90 degrees.

Rotates the image 180 degrees.

Rotates the image clockwise 90 degrees.

Rotates the image according to any EXIF data contained within the image (based on what the
camera thinks the orientation should be).

Flips the image along the vertical axis.

Flips the image along the horizontal axis.

Flips the image along the vertical axis, and then rotates it counter-clockwise 90 degrees.

Flips the image along the vertical axis, and then rotates it clockwise 90 degrees.

You can also use the Rotate tool in Edit mode to rotate an image using a custom angle of
rotation.



ACDSee Photo Studio Home 2026

Page 193 of 532

Setting Rotated and Flipped File Options

You can change the settings in the Batch Image Rotate/Flip Options dialog box to control where
ACDSee Home places modified images, how to handle file duplication conflicts, and specify whether
you want to preserve the last-modified date of the file when you use the Batch Rotate/Flip Images
tool.

To Set the Rotate and Flip Options:

1. In Manage mode, select one or more images, and then click Tools | Batch | Rotate/Flip.

2. In the Batch Rotate/Flip Images dialog box, click the Options button.

3. Set the options as described below.

4. Click OK.

Rotate and Flip Options
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Force lossless JPEG operations Rotates JPEG images without decompressing and re-
compressing the JPEG information. As a result, the image
does not lose quality when rotated or flipped.

File options Specifies where to place the new images. Select one of
the following options:

l Remove/replace original files: overwrites the ori-
ginal file with the new image.

l Rename modified images and place in source
folder: adds identifying labels to the image names
and places them in the same folder as the originals.

l Place modified images in the following folder:
places the converted image in a folder that you can
specify. Click the Browse button and select a folder.

Overwrite existing files Determines how ACDSee Home should handle overwriting
files. Select one of the following options from the drop-
down list:

l Ask: prompts you when overwriting a file.
l Skip: cancels the operation if there is a file with the

same file name and extension.
l Replace: overwrites the file.
l Rename: prompts you to rename the file.

Preserve last-modified dates Retains the date and time properties of the file.

Remember and apply the last rotation
performed

Automatically applies the same settings the next time you
rotate an image.

Auto-close progress dialog if all operations
succeed

Automatically closes the dialog box after all images have
been adjusted.

Save current settings as default Stores the current settings and applies them the next time
you use the Rotate/Flip Images wizard.

Resizing Multiple Images

You can resize multiple images at once using the batch resize tool.

Resize Status

When resizing files in ACDSee Photo Studio Home 2026, you can track their status, pause, or cancel
them from the Activity Manager. For more information see ACDSee Activity Manager.
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To Resize Multiple Images:

1. Do one of the following:

2. In Manage mode, select one or more images, and then click Tools | Batch | Resize | Resize...

3. In the Resize dialog box, you can choose from multiple ways to resize your images. Choose either Size in
Pixels, Percentage, Print Size, Long Edge, or Short Edge. Follow the directions in the table below.

4. Click Options to specify how you want to save and store the images.

5. Click Resize.

You can save your resize settings as a preset by clicking the save icon beside the preset drop-
down. From there, enter a name and press OK. To delete a preset, press the trash icon.

You can assign shortcuts to speed up your process of resizing multiple images by following the
directions in the Customizing Keyboard Shortcuts topic.

Resize Options
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Resize Method Setting Explanation

Size in Pixels

Width Enter a new width for the images in pixels.

Height Enter a new height for the images in pixels.

Resize Choose how to scale the images. Select one of the
following options:

l Enlarge or Reduce: resizes all images to the
specified height and width.

l Enlarge only: resizes only those images that
are smaller than the specified height and
width.

l Reduce only: resizes only those images that
are larger than the specified height and
width.

Preserve original
aspect ratio

Check this box to keep the width-to-height ratio of
the original images.

Fit within Specifies whether the aspect ratio is maintained
based on the specified width. For more information
about how the different combinations affect the
images, see Pixel resize options and resulting action.

Percentage

Width Enter a new width for the images as a percentage of
the original image.

Height Enter a new height for the images as a percentage of
the original image.

Preserve original
aspect ratio

Check this box to keep the width-to-height ratio of
the original images.

Print Size

Units Choose from inches, cm (centimeters), mm
(millimeters), or pixels.
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Resize Method Setting Explanation

Width Enter a new width for the images in pixels.

Height Enter a new height for the images in pixels.

Resolution Enter a resolution for the images in pixels per inch.

Resize Choose how to scale the images. Select one of the
following options:

l Enlarge only: resizes only those images that
are smaller than the specified height and
width.

l Reduce only: resizes only those images that
are larger than the specified height and
width.

l Enlarge or reduce: resizes all images to the
specified height and width.

Preserve original
aspect ratio

Check this box to keep the width-to-height ratio of
the original images.

Fit within Specifies whether the aspect ratio is maintained
based on the specified width. For more information
about how the different combinations affect the
images, see Pixel resize options and resulting action.

Long Edge

Size Enter a size in units, and choose the units from the
drop-down menu. There, you can choose from
inches, cm (centimeters), mm (millimeters), or
pixels.

Resolution Enter a resolution for the images in pixels per inch.

Resize Choose how to scale the images. Select one of the
following options:

l Enlarge only: resizes only those images that
are smaller than the specified height and
width.

l Reduce only: resizes only those images that
are larger than the specified height and
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Resize Method Setting Explanation

width.

l Enlarge or reduce: resizes all images to the
specified height and width.

Short Edge

Size Enter a size in units, and choose the units from the
drop-down menu. There, you can choose from
inches, cm (centimeters), mm (millimeters), or
pixels.

Resolution Enter a resolution for the images in pixels per inch.

Resize Choose how to scale the images. Select one of the
following options:

l Enlarge only: resizes only those images that
are smaller than the specified height and
width.

l Reduce only: resizes only those images that
are larger than the specified height and
width.

l Enlarge or reduce: resizes all images to the
specified height and width.

Options

Output Location Choose an output location from the options:

l Remove/replace original files: this option
overwrites your original files.

l Same as source folder: pastes the resized
files in the folder they originated.

l Specific folder: use the folder icon to
navigate to a specific folder for the output
files.

l Create subfolder: with an output location
selected, check this checkbox to create a
subfolder for your resized images. Enter a
name in the box. This is useful if you are
making multiple batch resizes to specific
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Resize Method Setting Explanation

dimensions. You can save your resized files in
separate folders.

File options Choose your file options for overwriting existing files.

Choose whether to preserve certain file information
when resizing.

Choose your JPEG Compression options, find out
more in the JPEG Options topic.

Choose your resample type from the following
options:

l Lanczos: produces the sharpest images, but
may also introduce some ringing artifacts.

l Bell: smoothes the image.

l Bicubic: produces good results with photo-
realistic images and with images that are
irregular or complex. Uses interpolation to
minimize the raggedness normally associated
with image expansion.

l Box: displays considerable tiling or jaggies
(jagged edges) when you resize an image.

l B-spline: produces smooth transitions, but may
cause excessive blurring.

l ClearIQZ: slower than Bicubic and Lanczos,
but produces the best results when enlarging
photos, especially those of people.

l Mitchell: produces smooth transitions when
enlarging photo-realistic images. This filter is
good compromise between the ringing effect
of Lanczos and the blurring effect of other
filters.

l Triangle: produces good results for image
reduction and enlargement, but displays
sharp transition lines.
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Setting File Options

You can change the settings in the Options dialog box to control where ACDSee Home places modified
images, how to handle file duplication conflicts, and specify whether you want to preserve the last-
modified date of the file.

File Options

File options Specifies where to place the new images. Select one of the
following three options:

l Remove/replace original files: overwrites the original file
with the new image.

l Rename modified images and place in source folder: adds
identifying labels to the image names and places them in
the same folder as the originals.

l Place modified images in the following folder: places the
converted image in a folder that you can specify. Click the
Browse button and select a folder.

Overwrite existing files Determines how ACDSee Home should handle overwriting files.
Select one of the following options from the drop-down list:

l Ask: prompts you when overwriting a file.
l Skip: cancels the operation if there is a file with the same

file name and extension.
l Replace: overwrites the file.
l Rename: prompts you to rename the file.

Preserve last-modified dates Retains the date and time properties of the file.

Auto-close progress dialog if all
operations succeed

Automatically closes the dialog box after all images have been
adjusted.

Save current settings as default Stores the current settings and applies them the next time you use
the Resize Images wizard.

JPEG Compression Options Opens the JPEG Options dialog where you can specify detailed
compression options to apply to the resized files.

Organizing and Managing Files in ACDSee

Adjusting Exposure For Multiple Images

In ACDSee, you can lighten or darken the colors of an image or a group of images with the Batch
Adjust Exposure wizard. You can adjust each image individually and preview the changes before
applying, or make adjustments to an image and automatically apply the same changes to all of the
images you selected.
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You can also save your settings as a preset for future use.

To Adjust Image Exposure:

1. In Manage mode, select one or more images, and then click Tools | Batch | Adjust Exposure.

2. In the Batch Adjust Exposure dialog box, do one or more of the following:

l To adjust image exposure, contrast, and fill light level, select the Exposure tab and adjust the
options.

l To precisely adjust the contrast and light levels in your images, select the Levels tab and set the
options.

l To adjust image exposure automatically, select the Auto Levels tab and set the options.

l To precisely adjust the RGB color channels in your image, select the Tone Curves tab and set the
options.

3. Do one of the following:

l Check the Apply settings to all selected images checkbox to apply the current settings to all of
the images you selected.

l Uncheck Apply settings to all selected images and click Next Image to move to the next image,
and then repeat step 2 for each image you want to adjust.

4. Click Options to specify how you want to save and store the images.

5. Click Filter All Images.

You can also adjust image exposure and color levels in Edit mode.

Adjusting Batch Exposure Options

You can use the options in the Batch Adjust Exposure dialog to correct the exposure of your images.
There are four tabs in the Exposure section: Exposure, Levels, Auto Levels, and Tone Curves.

To Use the Exposure Options:

In the Batch Adjust Exposure dialog box, use the following options:

Exposure Options
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Exposure Specifies the amount of light to add to all areas of the image.

Auto Automatically corrects the exposure based upon the brightness
of the image.

Contrast Specifies the amount of difference between color and
brightness in an image. Moving the slider to the right darkens
the shadowed areas in an image, while moving the slider to the
left brightens them.

Fill Light Specifies the amount of light to add to the darkest areas of the
image.

Levels Options

Channel Specifies the brightness or color channel you want to adjust.

Shadows Specifies the black point of an image.

Move the slider or type a number from 0 to 255 into the spin
box to define the blackest area of an image. As the value
increases, the dark colored areas of the image become darker.

Midtones Specifies the gamma correction in an image.

Move the slider or type a number from 0.00 to 2.00 into the
spin box to set the amount of gamma correction. Higher values
make the image appear brighter, while lower values make the
image appear darker.

Highlights Specifies the white point of an image.

Move the slider or type a number from 0 to 255 into the spin
box to define the whitest area of an image. As the value
increases, the light colored areas of the image become lighter.

Clipped % Indicates how much of the image detail is lost due to black point
and white point correction.

Black Point Eyedropper Click the button with the black eyedropper icon to adjust the
black point. Select the area in the Before image that you want to
set as the black point for the After image.

Mid Point Eyedropper Click the button with the gray eyedropper icon to adjust the
gamma correction value. Select the area in the Before image
that you want to set as the gamma correction value.

White Point Eyedropper Click the button with the white eyedropper icon to adjust the
white point. Select the area in the Before image that you want
to set as the white point for the After image.
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Auto Levels Options

Strength Adjusts the amount of exposure applied to the image.

Auto Contrast and Color Adjusts color differences, brightness, and image color channels.

Auto Contrast Adjusts the color differences and brightness only.

Auto Color Balances color within the whole image.

Tone Curves Options

Channel Specifies the color channels to adjust.

Show Histogram Toggles the histogram display.

Histogram Displays a visual representation of the color information levels
in the image, based on the selected channel. Click and drag the
line to manipulate the curve.

Renaming Multiple Files

You can use the Batch Rename tool to renamemultiple files. You can specify a template with a
numerical or alphabetical sequence, save your template for future use, replace specific characters or
phrases, change cases, and insert or remove text or spaces. This can be particularly useful if you deal
with large quantities of images, or you organize your images by file name.

To Rename Multiple Files:

1. In Manage mode, select one or more files, and then click Tools | Batch | Rename File| Rename... If
selecting two or more files, you can alternatively press F2.

2. In the Rename dialog box, you will see a list of operations. Click any operation to view or change it's
settings. You can use the checkboxes to select or deselect which operations to run when batch
renaming. The following operations enable you to perform the following actions:

l Template - create a renaming template to apply to all selected files.

l Search and Replace - search for and replace parts of your file name.

l Case Change - change the case of text in your file name.

l Insert Text - add text to your file name.

l Remove Text- remove text from your file name.

l Strip Spaces - remove spaces from your file name.
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3. Review changes you have made to file names in the Preview field.

4. Click Rename.

You can save your rename settings as a preset by clicking the save icon beside the preset drop-
down. From there, enter a name and press OK. You can also access your Last Used Settings in
the preset menu, if you wish to repeat an action. To delete a preset, press the trash icon.

You can assign shortcuts to speed up your process of renaming multiple files by following the
directions in the Customizing Keyboard Shortcuts topic.

Rename Settings
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Template

Template: Type a file name format to set as a template. You can type any text
into this box, including hyphens and underscores.

Use the * symbol to insert the original file name, so renaming IMG-
9359.jpg using the template "Summer Wedding*" will rename the
file "Summer WeddingIMG-9359.jpg".

Use the # symbol to begin a sequence, either numerical or
alphabetical.

Insert Metadata... Choose one or more metadata properties to include in the
renaming template by checking the relevant checkboxes. Press OK.

Clear Templates Select this option to clear the existing templates to create a new
one, or change the existing template.

Use numbers to replace #'s Select this option to replace #s in the rename template with
sequential numbers.

Use letters to replace #'s Select this option to replace #s in the rename template with
sequential letters.

Start at: Select either Fixed value or Auto detect. If you select Fixed value,
choose a number to start the sequence with. Select Auto detect to
identify an existing numerical system and continue it.

Search and Replace

Search for: Enter a term to search for.

Replace with: Enter a term to replace the searched term with.

Insert Metadata... Choose one or more metadata properties to include in the
renaming template by checking the relevant checkboxes. Press OK.

Case sensitive Check this checkbox to search only for results that match the case
of your search term. You can use this to remove all capitals in your
file names, or all lowercase terms.

Include extension Check this checkbox to include file extensions in your search and
replace.

Case Change

Name Choose from Lowercase, Uppercase, or Title case to make a change
to the case in your file name, or select No change to keep as is.

Extension Choose from Lowercase, Uppercase, or No change. This can be
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useful to unify case differences in file names, for example .JPG and
.jpg

Insert Text

Insert: Type the text you want to insert into the file name.

Insert Metadata... Choose one or more metadata properties to include in the
renaming template by checking the relevant checkboxes. Press OK.

At location Choose from Prefix, Suffix, Position (meaning how many characters
into the name), After text:, or Before text:. After and before text
lets you enter text to prelude or follow.

Add from right to left Check this box to add the text from right to left, rather than from
left to right.

Overwrite existing name Check this box to rename the file by overwriting the existing file
name.

Include extension Check this checkbox to include file extensions in your renaming
process.

Case sensitive Check this checkbox to search only for results that match the case
of your search term.

Remove Text

Start From Choose a Position or a Delimiter.

l Enter a position, meaning how many characters into the
name to start removing text.

l Enter a Delimiter, which is where you start removing text
from.

Remove Until Choose Count equals, Delimiter, or The end.

l Enter a Count equals, this is how many characters of text to
remove.

l Type a Delimiter, which is where to stop removing text
from.

l When you choose The end, text is removed until the end of
the file name.

Remove from right to left Check this box to remove text from right to left, rather than from
left to right.
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Remove delimiters Check this box to remove the delimiters when renaming, else they
will remain.

Include extension Check this box to include the file extension in the text you remove.

Case sensitive Check this box to make text in the delimiter fields case sensitive.

Strip Spaces

Type of space removal Choose Remove all, Remove trailing, Remove consecutive, or
Replace with.

l Remove all removes all spaces in the file name.

l Remove trailing removes spaces following the file name.

l Remove consecutive removes multiple spaces in the file
name.

l Replace with gives you the option to enter alternatives, such
as a letter, number, or dash.

Advanced...

Handle name conflicts Choose from the following options:

l Ask: produce a prompt when a name conflict occurs.

l Skip: skip names that include conflicts.

l Rename: rename files with conflicts.

Handle extension changes Choose from the following options:

l Ask: produce a prompt when a rename affects an
extension.

l Skip: skip changes that affect extensions.

l Rename: rename extensions where required by the
rename.

As well as editing the options listed in the table, you can also reorder how these operations
run. To reorder operations, use either the up or down arrows at the bottom of the list, or click
and drag the name of the operation to its new location.

You can add additional operations, up to 10 in total. To do this, press the plus button at the
bottom of the list.
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To remove an operation, press the trash icon.

About the ACDSee Home Database

The ACDSee Home database stores image, document, and media file information automatically when
you browse your folders. This process is called cataloging. The database increases the speed with
which you can browse your computer, and you can use the information stored in the database to sort,
organize, search, and filter your images and media files. You can also backup, restore, and share
database information.

You can store cached thumbnail previews, and add or edit the following information for each image or
media file on your computer:

l Categories

l Notes

l Keywords

l Color Labels

l Authors

l Dates

l Ratings

l Captions

l Face Data

You can also choose to exclude folders from the database, and keep the contents of those folders
separate from your other images and media files.

ACDSeeMetadata can be embedded directly into your files. See Embedding ACDSeeMetadata in Files
for more information.

When you add ACDSeeMetadata to a file in ACDSee, the file is linked to the database. If you
then copy, move, or rename your files using programs other than ACDSee, such as Windows
Explorer, the link to the database is broken and this can cause the loss of ACDSeeMetadata.

Embedding ACDSee Metadata in Files

If you edit or add ACDSeeMetadata to your files, ACDSee Home automatically adds the new data to its
database. If you have the Display embed ACDSee metadata reminder checkbox checked in the
Options dialog box, (click Tools | Options | Embed ACDSee Metadata), next time you close ACDSee,
the Embed ACDSeeMetadata dialog box opens and offers to embed the new data into the changed
files themselves. You can also set how often you would like this reminder displayed. Embedding
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ACDSeeMetadata in the files as well, is a safe way to back up this data and make it easier to retrieve if
you should need to.

For example, once you have assigned ACDSeeMetadata to a file, the file is linked to the database. If
the file is moved using Windows Explorer, or any application other than ACDSee, the link will be
broken. However if you have embedded this data in the file and the link is broken, you can still retrieve
the ACDSeeMetadata using the embedded data in the files.

You can use ACDSee Home to rename, move, or copy the file—even to another computer—and the
embedded ACDSeeMetadata will transfer with the file.

To Embed ACDSee Metadata in a File When You Are Prompted:

1. In the Embed ACDSee Metadata dialog, select either or both of the following:

l ACDSee Metadata will be embedded into X file(s): indicates the number of files that you
selected that have metadata to be embedded.

l ACDSee Face Data will be embedded into Y file(s): indicates the number of files that you
selected that have face data to be embedded.

2. Click Embed.

Click Options to open the Embed ACDSeeMetadata Options. Click here for more information.

To Embed ACDSee Metadata at Any Time:

You can embed data in files at any time.

1. Click Tools |Metadata | Embed ACDSee Metadata, and then select one of the following:

l Embed in All Files: embeds data for all files.

l Embed in Selected Files: embeds data for any files that you have selected.

2. In the Embed ACDSeeMetadata dialog, select either or both of the following:

l ACDSee Metadata will be embedded into X file(s): indicates the number of files that you
selected that have metadata to be embedded.

l ACDSee Face Data will be embedded into Y file(s): indicates the number of files that you
selected that have face data to be embedded.

3. Click Embed.

Click Options to open the Embed ACDSeeMetadata Options. Click here for more information.

ACDSee uses XMP to embed ACDSeeMetadata into each file. Only some file formats and file
extensions support XMP. These include GIF, JPEG, DNG, PNG, PSD, TIF, AVIF, and JPEG-XL. In
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the case of these file formats, the ACDSeeMetadata is embedded inside the file and so you
can rename or move the file outside of ACDSee and still be able to retrieve the ACDSee
Metadata. For formats that currently do not support XMP, including RAW and ABR, the
ACDSeeMetadata is written to a sidecar file that is stored in the same folder as its file. Because
a sidecar file is separate from the file itself, you need to rename or move them together, or
you could lose the ACDSeeMetadata permanently.

Embedding ACDSee Categories and Keywords into IPTC Metadata

There are quick commands to embed your ACDSee keywords and categories into IPTC metadata.

To Embed ACDSee Keywords and Categories to IPTC Keywords and Supplemental Categories

Select a file, Right-Click and chooseMetadata | Embed to IPTC | Embed Keywords to IPTC or Embed
Categories to IPTC.

or

Select a file, and choose Tools |Metadata | Embed to IPTC | Embed Keywords to IPTC or Embed
Categories to IPTC.

Merging or Overwriting IPTC Metadata

When embedding ACDSee Metadata into IPTC metadata, you can choose how the data is saved
alongside previously saved metadata.

l Merge: ACDSee Metadata will be added to any existing IPTC Keywords and/or IPTC Supplemental
Categories.

l Overwrite: ACDSee Metadata will replace any existing IPTC Keywords and/or IPTC Supplemental
Categories.

The Embed Pending Icon

In Manage mode, in the File List pane, the following overlay icon appears on top of files that have
ACDSeeMetadata and Face Data stored in the ACDSee Home database that has not yet been written

to the file:

Right-click and choose either:

l Embed ACDSee Metadata: writes the metadata to the file.
l Clear Embed Pending Icon...: clears this overlay icon, but does not write the metadata to the file.
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Viewing Files That Have Data to Embed

If you want to see the files that have data that needs to be embedded, there is a quick way to list them
using the Embed Pending option.

To View Files That Have Data to Embed:

In the Catalog pane, under Special Items, click Embed Pending.

All the files that have data to embed are displayed in the File List.

Retrieving ACDSee Metadata That is Embedded in Files

If you simply browse to the folder where the files are located, some of the ACDSeeMetadata is
retrieved and written to the database. Categories and keywords, however, are not.

The safest way to retrieve all the ACDSeeMetadata, (including categories and keywords), is to click
Tools | Database | Catalog Files. Then the following applies:

l If the files are GIF, JPEG, DNG, PNG, and TIF formats, all the data will be retrieved and written to the
database.

l If the files still have their sidecar files in the folder, and they still have the same file name, the database
information is retrieved and written to the database.

l If the files have become separated from their sidecar files or renamed, their ACDSee Metadata cannot
be retrieved and will be lost.

Excluding Folders From the Database

You can choose to exclude folders from the database, and keep the contents separate from your other
images and media files. By default, the Program Files and Windows folders on your hard drive are
automatically excluded from the database.

To Manage Your Excluded Folders Settings:

1. In Manage mode, click Tools | Database | Excluded Folder Settings.

2. In the Excluded Folders dialog box, do one of the following:

l To exclude a folder from the database, click Add. Browse to a folder on your hard drive, and
then click OK.

l To remove a folder from the excluded folders list, select a folder in the list, and then click
Remove.

l To reset your excluded folders list to the default settings, click Reset to Defaults.

3. When you are satisfied with your choices, click Close to return to ACDSee.
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Cataloging Files in the Database

ACDSee Home automatically adds file information and thumbnails to the database as you browse. You
can use the Catalog dialog box to add groups of files to the database without having to first browse
the folders. This can be particularly useful when using ACDSee Home for the first time, and when
browsing or managing large collections of images, as it reduces the loading time required for these
folders.

The first time you run ACDSee, you are prompted to catalog your files.

To Catalog Your Files:

1. In Manage mode, click Tools | Database | Catalog Files...

2. Select the files to be cataloged. For more information see the Catalog Options table below.

3. Click Start.

A progress bar shows your files as they are cataloged.

4. Click Finish.

Catalog Options
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Catalog

Add Folder... Click the Add Folder... button to browse for
folders to be added to the database.

Remove Folder Select a folder in the Folders to Catalog
table and click the Remove folder button to
remove the folder from the table.

Import from Cataloged Files
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Catalog

EXIF and IPTC metadata Enable to import EXIF and IPTC metadata.
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Catalog

IPTC Keywords to ACDSee Keywords Enable to import IPTC keywords into ACDSee
Keywords. IPTC keywords can also be impor-
ted by right-clicking on the image, and select-
ingMetadata | Import IPTC Keywords.

Files with ACDSee Keywords
assigned will import IPTC
Keywords without overwriting
or removing existing ACDSee
Keywords.

IPTC Supplemental Categories to ACDSee
Categories

Enable to import IPTC supplemental cat-
egories to ACDSee Categories.
IPTC supplemental categories can also be
imported by right-clicking on the image and
selectingMetadata | Import
IPTC supplemental categories.

Files with ACDSee Categories
assigned will import IPTC
Supplemental Categories
without overwriting or
removing existing ACDSee
Categories.

ACDSee Metadata, including categories,
keywords, tagged, and collections

Enable to import ACDSee metadata,
including categories, keywords, tagged, and
collections.

If a file's Embed Pending flag is
set, it will not import ACDSee
Categories and Keywords.

If a file's Embed Pending flag is
not set and it has embedded
ACDSee Categories and
Keywords, it will unassign the
file's existing categories and
keywords and import those
values from the embedded
data.
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Catalog

Face Data, including face outlines and
names

Enable to import Face Data, including face
outlines and names. Enabling the Face Data
checkbox activates the ACDSee Face Data
radio button and the Lightroom or Picasa
Face Data radio button.

ACDSee Face Data Enable to import ACDSee Face Data. The
ACDSee Face Data radio button is only
activated if the Face Data, including face
outlines and names checkbox is enabled.
Enabling the ACDSee Face Data radio
button disables the Lightroom or Picasa
Face Data radio button.

Lightroom or Picasa Face Data Enable to import Lightroom or Picasa Face
Data. The Lightroom or Picasa Face Data
radio button is only activated if the Face
Data, including face outlines and names
checkbox is enabled. Enabling the
Lightroom or Picasa Face Data radio
button disables the ACDSee Face Data
radio button.

File Formats

Catalog Images Only image file types will be cataloged

Catalog Images and videos Both image and video file types will be
imported.

Catalog all files All files in the selected folder will be
imported.

Options

Build and include thumbnails in database Enable to build thumbnails of the image or
video files and include the thumbnails in
the database.

Include contents of archive files Enable to include the contents of archived
files.

Create preview files for RAW images Enable to create preview files for
RAW images.
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Catalog

Other

Help Opens the help file related to cataloging
files in Media mode.

Start Starts the process of adding thumbnails and
file information to the database.

Cancel Closes the window.

If you are cataloging a large collection of files, do not disrupt the process, or use other
software while it is running. For large file collections, it is best to run cataloging overnight.

About the ACDSee Indexer

Cataloging and the Database.

The ACDSee database stores file information when you browse your folders. This process is called
cataloging. Cataloging and using the database can help you sort, organize, search, and filter your files,
as well as speeding up browsing. The ACDSee Indexer is a tool that helps you catalog your images
without browsing through them.

You can use the Catalog dialog box to add files to the database without having to first browse the
folders. During this time, you will not be able to use ACDSee.

The ACDSee Indexer allows you to catalog files while your computer is idle and ACDSee is not running.
This saves you from having to browse all folders or experience your computer slowing down while
processing. If you have edited any files in the selected folders, the ACDSee Indexer will update the
database.

You can set folders to be cataloged and how long you would like your computer to be idle before the
ACDSee Indexer begins to catalog your files. To configure these options, see Setting the ACDSee
Indexer Options.

Creating and Switching Between Multiple Databases

ACDSee allows you to create multiple databases and switch between them at any time, giving you
complete organizational control over your file collections.

When you open ACDSee for the first time, (and up until you create additional databases), you will be
using the original database called Default.dbin. It is located in: C:\Users\<Your
Name>\AppData\Local\ACD Systems\Catalogs\<Version #>. All additional databases that you create
will be stored in this same location, unless you specify otherwise.
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You can configure ACDSee to display the database it is currently running in the title bar of the
application.

To Create a New Database:

1. In Manage mode, open File | Database | New...

2. In the New Database dialog box, enter a name for your new database.

3. Browse to choose the location where the database will be stored, or leave it set to the existing location
to store the new database with your existing database, Default.dbin.

The database file will be stored with a folder of the same name. The database file and
folder must always share exactly the same name, or ACDSee will not be able to connect to
the database.

4. If you would like to have the name of your database displayed in the title bar of the application, check
the Show database filename in title bar checkbox.

5. Click OK.

6. A dialog will appear asking you if you would like to switch to your newly created database. Select Yes or
No. If you select Yes, ACDSee will restart and run with the new database.

To Switch from One Database to Another:

In Manage mode, do one of the following:

Open File | Database |
Open...

In the Open Database dialog, browse to the database file (*.dbin) you want to
use and click Open.

Open File | Database |
Recent

Select one of your recently used databases.

To Quickly Launch ACDSee in a Specific Database Using Command Line Switch:

1. Create a shortcut to ACDSee. It is recommended that you name this shortcut something that
corresponds to the name of the database you want to open.

2. In the shortcut properties, set the target to C:\Program Files\ACD Systems\ACDSee\<Version
#>\ACDSee<Version #>.exe" /db "C:\Users\<Your Name>\AppData\Local\ACD
Systems\Catalogs\<Version #>\<Name of Your Database>.dbin".

Converting an Older Database

You can use the ACD Database Convert wizard to take database information from previous versions of
ACDSee Home and add it to your current database. This ensures that any information associated with
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your files using a previous version of ACDSee Home is referenced properly in the current database.

If you have already added information to your current ACDSee Home database, it is
recommended that you create a backup of your database before converting an older ACDSee
Home database.

To Convert an Older Database:

1. In Manage mode, click Tools | Database | Convert Database.

2. On the Welcome page, click Next to select your conversion options.

3. On the Database Convert Options page, specify the version of the database files you want to convert, as
well as the folder where the database files are located on your hard drive. Click Next.

4. To automatically rebuild image thumbnails, IPTC and EXIF information after the conversion process is
complete, check the Rebuild thumbnails, EXIF and IPTC data for local images checkbox.

5. To automatically update your database after converting, check the Optimize database files after
convert checkbox.

6. Click Next.

7. On the Summary page, review your selections, and then click Next to convert your database.

Importing Database Information

You can use the ACD Database Import wizard to import archived database information, or to import
database information that was sent to you with images from another ACDSee Home user. After you
import the information, ACDSee Home associates it with the appropriate images.

If you have already added information to your current ACDSee Home database, it is
recommended that you create a backup of your database before converting an older ACDSee
Home database.

To Use the ACD Database Import Wizard:

1. In Manage mode, click Tools | Database | Import, and then select Database.

2. Click Next to start the wizard.

3. On the Import Options page, select the type of exported database information you want to import.

You can import image information from a compressed database version, or information from
an XML-based text file.

4. Click the Browse button to locate the database you want to import, and then click OK.

5. Check the Optimize database files after import checkbox to optimize the database after exiting the
wizard, and then click Next.
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6. On the Summary page, review your selections. Click Back to make changes, or click Next to begin
importing the database information.

7. Click Finish to close the ACD Database Import wizard.

If you are importing database information sent to you by another ACDSee Home user, ensure
that the images to which the information applies are in an identical location and folder
structure on your hard drive.

Importing File Information from Other Sources

You can import file information into your database from other sources, including ACDSee Photo Discs
and files from previous versions of ACDSee.

Importing Photo Discs

Previous versions of ACDSee (versions 4.0 and 5.0) created separate database files with a .ddf file
extension for Photo Discs. You can import the Photo Disc database files into your ACDSee Home
database.

To Import a Photo Disc:

1. In Manage mode, click Tools | Database | Import, and then select Photo Disc.

2. In the Open dialog box, locate and select the photo disc file you want to import.

3. Click Open.

To import the information from Photo Discs created with ACDSee 6.0 or later, you must
convert and import the entire database.

Importing Albums

In previous versions of ACDSee, you could create albums in an .ais file format that consisted of
organized shortcuts to your images. Now you can use categories to create albums of images that do
not require a separate file extension. You can, however, import your albums from previous versions of
ACDSee, and add the information from the albums to the database. ACDSee Home creates a new
category for each album you import.

To Import Album Information into the Database:

1. In Manage mode, click Tools | Database | Import, and then select Album.

2. In the Open dialog box, locate and select the .ais file you want to import.

3. Click Open.
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Working with Descript.ion Files

In previous versions of ACDSee, file descriptions were stored in a separate descript.ion file in each
folder that contained images. ACDSee Home now stores file descriptions as captions in the database,
along with other file information such as notes and keywords.

You can use the Descript.ion tools to import your old descript.ion files and add the information to the
database, or export your existing file captions to a descript.ion file.

To Import a Descript.ion File:

1. In Manage mode, click Tools | Database | Import, and then select Descript.ion File.

2. In the Open dialog box, locate and select the descript.ion file you want to import.

3. Click Open.

To Export Captions to a Descript.ion File:

1. In Manage mode, click Tools | Database | Export, and then select Descript.ion File.

2. In the Save As dialog box, type a name for the descript.ion file in the File name field.

3. Click Save.

Exporting Database Information

You can use the ACD Database Export wizard to save selected database information in a compressed
format, and then store it as a backup, or share it with other ACDSee Home users. You can also choose
to export your category and keyword definitions to a text file.

Exporting your database information differs from creating a backup in that you can choose to export
only the parts of your database that you want to share or store with specific files, such as those on a
CD. Other ACDSee Home users can import your information without affecting their existing database.

To create a backup of your entire database, including image or media files, use the ACD Database
Backup wizard.

To back up the contents of a local folder to a remote location, such as a network drive, use the ACD
Sync wizard.

To Use the ACD Database Export Wizard:

1. If you want to export your database information for a specific group of images or media files, select the
files in the File List pane in Manage mode.

2. Click Tools | Database | Export | Database.

3. Click Next to begin using the wizard.

4. On the Content and Format Options page, specify how you want to export your database information by
selecting one of the following options, and then clicking Next:
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l Export entire ACDSee database to a read-only, compressed version: exports the entire
contents of your ACDSee Home database to a compressed version that can be shared with
other ACDSee Home users.

l Export database information for selected items to a read-only, compressed version: exports
all of your database information for the images selected in the File List pane.

l Export database information to a text file: exports the selected information to an XML-based
text file. Check the checkboxes next to the information you want to include.

5. On the Location Options page, specify a location for the exported information, and a name for the text
file, if necessary, and then click Next.

6. On the Summary page, review your choices. You can click Back to make changes, or click Next to begin
exporting your database information.

7. Click Finish to close the wizard and return to ACDSee.

Generating File Lists

You can generate a text file that lists all of the files in the folder currently displayed in the File List pane.
The text file places the file name, size, image file format, modified date, image properties, caption, and
rating for all of the files in the folder into a table, and creates a single text file.

To Generate a List of Your Files:

In Manage mode, click Tools | Database | Export, and then select Generate File Listing.

ACDSee Home automatically generates the file listing and opens it as a text file in your default text
editor. You can then edit or save the text file.

Backing Up Your Database

You can use the ACDSee Backup wizard to back up all of your database information, which you can
then restore in the case of a system failure or other event. You can also choose to back up your image,
media, or archive files along with the relevant database information.

The ACDSee Backup wizard creates a series of files in a specified location that contain your entire
database. The backup is generated using your folder structure and is unique to your computer. To
back up portions of your database, or to share database information with another ACDSee Home user,
use the ACDSee Database Export wizard.

For some suggestions about managing your database backups, see Database Backup Tips and
Strategies.

To Back Up Your Database Information:
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1. In Manage mode, click Tools | Database | Back Up Database.

2. On the Welcome page, select whether you would like to create a new backup, or update an existing
backup. Click Next.

If you choose to update an existing backup, please go to step #5.

3. On the New Backup page, select the information you would like to back up. Click Next.

4. On the Backup Location page, click Browse and specify a location for your backup, and type a name for
the backup file. Click Next.

5. On the Backup Summary page, review your settings. If you chose to update an existing backup, click the
Backup to update drop-down list, and then select the existing backup. Click Next.

Backup Information Options

Do not include
thumbnails

Excludes thumbnails from the backup, saving a substantial amount of storage
space on your hard drive.

Include thumbnails for
offline files

Includes only thumbnails for files that do not reside on your hard drive, such as
PhotoDiscs.

Include thumbnails Includes all thumbnails in the database. This will require more space on your
hard drive to store the backup.

Backup files of type Backs up the specified file types with the database information. Select from the
following file types:

l Image: includes image files in the backup.

l Media: includes audio and video files in the backup.

l Archive: includes archive files in the backup.

All files of specified
types on your local hard
drives

Backs up all specified files on your hard drive.

All files of specified
types on local and
network hard drives

Backs up all specified files on your hard drive and network drives.

All files of specified
types in a folder
(including subfolders)

Backs up all specified files in a specified folder. Click the Browse button and
select the folder to back up.
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Database Backup Tips and Strategies

The ACDSee Home database stores information about your files, including EXIF information, file name
and folder location, thumbnails, categories, ratings, and any other information you add using the
Properties pane. The more information you store in the database, and the more time you spend
entering that information, the more important it is to back up your database, and to have a good
strategy for managing your backups. Losing hours of work to a system crash or other uncontrollable
event is something that should, and can, be avoided.

Backup Schedule

How often you need to back up depends on how often you add or change information in the
database. A good rule to use would be to back up your data as often as you want to avoid retyping it.
You can use the backup reminder settings on the Database page of the Options dialog box to set a
regular reminder for yourself to back up your data as often as you think appropriate. Business
environments and professional users should back up every day.

It is also recommended that you back up your database before performing any major adjustments to
it, such as importing information from another ACDSee Home user, or converting a database from a
previous version of ACDSee.

Backup Location

It's a good idea to consider where you back up your data, as well as how often. If you're backing up to
your hard drive, ACDSee Home creates a new folder for each day. This helps to avoid overwriting your
backup, and gives you several increments from which you can restore. Also helpful is a monthly
backup that is stored in a different physical location than your computer, such as a network drive.

Backup Size

To keep the size of the backup small, choose to back up database information only, and back up your
images separately, also on a regular basis.

Restoring Database Information From a Backup

You can use the ACD Database Restore wizard to restore previously backed up database information.

To Restore Database Information:

1. In Manage mode, click Tools | Database | Restore Database.

2. On the Welcome page, click Next to select the backup.
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3. On the Restore Options page, select the backup and date from which you want to restore, or browse to
the location of your backup and select a .bkup file.

4. Click Next when you are ready to restore your database.

When restoring a backup from a series of backup files, ACDSee Home will only restore the
information included in and prior to the selected backup file. Therefore, unless required, it is
recommended that you select the last file in the backup sequence.

Maintaining the Database

It is recommended that you regularly perform database maintenance and optimization to increase
hard drive space, remove redundant or extraneous information, and increase overall ACDSee Home
performance.

You can use the tools in the Database Maintenance dialog box to update folders, or to identify folders
whose thumbnails and database information you would like to delete. The Database Maintenance
dialog box displays a list of the folders on your system, and uses icons to indicate the status of
database information within specific folders.

Database Content Icons

Folder contains files with cached thumbnails stored in the database.

Folder contains files that were changed without a database update. For example, a folder or file was
renamed or moved outside of ACDSee.

To Perform Database Maintenance:

1. In Manage mode, click Tools | Database | Database Maintenance.

2. In the Database Maintenance dialog box, browse for folders marked with the database content icons. If
there are no marked folders, you do not need to perform database maintenance and can exit the
Database Maintenance dialog box.

3. Select a folder and click one of the following buttons to identify the maintenance you want to perform
on that folder:

l Remove Thumbnails: removes all thumbnail information for the selected folder.

l Remove All DB Info: deletes all database and thumbnail information for the selected folder.

l Remove Orphan Folders: deletes any out-of-date or broken references to missing files or
information for the selected folder. It is only possible to check for orphans in folders located on
your computer. This option will not be visible if the folder is located on a network.
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l Change Binding: changes all location references for the selected orphaned folder to another
folder, and retains all database information. The default binding folder is My Pictures.

4. The Database Maintenance tool will delete records, creating unused space in your database. To reclaim
the unused space, click Optimize Database, and follow the instructions in the wizard.

5. Click Close.

Optimizing the Database

You can use the Optimize Database wizard to quickly remove redundant or outdated database
records. Optimizing your database, along with performing regular database maintenance, helps regain
hard drive space and improves the overall performance of ACDSee.

If you are cataloging large numbers of files regularly, it is helpful to optimize weekly, or after an
extended cataloging session. This is also a good time to backup the database.

To Optimize Your Database:

1. In Manage mode, click Tools | Database | Optimize Database.

2. In the Database Optimization wizard, click Next.

3. Select one or both of the following:

l Optimize the database tables and fields: removes obsolete information from the database,
reduces the space used by database fields, and re-indexes the tables.

l Remove orphans from database: removes any orphan database entries, caused by files or
folders deleted by other programs.

4. Click Next.

5. When the wizard has finished, click Finish to return to ACDSee.

Mapping Drives for an Incoming Database

If you are upgrading to ACDSee Home or are importing or restoring your ACDSee Home database, the
Database Drive Mapping dialog displays how drive mappings (in the incoming database) will be re-
established in the ACDSee Home database. You can use this dialog to change how each drive will be
mapped in the database.

To Select New Drive Mappings:
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1. In the Database Drive Mapping dialog, select a drive and do one of the following:

l To create a new drive map, select Create new database entry.

l To map the drive to a local drive, select a drive from the Local Drive drop-down list.

2. Click Done.

Rebuilding Thumbnails and Metadata

Situations can develop in which your images will be out of sync with the thumbnail images displayed in
the File List pane and the embedded metadata. You can use the Rebuild Thumbnails and Metadata
tool to immediately regenerate the thumbnails for selected images and rebuild the metadata.

To Rebuild Thumbnails:

1. In Manage mode, do one of the following:

l Select one or more thumbnails in the File List pane.

l Select a folder in the Folders pane.

2. Click Tools |Metadata | Rebuild Thumbnails and Metadata.

Quarantined Files

If ACDSee Home has trouble reading a corrupted or incomplete image or media file, or a file causes a
plug-in to generate an error, ACDSee Home will quarantine that file. You can view a list of quarantined
files, and remove a file from the list.

To View Quarantined Files:

1. In Manage mode, click Tools | Database | Quarantine Files.

2. To remove a file, select it in the list, and then click Remove.

3. To disable the Quarantine feature, uncheck the Enable Quarantine checkbox.

4. Click OK to close the Quarantine Files dialog box and return to ACDSee.

Working with Plug-Ins

A plug-in is a software module that adds functionality to a larger program. ACDSee Home comes as
standard with many different plug-ins.
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Types of Plug-Ins

l Image Decode: converts a file from a binary format to the image displayed in ACDSee. Decode plug-ins
allow ACDSee Home to display images of many different file formats. The files that you can view
withACDSee Home depend on which decoding plug-ins are installed on your computer.

l Image Encode: converts the image displayed in ACDSee Home to a binary file format. Encode plug-ins
allow ACDSee Home to save (or convert) images to many different file formats. The files that you can
edit and save with ACDSee Home depend on which encoding plug-ins are installed on your computer.

l Archive: allows ACDSee Home to display and save archives of many different file formats. The archives
that you can view and create with ACDSee Home depend on which archive plug-ins are installed on your
computer.

l Camera: allows ACDSee Home to browse images on your digital camera and transfer them to a folder
on your hard drive.

l Command Extension: adds functionality to ACDSee. For example, there is a plug-in that you can use to
share your images over the Internet.

l Pane Extension: adds a pane to ACDSee Home where you can perform tasks like order prints of your
digital images.

We cannot ensure the quality of plug-ins that are not certified by ACD Systems. As with any
other piece of software, you are trusting that the plug-in is free of viruses and that the
company that produced the plug-in is trustworthy.

Managing Plug-Ins

The Plug-in Settings dialog box displays a list of all the ACDSee plug-ins installed on your computer.
You can also use the Plug-in Settings dialog box to control which plug-ins ACDSee Home uses.

To Access the Plug-In Settings Dialog Box:

In Manage mode, click Tools | Plug-in Settings.

Disabling a Plug-In

You can disable a plug-in in the Plug-in Settings dialog box so that ACDSee Home no longer uses it.

To Disable a Plug-In:

1. In the Plug-in Settings dialog box, select one of the Plug-in tabs.

2. Uncheck the checkbox beside the name of the plug-in that you do not want ACDSee Home to use.

3. Click OK.
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Changing the Plug-In Order

Some file formats can be supported by more than one plug-in. However, when this happens, you can
control which plug-in is used to read or write a file format. The order that plug-ins appear in the Plug-in
Settings dialog box is the order that ACDSee Home uses the plug-ins to read or write a file.

To Change the Plug-In Order:

1. In the Plug-in Settings dialog box, select one of the Plug-in tabs.

2. Select a plug-in in the Plug-ins list.

3. Do one of the following:

l Click the Move up button to move the plug-in higher in the list.

l Click the Move down button to move the plug-in lower in the list.

4. Click OK.

Viewing Plug-In Properties and Getting Help

You can view and set properties for certain plug-ins.

To View Plug-In Properties:

1. In the Plug-in Settings dialog box, select one of the Plug-in tabs.

2. Select a plug-in in the Plug-ins list.

3. Click the Properties button.

To View a Plug-In's Help File:

1. In the Plug-in Settings dialog box, select one of the Plug-in tabs.

2. Select a plug-in in the Plug-ins list.

3. Click the Plug-in Help button.

ACDSee SeeDrive™

The ACDSee SeeDrive™ pane provides direct access to your ACDSee 365 account. You can use the
ACDSee SeeDrive™ to manage your ACDSee 365 images, and monitor your uploads and downloads to
seedrive.acdsee.com, an image sharing and storage service. An ACDSee 365 account requires a
membership or the purchase of additional storage, which you can obtain at seedrive.acdsee.com.

ACDSee SeeDrive™ allows you to browse through your online images without having to launch an
Internet browser. Alternatively, you can go to seedrive.acdsee.com with an Internet browser. To view
the SeeDrive™ pane, go to Panes | SeeDrive.
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To Use ACDSee SeeDrive™:

In the ACDSee SeeDrive™ pane, press Connect and enter your ACDSee 365 login credentials. If you do
not have an ACDSee 365 account, select Create an account.

Alternatively, you can log in through 365mode.

Managing Your ACDSee 365 Files with SeeDrive™

You can create, rename, and delete ACDSee 365 folders directly from ACDSee SeeDrive™ in Manage
mode.

To Create a New Folder:

1. In the ACDSee SeeDrive™ pane in Manage mode, right-click your username and select New Online
Folder...

2. In the New Online Folder dialog, enter a name for your folder and press OK.

To add a newly created folder to an existing folder hierarchy, drag the new folder to your
desired location inside of it.

To Create a New Folder Inside an Existing Folder:

1. In the ACDSee SeeDrive™ pane in Manage mode, expose your folders by clicking the arrow next to your
username.

2. Right-click your desired folder and select New Online Folder...

3. In the New Online Folder dialog, enter a name for your folder and press OK.
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To Rename a Folder:

In the ACDSee SeeDrive™ pane in Manage mode, right-click the folder and select Rename.

To Delete a Folder:

In the ACDSee SeeDrive™ pane in Manage mode, right-click the folder and select Delete.

To Rename a File:

1. In the ACDSee SeeDrive™ pane in Manage mode, navigate to and open your desired folder.

2. In the File List pane, right-click the file and select Rename.

To Delete a File:

1. In the ACDSee SeeDrive™ pane in Manage mode, navigate to and open your desired folder.

2. In the File List pane, right-click the file and select Delete.

Uploading

Uploading Files to ACDSee 365 with SeeDrive™:

l To upload a folder: select a folder from the Folders pane and drag it into your desired folder in ACDSee
SeeDrive™.

l To upload individual files: select your desired files in the File List pane and drag them into your desired
folder in ACDSee SeeDrive™.

l Manage your uploads by right-clicking any folder in ACDSee SeeDrive™ and selecting Transfer
Manager... Use the Transfer Manager controls as described in the table below.

Downloading

Downloading Files from ACDSee 365 with SeeDrive™:

1. Select your destination folder in the Folders pane.

2. Select the folder you would like to download in ACDSee SeeDrive™, right-click and choose Download.

Manage your downloads by right-clicking any folder in ACDSee SeeDrive™ and selecting Transfer
Manager... Use the Transfer Manager controls as described in the table below.

Transfer Manager Options
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Choose the Uploads or Downloads tab.

Restarts paused transfer

Pauses transfer

Cancels transfer

Retry transfer

Select all

Clear finished

Making Folders Private or Public

You can set folders to private or public in the ACDSee SeeDrive™ pane in Manage mode. When you
make a folder public, anyone can find and see the images in that folder when they browse or search
seedrive.acdsee.com.

New folders are set to private by default.

To Change an ACDSee 365 Folder to Public Using ACDSee SeeDrive™:

1. In the ACDSee SeeDrive™ pane, expose your folders by clicking the arrow next to your username.

2. Right-click the folder you want to make public, and selectMake Public.

To Change an ACDSee 365 Folder Back to Private Using ACDSee SeeDrive™:

1. In the ACDSee SeeDrive™ pane, expose your folders by clicking the arrow next to your username.

2. Right-click the folder you want to make private, and selectMake Private.

Sharing and Downloading with ACDSee SeeDrive™

You can perform sharing and downloading actions on your online content from right within ACDSee
SeeDrive™. You can also view and manage the progress of your uploads and downloads with the
Transfer Manager.
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Sharing a Folder with ACDSee SeeDrive™

You can share your ACDSee 365 folders with others right from your ACDSee SeeDrive™ pane. You can
share using Email, post to a social networking site, or create a widget.

To Share Your Folders Using ACDSee SeeDrive™:

1. In the ACDSee SeeDrive™ pane in Manage mode, expose your folders by clicking the arrow next to your
username.

2. Right-click the folder you want to share and select Share Folder.

3. In the Share window, select your sharing method and enter your information, as described below.

Share Options
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Email

Scroll through your images at the bottom of the window and uncheck any photos you do not wish to include.
After you have entered the information below, press OK.

Recipient Email Addresses Enter your recipients' email addresses. Separate multiple
email addresses with commas.

Your Message Enter a message for your recipients.

Allow download of largest available
JPG

Allow your recipients to download the largest available
versions of your images.

Email me too Check this checkbox to receive a copy of your email.

Optional private access password If you would like your album to be password protected, enter
the password here. The password will be available to your
recipients in the body of your email, which they can then enter
to gain access to your album.

X™

Scroll through your images at the bottom of the window and uncheck any photos you do not wish to include.
After you have completed the steps listed below, press Upload.

X™ Press this button to launch X™ in a browser and enter your
login credentials.

Shorten URL with bit.ly Shortens the length of your album's URL, allowing you more
characters for your message.

Preview Displays a preview of your post.

Characters left Displays how many characters you have left of your message.

Allow download of largest available
JPG

Allows viewers to download the largest available versions of
your images.

Widget

A photo widget is an image viewer or slideshow that can be placed on a website or blog. This option
generates a piece of html code that you can copy and paste onto your website or blog. Scroll through your
images at the bottom of the window and uncheck any photos you do not wish to include.

Orientation Select the orientation of your photo widget from the drop-
down menu.

Theme Select the color theme of your photo widget from the drop-
down menu.
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Size Select the size of your photo widget from the drop-down
menu.

Sharing Your Folders by Copying and Pasting its URL Using ACDSee SeeDrive™

You can copy the URL of a folder from ACDSee SeeDrive™ and paste it in a browser, email, or anywhere
else.

You can only copy a URL from a public folder.

Copying and Pasting a Folder's URL:

1. In the ACDSee SeeDrive™ pane in Manage mode, expose your folders by clicking the arrow next to your
username.

2. Right-click the folder you want to share and select Copy URL.

3. Right-click and select Paste, or press Ctrl + V, wherever you would like to paste the URL.
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Chapter 4: Media Mode

Using Media Mode

Mediamode offers a streamlined, database-driven approach to Digital Asset Management. Only the
folders browsed inManagemode and that have been cataloged into the ACDSee database will be
displayed inMediamode, offering a clutter-free view of photographs and videos managed by ACDSee.

TheMediamode interface is divided into four separate functional areas:

1. Header Button Bar

2. My Folders

3. Display Area

4. Group By and Properties
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Header Button Bar

Located directly below the main menu, the Header Button Bar contains three buttons described
below:

l Refresh
l Catalog
l Show Orphan Files

Header Button Bar Options

Refresh Refreshes the My Folder pane's folder tree and the Display Area pane.

Catalog For more about cataloging files, please see Cataloging Files in the Data-
base.

Show Orphan Files Displays missing files flagged as orphans. Orphans will be displayed in
sepia.

My Folders

Located along the left side of the screen, theMy Folders pane is a simple folder tree populated with all
folders browsed while inManagemode. To add additional folders to theMy Folders pane without
leavingMediamode, use the Catalog Files tool.

TheMy Folders pane is hidden by default. To display theMy Folders pane, click the Hide/Show icon
in the lower left of the Display Area.

Clicking a folder containing media in theMy Folder pane will filter the Display Area's contents to
display the selected folder's media.

Display Area

The Display Area pane occupies the large central portion of the screen and is used primarily to display
images and videos that can be filtered, sorted, or grouped.

Double-click any image or video to display them in full screen. Videos displayed in full screen can be
played without leavingMediamode. Double click the full screen image or video to return to the grid
view.

Right-click individual media assets to produce a context-sensitive help menu containing the following
options:

l View: Opens media asset in View mode.

l Edit: Opens media asset in Edit mode.

l Rotate Left: Press Ctrl + L to rotate left.

l Rotate Right: Press Ctrl + R to rotate right.

l Show in File Explorer: Opens to the media asset file's location in File Explorer.
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Toggle Between Grid and Full Screen View

You can swap between Grid and Full Screen view by selecting the toggle button in the top left of the
display, found directly to the left of the Filter option.

Filter By

When enabled, the tools in the Filter By toolbar are very powerful for tailoring the results displayed in
the Display Area pane by filtering the results based on specific metadata.

To filter media assets in the Display Area pane, choose from a combination of any of the following:

l Enable the Tagged checkbox to display only those images with a tag.

l Make a selection from the ratings to display media with a specific rating. The button to the left of the rat-
ings lets you choose whether the results will include media with a Rating less than or equal, greater than
or equal, or matching the chosen rating.

l Make a selection from the color labels to display media tagged with a specific label.

Changes made to the Filter By tools will affect the results displayed in the Group By pane.

Sort and Group

Located directly above the media asset and to the right-side of the Display Area pane, the Sort and
Group drop-downs are used to alter how the contents of the Display Area pane are presented. Unlike
the Filter By field which refines the number of media assets displayed, the Sort and Group drop-downs
do not change the number of media assets displayed. Both the Sort and Group drop-down results can
be sorted forwards or backwards.

Selections made in the Group field will affect the results displayed in the Group By pane.

Group By and Properties Panes

Located along the right side of the screen, the Group By pane lists groups of media assets based on
the selection made in the Filter By drop-down and the Group drop-down. The Properties pane
displays key details such as IPTC, EXIF, and important ACDSee metadata. To display the Group By and

Properties pane, click the Hide/Show icon in the lower right of the Display Area.

The Group By pane results can be grouped forward and backwards.

The blue bar within each group tab is representative of the number of media assets in the group.

Clicking a tab in the Group By pane changes the display in the Display Area pane to reflect the group
selected.
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Navigation Buttons in Media Mode

When viewing an image in full screen, you can navigate between images by hovering over to the left or
right side of the window and clicking on the navigational arrow that appears.

Deleting Images in Media Mode

There are three ways of deleting images in Media Mode:

l Right click on an image and select delete from the context menu

l Click on the Edit dropdown at the top of the screen and select Delete

l Click once on the image and press the Delete key
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Chapter 5: View Mode
Viewmode is the main viewing component of the ACDSee user interface.

In Viewmode, you can:

l Click + hold + drag to pan around large images.

l Press the keyboard shortcut F to toggle in and out of full screen view.

l Zoom in or out on your images.

l View images in a slideshow.

l Play video and audio files and add audio to your image files.

l Add captions to your images.

l Catalog files by tagging them, adding categories, keywords, and other metadata.

l Automatically advance to the next image in the Filmstrip when you apply metadata.

l Detect faces in images and assign them names.

Previewing Your Images with Auto Lens

You can use Auto Lens to preview your images with a number of filters without actually applying them
to the file.

To View Your Image with an Auto Lens:

1. Open an image in View mode.

2. On the Toolbar, press the Auto Lens button.

3. Select a filter to preview your image in.

4. Use the Filmstrip or Previous/Next button to preview more images with your selected filter.

The Lens will remain turned on in Viewmode until you turn it off.

To Turn Off Your Selected Auto Lens:
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1. On the Toolbar, press the Auto Lens button.

2. Select None.

Light EQ™

You can view your image with an instant exposure adjustment in Viewmode with Light EQ™. You will
need to select Light EQ™ for each image you view.

To View Your Image with Light EQ™:

1. Open an image in View mode.

2. On the Toolbar, press the Light EQ™ button.

Using Face Detection and Recognition in View Mode

You can use Face Detection to detect people in images you browse in Viewmode. You can also import
face data from other programs in Viewmode.

This process will be expedited if you have allowed Face Detection to finish scanning in Manage
mode on the folder you are currently viewing.

You can assign names to the detected faces in Viewmode using the Face Detection pane or Face tool.
Naming faces will assist ACDSee with recognizing individuals in future images. This is referred to as
facial recognition. The more often a person is named, the more likely they will be recognized, saving
you time in the future. You can also improve your results by correcting names mistakenly assigned to
faces by ACDSee. The sooner the correction is made, the less likely it will reoccur. Once you have
named a face one or more times, ACDSee may suggest this name in future faces. See the Suggestions
section below.

Faces can only be auto named if the Enable Auto Naming option is enabled.

Assigned names will allow you to search for images using the names of the people in them. You can do
this using the Search functions in Manage mode, as well as the People group in the Catalog pane. You
can also manage the names assigned to faces using People mode.

Face Detection is enabled by default. Face Detection is only available on supported image file types.

You cannot run Face Detection on files in unsupported locations, such as archives, phones,
and photo disks, or on files excluded from the database.

To Enable or Disable Face Detection:

Choose Tools | Options | Face Detection and check/uncheck the Enable Face Detection checkbox.

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23enable-auto-faces
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When you browse images in Viewmode, Face Detection will scan each image for faces as you open it.

To Open the Face Detection Pane:

Choose Panes | Face Detection.

Detected faces will appear in the Face Detection pane.

To Show Face Outlines:

In the Bottom Toolbar, click the Show Face Outlines button or press Shift + B.

To Name Detected Faces:

1. In the Bottom Toolbar, click the Face Tool button or press Shift + F.

2. In the field below the face outline, enter the name of the detected face.

3. Press Enter.

You can use Tab to move your cursor between name fields on the image, as well as on the Face
Detection pane.

To Edit Face Outlines:

1. In the Bottom Toolbar, click the Face Tool button or press Shift + F.

2. Use your cursor to move, expand, or contract the outline.

To Draw Outlines Around and Name Undetected Faces:

1. In the Bottom Toolbar, click the Face Tool button or press Shift + F.

2. Click and drag to draw a face outline on the image.

3. In the field below the face outline, enter a name for the face.

Outlining and naming undetected faces will not improve ACDSee's recognition of the
individual.

To Import Embedded Face Data From Lightroom or Picasa:

1. In View Mode, select AI | AI Face Detection | Import Lightroom or Picasa Face Data.

2. Your face data will import and the face data will be added to your database.
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When you import Lightroom or Picasa face data, it will overwrite any existing face data on the
image.

Suggestions

Once you have assigned a name one or more times, ACDSee may suggest this name for faces in future
images. Suggestions can improve themselves over time, and even assign themselves based on
similarity.

Faces can only be auto named if the Enable Auto Naming option is enabled.

You must select the Face tool in order to interact with suggestions in the main viewer.

To Deny or Confirm Suggestions:

Click the green checkmark to confirm the suggested name, or the red deny symbol to reject the
suggested name.

You can ignore incorrect suggestions without negative consequences. Denying a suggestion will not
affect suggestions on other photos. You can also edit suggestions in the name field and press Enter.

Using ACDSee AI Super-Resolution

AI Super-Resolution enhances the quality of your images by using advanced algorithms to intelligently
upscale lower-resolution photos. This feature increases the resolution and detail of your images,
making them sharper and more defined without compromising quality. Whether you're enlarging a
small photo or improving the clarity of a digital image, AI Super-Resolution helps you achieve
professional results with ease.

DirectX 12 feature level 12_0 or higher is required for AI Features to run on your GPU. You can
check your GPU's support level by running the dxdiag.exe tool and reviewing the Display tab

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23enable-auto-faces
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or by looking up your device's official specifications. If your GPU doesn't meet the
requirements, AI Features will still run using your CPU instead. Aminimum of 4GB VRAM is
required for GPU acceleration for AI Super-Resolution.

How AI Super-Resolution Works:

AI Super-Resolution enhances image quality by analyzing patterns, textures, and colors in the image. It
then applies a complex algorithm to upscale the image, reducing noise and blurriness, removing
artifacts, and adding pixels where necessary to maintain clarity and detail. This feature is especially
useful for enlarging small images or zooming into cropped photos.

Examples of when to use AI Super-Resolution:

l Enlarging low-resolution images for large prints or displays

l Enhancing cropped images to improve their quality

l Increasing the size of older photos taken with lower-resolution cameras

How to apply AI Super-Resolution:

To enhance your images with AI Super-Resolution, perform the following:

1. Find the image you want to enhance in Manage mode or View mode and do one of the following:

l Right-click it and select AI Features | AI Super-Resolution.

l Press Shift + Alt + S.

2. In the AI Super-Resolution dialog, choose your preferred settings. The preview will automatically
generate a new preview whenever parameters are changed so you can always see what it looks like in
real-time.

3. Click Enhance to apply Super Resolution to your image. The enhanced image will be saved by default
into the same folder as the original. You can adjust this setting within Options at the bottom of the
AI Super-Resolution dialog.



ACDSee Photo Studio Home 2026

Page 245 of 532

How to apply Batch AI Super-Resolution:

To enhance multiple images at once with AI Super-Resolution, perform the following:

1. Find the images you want to enhance in Manage mode and do one of the following:

l Select the images you want, right-click one of them and select Batch | AI Super-Resolution
| AI Super-Resolution.

l Select Tools | Batch | AI Super-Resolution | AI Super-Resolution.

l Right-click on an image and select Batch | AI Super-Resolution | AI Super-Resolution.

l Press Shift + S.
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2. In the Batch AI Super-Resolution dialog, choose your preferred settings. The preview will automatically
generate a new preview whenever parameters are changed so you can always see what it looks like in
real-time.

Only the first image selected will display in the Preview when using multiple images in
Batch AI Super-Resolution.

3. Click Enhance to apply Super Resolution to your images. The enhanced images will be saved by default
into the same folder as the originals. You can adjust this setting within Options at the bottom of the
Batch AI Super-Resolution dialog.

Settings:

There are five option settings that are available no matter which measurement mode you use:

Show Original Shows the original image before any modifications for quick comparison.

AI Strength
Adjust the slider to increase or decrease the amount of influence the AI has in the
enhancement.

Zoom Adjust the zoom of the current preview display.

Actual Size Sets the preview display to show the Actual Size of the image.

Fit Image Sets the preview display to fit the image within the preview window.

Resize Options:

There are five different resize options you can use to determine how big your image will become. For
more information, see Setting the AI Super-Resolution Options.

Percentage Includes Width (%), Height (%), and Preserve Original Aspect Ratio.

Size in Pixels
Includes Width (px), Height (px), Preserve Original Aspect Ratio, and Fit Within.

Fit Within includes: Width and Height, Width Only, Height Only, Width or Height (largest
image).

Print Size

Includes Width, Height, Units, Resolution (pixels per inch), Preserve Original Aspect Ratio,
and Fit Within.

Fit Within includes: Width and Height, Width Only, Height Only, Width or Height (largest
image).

Long Edge Includes Size (Pixels, Inch, cm, mm), and Resolution (pixels per inch).

Short Edge Includes Size (Pixels, inch, cm, mm), and Resolution (pixels per inch).
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Rotating Images

You can rotate images in Manage and Viewmodes using the Rotate icons in the bottom toolbar.

When you rotate unedited JPEG images, ACDSee performs a lossless rotation, meaning no
information is lost.

To Rotate Images:

1. In Manage mode or View mode, select one or more images.

2. Click the Rotate Left or Rotate Right icon in the bottom toolbar.

Rotate Icons

Rotate Left Rotates the image 90° to the left.

Rotate Right Rotates the image 90° to the right.

Using the Histogram

The Histogram is a graph that represents the distribution of color intensity for each color channel in an
image.

To Display and Use the Histogram:

1. In View mode, click Panes | Histogram, or View | Histogram in Edit mode.

2. On the Histogram, check or uncheck the following checkboxes:

l R: shows or hides the red color channel.

l G: shows or hides the green color channel.

l B: shows or hides the blue color channel.

l L: shows or hides the lightness of the image.

Viewing Images with Image Advance

Image Advance allows you to create a quick slideshow preview of a group of images, or of all the
images in a folder.

To Start Image Advance:
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1. Open a group of images in View mode.

2. Click View | Image Advance | Options.

3. In the Image Advance dialog box, set the options as described below.

4. Click Start.

5. To advance to the next image, press Space.

6. To return to the previous image, press Backspace.

7. To stop or restart Image Advance, press Pause.

Image Advance Options

Sequence Determines the order that you want to display your images. Select one of the following
options:

l Forward
l Reverse
l Random

Repeat Automatically restarts the slideshow after the last image has been displayed.

Delay Specifies how long to display each image. Drag the slider or type a time in milliseconds.

Sound Check the Play audio clips checkbox to play any audio embedded in the selected
images.

Displaying Text on Images in View Mode

You can use the Header/Footer tool to display text with your images in Viewmode. The text is
displayed while you are viewing the image, but does not modify the original image. You can also hide
the headers and footers without changing the settings.

To add text directly to your photos and save it as part of the image, see Adding text to an image.

To Edit Image Headers and Footers:

1. In View mode, click View | Edit Header/Footer.

2. Do one or both of the following:

l Check the Header checkbox to add text at the top of the image.

l Check the Footer checkbox to add text at the bottom of the image.

3. Select or change the text options as described below.

4. Click OK.

Text Options
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Alignment Specifies the justification of the captions.

Background Adds a background color to the text. Click Color to specify a color.

Description Displays the text you want to see on your images. Type the text you want
to appear, or click inside the field to set an insertion point for inserting
metadata.

Insert Metadata Inserts file-specific information into the text for each image.

Font Sets the font, size, and color of the caption text.

To Insert Metadata in Image Text:

1. Position the cursor in the Description text box where you want to display the file information and click
Insert Metadata.

2. In the Choose Properties dialog box, select the file information you want to include.

3. Click OK.

The information you added is inserted as a placeholder that will be replaced by the specific text for
each image.

Hiding Image Text

You can hide either the header or footer, or disable both at once without changing or deleting the
information in the header and footer fields.

To Hide the Image Text:

1. In View mode, click View | Edit Header/Footer.

2. Do one or both of the following:

l Uncheck the Header checkbox to remove text from the top of the image.

l Uncheck the Footer checkbox to remove text from the bottom of the image.

3. Click OK.

To show or hide both headers and footers simultaneously, click View | Show Header/Footer.

Selecting Part of an Image

You can use the Select tool in Viewmode to select a rectangular area of an image. You can then zoom
in on the selection, copy the selection, save the selection as a new image, print the selection, and use
the selection as the desktop wallpaper.
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To Select Part of an Image:

1. Click the Select Tool icon.

2. Drag the cursor across the image to create a marquee.

3. Right-click inside the marquee and select one of the options described below.

4. To cancel the selection, click an area of the image outside of the marquee.

Selection Options

Zoom To Zooms in on the selected area.

Copy Copies the selected area to the Clipboard.

Save Crop As Saves the selected area as a new image.

Print Prints the selected area.

Wallpaper
Centered

Creates desktop wallpaper using the selected area and centers it on your desktop,
shrinking it to fit if necessary.

Wallpaper Tiled Creates a tiled desktop wallpaper pattern using the selected area.

Viewing File Properties in View Mode

You can view an image’s properties in Viewmode and edit the information in the Properties pane.

To View an Image’s Properties:

In Viewmode, click Panes | Properties.

For more information about the Properties pane, and adding or editing ACDSee HomeMetadata, see
Using the Properties Pane.

Viewing and Using Brush Files

You can view brush files in Manage mode just like fonts or other files. This means that you can assign
ratings or organize them just like any other file in ACDSee. Because many .abr files are actually groups
of images in one file, you need to open them in Viewmode to see the individual images.

This icon indicates an .abr brush file in ACDSee.

To View Brush Files:
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In Manage mode, navigate to the folder containing your brush files.

l To see just the top image in any .abr file, hover over the thumbnail to activate the pop-up, or click it to
see the image in the Preview pane.

l To view the other images in the .abr file, double-click it to open it in View mode. The file opens in View
mode showing the individual images in a pane on the left-hand side.

l To see the number of images, and select them by number, click the down-arrow at the top of the
sidebar, and then select the number of the image.

l To scroll through the images, click the right and left arrows at the top of the sidebar, or on each image.

To Use Brush Files in Adobe Photoshop®:

With both Adobe Photoshop® and ACDSee Home open, drag the file from the File List (in Manage
mode) onto the Photoshop® window.

Even though nothing appears to happen, the brush is loaded into the Photoshop® brush library. To
view the new brushes, open the library and scroll to the bottom of the pane.

To make it even easier to use brushes in Photoshop®, you can configure it to be your default
editor. Then you can use Ctrl + Alt + X to open Photoshop® and use the brush right away.

Playing Video and Audio Files

You can play video or audio files in many formats in ACDSee. You can control playback volume, and
create an image from a video frame.

To Play Video or Audio Files:

In Manage mode, in the File List pane, do one of the following:

1. Double-click a video or audio file.

2. Select one or more files and press Enter.

3. Select one or more files, right-click a selected file, and then select View.

4. Use the Media toolbar to adjust the volume, pause, loop, or extract frames from playback.

Automatically Playing Audio and Video Files

You can configure your settings to play audio and video files automatically, as soon as you open them
in Viewmode, or as you view them in the Preview pane in Manage mode.

To Start Playing Media Files Automatically:
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1. In Manage mode or View mode, click Tools | Options | Preview.

2. Check the Autoplay audio or video clips checkbox.

3. Click OK.

The Media Toolbar

You can use the Media toolbar to quickly access common media viewing and editing tools.

Media Toolbar Buttons

Play Plays the media file or selection. Changes into the Pause button
when a media file or selection is playing.

Extract Frames Opens a menu you can use to copy, save, and extract video
frames.

Frames are extracted at the resolution you viewed
them at, (your screen resolution).

Loop Continuously plays the media file or selection.

Volume Mute Click to mute the playback volume, click again to play the
volume.

Saving Video Frames as Images

You can extract an individual frame from a video and save it as a still image.

To Extract and Save a Single Video Frame as an Image:

1. Do one of the following:

l Find the frame you want to capture and press Pause.

l Skip to step 2 as the exact frame you want to extract is playing.

2. On the Selection and media controls toolbar, click the Extract Current Frame button.

3. In the Extract Current Frame dialog box, select a folder in which to save your file.

4. In the File name field, type a filename.

5. Click the Save as type drop-down list and select a file format. You can click the Options button to select
or change any options associated with the file format.

6. Click Save.
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Adding or Editing Image Audio

ACDSee Home supports images with embedded audio and images with associated audio files.

Images with embedded audio are TIFF or JPEG images with audio saved inside the image file. You can
embed audio inside an image file by adding audio to the image.

Images with associated audio are image files paired with separate WAV audio files. Image files and their
associated audio files contain the same file name and are located in the same folder. You can associate
any WAV file with an image file by giving them the same name and placing them in the same folder, or
by adding audio to the image.

If you move or rename either an image file or the audio file associated with it, both files must
be renamed and in the same folder or they will no longer be associated. This does not apply to
images with embedded audio.

To Add Audio to an Image:

1. Do one of the following:

l Select an image in Manage mode.

l Open an image in View mode.

2. Click Tools | Image Audio | Edit.

3. In the Edit Audio dialog box, click the Browse button.

4. Select a WAV file and click Save.

5. If you would like to truncate or clip the audio file, check the Use markers checkbox, and drag the Start
marker and End marker sliders. Do one of the following:

l Click the Truncate button to remove the beginning and end of the audio file (the sections
outside of the start and end markers).

l Click the Clip button to remove the section of the audio file inside the start and end markers.

6. To hear a preview of the file, click the Play button.

7. Click OK.

Recording Audio to an Image

You can record your own audio files and add them to your images. When you add audio to a JPEG or
TIFF image, the audio is embedded in the image. With other file formats, the audio file is associated
with the image; the audio file is saved in the same folder and is played when the image is viewed.

To Record and Add an Audio File to an Image:
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1. Do one of the following:

l Select an image in Manage mode.

l Open an image in View mode.

2. Click Tools | Image Audio | Edit.

3. In the Edit Audio dialog box, select or change the Record sound settings options as described below.

4. Click Record and do one of the following:

l Use a microphone and record a sound.

l Play audio from an audio player on your computer.

5. Click Record to stop the recording.

6. Click Save As to save the audio file.

7. In the Save Sound File dialog box, type a name in the File name field, and then click Save.

8. Click OK.

Record Sound Settings Options

Capture device Specifies which of your computer's devices you want
to record the audio.

Input format Determines which sample rate and audio type are used
to record the sound. The formats displayed depend on
the sound card you have installed on your computer.

Overwrite Replaces the recorded audio from the Start marker
slider location.

Mix Combines the recording with the existing audio file.

Insert using start marker Inserts the recording at the start marker location. Drag
the Start marker slider to select a position.

Append to sound file Adds the recording to the existing audio file.

Replace sound file Replaces the entire audio file with the new recording.

Printing Images in View Mode

With the ACDSee Home print utility, you can print your images and files on any size of paper, in any
orientation, and at any resolution your printer can support. You can also use the print utility to create
and print contact sheets, complete with headers, footers, and captions specific to each image.
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As you change the options in the Print dialog box, you can view a dynamically updated preview of the
image or file and its position on the page. You can adjust the output size, print multiple copies, and
change the orientation on each page.

To Print a Single Image:

1. In View mode, select the image you want to print.

2. Click File | Print....

3. Under Format, choose a print size.

4. On the Printer Options tab, specify the printer you want to use, the paper size, the number of copies
you want, the range of pages that you want to print, and image resolution.

5. On the Page Settings tab, specify the image position on the paper and the margin widths, and specify
the number of prints of each photo.

6. On the Adjustments tab, adjust the settings to compensate for the way your printer handles exposure,
contrast, and sharpness.

7. Add captions, headers, or footers.

8. Click Print.

To Print All Images:

1. In View mode, click File | Print All....

2. Under Print layout, do one of the following:

l Select Full page and then choose a print size from the Format list.

l Select Contact sheet and then set the Contact sheet format options to define the appearance
of your contact sheet.

l Select Layout and then choose one of the available layout options.

3. On the Printer Options tab, specify the printer you want to use, the paper size, the number of copies
you want, the range of pages that you want to print, and image resolution.

4. On the Page Settings tab, specify the image position on the paper and the margin widths.

5. On the Adjustments tab, adjust the settings to compensate for the way your printer handles exposure,
contrast, and sharpness.

6. Specify the number of prints of each photo. If you are printing a Full page or a Contact sheet this option
is available on the Page Settings tab. If you are printing a Layout this option is available below the list of
layouts.

7. Add captions, headers, or footers. You can only add captions, headers, or footers if you are printing a
Full page or a Contact sheet.

8. Click Print.
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Setting an Image as the Desktop Wallpaper

You can select any image and set it as theWindows desktop wallpaper. You can also automatically
stretch a wallpapered image to fill the screen, or restore your previous wallpaper.

To Set an Image as the Desktop Wallpaper:

1. Do one of the following:

l In Manage mode, select an image, and then click Tools | Set Wallpaper.

l In View mode, click Tools | Set Wallpaper.

2. Select one of the following:

l Centered: places the image in the center of the screen. If the image is larger than the screen, it
is shrunk to fit.

l Tiled: places the image in a tiled pattern that fills the entire desktop.

l Stretched: stretches the image to fit the screen.

The selected image is saved as ACD Wallpaper.bmp in theWindows folder. ACDSee Home
automatically changes the wallpaper settings in the Control Panel Display properties to display the
image.

To Automatically Stretch Wallpapered Images to Fit the Screen:

1. Click Tools | Options.

2. In the Options dialog box, click General.

3. On the General page, check the Automatically stretch wallpaper to fit screen checkbox.

4. Click OK.

To Display the Previous Wallpaper:

Click Tools | Set Wallpaper | Restore.

Synchronizing View Mode to a Folder

You can use the Sync to Folder option to change the images being displayed in Viewmode.

To Synchronize to a Folder:

1. In View mode, click File | Sync To Folder....

2. Type the path to the folder you want to synchronize, or click the Browse button to locate the folder.
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3. Select or change the New Images options as described below.

4. Click OK.

New Images Options

Show new images immediately Displays images as soon as they appear in the folder. If
this option is cleared, new images are added to the end
of the slideshow.

Ignore open files Delays adding a new file to the slideshow until the
transferring application has finished moving or
downloading the file.

Sort by name Sorts the images displayed in the slideshow by their file
name.

To Stop Synchronizing to a Folder:

In Viewmode, click File | Sync To Folder....

Viewing Offline Images

ACDSee Home stores thumbnails and database information for images contained on CDs or other
removable media as Photo Discs. You can then browse the thumbnails and view the information for
those images even when the disc is not in your CD-ROM drive.

To Add a Photo Disc:

1. Place a disc containing images into your CD-ROM drive.

2. In Manage mode, click File | New | Photo Disc.

3. In the New Disc dialog box, type a name for your disc in the Title field, and then click OK.

You can then browse the contents of the Photo Disc in the Offline Media section of the Folders
pane.

If you add or remove images from a disc that you have already added to ACDSee Home as a
Photo Disc, you can update the information stored in the database. Insert the disc in your CD-
ROM drive, and then right-click the name of the disc in the Folders pane and select Update
Photo Disc.

By default, ACDSee Home identifies Photo Discs by their serial numbers. This is the most reliable
setting to use when working with Photo Discs, particularly if you are importing or converting Photo
Discs from previous versions of ACDSee.
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However, if you are working with, or planning to work with, multi-session discs, the serial number may
be regenerated or changed each time you change the contents of a disc. Therefore, the volume label is
the required method of identification for multi-session Photo Discs.

Rebinding Photo Discs

Depending on the method used to identify Photo Discs, ACDSee Homemay encounter a Photo Disc
that it does not recognize. This is most common when you are using the serial number method to
identify Photo Discs and you insert a multi-session disc. ACDSee Homemay not recognize the disc, as
serial numbers are likely to change when updating a multi-session disc.

You can use the Rebind option to update the identification information, and associate the correct
database information with your disc.

To Rebind a Photo Disc to its ACDSee Home Database Information:

1. In the Rebind Photo Disc dialog box, carefully review the Current disc information to be sure that the
correct disc is in the drive.

2. Select the Photo Disc record that you want to rebind to the current disc from the Photo Disc Name list.

3. Click Rebind.

Viewing Images in Another Application

You can open a file in another program from within ACDSee. For example, you can open documents in
the application used to create them.

To Use the Shell Open and Edit Commands:

1. In Manage mode, click File | Shell.

2. Select one of the following options:

l Open: opens the file using the application that Windows associates with its file extension.

l Edit: opens the file using the default system application, or opens a dialog box where you can
select an application.

Showing Originals

When you make changes to your images, the original image is saved so that you can restore the image
to its original settings.

To Show the Original Image:



ACDSee Photo Studio Home 2026

Page 259 of 532

1. In View mode, select an image that has been edited.

2. Click and hold the Show Original button in the bottom toolbar.

When you release the mouse button, the edited image is displayed.

Committing Changes

When you make changes to your images, the original image is saved so that you can restore the image
to its original settings. If you decide that you want to keep your edited image and save that as your
original image, you can commit the changes to the image. This deletes any sidecar files or originals that
have been saved, and removes the Edited overlay icon that indicates the image has been edited.

To Commit Changes to an Image:

1. In Manage mode or View mode, select an image that has been edited.

2. Click Tools | Commit Changes.

Changing Image Color Depth

You can modify an image's color depth in Viewmode. Color depth refers to the range of colors an
image contains.

To Change the Color Depth of an Image:

In Viewmode, click Tools |Modify | Change Color Depth, and select one of the options described
below.

Color Depth Options

Black and White Two-color black and white palette

16 Grays 16-color grayscale palette

256 Grays 256-color grayscale palette

16 Colors 16-color palette

256 Colors 256-color palette (GIF format uses 256 colors by default)

Hicolor 32,768-color palette

Truecolor 16,777,216-color palette of all colors visible to humans

You can use ACDSee Home to convert an image to any of these color depths. However, to use certain
image enhancement tools, filters, blends, and adjustment options, the image must be Hicolor or
Truecolor. To edit an image that is not originally Hicolor or Truecolor, you can convert it, edit the
image, and then convert it back to its original color depth.
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Zooming In and Out

In Viewmode you can use the Zoom tools to enlarge or reduce the size of the image you are viewing.
When an image is zoomed to a larger size than the Viewmode window, you can use the Scroll tool
(hand icon) to pan or scroll the image.

To Zoom an Image In or Out:

l Click once on the image to toggle between your default view and Actual Size view.

l Click Tools | Zoom, and then select one of the Zoom menu options.

Zoom Menu Options

Zoom In Increases the magnification of the image.

Zoom Out Decreases the magnification of the image.

Actual Size Displays the image at its original dimensions (100%).

Fit Image Displays the image at the largest magnification that fits in View mode window.

Fit Width Fits the image within the left and right sides of the View mode window.

Fit Height Fits the image within the top and bottom of the View mode window.

Zoom Lock Displays all images at the zoom option of the current image. If the zoom level is
adjusted, the new zoom level is applied to all images that you view.

Zoom To Opens a dialog box where you can select a zoom level.

Pan Lock Locks the panned area of an image.

If you select Fit Image you can display the previous or next image by pressing the left and right
arrow keys on your keyboard.

To change your default image view, click Tools | Zoom and select Actual Size, Fit Image
(standard), Fit Width, or Fit Height.

You can also quickly access the Zoom Lock on the Toolbar by toggling the Zoom Lock button.

Setting the Zoom Level

You can use the Set Zoom Level dialog box to set a specific zoom level in Viewmode.
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To Set a Specific Zoom Level:

1. Click Tools | Zoom | Zoom To...

2. In the Set Zoom Level dialog, select one of the following:

l Fit whole image: zooms the image to fit entirely within the window.

l Fit width: zooms the image to fit the width of the window.

l Fit height: zooms the image to fit the height of the window.

l Specify: specifies a zoom percentage. Type a number in the field or click the drop-down list and
select a zoom level.

3. To use this setting as the default View mode zoom level, check the Lock at this zoom level checkbox.
View mode displays all images based on the specified zoom level.

4. Click OK.

If you select Fit whole image you can display the previous or next image by pressing the left
and right arrow keys on your keyboard.

Automatically Shrinking or Enlarging Images

You can use the settings on the Display page of the Options dialog box to automatically enlarge or
shrink images to fit the size of the ACDSee Home window. For information about how the combination
of the choices affects the display of images, see the Zoom mode and Resize results table below.

To Automatically Shrink or Enlarge Images:

1. In Manage mode or View mode, click Tools | Options.

2. In the Options dialog box, click View mode | Display.

3. In the Zoom options area, select one of the following options from the Default zoom mode drop-down
list:

l Actual Size: keeps images at their original size.

l Fit Width: resizes images to fit the width of the View mode window.

l Fit Height: resizes images to fit the height of the View mode window.

l Fit Image: resizes images to fit the size of the View mode window.

4. Select one of the following options from the Resize drop-down list:

l Reduce Only: reduces large images to fit the size of the View mode window.

l Enlarge Only: enlarges smaller images to fit the size of the View mode window.
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l Reduce or Enlarge: reduces large images, and enlarges smaller images to fit the size of the
View mode window.

5. Click OK.

Zoom Mode and Resize Results

Fit Image Fit Width Fit Height

Reduce Only Reduces large
images to fit the
size of the View
mode window.

Images that are
smaller than the
View mode
window are
displayed at their
original size.

Reduces large images to
fit between the left and
right sides of the View
mode window.

Images that are smaller
than the View mode
window are displayed at
their original size.

Reduces large images to
fit between the top and
bottom of the View
mode window.

Images that are smaller
than the View mode
window are displayed at
their original size.

Enlarge Only Enlarges small
images to fit the
size of the Viewer.

Images that are
larger than the
View mode
window are
displayed at their
original size.

Enlarges small images to
fit between the left and
right sides of the View
mode window.

Images that are larger
than the View mode
window are displayed at
their original size.

Enlarges small images to
fit between the top and
bottom of the View
mode window.

Images that are larger
than the View mode
window are displayed at
their original size.

Reduce and
Enlarge

Reduces large
images and
enlarges small
images to fit the
size of the View
mode window.

Reduces large images
and enlarges small
images to fit between
the left and right sides of
the View mode window.

Reduces large images
and enlarges small
images to fit between
the top and bottom of
the View mode window.

If you select Fit Image you can display the previous or next image by pressing the left- and
right-arrow keys on your keyboard.

Using the Navigator to View Select Areas of an Image

Use the Navigator pane to display a thumbnail overview of images that are larger than the View
mode display area. In the Navigator, a marquee indicates the area of the image that is visible.
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To Display and Use the Navigator Pane:

1. In View mode, click Panes | Navigator.

2. Drag the slider to increase or decrease the magnification of the image in View mode.

3. Drag the marquee to the area of the image you would like to display in View mode.

To Use the Quick Navigator Pane:

1. In View mode, click and hold the Navigator button in the bottom toolbar.

2. Drag the marquee to the area of the image you would like to display in View mode.

Panning a Magnified Image

In Viewmode, you can pan large images by moving them vertically, horizontally, and diagonally across
the display area to view specific areas of the image. When an image is larger than the ACDSee Home
window and you use the Scroll tool, the cursor changes to a hand.

To Pan an Image:

Do one of the following:

l Drag the image to center the area you want to view.

l Press an arrow key. You can hold the Ctrl key to pan quickly, or hold the Shift key to pan more slowly.

Using Pan Lock

You can use the Pan Lock setting to automatically center the same area of a series of larger images in
Viewmode.

To Use Pan Lock:

1. In View mode, pan over a large image to a specific area you want to view.

2. Using the Zoom menu, zoom in on the image until you reach the magnification you want to use for all of
your images.

3. Click Tools | Zoom | Zoom Lock to keep the current zoom level.

4. Click Tools | Zoom | Pan Lock.

As you move through your images, each one will be automatically zoomed and panned to the
same area.

Magnifying Specific Areas of an Image

You can view specific areas of an image at a higher magnification in the Magnifying Glass pane.



ACDSee Photo Studio Home 2026

Page 264 of 532

To Use the Magnifying Glass Pane:

1. In View mode, click Panes |Magnifying Glass.

2. Move the cursor over an area of the image to view that area in the Magnifying Glass pane.

3. Change the Magnifying Glass pane settings by doing any of the following:

l Move the slider at the bottom of the Magnifying Glass pane to increase or decrease the
magnification.

l Check the Fixed checkbox to apply the slider setting to the original size of the image. Uncheck
the Fixed checkbox to apply the slider setting to the magnification of the zoomed image in View
mode.

l Check the Smooth checkbox to apply anti-aliasing to the magnified portion of the image, or
uncheck the Smooth checkbox to view the individual pixels. Anti-aliasing reduces jagged-lines,
also known as 'jaggies'.



ACDSee Photo Studio Home 2026

Page 265 of 532

Chapter 6: Edit Mode
Make your final edits in Edit mode, where you can apply fine-tuned adjustments on the more
limited RGB image data. Use the tools in Edit mode for any touch-ups to specific areas of your images.

In Edit Mode You Can:

l Use the Selection tools to select and apply edits to a specific part of the image.

l Use the Edit Brush

l Remove flaws, red eye, adjust skin tone.

l Add text, watermark, borders, vignettes, a tilt-shift, special effects, and drawing tools.

l Crop, flip, resize, and rotate.

l Adjust lighting using the Exposure, Levels, Auto Levels, Tone Curves, and Light EQ™ filters.

l Adjust color using the White Balance, Color EQ, Convert to Black & White, Split Tone, and Color LUTs
filters.

l Add details to your image using Sharpen, Blur, Remove Noise, Add Noise or Clarity filters.

Using Edit Mode

In Edit mode, you can use the editing tools to fine tune your image, remove red eye, and apply special
effects.

Editing an Image

To Edit an Image:

1. Select Edit mode.

2. Do any one or more of the following:

l At the top of the panel, use the Selections or Drawing tools.

l In the Enhance group, click Red Eye Reduction, Skin Tune or Repair Tool.

l In the Add group, click Text, Watermark, Borders, Vignette, Drawing tools, Tilt-Shift, Grain, or click
Special Effect and select an effect.

l In the Geometry group, click Rotate, Flip, Crop, or Resize.

l In the Exposure/Lighting group, click Exposure, Levels, Auto Levels, Tone Curves, Light EQ™ or
Dehaze.

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/About_Special_Effects.htm
file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/Adjusting_Split_Tone.htm
file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/About_Special_Effects.htm
file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/IDDH_EM_DEHAZE.htm
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l In the Color group, click White Balance, Color EQ, Convert to Black & White, and Color LUTs.

l In the Detail group, click Sharpen, Blur, Clarity, or click Noise to remove or add noise.

3. You have several options in saving your images. See Saving images in Edit for more information.

Reverting to Original Settings

You can discard your Edit settings and revert to the original settings for your image. For steps to revert
your image, see Restoring originals.

Histogram and Image Viewing Controls

While editing an image, you can adjust the magnification with the zoom controls, located in the
bottom right corner.
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Histogram Displays the histogram preview for the current
image. The histogram provides a graphical
representation of the intensity level of pixels
within each color channel. Spikes at either end
of the graph indicate clipped colors. Keeping the
histogram open is particularly useful when
adjusting exposure, as the histogram reflects all
adjustments as you make them.

You can also display the Histogram by selecting
View | Histogram.

Undo/Redo Undo to discard all changes made on the current
tab. Redo to return to the options that you had
selected prior to clicking Undo. In Edit, Undo
and Redo buttons display the changes you can
undo or redo.

Reset Click on the Reset button to reset the image to
its default settings.

Display Full Screen Displays the image on a full screen. Press F to
view full screen and to return to Edit mode.

Actual Size Returns the current image to its actual size.

Navigator Pane Automatic Window: when Automatic Window is
enabled, the Navigator pane appears as soon as
you zoom in on a photo. Drag your cursor to the
section of the image you would like to see
magnified. Release the cursor to settle on an
area of the image.

Right-click on the Navigator pane to
switch from Automatic to Manual.

Manual Window: when Manual Window is
enabled, you can view the Navigator pane by
selecting the Navigator icon. The Navigator
icon only appears when the image is magnified
or if the Actual Size icon has been clicked. Click
and hold the Navigator icon to display a small
duplicate of your image. Then drag your cursor
to the section of the image you would like to see
magnified. Release the cursor to settle on an
area of the image.
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Right-click on the Navigator icon to
switch from Manual to Automatic.

Fit Image Reduces the image to fit within the Edit mode
area.

Show Previous Toggles the changes on or off, to compare the
current image to the last saved version.

Zoom slider Increases the size of the image if you drag it to
the right, decreases the size if you drag to the
left.

Zoom drop-down list Displays a list of zoom sizes to select.

Using Color Pickers in Edit Mode

When you use the color pickers in Edit mode, the RGB and luminance values beside the color picker
relate to the image before any new and unsaved edits. You can see the up-to-date RGB values for the
image as edited in the status bar at the bottom of the screen.

Using Presets in Edit Mode

Many ACDSee Home editing tools and special effects allow you to save your settings as presets. This is
convenient when you frequently use the same settings for a particular tool or effect.

For most tools, ACDSee Home automatically saves the last option settings you applied to an image
when you clicked Apply or Done. This preset is called Last Used.

The Save Preset and Delete buttons are located at the top of an editing tool's panel.

To Save a Preset:

1. In Edit mode, select a tool and specify its settings.

2. Click the Save Preset button.

3. In the New Preset dialog box, enter a name for your preset, and then click OK.

The new preset will appear in the tool's Presets drop-down list.

To Use a Previously Saved Preset:

1. In Edit mode, select the tool for which you created the preset.

2. Click the Presets drop-down list and select the preset you want to apply.
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To Delete a Preset:

1. In Edit mode, select the tool for which you created the preset.

2. Click the Presets drop-down list and select the preset you want to delete.

3. Click the Delete button.

4. In the Confirm Delete dialog box, click Yes.

Using the Undo/Redo Button

You can undo and redo your changes when editing an image.

To Undo a Change:

In Edit mode, do one of the following:

l Click the Undo button found at the bottom of the left pane.

l Use the keyboard shortcut Ctrl + Z.

To Redo a Change:

In Edit mode, do one of the following:

l Click the Redo button found at the bottom of the left pane.

l Use the keyboard shortcut Ctrl + Y.

Restoring Originals

If you have committed changes to an image, you cannot restore the original.

You can discard all your changes and revert to the original image.

To Revert an Image Back to the Original in Edit:

In Edit mode, select File | Restore to Original.

To Revert an Image Back to the Original in Manage or View Mode:

1. Select the image.

2. Select Tools | Restore to Original.



ACDSee Photo Studio Home 2026

Page 270 of 532

Using the Edit Brush

While the tools in Edit mode allow you to make a variety of global adjustments, sometimes you may
only want to adjust specific areas of your photos. For example, instead of blurring an entire photo,
you may want to blur certain areas, such as the background. To do this, and other local adjustments,
you can use the Edit Brush.

The Edit Brush allows you to selectively edit your photo by simply brushing on the effects. The Edit
Brush is essentially creating a mask that is used to determine which pixels will be affected by the
current settings of the chosen operation.

Edit Brush

The Edit Brush button displays at the center of the top editing panel toolbar for all applicable Edit
mode tools.

To Use the Edit Brush:

1. In Edit mode, select the tool you want to use.

2. Click the Edit Brush button to enter Brushing mode and open the Brush controls. Or, toggle the
Brush panel open and closed with the B key.

3. Specify the brush settings in the panel or as you work as described in the table below.

4. Start painting the effects on your photo.

5. Adjust the sliders to get the effect you want.

6. Press Done to apply your brush strokes.

Edit Brush Controls
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Add brush stroke Brush while holding the left mouse button down.

Erase brush stroke Brush while holding the right mouse button down.

Nib Width Adjusts the size of the brush. You can use the mouse wheel to
adjust nib width or adjust the Nib Width slider.

Feathering Adjust the slider to control the softness of the transition between
the brush strokes and the image. Use Ctrl + mouse wheel to
adjust the amount of feathering or adjust the Feathering slider.

Pressure Adjust the slider to control the strength of the brush.

Alternating between Brush mode and
cursor-applied tools

For filters that involve drawing or clicking on the image, such as
Light EQ™ and White Balance, hold down the Alt key to switch
from Brush mode to using the tool.

Clear all brush strokes
Removes all brush strokes from the image.

Invert all brush strokes
Toggle this option to invert brushed strokes. This makes

brushed areas no longer brushed and untouched areas brushed.
This is useful if you want the majority of the image brushed and a
small section untouched. Simply brush only the small area you
don't want affected and invert the brush strokes.

Load last applied brush strokes
Applies effects to the area most recently brushed and

applied.

Show brush strokes

When this option is checked, your brush strokes will be displayed
in the color shown. This is helpful when brushing a complex area
with a subtle effect, as it can be difficult to tell if you have missed
a spot. Alternatively, hold down the S key to see your brush
strokes on the image.

When you click the Edit brush and enter Brushing mode, you need to apply brush strokes in
order to see any of your adjustments.

To exit Brushing mode, toggle the Edit brush button.

Creating Straight Lines:
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Hold the Shift key while using the Edit Brush to draw horizontal or vertical lines. For example, holding
Shift, then clicking and dragging horizontally will lock the cursor into horizontal only so long as shift is
being held. Release Shift to return to free hand brushing. You can even release Shift to return to free
hand brushing, then press it again while still drawing the same line to unlock and re-lock the brush at
will.

Creating Diagonal Lines:

Using the Edit Brush, you can create straight diagonal lines by placing two points on the image. Place
the cursor where you want the line to begin, press and hold Shift, then Left-Click on the image to
create a point. Let go of Shift, and move the brush to where the line will end, press and hold Shift,
then Left-Click again to create a second point. A straight line will fill in between these two points.

The Edit Brush is enabled in many of the editing tools and special effects filters. When it does not make
sense to have this option, it is omitted. The Edit Brush is not available in the following tools: Crop,
Resize, Rotate, Flip, Text, Red Eye Reduction, Repair Tool, and Selections.

Using the Gradient Tool

While the tools in Edit mode allow you to make solid, global adjustments, sometimes you want these
effects to gradually progress over your photo. For example, instead of applying a blur across an entire
photo, you may want a blur that advances across the image, or advances over a section of the image.
Use the Gradient tool to gradually progress an effect across an image.

Gradient Tool

The Gradient tool button displays at the center of the top Editing panel toolbar for all applicable Edit
mode tools.

To Use the Gradient Tool:

1. In Edit mode, select the tool you want to use.

2. Click the Gradient tool button to enter Gradient mode. Or, toggle the Gradient panel open and
closed with the G key.

3. Specify the gradient settings in the panel or as you work, as described in the table below.

4. Position the guides on your photo. Inside the guide boxes, the gradient is transitioning. On either side of
the boxes, the effect being applied by the Gradient tool is at full strength or not applied at all. To make
this clearer, check the Show gradient mask checkbox. Move the boxes to define where the effect will
begin or end. Hold down the Shift key while positioning the effect to lock to the nearest 45° angle, for
straightness.

5. Adjust the sliders to get the effect you want.

6. Press Apply or Done.
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Gradient Tool Options

Invert gradient
Toggle this option to invert the gradient. By pressing the

Invert button after applying a gradient beginning at the top of the
image, the gradient would now begin at the bottom, and vice
versa.

Show gradient mask

When this option is checked, your gradient mask will be displayed
in the color shown. Alternatively, hold down the S key to see the
mask on the image. Click the drop-down arrow to select another
display color.

Alternating between the Gradient
tool and cursor-applied tools

For filters that involve drawing or clicking on the image, such as
Light EQ™ and White Balance, hold down the Alt key to switch
from Gradient mode to using the tool.

To exit Gradient mode, toggle the Gradient tool button.

To maintain your gradient mask while switching to Edit Brush mode, hold down Shift and click
the Edit Brush button. This allows you to add to the gradient mask or erase parts of it that you

don't want.

The Gradient tool is enabled in many of the editing tools and special effects filters. When it does not
make sense to have this option, it is omitted. The Gradient tool is not available in the following tools:
Resize, Crop, Rotate, Drawing Tools, Vignette, Borders, Text, Repair Tool, Red Eye Reduction, and
Selections.

Using the Radial Gradient Tool

While the Edit tools allow you to make a variety of adjustments, sometimes you want these effects to
draw attention to a specific area of your photo. For example, instead of applying sharpening across an
entire photo, you may want to only sharpen the center subject. Use the Radial Gradient tool to apply
effects around, or directly to, a center point.

Radial Gradient Tool

The Radial Gradient tool button displays at the top of the Editing panel toolbar for all applicable Edit
mode tools.

To Use the Gradient Tool:
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1. In Edit mode, select the tool you want to use.

2. Click the Radial Gradient tool button to enter Radial Gradient mode. Or, open and close the Radial
Gradient panel with the R key.

3. Specify the Radial Gradient settings in the panel or as you work, as described in the table below.

4. Position the guides on your photo. Inside the circle, the image is unaltered. At the perimeter of the
circle, the effect being applied by the Radial Gradient is transitioning between not applied at all (inside),
and full strength (outside). To make this clearer, check the Show gradient mask checkbox. Hold down
the Shift key while positioning the effect to change the radial gradient to a perfect circle.

5. Adjust the sliders to get the effect you want.

6. Press Done.

Gradient Tool Options

Invert gradient
Toggle this option to invert the radial gradient. By pressing the

Invert button, the effects will be applied to the center of the image
(inside the circular guides), and outside of the radial gradient will
be unaltered.

Show gradient mask

When this option is checked, your radial gradient mask will be
displayed in the color shown. Alternatively, hold down the S key to
see the mask on the image. Click the drop-down arrow to select
another display color.

Alternating between the Radial
Gradient Tool and cursor-applied
tools

For filters that involve drawing or clicking on the image, such as
Light EQ™ and White Balance, hold down the Alt key to switch
from Radial Gradient mode to using the tool.

To exit Radial Gradient mode, toggle the Gradient tool button.

To maintain your radial gradient mask while switching to Edit Brush mode, hold down Shift
and click the Edit Brush button. This allows you to add to the gradient mask or erase parts of it

that you don't want.

The Radial Gradient tool is enabled in many of the editing tools and special effects filters. When it does
not make sense to have this option, it is omitted. The Radial Gradient tool is not available in the
following tools: Resize, Crop, Rotate, Drawing Tools, Vignette, Borders, Text, Repair Tool, Red Eye
Reduction, and Selections.
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Using Blend Modes and Opacity

When using a tool in Edit, there are blend mode and opacity tools. These tools give you creative
control and let you combine the two to create a new image. You can apply blend modes and opacity to
an entire image or to a selected part of an image.

Opacity

The Opacity slider changes the opacity of the edited image. It gives you control of howmuch of the
edit should be visible on the image.

Blend Modes

The ability to control how the edits and the image merge means that other blend modes besides
opacity can be used to affect the final image.
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Normal Pixels in the edited image are combined with those in the original. Only
opacity affects this blend.

Screen Combines the edited image color with the inverse of the original photo color,
resulting in a color that is the same or lighter.

Multiply Combines the edited image color with the original photo to produce a darker
color. Multiplying any color with black produces black; multiplying any color
with white leaves the color unchanged.

Dodge Combines the edited image color with the original pixels in the photo to
produce a lighter color.

Burn Combines the edited image color with the original pixels in the photo to
produce a darker color.

Overlay Preserves the shadows and highlights of the lower layers while applying either
Multiply or Screen blend mode based on the original image area's color
values.

Difference Subtracts the edited image color from the color of the original photo. Any
white in the edited image produces a true negative of the color in the image,
while black produces no effect.

Darken Applies pixels in the edited image that are darker than the original image.
Pixels in the edited image that are lighter than the original image disappear
(based on RGB values).

Lighten Applies pixels in the edited image that are lighter than the original image.
Pixels in the edited image that are darker than the original image disappear
(based on RGB values).

Hard Light Adds strong highlights or shadows by applying Multiply or Screen based on the
original image area's color values.

Soft Light Adds soft highlights or shadows by darkening or lightening based on the
original image area's color values.

Hue Applies the hue value of colors in the edited image to the color of the original
image areas.

Saturation Applies the saturation value of colors in the edited image to the color of the
original image areas.

Color Applies the hue and saturation of the edited image to the image. This blend
does not affect the luminance of the original image.

Luminosity Applies the lightness value of colors in the edited image to the color of the
original image areas.



ACDSee Photo Studio Home 2026

Page 277 of 532

Dissolve Applies some pixels from the edited image layer onto the original image,
resulting in specks of color. The Opacity slider controls the amount of
speckling.

Exclusion Like Difference, but with less contrast, Exclusion subtracts the blend color
from the color of the underlying photo. Any white in the blend color produces
a true negative of the color in the image, while black produces no effect.

Vivid Light Combines the blend color with the underlying pixels in the photo by
increasing or decreasing contrast to produce a lighter or darker color, as
determined by the blend color.

Pin Light When the light source is lighter than 50% gray, the pixels darker than the light
source are replaced. Pixels lighter than the light source remain the same.
When the light source is darker than 50% gray, the pixels lighter than the light
source are replaced. Pixels darker than the light source remain the same.

Linear Light Dodges or burns by lightening or darkening the brightness value, depending
on the blend color.

Hard Mix Applies red, green, and blue channel values of the blend color to the RGB
values of the image.

Subtract Subtracts the blend color from the image (base) color in each channel.

Divide Divides the blend color from the image (base) color.

Darker Color From the blend color and the image (base) color, the lower channel values are
chosen.

Lighter Color From the blend color and the image (base) color, the higher channel values
are chosen.

You can use the Edit Brush to paint an effect onto specific areas of your image, and
then set the blend mode and opacity slider to change the way the effect is applied.

The blend mode and opacity controls apply to many of the editing tools and special effects filters.
When it does not make sense to have these controls, they are omitted. The blend mode and opacity
controls are not on the following tools: Crop, Resize, Rotate, Flip, Text, Red Eye Reduction, Repair
Tool, Selections.
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Saving Images in Edit Mode

Saving Images

When you have finished editing an image, you can choose from one of the many options for saving
your image, depending on what you want to do next.

To Save the Image and Return to the Mode You Were in Previously:

1. Click Done.

2. Select one of the following:

Save Save your changes.

Save as Save a copy of your edited image with a new name or format.

Depending on your file type, any of the following checkboxes appear in the bottom left
corner of the Save as dialog box:

l Preserve Metadata: retains metadata with the new image.

l Preserve database information: maintains your catalog information, such as
ratings.

l Embed Color Profile in Image: retains color profile selected in Color Management
with your new image.

Discard Discard your changes.

Cancel Remain on the same image, with your changes intact, without saving the image.

AutoSave You can enable AutoSave in order to avoid selecting a saving option each time you finish
with an image. When AutoSave is enabled, pressing Done, or selecting another image
from the Filmstrip will prompt ACDSee to automatically save your changes in Edit mode.
You will no longer see the Save Changes dialog. To disable AutoSave, choose Tools |
Options... In the Options dialog, click Edit Mode. Then uncheck the AutoSave all changes
checkbox.

AutoSave is not available for RAW images.

To Save the Image and Continue Processing Other Images:
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1. Click Save.

2. Select one of the following:

l Save: save your changes.

l Save As: save a version of your edited image with a new name or format and switch to the
updated image.

l Save a Copy: save a copy of your edited image with a new name or format, and continue to
work on the original file.

Save a Copy is useful for making multiple versions of an image while continuing to work from
the original file instead of a new processed copy. For example, if you take a RAW image and
save a copy of it as a JPG, instead of switching to this lossy JPG image, you remain on the RAW
file with the settings still intact.

Save is not available for RAW file formats because you cannot directly save changes to a RAW
file.

To Discard Changes to the Image and Return to the Mode You Were in Previously:

Click Cancel or use the keyboard shortcut Esc.

Using Selections

Use Selections to isolate an area of a photo in order to apply edits or filters to only that area, rather
than the whole photo. There are four different selection tools and each selects an area of a photo in a
unique way. The controls available change depending on which tool you select.

To Use a Selection Tool:

1. In Edit mode, at the top of the panel, select the button for one of the following selection tools:
Rectangular selection tool, Elliptical selection tool, Lasso selection tool, Magic wand selection tool. See
below for more detailed steps for using these tools.

You can use Selections with the following Edit tools:

l Enhance: Skin Tune

l Add: Vignette, Special Effects, Tilt-Shift, Drawing tools, Grain

l Exposure/Lighting: Exposure, Levels, Auto Levels, Tone Curves, Light EQ™

l Color: White Balance, Color EQ

l Detail: Sharpen, Blur, Noise, Clarity, Chromatic Aberration
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The Selection Tools

l Freehand Lasso: click the left mouse button and drag the cursor to draw around the area that you
wish to select. As you draw, a line appears showing where you have drawn. When you release the
mouse, the end of the line joins to the start automatically to complete the selection. The whole
selection animates and looks like marching ants.

l Magic Wand: click on any area of the image and all the pixels the same color are included in the
selection. You can choose whether to select only the same color pixels that are actually touching the
one you clicked, or all the pixels in the photo that are similar. You can increase the threshold to include
more pixels in the selection. The lower the threshold, the more similar a pixel has to be to the one
clicked in order to be included. The greater the threshold, the more different a pixel can be and still be
in the selection.

l Rectangular or Elliptical: click and drag either a rectangle or an ellipse that begins where
you first click and ends when you release the mouse. Hold Shift when using the Rectangular Selection
tool to make it into an equilateral Square shape, or while using the Elliptical Selection tool to make it
into an equilateral Circular shape.

Using the Selection Tools

To Use the Lasso:

1. Select the Lasso button.

2. On the image, click and hold down the left mouse button as you draw around the area you want to
select.

3. Release the mouse button to complete the selection.

4. To clear the selection, click anywhere on the image (for the Lasso , Rectangular, or Elliptical selection).

5. To add to an existing selection, hold down Shift, or press the Add to selection button in the Context bar,
and draw a shape that includes any part of the original selection line.
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When you release the mouse, the original selection expands to include the outer edge of your
addition.

6. To add multiple areas into your selection, hold down Shift, or press the Add to selection button in the
Context bar and draw around any part of the image.

As long as you do not touch the line of any other selection, you can add several separate areas
to a selection.

7. To subtract from a selection, hold down Ctrl, or press the Subtract from selection button in the Context
bar, and draw a shape that includes part of the original selection, or encircles it completely.

8. If you wish to apply edits or effects to the outside areas of the image, you need to click Select | Inverse
to reverse the selected area.

Now the selection includes all the outside areas of the image with the central area outside the
selection.
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You can preview the selection mask by holding down the Preview button:

You can select an editing tool or a special effect to apply to the selection.

To Use the Magic Wand:

1. Select the Magic Wand button.

2. Click any color in the image.

3. Do any of the following:

l Slide the Threshold slider to adjust the number of pixels to be included or excluded. The
Threshold slider sets how similar a pixel needs to be to the one you clicked in order to be
included in the selection.

l Click the Connected checkbox if you want to include only pixels that are touching the one you
clicked.

l Hold down Shift and click around the selection to include more pixels.

l Hold down Ctrl and click around the selection to remove pixels from the selection.

4. From the Wand type drop-down list, select one of the following:

l Brightness: selects pixels similar in brightness to the area of the image you clicked.

l Color: selects pixels similar in hue and brightness to the area of the image you clicked.

Color is generally your best option.

l RGB: selects pixels with red, green, and blue combination similar to the area of the image you
clicked.

You can preview the selection mask by holding down the Preview button:

You can select an editing tool or a special effect to apply to the selection.

To Use the Rectangular or Elliptical Selection Tool:
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1. Select either the Rectangular or Elliptical button.

2. Click and drag to draw the selection on the image.

3. Do any of the following:

l To add to an existing selection, hold down Shift, or use the Add to selection button , and drag
another selection that includes any part of the original selection line. Release the mouse and
the selection now includes the additional area.

l To add multiple areas to your selection, hold down Shift and drag as many as you want.

l To subtract from an existing selection, hold down Ctrl, or use the Subtract from selection
button , and drag another selection that intersects with the one you want to reduce. Release
the mouse and any part that was inside the new selection is removed.

You can preview the selection mask by holding down the Preview button:

You can select an editing tool or a special effect to apply to the selection.

Combining the Tools

You can use the Selection tools separately or in combination. For example, you can use the Magic
Wand to select most of a particular color, then switch to the Freehand Lasso to add to, or subtract
from, the selection. Or you could use the Rectangular selection to select a large general area, then
refine it using the Freehand Lasso.

To Combine Selection Tools:

1. Choose a tool and make a selection.

2. Switch to another tool.

3. Press the Add to selection button.

4. Make another selection.

Saving Selections as Presets:

You can save your settings as a preset for future use. After you have made a selection, click Select |
Save Selection...

To use a previously saved selection, click Select | Load Selection...

To delete a saved selection, click Select |Manage Selections...

Applying Edits or Effects to Selections

You can use the Selections tools to isolate an area of an image. Once selected, you can apply many of
the editing tools, such as color and exposure, or any of the special effects filters, to the selected area.
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An active selection in an image looks like a line of marching ants.

To Apply an Edit or Effect to a Selection:

1. Use the Selections tools to create a selection.

2. Select a tool to use from any of the following groups:

l Exposure/Lighting

l Color

l Detail

l Add (Special Effects)

Ensure that the Use Selection button adjacent to the Feathering slider is toggled on.

3. Use the tool to edit the image.

Use Any of These Special Selections Options:

Use Selection Click to use the selection or apply the edit or effect to the
whole image. This control means you can edit just the
selection, then deselect Use Selection and apply another
edit to the whole image without clearing the selection.

Invert Selection Click to invert the selection.

Feathering Drag to increase or decrease the blurring between the
edge of the selection and the edit or effect.

Feathering prevents an unnatural or sharp transition
between the selection and the rest of the image as it
blends the edges. This control also makes it unnecessary
for your selection to be perfectly on the edge of the area
you want to select.

Show/Hide Selection Click to show or hide the marching ants around the
selection. Hiding the selection line makes it easier to judge
the effect of various effects. Press Ctrl + Alt + Z to enable
or disable.

Reducing Red Eye

You can use the Red Eye Reduction tool in Edit mode to correct red eye in digital photographs.

To Correct Red Eye:
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1. In Edit mode, in the Enhance group, select Red Eye Reduction.

You can also access the Red Eye Reduction tool from the Filter drop-down menu or Filter
toolbar.

2. Use the Zoom tools in the bottom right corner to enlarge and center the eye you want to correct.

3. Click within the red portion of the eye.

4. In the Red Eye Reduction group, adjust the sliders as described below.

Red Eye Reduction Options

Size
Drag the slider to the right to increase the size of the area being darkened, or to the
left to decrease.

Darkening Drag the slider to the right to intensify the fill color, or to the left to lighten.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

You can right-click a slider to reset to the default value.

Scroll with your mouse to adjust the size of the area you would like to darken at anytime.

You can show or hide the outline of the darkened area by checking or unchecking the Show
Outline checkbox.

Press Delete to remove the currently selected red eye adjustment.

Removing Flaws

You can use the Repair Tool to remove flaws, such as:

l Skin blemishes

l Telephone wires and other unwanted objects

l Flash flares from snowflakes or windows

l Lens scratches and water drops

There are two options available for the Repair Tool: the Healing Brush, and the Cloning Brush.

Heal: when you select the Healing Brush, the Repair Tool copies pixels from one area of a photo to
another, but it analyzes the pixels in the source area before copying them. It also analyzes the
pixels in the target area, and then blends the pixels of both source and target, to match the
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surrounding area. This ensures that the lighting and color of the replacement pixels integrate with
the surrounding area. The Healing Brush works particularly well with photos that involve
complicated textures, like skin or fur.

Clone: when you select the Cloning Brush, the Repair Tool copies the exact pixels from one area of a
photo to another, creating an identical image area. The Cloning Brush is more effective for photos
that have strong, simple textures or uniform colors, as it is more difficult to identify the copied
pixels in the finished photo.

You can save your settings as a preset for future use.

To Remove Flaws from a Photo:

1. In Edit mode, in the Enhance group, select Repair Tool.

You can also access the Repair Tool from the Filter drop-down menu or Filter toolbar.

2. Select one of the following:

l Heal: copies the pixels from the source area to the target area, and blends pixels into the
surrounding image area.

l Clone: copies the pixels from the source area to the target area.

3. Drag the Nib Width and Feathering sliders as described in the table below.

4. Right-click the image to set a source location. Pixels will be copied from this location and used in the
target location.

5. Click and drag over the area that you want to cover. If you selected the healing brush, ACDSee Home
analyzes and replaces the pixels when you release the mouse button.

6. Do one of the following:

l Click Done to apply your changes and close the tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to reset the sliders. If you saved your changes, you cannot reset your settings.

Scroll with your mouse to adjust the brush sizeas you work, or press the Shift key while you
scroll to adjust feathering.

Drawing Straight Lines:

Hold the Shift key while using any of the repair tools to draw horizontal or vertical lines. For example,
holding Shift, then clicking and dragging horizontally will lock the cursor into horizontal only so long as
shift is being held. Release Shift to return to free hand brushing. You can even release Shift to return
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to free hand brushing, then press it again while still drawing the same line to unlock and re-lock the
brush at will.

Drawing Diagonal Lines:

Using the any of the repair tools, you can create straight diagonal lines by placing two points on the
image. Place the cursor where you want the line to begin, press and hold Shift, then Left-Click on the
image to create a point. Let go of Shift, and move the brush to where the line will end, press and hold
Shift, then Left-Click again to create a second point. A straight line will fill in between these two points.

Repair Tool Options

Nib Width Sets the width of the brush. The maximum brush width is
relative to the size of your image.

Feathering Sets the amount to feather on the edge of the brush to prevent
sharp transitions between the original and healed part of the
photo.

Feathering is set as a percentage of the nib width, not as a
specific number of pixels. This means that you do not have to
adjust the feathering when you reset the Nib Width, as it
automatically adjusts to a percentage of the new nib width.

Pressure After setting a source point for the Clone tool, adjust the slider
to control the strength of the effect being applied.

Show preview in cursor Check this checkbox to display a preview of your selected
source point in the cursor.

You can right-click a slider to reset to the default value.

Adjusting Skin Tone

You can use the Skin Tune tool to even skin tone and smooth away blemishes and flaws.

To Correct Skin Tone:

1. In Edit mode, in the Enhance group, select Skin Tune.

You can also access the Skin Tune tool from the Filter drop-down menu or Filter toolbar.

2. On the Skin Tune panel, adjust the settings as described below.
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3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Skin Tune Options

Smoothing Refines skin by suppressing texture detail.

Glow Increases the brightness of skin while subtly smoothing.

Radius Specifies the scale of the texture detail that is affected by the effect. A lower value
enhances small details, while a large value enhances larger details.

Adding Drawings to Your Image

You can use the Drawing Tools in Edit mode to add lines and shapes, such as squares, circles, and
arrows to your image. You can also adjust the width, feathering, and blending of your brush, which is
useful for creating subtle and dramatic drawings.

To Draw on Your Image:
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1. In Edit mode, at the top of the panel, select from the following tools:

Hand

Use the Hand tool to exit out of any other drawing or selection tool. If you have
a scrollable image, the Hand tool also allows you to pan it.

Rectangle

Drag over the image to create rectangle. Press Shift as you draw to create a
square. To fill your shape with color, ensure that the Fill checkbox is checked.

Ellipse

Drag over the image to create an ellipse. Press Shift as you draw to create a
circle. To fill your shape with color, ensure that the Fill checkbox is checked.

Line

Drag over the image to draw a straight line. Press Shift as you draw to create a
vertical or horizontal line.

Arrow

Drag over the image to create an arrow. Press Shift as you draw to create a
vertical or horizontal arrow.

Polygon

Click to set the corner points of a polygon, then double-click to connect the
start and end points to complete the polygon. To fill your shape with color,
ensure that the Fill checkbox is checked.

Curve

Drag over the image then release. Next, move your mouse to create the curve
and click to set.

Brush

Drag over the image to draw a free-flowing line. Left-click with your mouse to
draw with the foreground color, and right-click to draw with the background
color.

Use the Opacity slider to adjust the amount of Opacity that is applied to the
canvas.

Use themouse wheel to adjust nib width or use the Size slider at
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the top of the panel.

You can undo and redo each brush stroke individually using the
Undo and Redo buttons at the bottom of the Filter Menu.

Fill

Select the Fill button, and click on a pixel to shade every pixel of that same color
value with your selected color. Your selected color is defined in the color box,
as described below. Use the Threshold slider to adjust the number of pixels to
be included or excluded. The Threshold slider sets how similar a pixel needs to
be to the one you clicked in order to be included in the selection. Check the
Connected checkbox in the Context Bar to fill all of the connected pixels of the
same color.

Gradient

Use the Gradient tool to draw gradients across your image, or use the radial
option to draw a gradient around an area. Select the Gradient tool, then
configure your color, opacity and blend mode using the Context bar. For a radial
gradient, select the Radial Gradient button in the Context bar. Then draw your
gradient by dragging across the image. To discard your gradient, press the
Discard button in the Context bar. Rearrange your gradient as desired, then
press the Commit button in the Context bar. You can undo your commit by
pressing Ctrl + Z or selecting Edit | Undo.

Eye Dropper

Use the Eye Dropper tool to select colors from your images. Click a color in the
image, which will appear in the color boxes at the top right of the panel. You
can then apply this color using the drawing tools, such as the Brush tool.

You can select the background color (bottom of the color boxes) by right-
clicking on your image.

You can select a color from outside of the application by left-clicking on your
image and dragging your cursor to the color outside of the application. When
you release your mouse button, the color will be selected and shown in the
color boxes at the top right of the panel.

Eye Dropper also displays the luminance value of the highlighted pixel.

2. Select from one or more of the following options (Note: options vary depending on the tool
selected):
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Color

Select a color by clicking the color boxes at the top right of the panel to open the
Foreground or Background Color dialog, which displays a dialog of swatches to
choose from. If you are drawing a solid shape, such as a rectangle, the top
(foreground) color box defines the color for the outline of the shape. The
bottom (background) color box defines the color that fills the center of the
shape. If you want your shape to be a solid color, set both color boxes to match.

You can reset to black and white by pressing the reset button
directly next to the color boxes.

Nib Width

Drag the Nib Width slider to set the diameter of the brush measured in pixels.
You can also adjust the nib width with the mouse wheel or by right-clicking on
the image to reveal the Nib Width sliders.

Feathering

Select the Nib Width button to reveal the Feathering slider. Drag the Feathering
slider to set the blurring radius of the brush. You can also right-click on the image
to reveal the Nib Width and Feathering slider. Or, you can also hold down Shift
while using the mouse wheel to adjust the feather radius, represented by the
dotted circle.

Spacing

Drag the Spacing slider to set how far apart each brush segment will be. This
slider specifies the percentage of the size of the nib width, which determines
how smooth or choppy the strokes will appear.

Use Auto Spacing: check the Use Auto Spacing checkbox to allow ACDSee to
choose a spacing percentage based on the nib width and feathering settings,
which will create a smooth-looking stroke.

Fill

Check the Fill checkbox to fill the shapes you draw with the selected color.

Opacity

Drag the Opacity slider to specify the transparency of the brush strokes.

Blending

Select an option from the Blending drop-down menu to affect how your brush
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strokes blend with your image as you draw.

3. Drag over the image to draw.

You can right-click a slider to reset to the default value.

Drawing Straight Lines:

Hold the Shift key while using any brush to draw horizontal or vertical lines. For example, holding
Shift, then clicking and dragging horizontally will lock the cursor into horizontal only so long as shift is
being held. Release Shift to return to free hand brushing. You can even release Shift to return to free
hand brushing, then press it again while still drawing the same line to unlock and re-lock the brush at
will.

Drawing Diagonal Lines:

Using any brush, you can create straight diagonal lines by placing two points on the image. Place the
cursor where you want the line to begin, press and hold Shift, then Left-Click on the image to create a
point. Let go of Shift, and move the brush to where the line will end, press and hold Shift, then Left-
Click again to create a second point. A straight line will fill in between these two points.

Adding Text to an Image

You can use the Add Text tool in Edit mode to add formatted text to a photo, or add talk and thought
bubbles to create a comic-book effect. You can also adjust the opacity of the text to create a
watermark effect, which is useful for putting copyright information onto your photos.

You can save your settings as a preset for future use.

To Add Text to an Image:

1. In Edit mode, in the Add group, select Text.

You can also access the Text tool from the Filter drop-down menu or Filter toolbar.

2. Type the text you want to add in the Text field.

3. In the Font area, specify the font you want to use, the formatting options, such as italics or justification,
and the color of the text. Drag the Size slider to specify a point size, and then drag the Opacity slider to
specify the transparency of the text.

4. Click and drag the text marquee to reposition it anywhere on your image, or drag the marquee's
handles to resize it.

5. Select an option from the Blend Mode drop-down list to specify how you want the text to blend into the
underlying image.

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/About_blend_modes.htm
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6. Do one of the following:

l Check the Bubble Text checkbox, and set the Bubble Text settings as explained in the table
below. Note that other text effects cannot be applied to bubble text.

l Check one or more of the Effects, Drop Shadow, and Bevel checkboxes to customize your text.
Click the Settings button to adjust the settings for each of these options as explained in the table
below.

7. Do one of the following:

l Click Apply to add the text to your image, and keep the Text tool open so you can add more
text. The Text tool creates a new, empty marquee, and you can return to step 3 in the list
above.

l Click Done to add the text to your image, and leave the tool. If you still have an empty marquee
open, it will be discarded.

l Click Cancel to discard your changes and leave the tool.

Add Text Options
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Bubble Text Settings

Talk Encloses your text in a comic-book text bubble with a pointed stem.

Thought Encloses your text in a comic-book text bubble with a dotted stem.

Stem Angle Specifies the direction of the text bubble stem. Drag the arrow to adjust
the angle.

Thickness Specifies the thickness of the text bubble border.

Length Specifies the length of the text bubble stem.

Fill Specifies the background color of the text bubble. Click the arrow to select
a color.

Border Specifies the color of the text bubble border. Click the arrow to select a
color.

Effect Settings

Effect Specifies the effect you want to apply to your text. Each effect has different
options that control its appearance. Drag the sliders to adjust the
appearance of the text.

Drop Shadow Settings

Distance Specifies the distance between the drop shadow and the text. The higher
the value, the farther the shadow and the higher the text appears.

If a drop shadow is cut off, or has a noticeably sharp edge, you may need to
increase the size of the text rectangle.

Blur Specifies the amount of blur applied to the drop shadow. Sharp shadows
tend to seem less realistic than those with a slight blur.

Opacity Specifies the darkness of the drop shadow where it falls on the image.

Angle Specifies the direction of the imaginary light source that creates the drop
shadow. Drag the arrow to adjust the angle — note that this also adjusts the
shading of the text bevel.

Bevel Settings

Bevel Specifies how much of each letter's edge is bevelled. Higher values give
the text a more rounded, smoother look.

Strength Specifies the difference between the highest and lowest points on the text.
Higher values heighten the difference between the flat portions of the text
and the bevelled edges.
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Elevation Specifies the height of the imaginary light source that creates the bevel's
shadowed effect. Lower values produce longer shadows on the text, while
a higher value produces a more direct lighting effect and shorter shadows.

Angle Specifies the direction of the imaginary light source that creates the bevel
effect. Drag the arrow to adjust the angle — note that this also adjusts the
angle of the drop shadow.

You can right-click a slider to reset to the default value.

Adding a Watermark to an Image

You can use theWatermark tool to add a watermark to a photo. You can move the watermark to any
position on the photo. You can also change the opacity of the watermark and blend the watermark
into the image. You can add newwatermarks and delete watermarks from the list that you no longer
use.

You can save your settings as a preset for future use.

You will need to create a watermark image before you can add the watermark to your photos.

To Add a Watermark to an Image:

1. In Edit mode, in the Add group, selectWatermark. A default watermark displays in the bottom right of
the photo by default.

You can also access theWatermark tool from the Filter drop-down menu or Filter toolbar.

2. Choose a watermark from the drop-down list, or add a new watermark by using the + button.

3. Click and drag the watermark to reposition it anywhere on your image, or choose an Anchor Point from
the Positioning settings. Ruler guidelines will appear as you move the watermark around the image to
show you pixel distances from the edge. You can also change this pixel distance in the Positioning
setting.

4. Drag the marquee handles to resize the watermark image.

5. SelectMaintain aspect ratio when resizing if you want to resize the watermark image without
distorting it.

6. Select Apply Alpha Channel to apply the alpha channel if it is present in the watermark.

(Only TIFF, PNG, and ICO watermark files can have an alpha channel.)

7. Select Apply Transparency to make a color in the watermark transparent.
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The default color is black. You can choose a different color by clicking on the color box. In the
Standard tab, you can choose a color, or select a color using the color picker. In the Custom
tab, you can enter HSB values (Hue, Saturation, and Brighness), Red Green Blue values, or a
hex color code. The color selected will be made transparent in the watermark image itself.

8. Select an option from the Blending Mode drop-down list to specify how you want the watermark to
blend into the underlying image.

9. Drag the Opacity slider to specify the transparency of the watermark.

10. Do one of the following:

l Click Apply to add the watermark to your image, and keep the Watermark tool open.

l Click Done to add the watermark to your image, and leave the tool.

l Click Cancel to discard your changes and leave the tool.

You can right-click a slider to reset to the default value.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

To Remove a Watermark From the List:

1. Choose the watermark in the drop-down list.

2. Press the minus symbol -.

3. Your watermark is removed.

Adding Borders

You can use the Borders tool to add one or more borders and edge effects to your images. You can set
the size of each side of the border, change the color and texture of the border or pick up a color from
within the image by clicking on that color in the image.

There are libraries of edges and textures to get you started, but you can save your own textures or
edges to the ACDSee folder so that they appear in the library for you to use.

You can also use Edge blur to soften the edges or blend the image into the background texture. You
can also add a third dimension to your images using the Drop Shadow and Raised edge effects.

Using combinations of multiple borders and edge effects can add to the mood and atmosphere of a
photo, emphasize contrast, and enhance color.

You can save your settings as a preset for future use.

To Add a Border to an Image:
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1. In Edit mode, in the Add group, select Borders.

You can also access the Borders tool from the Filter drop-down menu or Filter toolbar.

2. Create the border by selecting its size, color, texture, edge, or edge effects as described in the Borders
options below.

3. Do one of the following:

l Click Done to apply your changes and close the Border tool.

l Click Cancel to discard all changes and close the tool.

4. To add another border, restart the border tool and repeat these steps.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Border Options
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Eyedropper

Picks up the color beneath the cursor when you click on
the image. The border changes to the clicked color, which
also appears in the Color box on the Borders pane so that
you can adjust it if you open the Color dialog box.

The eyedropper is not available when you are
using a texture.

Border

Size Sets the size of all the sides of the
border simultaneously. Drag the
slider left and right to adjust the
width of the border. You can also
type in a different number or use
the up and down arrows to change
the size of the border.

The text below the Size field shows
the final size of your image with
the border added. The final size
changes dynamically as you adjust
the size of the border.

Advanced size
controls

Opens a fly-out menu of advanced
size controls. Use the sliders, up
and down arrow keys, or type in a
number to set the size of each side
of the border individually. For
example, you can set the bottom
border to be larger to include a
space for copyright information.
Click on the arrow beside the Size
slider to open the advanced size
controls menu.

Color box Activates when you select the
Color radio button.

Do any of the following:

l Click on a color in the
image to make the border
that color. The clicked
color appears in the Color
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box.

l Click on the color in the
middle of the Color box to
open the Colors dialog,
where you can adjust the
color in multiple ways.

l Click the down-arrow
beside the box and hover
over the quick-color box
until you find a color you
like. When you click inside
the quick color box, the
picked color appears in the
Color box and the border
changes to the selected
color.

Texture box Activates when you select the
Texture radio button.

Do any of the following:

l Click the side arrow to
open the texture library
and view thumbnails of
textures to select.

l Click the forward and back
arrows to browse through
the textures one at a time,
without opening the
library.

Edge

Straight Sets the edge of the border to be a
straight line.

Irregular Activates when you select the
Irregular radio button.

Do any of the following:

l Click the side arrow beside
the edge box to open the
edge library and view
thumbnails of edges to
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select.

l Click the forward and back
arrows to browse through
the edges one at a time,
without opening the
library.

Edge blur Blurs the edges of the edge of the
image into the border. Drag the
slider to the right to increase the
blur, or to the left to decrease the
blur.

Edge effects

Drop shadow Adds a drop shadow to the image
that appears to lift it off the page.
The drop shadow appears behind
the image, between it and the
border. You can adjust the depth
of the blur on the edge of the
shadow, and the transparency of
the shadow, which affects how
much of the border shows through
the shadow. You can also change
the direction of the imaginary
source of light by dragging the
glow on the Light Source ball.

l Blur: adjusts the blur on
the edge of the shadow
when you drag the slider.

l Opacity: adjusts the
transparency of the drop
shadow when you drag the
slider.

Raised Adds a raised edge to the image
that appears to raise it above the
border, giving it a 3D look. The
raised effect is applied to the
image, between it and the border.
You can change the direction of
the imaginary source of light of the
raised edge by dragging the glow
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on the Light Source ball. You can
also adjust the size, strength, and
color of the raised edge in the
following ways:

l Size: drag the slider to the
right to increase the size of
the raised edge so that it
appears higher. The
greater the size the more
rounded the effect.

l Strength: drag the slider to
the right to increase the 3D
effect of the raised edge.

l Colored: select this option
to apply the border color
to the raised edge.

Light Source

Activates when you check either the Drop shadow or
Raised checkboxes. Click and drag the glow on the ball to
reposition the imaginary light source for the 3D effect of
the Drop shadow or Raised edge effects.

You can right-click a slider to reset to the default value.

Adding Your Own Textures or Edges

It is possible to add custom textures and edges to the libraries in the Borders tool. If you make your
own edges or textures, or own a collection from the Internet, you can add them to the texture and
edge libraries. You can also delete existing files from the libraries to make room for others.

The textures or edges have to be in the following file formats with these extensions:

l BMP

l EMF

l GIF

l JPG

l GIF
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l PNG

l TIF

Textures

As the textures are tiled, it is important to use an image that can be seamlessly repeated. The files are
used at their full resolution, not scaled up or down. For example, if your texture image is 100 x 100
pixels and you are creating a bordered image that is 1000 x 1000 pixels, then your texture file will be
tiled 10 times. If you use a texture file that is 1000 x 1000 pixels, then there would just be the one
texture tile for the whole border.

To Add Your Own Textures to the Texture Library:

1. In ACDSee, close the Borders tool if it is open.

2. Copy and paste your texture files into this folder:

C:\Program Files\Common Files\ACD Systems\borders\textures

3. In Manage mode, select the image you want to use and then click Tools | Edit.

4. In the Add group, click Borders.

5. Select the Texture radio button and then click the arrow on the right side of the texture box to open the
texture library.

Thumbnails of the textures display for you to select.

Edges

Edge files are grayscale images that are resized to fit the image. The image file shows through any areas
in the edge file that are white, and does not show through any black areas. Pixels that are tones of
gray in the edge file show through with relative opacity depending on how close the pixels are to black
or white (in other words, the darker the gray pixel, the less it shows through).

To Add Your Own Edges to the Edges Library:

1. In ACDSee, close the Borders tool if it is open.

2. Copy and paste your edge files into this folder:

C:\Program Files\Common Files\ACD Systems\borders\edges

3. In Manage mode, select the image you want to use and then click Tools | Edit.

4. In the Add group, click Borders.

5. Select the Irregular radio button and then click the arrow on the right side of the edge box to open the
edge library.

Thumbnails of the edges display for you to select.
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If you open an image with borders already applied, another border will be applied to the
image.

Adding a Vignette

You can use the Vignette effect to add a frame around a subject, such as a person or a bouquet of
flowers. You can change the focal point in the portrait. You can also control the appearance of the
border.

You can save your settings as a preset for future use.

To Apply a Vignette Effect:

1. In Edit mode, in the Add group, select Vignette.

You can also access the Vignette tool from the Filter drop-down menu or Filter toolbar.

2. Set the options as described below.

3. Do one of the following:

l Click Done to apply your changes and close the tab.

l Click Cancel to discard all changes and close the tab.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Vignette Options
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Horizontal Specifies the focal point of the portrait on the horizontal axis. A value of 500
places the center in the middle of the photo.

Vertical Specifies the focal point of the portrait on the vertical axis. A value of 500
places the center in the middle of the photo.

Clear zone Specifies the size of the clear area around the focal point in the portrait. Drag
the slider to the left to reduce the size of the clear area. Drag the slider to
the right to increase the size of the clear area.

Transition zone Specifies the width of the transition area between the clear zone and the
frame. Drag the slider to the left to narrow the transition area. Drag the
slider to the right to widen the transition area.

Stretch Stretches the vignette horizontally to make the shape elliptical rather than
round.

Shape Specifies the shape of the frame:

l Round: select Round if you want the frame to be round.

l Rectangular: select Rectangular if you want the frame to be square.

Show outline Select Show outline if you want to display an outline that shows the outside
edge of the clear zone and the inside edge of the frame.

Frame Applies the following special effects to the vignette frame area around the
focal point:

l Color: changes the color of the frame area to the color you select in
the color picker.

l Saturation: removes color from the people or objects in the vignette
frame so they are gray scale.

l Blur: blurs the vignette frame area.

l Clouds: applies a Clouds effect to the frame area.

l Edges: applies an Edges effect by tracing the lines and details of
people or objects with neon colors.

l Radial Waves: creates the appearance of waves radiating from the
focal point into the frame area.

l Radial Blur: creates a Radial Blur that rotates and stretches the frame
area.

l Zoom Blur: applies a Zoom Blur to the frame area.

l Crayon Edges: applies the Crayon Edges effect by tracing the lines
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and details around people or objects with crayon.

l Dauber: creates the impression that the people or objects around
the focal point were painted with a brush.

l Pixelate: applies a pixel effect to the frame.

l Old: applies an aging effect to the frame to make it look like an old
photo.

l Glowing Edges: applies glowing edges to all the strong lines in the
frame area.

l Ripple: adds ripples to the frame so that it looks like liquid ripples
moving outwards from the focal area.

Frame settings The settings that display below the Frame drop-down list change depending
on the frame you select. For example, if you select Color in the Frame drop-
down list, a color picker displays so that you can select the color for the
vignette. Similarly, if you select Blur in the Frame drop-down list, a slider
appears that you can use to change the amount of blur surrounding the
photo. For some choices, like Edges, there are no settings to apply.

You can right-click a slider to reset to the default value.

Adding a Tilt-Shift Effect

You can use the Tilt-Shift effect to create emphasis on specific subjects in your photos, or make your
photos look like miniature landscapes.

To Use the Tilt-Shift Effect:

1. In Edit mode, in the Add group, select Tilt-Shift.

You can also access the Tilt-Shift tool from the Filter drop-down menu or Filter toolbar.

2. On the Tilt-Shift panel, set the options as described below.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Tilt-Shift Options
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Use the guides on the image to place the effect. The inside boxes represent the points where the focus is
transitioning to blur. Complete blur occurs at the outside boxes. Move the boxes to define where the effect
will begin or end. Hold down the Shift key while positioning the effect to lock to the nearest 45° angle, for
straightness.

Blurring

Select the type of blur you want from the Blur drop-down menu.

l Lens Blur
l Gaussian Blur

See Blur Types for more information.

Amount Specifies the amount of blur applied.

Bokeh Frequency Specifies how often the bokeh shapes occur.

Bokeh Brightness Specifies how bright the bokeh shapes appear.

Bokeh Sides Defines the number of sides the bokeh shape will have.

Saturation

Drag the slider to the right to intensify the effect.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Adding a Grain Effect

You can use the Grain effect to give your images a stylized look, like old film grain. The Grain tool can
also be used in combination with other effects to achieve a general vintage look.

You can save your settings as a preset for future use.

To Apply a Grain Effect:

1. In Edit mode, in the Add group, select Grain.

You can also access the Grain tool from the Filter drop-down menu or Filter toolbar.
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2. Set the options as described below.

3. Do one of the following:

l Click Done to apply your changes and close the tab.

l Click Cancel to discard all changes and close the tab.

Grain Options

Amount Specifies the strength of the grain.

Smoothing Specifies the smoothness of the grain.

Size Specifies the size of the grain.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

About Special Effect Filters

You can use filters to add unique effects to your images. ACDSee Home includes more than 40 special
effect filters, such as Crosshatch, Pencil Drawing, and Solarize.

To Access the Special Effects Filters:

In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter toolbar.

For more information about each effect, click the Help button to view a Help file page specific to that
effect.

Applying a Bathroom Window Effect

The Bathroom Window effect divides your images into bars, transforming them so they resemble the
view through privacy glass often found in bathrooms. You can select or change the Bathroom Window
options to apply this effect to your image.
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You can save your settings as a preset for future use.

To Apply a Bathroom Window Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Bathroom Window.

3. Drag the Bar width slider to set the thickness of the bars. Thinner bars result in a more distorted image.

4. In the Bar direction area, select one of the following to specify the orientation of the bars in your image:

l Vertical

l Horizontal

5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Blinds Effect

Use the Blinds effect to divide your image into bars that look like venetian or vertical window blinds.
You can customize the characteristics of the blinds you would like added to your image.

You can save your settings as a preset for future use.

To Apply a Blinds Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Blinds.

3. On the Blinds panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Blinds Options

Width Specifies the width of the blinds. Type a number from 1 to 1000 or drag the slider
to adjust the width of each blind. As the value increases, the width of the blind also
increases.

Opacity Specifies the opacity of the blinds. Type a number from 1 to 99 or drag the slider
to adjust the opacity of the blinds. The higher the opacity, the more the image is
obscured.

Angle Specifies the angle of the blinds. Type a number from 1 to 360 or drag the arrow
to adjust the angle.

Blind color Specifies the color of the blinds.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Blue Steel Effect

You can use the Blue Steel effect to give your images a stylish blue tint.

To Apply the Blue Steel Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Blue Steel.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Bob Ross Effect

You can use the Bob Ross effect to give your images a painted look.

You can save your settings as a preset for future use.

To Give Your Photos a Bob Ross Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Bob Ross.

3. On the Bob Ross panel, set the options as described in the table below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Bob Ross Options
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Brush size Drag the Brush size slider to specify the width of the brush strokes in the
effect. The higher value, the wider the brush stroke.

Coverage Drag the Coverage slider to specify the amount or density of paint on the
"canvas" of your photo.

Paint thickness Drag the Paint thickness slider to specify how three dimensional the paint
appears.

Colorfulness Drag the Colorfulness slider to specify the amount of color in your image.

Background color

Image Check the Image checkbox to use the color in the image as the
background color behind the brush strokes added to the photo. To use a
different color for the background, uncheck the Image checkbox and
select a new color from the color drop-down menu.

Randomize Indicates the random placement of the paint daubs. When you apply the
Bob Ross effect to an image, ACDSee places the daubs randomly. This
makes the paint daubs different every time you apply the filter. To
generate a new random placement of the paint daubs, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Bulge Effect

Use the Bulge effect to stretch or shrink areas of your images horizontally and vertically. You can
customize the strength, radius and position of the distortion.

You can save your settings as a preset for future use.

To Apply a Bulge Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Bulge.

3. On the Bulge panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Bulge and Shrink Options

Horizontal position Specifies the center of the distortion along the horizontal axis. A lower value
moves the distortion towards the left side of the image, while a higher value
moves it towards the right side of the image.

Vertical position Specifies the center of the distortion along the vertical axis. A lower value moves
the distortion towards the bottom of the image, while a higher value moves it
towards the top of the image.

Radius Specifies the radius of the distorted area. A lower value decreases the radius of
the distortion, while a higher value increases the radius of the distortion.

Strength Specifies the strength of the distortion. A negative value shrinks the center of the
distortion, while a higher value bulges the distortion.

Background color Specifies the background color for the filtered image.

Check the Image checkbox to use the original image color, or click the color picker
to select a different color.

Bulge direction Specifies the direction of the distortion. Select one or both of the following
options:

l Horizontal: moves the distortion horizontally.

l Vertical: moves the distortion vertically.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.
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You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Cartoon Effect

You can use the Cartoon Effect to give your images a sketched appearance.

You can save your settings as a preset for future use.

To Apply a Cartoon Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Cartoon.

3. On the Cartoon panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Cartoon Options
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Shading strength Specifies the strength of the shading in the image. The higher the
setting, the more intense the shading that is applied to the image.

Shading radius Specifies how spread out the shading is.

Shading threshold Specifies how sharp an edge must be in the image before shading is
applied. If you specify a higher value, more edges in the photo will
be shaded.

Smoothness Controls how smooth the transitions between similar colors are.

Outline detail Specifies how much the details are outlined in black.

Outline strength Specifies how strong the black outlines are applied.

Artifact Suppression Remove small details Prevents small
details from
being outlined
in black,
allowing the
image to
appear more
cartoon-like.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Childhood Effect

You can use the Childhood effect to give your images a dreamy, nostalgic look.

To Apply the Childhood Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Childhood.
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3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Collage Effect

You can use the Collage effect to creatively break up a photo into a number of photos.

You can save your settings as a preset for future use.

To Use the Collage Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Collage.

3. Drag the sliders to set the Number and Size of the photos.

4. Select a background color by clicking the drop-down arrow to display gradients of colors, or click the
color box to display a dialog of swatches to choose from.

5. If you would like to reshuffle the photos, click Randomize.

6. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

7. Click Exit to leave Special Effects, and return to the Filter menu.

You can right-click a slider to reset to the default value.
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You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Colored Edges Effect

You can use the Colored Edges effect to trace the lines and details of people or objects in your images.

You can save your settings as a preset for future use.

To Apply a Colored Edges Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Colored Edges.

3. On the Colored Edges panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Colored Edges Options

Intensity Specifies the amount of color added to the edges within the image. The
higher the setting, the thicker the color that is applied to the image.

Edge color Specifies the color of the edges.

Edge detection Specifies the edge detection algorithm. The algorithm controls the formula
used to detect the edges and the direction of the edge indicators.

Blurring Blurs the edges in the image. Check the Use blurring checkbox, and then
choose a blur setting to determine how much blur is applied.

You can right-click a slider to reset to the default value.
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You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Contours Effect

You can use the Contours effect to draw contour lines on your image to create a cartoon effect. Select
or change the rounding, line frequency, color and strength setting to apply to your image.

You can save your settings as a preset for future use.

To Apply a Contours Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Contours.

3. On the Contours panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Contours Options

Rounding Specifies the amount of curve in the contour lines. The higher the value,
the rounder the lines.

Line frequency Specifies the amount of space between the contour lines. The higher the
value, the closer the lines move together.

Strength Specifies the strength of the line. The higher the value, the darker the line.

Line color Specifies the color of the contour lines.

You can right-click a slider to reset to the default value.
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You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Crayon Drawing Effect

You can use the Crayon Drawing effect to give your photos the appearance of a crayon drawing.

To Use the Crayon Drawing Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Crayon Drawing.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Crosshatch Effect

You can use the Crosshatch effect to add crosshatching to an image.

To Use the Crosshatch Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.
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2. Click Crosshatch.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Dauber Effect

You can use the Dauber effect to make your images look like they were painted with a paint dauber.
Select or change the settings of the effect you want applied to your image, such as intensity, frequency
and more.

You can save your settings as a preset for future use.

To Use the Dauber Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Dauber.

3. On the Dauber panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Dauber Options
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Intensity Specifies the amount of color applied with each daub.

Frequency Specifies the number of daubs added to the image.

Background color Specifies the background color of the filtered image.

Check the Image checkbox to use the original image colors or click the
color picker to select a different color.

Randomize Indicates the random placement of the paint daubs.

When you apply the Dauber effect to an image, ACDSee Home places
the daubs randomly. This makes the paint daubs different every time
you apply the filter. You can define a specific random seed to generate
identical daubs.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Dramatic Effect

You can use the Dramatic effect to make your images look dramatic and moody by drastically changing
the contrast in specific areas.

You can save your settings as a preset for future use.

To Apply a Dramatic Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Dramatic.

3. On the Dramatic panel, set the options as described below.
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4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Dramatic Options

Strength Specifies the strength of the contrast being applied.

Spread Specifies how far the effect spreads over the details in the photo.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying an Edge Detect Effect

You can use the Edge Detect effect to create a highlighted outline of your image. After creating a black
image, the effect uses colored lines to outline the detail of an image where significant color differences
exist. Greater differences between colors in the original image produce brighter outline colors. (The
Sobel effect is similar to the Edge Detect effect, but produces sharper and brighter outlines.)

To Use the Edge Detect Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Edge Detect.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.
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You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying an Emboss Effect

You can use the Emboss effect to add a grayscale relief to an image.

You can save your settings as a preset for future use.

To Emboss an Image:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Emboss.

3. On the Emboss panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Emboss Options

Elevation Specifies the light source's elevation on the image. Lower values produce more
shadows and a darker image. Higher values produce fewer shadows and a lighter
image.

Weight Specifies the amount of relief added to the image. Higher values increase the relief
depth.

Azimuth Specifies the angle of shadows that extend from the edges of image details. A
value of 0 adds shadows to the left side, while a value of 180 adds shadows to the
right side.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.
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You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Furry Edges Effect

You can use the Furry Edges effect to add fur and bristles to the lines and details of people or objects
in your image.

You can save your settings as a preset for future use.

To Use the Furry Edges Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Furry Edges.

3. On the Furry Edges panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Furry Edges Options
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Frequency Specifies how much fur is added to the image. The higher the setting, the
more dense the fur that is applied to the image.

Threshold Specifies how sharp an edge must be before fur is applied to it. As the
value decreases, the area of the image that fur is added to increases.

Fur length Specifies the length of each strand of fur. As the value increases, the
length of each fur strand also increases.

Variance Specifies how much of the fur grows in the direction indicated by the
Hair direction setting. The higher the value, the more random the fur
direction will be.

Hair direction Specifies the general direction in which fur appears to grow.

Edge detection Specifies the edge detection algorithm. The algorithm controls the
formula used to detect the edges and the direction of the edge
indicators.

Background color Specifies the background color of the filtered image. Check the Image
checkbox to use the original image colors, or click the color picker to
select a different color.

Fur color Specifies the color of the fur. Check the Image checkbox to use the
original image colors, or click the color picker to select a different color.

Randomize Indicates the random placement of the fur strands.

When you apply the Furry Edges effect to an image, ACDSee Home
places the fur randomly. This makes the fur strands different every time
you apply the filter. You can define a specific random seed to generate
identical fur patterns.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Applying a Glowing Edges Effect

You can use the Glowing Edges effect to add color to the lines and details of people or objects in your
images. The colored lines and details appear to glow.

You can save your settings as a preset for future use.

To Apply a Glowing Edges Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Glowing Edges.

3. On the Glowing Edges panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Glowing Edges Options

Intensity Specifies the amount of color added to the edges within the image. The higher the
setting, the more intense the color that is applied to the image.

Color Specifies the color of the edges.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Granite Effect

You can use the Granite effect to give your images the appearance of being painted on a rock wall.

You can save your settings as a preset for future use.
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To Use the Granite Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Granite.

3. On the Granite panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Granite Options

Light Angle Specifies the direction from which an imaginary light source is shining on the
image. Drag the arrow to adjust the angle. Different light angles will change the
highlights and shadows in the peaks and valleys on the rock.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Lomo Effect

Simulate the retro-effects of a lomo camera. Photos taken with a lomo camera are high contrast, with
a golden hue and a noticeable vignette.

You can save your settings as a preset for future use.

To Use the Lomo Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Lomo.

3. Drag the Color Distortion slider to the right to increase the color distortion.
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4. Drag the Vignette Strength slider to the right to increase the vignette strength.

5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

6. Click Exit to leave Special Effects, and return to the Filter menu.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Mirror Effect

You can use the Mirror effect to reflect an image along the horizontal or vertical axis. Select or change
the Mirror options to apply mirroring to your image, including mirror axis and direction.

You can save your settings as a preset for future use.

To Apply a Mirror Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. ClickMirror.

3. On the Mirror panel, in the Mirror direction area, select one of the following options to indicate which
direction you want to mirror the image:

l Horizontal

l Vertical

4. Drag the Mirror axis slider to adjust the position of the mirror. A value of 500 places the mirror in the
center of the image.
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5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Negative Effect

You can use the Negative effect to create a negative of your image. You can also apply the Negative
filter to a negative scanned from a roll of film to produce a positive image.

To Create an Image Negative:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Negative.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Applying an Oil Paint Effect

You can use the Oil Paint effect to give your images a painted appearance.

You can save your settings as a preset for future use.

To Create an Oil Painting from a Photo:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Oil Paint.

3. On the Oil Paint panel, drag the Brush width slider to specify the width of the brush strokes in the effect.
The higher the value, the wider the brush stroke.

4. Drag the Variance slider to specify the color variance in each brush stroke. Higher values increase the
number of colors used in each stroke.

5. Drag the Vibrance slider to adjust the intensity of the colors in the image.

6. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying an Old Effect

You can use the Old effect to give your images an antique look. (The Old effect is similar to the Sepia
effect, but produces a more realistic appearance of age.)

You can save your settings as a preset for future use.

To Apply the Old Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Old.

3. On the Old panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Old Options

Age Specifies the intensity or degree of the effect. (The numbers do not correspond to
how old the photo should appear.)

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying an Orton Effect

Create beautiful impressionistic images with the Orton effect. The Orton effect mimics a darkroom
technique created by sandwiching two images together, one of which is slightly out of focus, and both
of which are slightly overexposed.

You can save your settings as a preset for future use.

To Use the Orton Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Orton.
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3. Drag the Blur, Contrast, and Brightness sliders to adjust each effect.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

5. Click Exit to leave Special Effects, and return to the Filter menu.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying an Outline Effect

The Outline effect is similar to the Edge Detect effect. You can use the Outline effect to create a
highlighted outline of your image. However, with the Outline effect you can control the thickness of
the outline, whether an edge is outlined or not, and the color that displays behind the outlined image.

You can save your settings as a preset for future use.

To Use the Outline Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Outline.

3. On the Outline panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Outline Options
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Line width Specifies the width of the outline in the effect. The higher the value, the
wider the outline.

Threshold Specifies how sharp an edge must be in order to be outlined. If you
specify a higher value, more edges in the photo will be outlined.

Background color Specifies the background color of the filtered image. Click the color
picker to select a different color.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Pencil Drawing Effect

You can use the Pencil Drawing effect to create a pencil drawing from your images.

To Create a Pencil Drawing from an Image:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Pencil Drawing.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.
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You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Pixel Explosion Effect

You can use the Pixel Explosion effect to explode pixels from a center point in your images. Select or
change the Pixel Explosion settings, such as intensity and direction, to apply this effect to your image.

You can save your settings as a preset for future use.

To Use the Pixel Explosion Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Pixel Explosion.

3. On the Pixel Explosion panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Pixel Explosion Options
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Horizontal center Specifies the center point of the explosion on the horizontal axis. A
value of 500 places the explosion at the middle of the image.

Vertical center Specifies the center point of the explosion on the vertical axis. A
value of 500 places the explosion at the middle of the image.

Intensity Specifies the intensity of the explosion. A higher value creates a
larger, more brilliant spread of the pixels in the image.

Explosion direction Specifies the direction of the explosion. Select one or both of the
following:

l Explode horizontally: explodes the pixels towards the right
and left sides of the image.

l Explode vertically: explodes the pixels towards the top and
bottom of the image.

Randomize Indicates the random placement of the pixels.

When you apply the Pixel Explosion effect to an image, ACDSee
Home places the pixels randomly. This makes the pixels different
every time you apply the filter. You can define a specific random
seed to generate identical pixel patterns.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Pixelate Effect

A pixel is the smallest piece of a digital image, arranged in rows and columns. When you reduce the
resolution of your image, the size of the pixel increases and produces blurring. You can use the Pixelate
effect to increase the size of the pixels in your image.

You can save your settings as a preset for future use.

To Apply a Pixelate Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Pixelate.

3. On the Pixelate panel, drag the Width and Height sliders to set the size of the pixels in your image.
Check the Square checkbox to make the width and height equal.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Posterize Effect

You can use the Posterize effect to reduce the number of brightness levels in your image. Select or
change the Posterize options to apply this effect to your image.

You can save your settings as a preset for future use.

To Apply a Posterize Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Posterize.

3. On the Posterize panel, drag the Brightness levels slider to adjust the variance of colors in the image.
The lower the value, the fewer colors used in the image.
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4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Purple Haze Effect

You can use the Purple Haze effect to give your image a hyper-retro, purple tint.

To Apply the Purple Haze Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Purple Haze.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Applying a Radial Waves Effect

You can use the Radial Waves effect to display waves radiating from a center point in the photo. You
can change the center point in the photo and you can also control the appearance of the waves.

You can save your settings as a preset for future use.

To Apply a Radial Waves Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Radial Waves.

3. On the Radial waves panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Radial Waves Options

Horizontal position Specifies the center of the waves on the horizontal axis. A value of 500
places the waves in the middle of the image.

Vertical position Specifies the center of the waves on the vertical axis. A value of 500
places the waves in the middle of the image.

Amplitude Specifies the depth and height of each wave.

Wavelength Specifies the amount of space between waves.

Light strength Specifies the amount of light contrast between the top and bottom of
each wave.

Background color Specifies the background color of the filtered image. Check the Image
checkbox to use the original image colors, or click the color picker to
select a different color.

Wave direction Specifies the direction of the waves. Select one, or both, of the
following:

l Wave horizontally: makes the waves move towards the right
and left sides of the image.

l Wave vertically: makes the waves move towards the top and bot-
tom of the image.
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You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Rain Effect

You can use the Rain effect to make it look like it was raining when you took a photo. Control the
amount, the angle, strength and other characteristics of the rain.

You can save your settings as a preset for future use.

To Apply Rain to a Photo:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Rain.

3. On the Rain panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Rain Options
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Strength Specifies the length of the rain drops. Drag the slider to the right to
increase the length.

Opacity Specifies the opacity of the rain drops. Type a number from 0 to 100 or
drag the slider to adjust the opacity of the rain drops. The higher the
opacity, the more the image is obscured.

Amount Specifies the number of rain drops.

Angle variance Specifies the angle of the rain drops. Type a number from 0 to 50 or
drag the arrow to adjust the angle.

Strength variance Specifies how much variety there should be in the length of the rain
drops. Drag the slider to the left if you want rain drops to have a similar
length. Drag the slider to the right if you want to vary the length of rain
drops. If you vary the length of rain drops they look natural.

Background blur Specifies the amount of blur in the photo. Heavy rain will block your
vision. Use this option to blur the photo so the rain effect looks natural.

Angle Specifies the angle at which the rain drops are falling.

Color Specifies the color of the rain drops.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Ripple Effect

You can use the Ripple effect to divide your images into concentric circles that resembles what you see
when you drop a pebble into water. Select or change the Ripple settings to apply to your image, such
as position, strength and more.

You can save your settings as a preset for future use.

To Apply a Ripple Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Ripple.

3. On the Ripple panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Ripple Options

Horizontal position Specifies the center of the ripples on the horizontal axis. A value of
500 places the ripples in the middle of the image.

Vertical position Specifies the center of the ripples on the vertical axis. A value of
500 places the ripples in the middle of the image.

Amplitude Specifies the depth and height of each ripple.

Wavelength Specifies the amount of space between ripples.

Light strength Specifies the amount of light contrast between the top and bottom
of each ripple.

Background color Specifies the background color of the filtered image. Check the
Image checkbox to use the original image colors, or click the color
picker to select a different color.

Ripple direction Specifies the direction of the ripples. Select one or both of the
following:

l Ripple vertically: makes the ripples move towards the top
and bottom of the image.

l Ripple horizontally: makes the ripples move towards the
right and left sides of the image.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.
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You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Scattered Tiles Effect

You can use the Scattered Tiles effect to divide your images into rectangular tiles, and scatter and stack
the tiles. Select or change the Scattered Tiles options to apply this effect to your image.

You can save your settings as a preset for future use.

To Apply a Scattered Tiles Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Scattered Tiles.

3. On the Scattered Tiles panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Scattered Tiles Options

Tile size Specifies the size of the tiles.

Scatter amount Specifies how much the tiles will move from their original positions.

Background color Specifies the color of the background. Click the color picker to select a
different color.

Randomize Indicates the random placement of the tiles.

When you apply the Scattered Tiles effect to an image, ACDSee Home
places the tiles randomly. This makes the effect different every time you
apply the filter. You can define a specific random seed to generate
identical tile patterns.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.
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You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Sepia Effect

You can use the Sepia effect to give your images an antique look. (The Old effect is similar to the Sepia
effect, but produces a more realistic appearance of age.)

You can save your settings as a preset for future use.

To Add a Sepia Tone to an Image:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Sepia.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Seventies Effect

You can use the Seventies effect to give your images a retro look.

To Apply the Seventies Effect:



ACDSee Photo Studio Home 2026

Page 343 of 532

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Seventies.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Sheet Metal Effect

You can use the Sheet Metal effect to turn your images into sheet metal impressions.

You can save your settings as a preset for future use.

To Apply a Sheet Metal Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Sheet Metal.

3. On the Sheet Metal panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Sheet Metal Options
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Rounding Specifies the amount of curve in the edges of the impressions.

Detail Specifies the amount of detail in the impression.

Angle Specifies the angle of the grain in the sheet metal.

Metal color Specifies the color of the sheet metal.

Direction Specifies the direction in which the sheet metal was manipulated. Select one of
the following:

l Indented: stamps the metal from the top side of the image.
l Pushed out: stamps the metal from underneath the image.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Shift Effect

You can use the Shift effect to divide your images into bars and shift them in random directions.

You can save your settings as a preset for future use.

To Apply a Shift Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Shift.

3. On the Shift panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Shift Options
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Strength Specifies the amount of shift between the bars.

Width Specifies the width of each bar.

Angle Specifies the angle of the bars.

Background color Specifies the background color of the filtered image. Check the Image
checkbox to use the original image colors, or click the color picker to
select a different color.

You can right-click a slider to reset to the default value.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Slant Effect

You can use the Slant effect to make a photo appear slanted. For example, you could use the Slant
effect to distort a photo by pushing the top of the photo to the left and the bottom of the photo to
the right. Similarly, you could use the slant effect to push the left side of the photo upwards and the
right side of the photo downwards.

You can save your settings as a preset for future use.

To Apply a Slant Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Slant.

3. On the Slant panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Slant Options
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Amount Specifies the degree of the slant.

Fulcrum Specifies the center of the slant. Drag the slider to the left to place the
center of the slant near the bottom of the photo. Drag the slider to the
right to place the center of the slant near the top of the photo.

Background color Specifies the background color of the filtered image. Click the color
picker to select a different color.

Slant Direction Specifies the angle of the slant:

l Horizontal: select Horizontal to push the top or bottom of the
photo to the left or right.

l Vertical: select Vertical to push the left or right side of the photo
up or down.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Sobel Effect

You can use the Sobel effect to create a highlighted outline of your image. After creating a black image,
the effect uses colored lines to outline the detail of an image where significant color differences exist.
Greater differences between colors in the original image produce brighter outline colors. (The Sobel
effect is similar to the Edge Detect effect, but produces sharper and brighter outlines.)

To Use the Sobel Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Sobel.
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3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Solarize Effect

You can use the Solarize effect to simulate the effect of overexposing an image, as though the film was
exposed to light before developing. Select or change the Solarize options to apply this effect to your
image.

You can save your settings as a preset for future use.

To Apply a Solarize Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Solarize.

3. On the Solarize panel, drag the Threshold slider to specify the brightness threshold of the image.

4. In the Effect area, specify which pixels you want to adjust by selecting one of the following options:

l Solarize: adjusts pixels located above the specified threshold option. The effect takes any pixels
above the threshold and replaces them with their negative value. When you solarize an image,
a higher threshold value sets a brighter threshold, and colors need to be brighter to be
overexposed.

l Lunarize: adjusts pixels located below the specified threshold option. The effect takes any pixels
below the threshold and replaces them with their negative value. When you lunarize an image,
a higher threshold value sets a darker threshold, and colors do not have to be as bright to be
overexposed.
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5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Somber Effect

You can use the Somber effect to give your images an austere or sleek look.

To Apply the Somber Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Somber.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Applying a Stained Glass Effect

You can use the Stained Glass effect to divide your image into fragments of a random size and shape,
to give the photo the appearance of a stained glass window. Control the size and position of the
fragments using the effect settings.

You can save your settings as a preset for future use.

To Apply a Stained Glass Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Stained Glass.

3. On the Stained Glass panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Stained Glass Options

Fragment size Specifies the size of the fragments.

Randomize Indicates the random placement of the fragments.

When you apply the Stained Glass effect to an image, ACDSee Home places the
fragments randomly. This makes the effect different every time you apply the
filter. You can define a specific random seed to generate identical fragment
patterns.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Applying a Sunspot Effect

You can use the Sunspot effect to add a bright spot in your images.

You can save your settings as a preset for future use.

To Apply a Sunspot Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Sunspot.

3. On the Sunspot panel, drag the Horizontal Position and Vertical Position sliders or click the image to set
the location of the sunspot.

4. Drag the Brightness slider to set the intensity of the sunspot.

5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

Applying a Swirl Effect

You can use the Swirl effect to rotate and stretch people and objects in your image.

You can save your settings as a preset for future use.

To Apply a Swirl Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Swirl.

3. On the Swirl panel, set the options as described below.



ACDSee Photo Studio Home 2026

Page 351 of 532

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Swirl Options

Horizontal position Specifies the center of the swirl on the horizontal axis. A value of 500
places the swirl in the middle of the image.

Vertical position Specifies the center of the swirl on the vertical axis. A value of 500
places the swirl in the middle of the image.

Radius Specifies the size of the swirl effect.

Strength Specifies the strength and direction of the swirl. Higher values create
a clockwise swirl, while negative values create a counter-clockwise
swirl.

Focus Specifies the concentration of the swirl. Higher values concentrate
the effect on the center of the swirl, while lower values spread the
swirl across the image.

Background color Specifies the background color of the filtered image. Check the
Image checkbox to use the original image colors, or click the color
picker to select a different color.

Swirl direction Specifies the direction of the swirl. Select one or both of the
following:

l Swirl horizontally: moves the swirl towards the top and bot-
tom of the image.

l Swirl vertically: moves the swirl towards the right and left
sides of the image.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Threshold Effect

You can use the Threshold effect to create a black and white image.
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You can save your settings as a preset for future use.

To Apply the Threshold Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Threshold.

3. On the Threshold panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Threshold Options

Threshold This slider determines which pixels become black and which ones become white
in the black and white image. Any pixels that are brighter than the selected
threshold will become white and any pixels that are darker than the threshold will
become black.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Topography Effect

You can use the Topography effect to change the details of your images into contour lines.

You can save your settings as a preset for future use.

To Apply a Topography Effect:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click Topography.

3. On the Topographic Map panel, drag the Rounding slider to adjust the amount of curve in the contour
lines.

4. Drag the Number of lines slider to specify how many contour lines you want to add.

5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Water Effect

You can use theWater effect to insert an expanse of water below the subject of a photo and to display
a reflection of the subject in the water. You can control the position of the water below the subject.
For example, you can position the water below a person's chin, or below their waist. You can also
control the appearance of ripples in the water and how dark or light the water appears.

You can save your settings as a preset for future use.

To Apply a Water Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. ClickWater.

3. On the Water panel, set the options as described below.
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4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Water Options

Position Specifies the position of the water below the subject of the photo.

Amplitude Specifies the height of the ripples in the water. Drag the slider to the left to reduce
the height of the ripples and the distortion caused by the ripples. Drag the slider to
the right to increase the height of the ripples and the distortion caused by the
ripples.

Wavelength Specifies the distance between ripples. Drag the slider to the left to reduce the
distance between ripples and increase the distortion caused by the ripples. Drag
the slider to the right to increase the distance between ripples and reduce the
distortion caused by the ripples.

Perspective Changes the size of the waves as they get farther from the subject. Drag the slider
to the left to increase the size of the waves farthest from the subject and to
increase the illusion of distance.

Lighting Specifies the amount of light in the water.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Water Drops Effect

You can use theWater Drops effect to display water drops on the surface of the photo. You can
control the number and size of water drops, and their position on the photo.

You can save your settings as a preset for future use.

To Apply Water Drops to a Photo:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. ClickWater Drops.

3. On the Water Drops panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Water Drops Options

Density Specifies the number of water drops on the photo. Drag the slider to the left to
remove water drops. Drag the slider to the right to add water drops.

Radius Specifies the size of the water drops. Drag the slider to the left to make the water
drops smaller. Drag the slider to the right to make the water drops larger.

Height Specifies the height of the water drops above the photo surface. Drag the slider to
the left to reduce the height of the water drops and the distortion caused by the
water drops. Drag the slider to the right to increase the height of the water drops
and the distortion caused by the water drops.

Randomize Indicates the random placement of the water drops.

When you apply the Water Drops effect to an image, ACDSee Home places the
water drops randomly. This makes the effect different every time you apply the
filter. You can define a specific random seed to generate identical water drop
patterns.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Applying a Waves Effect

You can use theWaves effect to display waves across the photo. You can change the distance between
waves. This distance is called wavelength. You can also change the height of the waves, and the angle
at which the waves cross the photo.

You can save your settings as a preset for future use.

To Apply a Waves Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. ClickWaves.

3. On the Waves panel, select or change the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Waves Options

Wavelength Specifies the distance between waves. Drag the slider to the left to
reduce the distance between waves and increase the distortion caused
by the waves. Drag the slider to the right to increase the distance
between waves and reduce the distortion caused by the waves.

Amplitude Specifies the height of the waves. Drag the slider to the left to reduce
the height of the waves and the distortion caused by the waves. Drag
the slider to the right to increase the height of the waves and the
distortion caused by the waves.

Angle Specifies the angle of the waves. Type a number from 1 to 360 or drag
the arrow to adjust the angle.

Background color Specifies the background color. Check the Image checkbox to use the
original image colors, or click the color picker to select a different color.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.
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You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Weave Effect

You can use theWeave effect to give a photo the appearance of being woven into a tapestry or basket.
You can control the width of the vertical and horizontal strips, the width of the gap between the strips,
and the background color that displays through the gap.

You can save your settings as a preset for future use.

To Apply a Weave Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. ClickWeave.

3. On the Weave panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Weave Options

Strip width Specifies the width of the vertical and horizontal strips.

Gap width Specifies the width of the gap between the strips.

Background color Specifies the color of the background. Click the color picker to select a
different color.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.
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You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Applying a Wind Effect

You can use theWind effect to add wind lines that make stationary objects in your image look like
they are moving. Select or change the settings to control the effect of the wind added to your image.

You can save your settings as a preset for future use.

To Apply a Wind Effect:

1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. ClickWind.

3. On the Wind panel, select or change the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Wind Options
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Strength Determines how strong the wind lines are in the image. The higher the
value, the stronger the wind lines.

Threshold Determines how sharp an edge must be before the filter will apply wind.
The higher the value, the sharper the edge needs to be.

Chance of wind Determines the amount of wind lines to place in the image.

Edge detection Specifies the edge detection algorithm. The algorithm controls the
formula used to detect the edges and the direction of the edge
indicators.

Background color Specifies the background color. Check the Image checkbox to use the
original image colors, or click the color picker to select a different color.

Wind color Specifies the color of the wind lines. Check the Image checkbox to use
the original image colors, or click the color picker to select a different
color.

Wind angle Specifies the angle of the wind lines.

Randomize Indicates the random placement of the wind lines.

When you apply the Wind effect to an image, ACDSee Home places the
wind lines randomly. This makes the wind lines different every time you
apply the filter. You can define a specific random seed to generate
identical wind lines.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Creating a Custom Special Effect Filter (Convolution Effect)

You can use the Convolution filter to create your own special effects and apply them to your image.

You can save your settings as a preset for future use.

To Create a Custom Effect Filter:
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1. In Edit mode, in the Add group, select Special Effect.

You can also access the Special Effects menu from the Filter drop-down menu or Filter
toolbar.

2. Click User Defined Convolution.

3. On the User Defined Convolution panel, set the options as described below.

4. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

User Defined Convolution Options

Convolution Matrix Specifies the formula to use when altering the image.

Type numbers in the matrix fields to change the pixels in the image.
Using a mathematical formula, the color value of each pixel in an
image is multiplied by the numbers in the matrix to produce an effect.

Division Specifies the fractional coefficient of the matrix.

Type a number into the Division field to use fractional coefficients in
the matrix. The product of the convolution matrix is divided by the
division factor before being applied to a pixel.

Bias Specifies the brightness of the image.

Type a number into the Bias field to change the brightness of the
image. The bias number is added to the RGB values of each pixel. A
positive number brightens the image, while a negative number
darkens the image.

Clear Matrix Resets the matrix.

Sample Filters Drop-Down Menu Loads a sample effect to use as a starting point for creating your own
effect.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.
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Rotating an Image

You can rotate an image at preset or custom angles in Edit mode.

You can save your settings as a preset for future use.

To Rotate an Image at a Custom Angle:

1. In Edit mode, in the Geometry group, select Rotate.

You can also access the Rotate tool from the Filter drop-down menu or Filter toolbar.

2. Select one or more of the following:

l Select one of the default orientation options.

l Drag the Straightening slider to the left or right until the image appears straightened.

l Click the Horizontal or Vertical button, and use the tools as described below.

l Select Crop straightened image if you want to crop the image after it is straightened.

l Select Preserve straightened image if you do not want to crop the straightened image. Select
the color that you would like to display behind the straightened image from the Fill color drop-
down.

l Select Show grid overlay to display a grid over the image. You may find that the grid helps you
straighten the image and understand how the image will be cropped.

3. Do one of the following:

l Click Done to apply your changes and close the tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Rotate Icons

Horizontal Click on the horizontal icon, and then use the cursor to draw a line on the image
that you want to set as the horizontal line.

Vertical Click on the vertical icon, and then use the cursor to draw a line on the image that
you want to set as the vertical line.

You can right-click a slider to reset to the default value.
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Flipping an Image

You can flip an image both vertically and horizontally in Edit mode.

You can save your settings as a preset for future use.

To Flip an Image:

1. In Edit mode, in the Geometry group, select Flip.

You can also access the Flip tool from the Filter drop-down menu or Filter toolbar.

2. Do one or both of the following:

l Check the Horizontal Flip checkbox.

l Check the Vertical Flip checkbox.

3. Do one of the following:

l Click Done to apply your changes and close the tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

Cropping an Image

You can use the Crop tool to remove unwanted parts of your images, or to reduce the image canvas to
a particular size. You can also enable relative positioning which is useful for creating settings to batch
crop a selection of images.

You can save your settings as a preset for future use.

When zooming in, hold down the Spacebar to pan the image.

To Crop an Image:
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1. In Edit mode, in the Geometry group, select Crop.

You can also access the Crop tool from the Filter drop-down menu or Filter toolbar.

2. Resize the crop window, and position it over the area of the image you want to keep.

3. To darken the parts of the image outside the crop window, drag the Darken outside crop area slider to
the left. Drag the slider to the right to lighten the area outside the crop window.

4. Click Estimate new file size to view how big your image file is after cropping.

5. Do one of the following:

l Click Done to crop the image and close the tool.

l Click Cancel to exit the tool without cropping the image.

You can right-click a slider to reset to the default value.

Resizing the Crop Window

You can resize the crop window in three ways:

l Drag the edges of the crop window to the desired size.

l Specify an exact size for the crop window in pixels, inches, centimeters, or millimeters.

l Apply a ratio to constrain the crop window proportions.

To Resize the Crop Window by Dragging:

1. Position your cursor over the edge or corner of the crop window until it changes into a double-pointed
arrow.

2. Drag the crop window's border to the desired size.

To Specify an Exact Size for the Crop Window:

1. Type the desired crop window proportions into the Width and Height spin boxes.

2. In the Units drop-down list, select a unit of measurement.

3. Use the Dots per inch spin box to specify a resolution.

To Constrain the Crop Window to a Ratio:

1. Check the Constrain cropping proportion checkbox.

2. Choose a ratio from the drop-down list.

3. Click on the Rotate button if you want to change the orientation of the crop window.
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4. Do one of the following:

l Position your cursor over the edge of the crop window until it changes into a double-pointed
arrow, and then drag the edge of the crop window to the desired size.

l Use the Width or Height spin box to specify a dimension for one side of the crop
window.ACDSee Home automatically resizes the other dimension based on the ratio you
selected.

To Resize the Crop Window by Using Relative Positioning:

You can enable relative positioning to specify how you want your image to crop. This can be
particularly useful for cropping in batches.

1. Check the Enable relative positioning checkbox.

2. Choose in the Horizontal settings whether you would like to position the crop from the left or right
edges, and the distance in pixels or as a percentage.

3. Choose in the Vertical settings whether you would like to position the crop from the left or right edges,
and the distance in pixels or as a percentage.

Resizing an Image

You can resize an image by adjusting its dimensions in pixels, percentage, or actual/print size. While
resizing, you can also choose an aspect ratio and a resampling filter to adjust the resized image's
appearance.

You can save your settings as a preset for future use.

To Resize an Image:

1. In Edit mode, in the Geometry group, select Resize.

You can also access the Resize tool from the Filter drop-down menu or Filter toolbar.

2. Select one of the following resize options:

l Pixels: resizes the image to specific dimensions in pixels.

l Percent: resizes the image to a percentage of the original.

l Actual/Print size in: resizes the image to match a specific output size. Click the drop-down list
to specify a unit of measurement.

3. If you want to maintain a specific width to height ratio, check the Preserve aspect ratio checkbox, and
then select one of the following options from the drop-down list:
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l Original: maintains the original image's width to height ratio.

l 1 x 1: forces the width and height to be equal.

l 2 x 3: forces a width to height ratio of 2:3.

l 3 x 2: forces a width to height ratio of 3:2.

l 3 x 5: forces a width to height ratio of 3:5.

l 5 x 3: forces a width to height ratio of 5:3.

l Custom: applies a custom ratio. Enter a width to height ratio in the Custom Aspect Ratio dialog
box.

4. Select a resizing filter from the Resizing Filter drop-down list.

5. Under the resize option you selected in step #3, type the image's new dimensions into the Width and
Height spin boxes. If you selected Actual/Print size in, click the Resolution drop-down list, and then
select a resolution (in dots per inch) for your output image.

6. To estimate the size of the output image, click Estimate new file size.

7. Do one of the following:

l Click Done to apply your changes and close the Resize tool.

l Click Cancel to discard all changes and close the tool.

Resizing Tips:

l Maintain image quality by reducing images only by 33%, 50%, or 66%. Other percentages
can distort the aspect ratio.

l Avoid resizing an image repeatedly. Each resizing places image pixels using a slightly
different orientation. As a result, multiple resizes can change the overall color and
appearance of the image. If your first resize attempt does not produce the desired result,
click the Undo button.

l Avoid increasing the size of an image. Increasing image size makes the image's pixels
more apparent, causing a grainy effect.

Pixel Resize Options and Resulting Action

You can reduce and enlarge the size of one or more images from Manage mode by entering a new
dimension in pixels. For more information on how to resize an image using pixel dimensions, please
see Resizing an image or Resizing multiple images.

Enlarging an image tends to pixelate the image, reducing image quality. It is best to avoid
enlarging images.
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Resize Options Fit within Options Action

Enlarge only

Width only Resizes the image if the specified
dimensions are larger than the
image's original dimensions. The
width is increased to the specified
value and the height is increased to
maintain the aspect ratio.

Height only Resizes the image if the specified
dimensions are larger than the
image's original dimensions. The
height is increased to the specified
value and the width is increased to
maintain the aspect ratio.

Width and height Resizes the image if the specified
dimensions are larger than the
image's original dimensions. The
width and height are increased as
close to the specified value as
possible, while maintaining the
aspect ratio.

Width or height (largest image) Resizes the image if the specified
dimensions are larger than the
image's original dimensions. The
width or height is increased as close
to the specified value as possible to
maximize the size of the image, while
maintaining the aspect ratio.

Reduce only

Width only Resizes the image if the specified
dimensions are smaller than the
image's original dimensions. The
width is decreased to the specified
value and the height is decreased to
maintain the aspect ratio.

Height only Resizes the image if the specified
dimensions are smaller than the
image's original dimensions. The
height is decreased to the specified
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Resize Options Fit within Options Action

value and the width is decreased to
maintain the aspect ratio.

Width and height Resizes the image if the specified
dimensions are smaller than the
image's original dimensions. The
width and height are decreased as
close to the specified value as
possible, while maintaining the
aspect ratio.

Width or height (largest image) Resizes the image if the specified
dimensions are smaller than the
image's original dimensions. The
width or height is decreased as close
to the specified value as possible to
minimize the size of the image, while
maintaining the aspect ratio.

Enlarge or reduce

Width only Resizes the width to the specified
value and resizes the height to
whatever value is necessary to
maintain the aspect ratio.

Height only Resizes the height to the specified
value and resizes the width to
whatever value is necessary to
maintain the aspect ratio.

Width and height Resizes the image within the
specified width and height. The width
and height are resized as close to the
specified value as possible while
maintaining the aspect ratio.

Width or height (largest image) Resizes the image within the
specified width and height. The width
or height is resized as close to the
specified value as possible to
maximize (or minimize) the size of
the image, while maintaining the
aspect ratio.
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Adjusting Image Exposure

You can use the Exposure tool to adjust an image's exposure, contrast, and fill light.

You can save your settings as a preset for future use.

To Adjust the Image Exposure:

1. In Edit mode, in the Exposure/Lighting group, select Exposure.

You can also access the Exposure tool from the Filter drop-down menu or Filter toolbar.

2. Set the options as described below.

3. Do one of the following:

l Click Apply to apply your changes and set options on another tab.

l Click Done to apply your changes and close the tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Image Exposure Options

Exposure Drag the slider to the right to increase the exposure, or drag to the left to
decrease exposure.

Auto Click the Auto button to automatically adjust the exposure level.

Contrast Drag the slider to the right to increase contrast, or drag to the left to decrease
contrast.

Fill Light Drag slider to the right to increase the amount of light in the darkest areas of the
image, or drag to the left to decrease fill light. Fill light brightens dark areas of the
image.

Exposure warning Highlights overexposed and underexposed areas of the image. Overexposed
pixels turn red, underexposed pixels turn green. The icon is gray when disabled,
and turns yellow if enabled.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.
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You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Adjusting Image Levels

You can use the Levels tool to precisely adjust the contrast and light levels in your images.

You can save your settings as a preset for future use.

To Adjust Image levels:

1. In Edit mode, in the Exposure/Lighting group, select Levels.

You can also access the Levels tool from the Filter drop-down menu or Filter toolbar.

2. Do one of the following:

l Set the options as described below to adjust the contrast and light levels manually.

l Click Auto and select a menu option to automatically adjust image properties.

3. Do one of the following:

l Click Apply to apply your changes.

l Click Done to apply your changes and close the Levels tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Levels Options
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Channel Specifies the brightness or color channel you want to adjust.

Shadows Specifies the black point of an image.

Move the slider or type a number from 0 to 255 into the spin box to
define the blackest area of an image. As the value increases, the
dark colored areas of the image become darker. You can also click
on the arrow to automatically set it to where the black point start in
the image.

Midtones Specifies the midtones in an image.

Move the slider or type a number into the spin box to set the
midtone. Higher values make the image appear brighter, while
lower values make the image appear darker. You can also click on
the arrow to automatically set it to the midtone of the image.

Highlights Specifies the white point of an image.

Move the slider or type a number from 0 to 255 into the spin box to
define the whitest area of an image. As the value increases, the light
colored areas of the image become lighter. You can also click on the
arrow to automatically set it to where the highlights start in the
image.

Auto Select one of the following options:

l Adjust Contrast: automatically analyzes and adjusts image con-
trast.

l Adjust Color and Contrast: automatically analyzes and adjusts
each color channel independently, and then adjusts the con-
trast.

l Adjust Color and Brightness: automatically analyzes and
adjusts image color and brightness.

l Tolerance: opens the Tolerance settings dialog box. Specify
the maximum clipping percentage for black and white levels,
and click OK. ACDSee Home adjusts the image levels auto-
matically.

Black Point picker Click the Black Point picker, and then click the image area you want
to set as the black point.

Mid Point picker Click the Mid Point picker, and then click the image area you want
to set as the mid point.

White Point picker Click the White Point picker, and then click the image area you want
to set as the white point.
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When you click around the image with a selected eye dropper you will see the RGB numbers
changing to reflect the RGB values of the pixel under the eye dropper. The RGB values
represent the source pixel (unprocessed) and the current pixel as it appears on the screen.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

Adjusting Levels Automatically

You can use the Auto Levels tool to automatically correct the exposure levels of your images. Auto
Levels makes the darkest image pixels darker, and the brightest pixels brighter.

You can save your settings as a preset for future use.

To Automatically Correct an Image's Levels:

1. In Edit mode, in the Exposure/Lighting group, select Auto Levels.

You can also access the Auto Levels tool from the Filter drop-down menu or Filter toolbar.

2. Select one of the following options:

l Auto Contrast and Color: adjusts color differences, brightness, and balances RGB channels.

l Auto Contrast: adjusts the color differences and brightness only.

l Auto Color: balances the RGB channels in the image, without changing the brightness or
contrast.

3. Use the Strength slider to fine tune the amount of exposure you want to apply.

4. Click Exposure Warning to make overexposed and underexposed pixels visible. Overexposed pixels turn
red, underexposed pixels turn green.
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5. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Adjusting Tone Curves in Edit Mode

In Editmode, the Tone Curves filter changes the tonal range of an image. Channel Filtering embedded
in the Tone Curves pane adjusts either the entire range of the image (RGB), or specific colors (Red,
Green, and Blue).

Save adjusted settings as a preset for future use.

To adjust the Brightness Curves in an image:

1. In Edit mode, do one of the following:
l In the Filter Menu pane, under the Exposure / Lighting group, select Tone Curves,
l Select Filter | Exposure / Lighting | Tone Curves from the main menu, or
l Press U.

2. Set the options as described below.

3. Do one of the following:

l Click Apply to accept any changes and remain in the tool,
l Click Done to accept any changes and close the tool, or
l Click Cancel to discard any changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.
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Tone Curves Options

Channel Specifies the color channels to adjust. Options include RGB, Red, Green,
and Blue.

Show Histogram Toggles the histogram display on and off.

Histogram Displays a graphic of the color information levels in the image, based on
the selected channel. Click and drag the line to manipulate the curve. Note
that when a point on the curve is clicked, a Node Info Box appears in the
top left corner of the Histogram. The Node Info Box contains In and Out
pixel values which are set in blocks of color to give a visual representation.
The Node Info Box numbers convey that an In value pixel will be changed
to the Out value. For example, if the In value is 40 and the Out value is 80,
all pixels with a value of 40 will be changed to 80. Clicking the curve adds a
new point to the curve. Drag the points up and down the curve. To delete
a point, right-click the node and select Delete point.

Color Picker Drag the cursor onto the image to change the cursor to a color picker that
provides the RGB and luminance values of the picker's current location.
Click the image at a desired tone to add a corresponding point to the
adjustment curve.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Edit Brush to paint this effect onto specific areas of your image.

Adjusting Lighting

You can use the Light EQ™ tool to adjust areas in an image that are too dark or too light, without
affecting other areas of the photo. You can also simultaneously brighten dark areas that are too dark,
and darken areas that are too bright. An example would be a portrait of someone in shadow but with a
light background.

You can save your settings as a preset for future use.

The Light EQ™ tool lets you make quick and easy adjustments. ACDSee Home analyzes the photo and
varies the adjustment throughout the image automatically. For example, darker images are
brightened more. By opening the Light EQ™ tool, 1-Step applies an automatic exposure adjustment.
For a more hands-on approach, the Basic tab allows you to click the Auto button and have ACDSee
Home fully analyze the photo and set the slider positions automatically. You can also click directly on
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an area of the image to generate automatic settings optimal for that area, (usually the subject of the
photo).

l 1-Step tab: for an instant, effortless exposure adjustment.

l Basic tab: for very quick and easy adjustments using three sliders. ACDSee Home analyzes the photo and
varies the adjustment throughout the image automatically. For example, darker images are brightened
more. By clicking the Auto button, you can have ACDSee Home fully analyze the photo and set the slider
positions automatically. You can also click directly on an area of the image to generate automatic settings
optimal for that area, (usually the subject of the photo).

To Open the Light EQ™ Tool:

In Edit mode, in the Exposure/Lighting group, select Light EQ™.

You can also access the Light EQ tool from the Filter drop-down menu or Filter toolbar.

Light EQ™ Controls

Right-click on a slider Right-click on a slider to reset it.

Exposure Warning Click the Exposure Warning to make any overexposed or underexposed areas
visible. Overexposed pixels turn red, underexposed pixels turn green. You can also
toggle Exposure Warning on and off momentarily by holding down the E key.

Auto Click to allow the software to analyze the photo and apply optimal settings based on
the amount of light and dark pixels in the photo. Darker photos are brightened more
than photos that are already bright.

Done Click to apply your changes and close the tool.

Cancel Click to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Using the 1-Step Tab

When you open an image in the Light EQ™ tool, 1-Step automatically adjusts your image's exposure.
You can further adjust it using the Amount slider. To return to the 1-Step automatic adjustment, press
the Reset button.

Using the Basic Tab

To Add Light to Dark Areas:
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1. Drag the Shadows slider to the right to add light to the dark parts of the photo.

2. Adjust the settings using any of the controls in the table below.

To Darken Areas That Are Too Bright:

1. Drag the Highlights slider to the left to darken and return detail to areas that are too bright.

2. Adjust the settings using any of the controls in the table below.

To Adjust Midtones That Are Too Light or Dark:

1. Drag the Midtones slider to the right or left to brighten or darken the midtones.

2. Adjust the settings using any of the controls in the table below.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Adjusting White Balance

You can use theWhite Balance tool to remove unwanted hue from an image. For example, if you take
a photo at sunset and the resulting image has a reddish hue, also known as a red color cast, you can
use theWhite Balance tool to remove it.

You can save your settings as a preset for future use.

To Remove a Color Cast from an Image:

1. In Edit mode, in the Color group, selectWhite Balance.

You can also access theWhite Balance tool from the Filter drop-down menu or Filter
toolbar.

2. Click an image area that should be white or gray. The color square shows the color of the original pixel
on the left, and the modified pixel on the right.

3. Drag the Temperature slider to the left (more blue) or right (more yellow) to select a specific color
temperature.
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4. Drag the Tint slider to the left (more magenta) or right (more green) to match the white balance settings
that you selected when you took the photo.

5. To specify the strength of the white balance adjustment, move the Strength slider. Higher settings
remove more of the unwanted color.

6. Click Done to save your changes, or click Cancel to discard your changes and leave the tool.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can select the Highlight neutral pixels option to create a white balance mask over your
image. Whiter pixels represent areas of low color saturation, while darker pixels represent
areas of higher color saturation.

If you are having difficulties achieving the desired effect, try clicking an image area that is a
different shade of white or gray.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Adjusting Color with Color EQ

You can use the Color EQ tool in Edit mode to adjust overall colors in an image or each color
individually. The advanced tools can subtly fine-tune and enhance colors, or completely change
individual colors in an image.

Color EQ is useful for changing a single color in an image. If you have an image with a yellow car, you
can use the Saturation tab to saturate the yellow or use the Brightness tab to brighten the yellow. In
the Hue tab, you can change the color of the car from yellow to pink. In the Contrast tab, you can
adjust the contrast of the yellow and use the Balance slider to target the brightness range for that
contrast adjustment.

You can then use the Global Adjustments to make changes to balance the colors in your image.
Vibrance adjusts the vibrancy of colors, saturation affects the strength of colors, color shift adjusts the
hue without affecting brightness, hue will change colors, and lightness will affect how light the whole
image is. You can also adjust color using the Red, Green, and Blue sliders to increase or decrease the
balance of those colors.
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You can save your settings as a preset for future use.

If you have an image of a yellow car with a yellow building in the background, you can change
just the car by using the Selections tool. Select the car using the Selections tool and then apply
your color adjustments.

To Adjust Color:

1. In Edit mode, in the Color group, select Color EQ.

You can also access the Color EQ tool from the Filter drop-down menu or Filter toolbar.

2. Select any of the tabs within the ColorEQ or any of the sliders in the Global Adjustments section, and
adjust them according to the options described in the tables below.

3. Do one of the following:

l Click Apply to apply your changes.

l Click Done to apply your changes and close the tool.

l Click Cancel to discard all changes and close the tool.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

At the top of the Color EQ pane, choose either High Quality or Standard. Adjust image colors
individually. High Quality uses the newer, more modern color models, allowing for a visually
perceptive and higher quality adjustment. Standard supports previously developed images and allows
you to adjust colors individually or make global adjustments.

Color EQ Options - High Quality.
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Presets In the presets drop-down menu, you can
choose from existing presets, or save any
of your current edits as a preset, using

the save icon.
Color EQ Saturation,

Brightness
and Hue
sliders

Adjust each color
individually by dragging
sliders right for more
intensity, or left for less
intensity. You can also enter
a number into the fields for
precise adjustments.

You can also select a precise
color to adjust by placing
your cursor on the image
for the double arrow icon to
appear. Then click and drag
up or down to adjust the
colors beneath the double
arrow icon. The affected
color sliders automatically
adjust as you move your
cursor.

The sliders have the
following effects:

l Saturation: slide left
to decrease
saturation and slide
right to increase
saturation.

l Brightness: adjusts
the image
brightness.

l Hue: adjusts the hue
of the image.

Contrast
sliders

Adjust each color
individually by dragging
sliders right for more
intensity, or left for less
intensity. You can also enter
a number into the fields for
precise adjustments.

You can also select a precise
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color to adjust by placing
your cursor on the image
for the double arrow icon to
appear. Then click and drag
up or down to adjust the
colors beneath the double
arrow icon. The affected
color sliders automatically
adjust as you move your
cursor.

On the Contrast tab, once
you have adjusted contrast,
you can adjust contrast
balance, which changes
whether you apply the
contrast to the lighter or
darker colors in the image.

Global Adjustments Vibrance,
Saturation,
Color Shift,
Hue, and
Lightness
Sliders

Drag the sliders to make
global adjustments. They
will have the following
effects:

l Vibrance: adjust the
vibrance of the
image without
affecting skin tones.

l Saturation: slide left
to decrease
saturation and slide
right to increase
saturation.

l Color Shift: adjusts
the hue without
affecting brightness.

l Hue: adjusts the hue
of the image.

l Lightness: adjusts
the image
brightness.

Red, Green,
and Blue
sliders

Drag the sliders to make
global adjustments to the
red, green, and blue
channels in your image.
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Color EQ Options - Standard.

Presets In the presets drop-down menu, you can
choose from existing presets, or save any
of your current edits as a preset, using the

save icon.
Vibrance Drag the slider to adjust the vibrance of the

image without affecting skin tones.

Vertical slider The vertical slider applies adjustments to the
entire image. It has the following effects on
the tabs:

l Saturation: adjusts saturation from
grayscale to highly saturated.

l Brightness: adjusts the image
brightness.

l Hue: adjusts the hue of the image.

You can also enter a number into the field for
precise adjustments.

Direct image adjustments Place your cursor on the image for the double
arrow icon to appear. Then click and drag up
or down to adjust the colors beneath the
double arrow icon. The curve control and the
affected color sliders automatically adjust as
you move your cursor. The black down arrow
on the graph indicates the color you are
adjusting in the image.

The curve appears black in the graph, and you
cannot directly adjust it. To apply further
adjustments, you can alter the white curve.
When you adjust the white curve, the black
curve automatically changes with it. You can
also enter a number into the fields for precise
adjustments.

Individual color sliders Adjust each color with individual sliders.
Select the color you want to adjust and click
and drag the sliders. You can also enter a
number into the fields for precise
adjustments.

You can right-click a slider to reset to the default value.
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Creating a Grayscale Image

You can create rich grayscale images when you can control the brightness of the red, green, and blue
channels, as well as the overall brightness. Use the Convert to Black and White tool to emphasize
different areas or aspects of a photo, as well as alter its mood and tone.

If you hover your mouse over each slider and watch the effect on the small preview, it shows you
which parts of the image will be affected by each channel. This helps to gauge the effect of each slider
on the image.

You can also save your settings as a preset for future use.

To Create a Grayscale Image:

1. In Edit mode, in the Color group, select Convert to Black &White.

You can also access the Convert to Black & White tool from the Filter drop-down menu or
Filter toolbar.

2. Adjust the settings as described in the table below.

3. Click Done to save your changes, or click Cancel to discard your changes and return to the Filter menu.

Grayscale Options
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Brightness Tab

On the Brightness tab, do any of the following:

l Drag individual color sliders, or left-click on the image (where a color previously occurred) and drag up or
down to alter the brightness of specific tones. For instance, drag your cursor on sky areas to alter the
brightness of the blue.

l Drag the Percent Red slider to the left or right.

The more red there is in a pixel, the more effect the red slider has on that pixel. The area of
red in the picture is brightened or darkened more than other areas.

l Drag the Percent Green slider the left or right.

The more green there is in a pixel, the more effect the green slider has on that pixel. The area
of green in the picture is brightened or darkened more than other areas.

l Drag the Percent Blue slider to the left or right.

The more blue there is in a pixel, the more effect the blue slider has on that pixel. The area of
blue in the picture is brightened or darkened more than other areas.

l Drag the Percent Brightness slider to the right or left to brighten or darken the whole image.

You can right-click the slider to reset the value to zero.

Contrast Tab

You can increase or decrease the contrast of each individual color. In addition, you can specify the brightness
range that the contrast adjustment will target for each color.

On the Contrast tab, do the following:

Strength: to adjust the contrast in specific color tones, drag individual color sliders, or left-click on the image
(where a color previously occurred) and drag up or down.

Balance: to set the targeted brightness range for the contrast adjustment, adjust the slider to bring details out
of highlights or shadows. To bring details out of the midtones, leave the Balance sliders set to 0.

Hold down Shift while clicking and dragging on the image to target the color's corresponding
Balance slider.

You can right-click the slider to reset the value to zero.

At the bottom of the Convert to Black & White panel, you can use the Amount and Hue sliders to add color
back into the image. Choose the color using the Hue slider. The saturation of the color added back to any given
pixel is scaled based on both the amount of color/saturation that existed in the original image and the Amount
slider.
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You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Color Grading with LUTs

"Color LUT" stands for Color Lookup Table. Color LUTs are lists that instruct ACDSee or related
programs to map specific RGB values to other specific color values. You can import LUTs and use them
as filters in ACDSee. You can apply a LUT in the same way you would use any other Edit mode filter.
Color LUT supported file types are .3DL and .CUBE.

To Apply a Color LUT to Your Image:

1. In Edit mode, in the Color group, select Color LUTs.

2. On the Color LUTs panel, do one of the following:

l Select a LUT from the list. The LUT is immediately applied.

l Press the Import LUTs button. In the Open dialog, browse to the location of your LUT files, and
press Open. The LUT is immediately applied.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

If an imported LUT file's location has changed, you will have to reload it in the Color LUTs
panel.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

You can use the Gradient tool to transition this effect across specific areas of your image.

To Refresh Your List of Color LUTs:
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You can refresh your list of available LUTs to reveal moved or deleted files. Unavailable LUTs will be
indicated in a darker font color.

On the Color LUTs panel, press the Refresh List button.

To Remove Color LUTs:

1. On the Color LUTs panel, press the Remove LUTs button.

2. In the Remove LUTs dialog, toggle the checkboxes next to the LUTs you want to delete.

3. Press Remove LUTs.

Using the Histogram

The Histogram is a graph that represents the distribution of color intensity for each color channel in an
image.

To Display and Use the Histogram:

1. In View mode, click Panes | Histogram, or View | Histogram in Edit mode.

2. On the Histogram, check or uncheck the following checkboxes:

l R: shows or hides the red color channel.

l G: shows or hides the green color channel.

l B: shows or hides the blue color channel.

l L: shows or hides the lightness of the image.

Using the Color Dialog Box

The Colors dialog box appears in several places in Edit mode when you select or apply a color. You can
use the Color dialog box to select a color in multiple ways and to adjust a color using several different
tools.
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The Standard Tab

On the first tab, there is a fixed honeycomb of Basic colors to choose from, including gray, black, and
white at the bottom. Below it is a grid of Custom or Favorite colors that you can fill in by selecting a
color and then right-clicking a box in the grid. To create a custom color, click the Custom tab.

The Custom Tab

On the second tab, there is a color palette. On the far right is a color slider, which you can use to
navigate to a color group and gain access to any or all colors of the spectrum. Add colors to your
Custom colors by selecting the color in the palette and then right-clicking a box in the grid.

Selecting and Adjusting Colors

To select a color, click on a square in the grid of custom colors, or on the color palette. You can also
drag over the color palette. When you click a color, that color appears in the New box and all of its
numerical values, (Hue, Saturation, Luminosity, as well as Red, Green, and Blue), appear in the fields
on the Custom tab.

You can also adjust a color by changing the Hue, Saturation, and Luminosity values. To select a precise
color, type in the values for that color. You can do the same using the Red, Green, and Blue values.
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Sharpening an Image

You can use the Sharpen tool to sharpen an image by enhancing medium and high contrast edges.

You can save your settings as a preset for future use.

To Sharpen an Image Using Sharpen Tool:

1. In Edit mode, in the Detail group, select Sharpen.

You can also access the Sharpen tool from the Filter drop-down menu or Filter toolbar.

2. Drag the sliders to enhance or fix your image as described below.

3. Do one of the following:

l Click Done to apply your changes and close the tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Sharpen Options

Amount Specifies the amount of sharpening applied by increasing contrast around the
edges.

Radius Controls the number of pixels to adjust around each edge. Higher values increase
the number of sharpened pixels and tend to bring out coarser detail, while lower
values reduce the number of sharpened pixels and tend to bring out finer detail.

Detail Suppresses the halo, (the light border that forms around edges with extreme
sharpening), by reducing its intensity. The higher the value, the stronger the
reduction.

Threshold Specifies how different the pixel lightness values within an edge must be before
the pixels within the edge are sharpened. Higher values sharpen only stronger
edges but minimize the appearance of noise. Lower values sharpen both strong
and weaker edges, but can increase the appearance of noise. We recommend you
set the threshold to enhance edges while keeping background noise to a
minimum.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.
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You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Blurring an Image

You can use the Blur tool to apply different kinds of blur to an image.

You can save your settings as a preset for future use.

To Blur an Image:

1. In Edit mode, in the Detail group, select Blur.

You can also access the Blur tool from the Filter drop-down menu or Filter toolbar.

2. In the Blur type section, select the type of blur to apply.

3. Set the options as described below.

4. Do one of the following:

l Click Done to apply your changes and close the Blur tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Blur Types
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Gaussian

Produces an even, smooth blur.

Amount Specifies the amount of blur. Move the slider to
the right to intensify the effect.

Linear

Produces a blurring effect that gives the illusion of movement.

Amount Specifies the amount of blur. Move the slider to
the right to intensify the effect.

Angle Specifies the direction of the blur effect.

Radial

Produces blur around a center point. Click the image to set the center point.

Amount Specifies the amount of blur. Move the slider to
the right to intensify the effect.

Clockwise Specifies clockwise blur.

Counter-clockwise Specifies counter-clockwise blur.

Horizontal position Specifies the blur's center point on the horizontal
axis.

Vertical position Specifies the blur's center point on the vertical
axis.

Spread

Produces a smeared or frosted blur.

Amount Specifies the amount of blur. Move the slider to
the right to intensify the effect.

Zoom
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Produces inward or outward blur to or from a center point.

Amount Specifies the amount of blur. Move the slider to
the right to intensify the effect.

Zoom in Creates a blur that zooms in to the image's center.

Zoom out Creates a blur that zooms out from the image's
center.

Horizontal position Specifies the blur's center point on the horizontal
axis.

Vertical position Specifies the blur's center point on the vertical
axis.

Smart Blur

Produces blur by detecting and avoiding edges, and preserves detail based on the threshold
setting. This effect is usually used to smooth out skin.

Amount Specifies the amount of blur. Move the slider to
the right to intensify the effect.

Threshold Specifies how little detail an area must have
before the blur will apply to it.

Lens

Produces a blur that mimics the blurring effect of a camera aperture.

Select a bokeh shape from the options on the Blur panel. These shapes concentrate in
highlights.

Amount Specifies the strength of the blur. Move the slider
to the right to intensify the effect.

Bokeh Frequency Specifies how often the bokeh shapes show up.

Bokeh Brightness Specifies how much the bokeh shapes stand out.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.
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You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

About Noise and Noise Reduction

Image noise looks like random black, white, or colored pixels in an area of a photo where there should
be solid color, such as a dark night sky. In digital photography, noise is typically more visible in the
dark areas of a photo.

There are many causes of image noise. You will increase image noise if you use a high ISO setting (such
as ISO 800) to capture a photo, or if you extend the exposure time. (You would typically use a high ISO
setting and extend exposure time to take a photo in low light.) However, image noise can be caused by
dead or stuck pixels in a digital camera's image sensor. Similarly, dust on a camera lens or scanner bed
can cause noise by blocking or reflecting light.

Images generally have two types of noise: luminance and color. Luminance noise is random variations
of brightness, and particularly in gray areas, may appear spotted when there should be a solid color in
the area of the image.

Color noise is random variations of color in the image.

Noise is visually distracting, so in most cases you will want to reduce noise in your photos. However, if
you reduce noise too much you may unintentionally reduce image sharpness. You can use the Noise
Removal tool to remove both luminance and color noise in your images.

Removing Noise

You can use the Remove Noise tool to remove noise from your images while preserving details that
you want to retain.



ACDSee Photo Studio Home 2026

Page 391 of 532

You can use the Remove Noise tool to remove hot image pixels caused by digital cameras with
malfunctioning CCD array sensors, or the extra pixels caused by a dusty scanner or camera
lens.

You can save your settings as a preset for future use.

To Remove Noise from an Image:

1. In Edit mode, in the Detail group, select Noise.

You can also access the Noise tool from the Filter drop-down menu or Filter toolbar.

2. Select the Remove Noise tab.

3. Select an option from the Noise Type section.

4. Set the options as described below.

Hold down the Alt key while adjusting a slider to view a preview of its effect on the image.

5. Do one of the following:

l Click Done to apply your changes and close the Remove Noise tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Noise Removal Options
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Apply to channel

Modifies a targeted color channel by mixing the existing color channels in the image.

Noise Type

Camera Noise
Removal

Removes digital camera noise. Adjust the following sliders to
further remove noise:

Luminance Reduces the random variations of brightness in the noise.

Strength Controls the strength of the Luminance tool.

Color Noise
Reduction

Drag the slider to the right to remove color noise from the image.
Hold down the Alt key while using the slider to see the remaining
color noise in the image.

Tonal
Range

Tonal Range refers to a range of average brightness values in an
image. For example, the tonal range of a photo taken in a dark
cavern it would be low, whereas a sunny sky would be high.

The Tonal Range slider increases in value from left to right,
increasing from a low tonal range on the left to a high tonal range
on the right. The Tonal Range slider is used to focus noise
reduction to areas of the image that have a corresponding tonal
range. For example, the left-most position would reduce the noise
in a cavern more than a sky.

Tonal Range only affects luminance noise reduction.

Frequency
Range

The Frequency Range slider adjusts the noise pattern. High
frequency noise looks like fine static while low frequency noise
looks like coarse grain or "splotches". Move the Frequency Range
slider to the left to limit noise reduction to high frequency noise.

Frequency Range affects both luminance and color noise
reduction.

Median Noise
Removal

Reduces impulsive, or salt-and-pepper noise while preserving
edges. Select from the following options to further remove noise:

Square Removes noise using a 3 x 3 pixel square.

X Removes noise using a 3 x 3 pixel X shape. Use this option when
you want to preserve an image's thin and diagonal lines.

Plus Removes noise using a 3 x 3 pixel plus (+) shape. Use this option
when you want to preserve an image's thin, vertical, and
horizontal lines.
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Despeckle Removes noise.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Adding Noise

You can use the Add Noise tool to add a grainy texture to an image. Adding small amounts of noise can
reduce the appearance of minor imperfections in the original image.

You can save your settings as a preset for future use.

To Add Noise to an Image:

1. In Edit mode, in the Detail group, select Noise.

You can also access the Noise tool from the Filter drop-down menu or Filter toolbar.

2. Select the Add Noise tab.

3. Set the options as described below.

4. Do one of the following:

l Click Done to apply your changes and close the Add Noise tool.

l Click Cancel to discard all changes and close the tool.

Click Reset to clear your changes and reset to default settings. If you saved your changes, you
cannot reset your settings.

Add Noise Options
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Intensity Specifies the amount of noise to add to the image. A higher intensity
increases the chance that a noise pixel will replace a pixel in the original
image.

Color proximity Specifies the color of noise pixels to add to the image. A lower value gives
each noise pixel a color similar to the pixel it replaces. Higher values
result in a random selection of the noise pixel color.

Noise color Select one of the following options to specify noise pixel color:

l Random: randomly selects the color.
l Monochrome: produces black and white noise pixels.
l Adjustable: randomly selects the color of each noise pixel, but

more pixels match a defined color. To define a color, click the color
picker and select a color.

Noise placement Adds noise to image areas that closely match a defined color. Check the
Set color checkbox to enable noise placement, and click the color picker
to specify a color.

Randomize Indicates the random placement of noise in an image.

When you use the Add Noise tool, ACDSee Home places the noise pixels
based on a random seed. This makes the image noise different each time
you use the Add Noise tool. You can define a specific random seed to
generate identical image noise.

To generate a new random seed, click Randomize.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

Adjusting Clarity

The Clarity tool adds subtle definition to the details in your image. Use the Clarity tool to enhance the
contrast of midtones in your images, without overpowering the shadows and highlights.

You can save your settings as a preset for future use.

To Adjust the Clarity of Your Image:
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1. In Edit mode, in the Detail group, select Clarity.

You can also access the Clarity tool from the Filter drop-down menu or Filter toolbar.

2. Drag the Strength slider to the right for greater clarity, or to the left for reverse clarity.

3. Do one of the following:

l Click Done to accept your changes and close the panel.

l Click Cancel to discard your changes and close the panel.

You can also type a number into the number box and incrementally make precise
adjustments.

You can right-click a slider to reset to the default value.

You can use the Edit Brush to paint this effect onto specific areas of your image.

You can use the Gradient tool to transition this effect across specific areas of your image.

You can use the Radial Gradient tool to apply effects around, or directly to, a center point.

Using People Mode

Peoplemode is a dedicated space for managing all your images of the people in your life.

Peoplemode can be accessed by selecting the Peoplemode icon in the mode bar, or by selecting
Tools | Manage People... from theManagemodemain menu.

There are three views in Peoplemode:

l Named

l Unnamed

l Person

The Named and Unnamed views can be accessed from the Named and Unnamed buttons directly
above the results grid in the button bar. To access the Person view, double-click a person's facial image
in Named view only.

In Unnamed and Person view, select faces by clicking the face, or multi-select with Ctrl + click,
Shift + click. Click the mode switch toolbar to take your selected thumbnails directly to View
or Editmode. Double-clicking on a single thumbnail will bring the image into Viewmode.
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For both the Unnamed and Person views, toggle the Show Face Thumbnails icon and the

Source Image Thumbnails icon to view the face thumbnail or the entire source image.

Named View

The Named view in Peoplemode is populated with images of all the people that have been assigned a
name in the ACDSee photo database. Images of identified people can be merged (for people with
many like-sounding names such as "Jonathan", "Johnny", "John"), renamed, or removed. Double-
clicking a person opens that person's Person viewwhere all of the person's assigned faces reside and
AI-prepared suggestions can be confirmed or denied.

The Named viewwill display the number of faces assigned to each person. More faces can still
be assigned beyond 9999.

Unnamed View

The Unnamed view in Peoplemode is populated with faces that haven't been assigned a name.

The Unnamed view can be filtered between Grouped and Ungrouped faces by toggling the drop-down
list located at the far right of the button bar above the facial images.

In Grouped, the view is split between two panes. The top pane displays grouped faces with a number
in the bottom-right corner of each, indicating howmany similar faces have been detected. The bottom
pane shows both the total number of faces and the faces associated with the selected group(s).
Grouped faces are similar enough in structure that the AI in People mode suggests grouping them
together.

In Ungrouped, the view displays a flat grid of all of the unnamed faces in the database. Ungrouped
images are all of the single facial images without AI-generated groups applied.

The Unnamed view is used to manage the unnamed faces by assigning them to a name, or deleting
the face.

Person View

In Peoplemode, the Person view is a display of all faces associated with one person.

The Person view is comprised of two separate areas:

l The Assigned Faces pane, a collection of facial images previously assigned with the person's name.

l The Suggested Faces pane, a collection of faces that AI considers a possible match with the person.

Person view can only be accessed from the Named view.
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Folders Pane

The Folders pane is used for filtering results by folder. Click to select a single folder, or multi-select with

Ctrl + click, Shift + click, or by clicking the Easy-Select arrows to the left of the folder names.

The Folders pane is located to the left of the results grid and has two views:

l Tree view, for an expanded view of folders visited in Manage mode that contain faces.

l List view, for a flat list of folders containing faces.

Use the View button to the right of the Folders label to toggle between the Tree view and the List view.

Use the Folders Refresh icon below the Folders label to clear the current folder selection.

The Named View

The Named view in Peoplemode is populated with images of all the people that have been assigned a
name in the ACDSee photo database. Images of identified people can be merged (for people with
many like-sounding names such as "Jonathon", "Johnny", "John"), renamed, or removed. Double-
clicking a person opens that person's Person viewwhere all of the person's assigned faces reside and
AI-prepared suggestions can be confirmed or denied.

The Named viewwill display the number of faces assigned to each person. More faces can still
be assigned beyond 9999.

To Merge People:

1. In People mode, in the Named view, select more than one person.

2. Right-click one of the selected people.

3. From the context menu, selectMerge People.

4. In the Merge People dialog, do one of the following two options:

l Enter a new name in the Enter or select a name field, or

l Select a name from the Enter or select a name dropdown.

5. Click the OK button.

Merging can also be driven from the Edit menu.

To Rename a Person:

1. In People mode, in the Named view, select a person to rename.

2. Right-click the selected person.

3. From the context menu, select Rename Person.
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4. Enter the person's new name in the highlighted bar beneath the person's image.

5. Press Enter.

Renaming can also be driven by clicking an associated name box beneath the image, or from
the Edit menu.

To Remove a Person or Persons:

1. In People mode, in the Named view, select a single person or people to remove.

2. Right-click the selected person(s).

3. From the context menu, select Remove Person(s).

4. In the prompted dialog, click the OK button.

Removing can also be driven from the Edit menu.

Grouping People:

Located directly above your named people and to the right-side of the Named and Unnamed buttons,
the Group dropdown is used to alter how people are presented. Groups can be sorted forward or
backward.

Type Description Example

Name
Displays people grouped by names.
Groups are ordered alphabetically by
first letter.

Use this when you want to organize all detected people
under their assigned names for easier browsing and
verification.

Face
Count

Displays people grouped by the
number of detections for each
person.

Use this when you want to prioritize people that appear
most frequently in your photos, which can speed up
tagging for commonly seen individuals.

Suggestion
s

Displays people grouped by whether
or not suggestions are available for
each detected person.

Use this when you want to review people that specifically
do or do not have suggestions.

Right-click on group headers to show options for collapsing and expanding groups.

Unnamed View

The Unnamed view in Peoplemode is populated with faces that haven't been assigned a name.

The Unnamed view can be filtered between Grouped and Ungrouped faces by toggling the drop-down
list located at the far right of the button bar above the facial images.
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In Grouped, the view is split between two panes. The top pane displays grouped faces with a number
in the bottom-right corner of each, indicating howmany similar faces have been detected. The bottom
pane shows both the total number of faces and the faces associated with the selected group(s).
Grouped faces are similar enough in structure that the AI in People mode suggests grouping them
together.

In Ungrouped, the view displays a flat grid of all of the unnamed faces in the database. Ungrouped
images are all of the single facial images without AI-generated groups applied.

The Unnamed view is used to manage the unnamed faces by assigning them to a name, or deleting
the face.

To Delete the Face From the Unnamed View:

1. Select the face to be deleted.

2. Do one of the following:

l Right-click the face and select Delete Face(s) from the context menu,

l Select Edit | Delete Face(s) from the main menu, or

l Press Delete.

To Assign a Name to an Unnamed Face Using the Name Bar:

1. Click the bar beneath an unnamed face.
2. Enter a name.
3. Press Enter.

When pressing enter, the cursor will be automatically taken to the next unnamed face.

To Assign a Name to an Unnamed Face Using the Context Menu:

1. Right-click an unnamed face.
2. Select Name Face(s)... from the context menu, or press F2,
3. Enter a name in the Name field.
4. Click OK.

Faces supplied with names automatically disappear from the Unnamed view and are
populated into the Named view.

In Grouped, deleting or naming a group in the top pane will affect all of the faces in the group.
Deleting or naming faces in the bottom pane will affect only those faces.

Deleting Images and Faces in the Unnamed View:

To Delete Faces:
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1. Select one or more unnamed faces.

2. Perform one of the following:

l Select Edit | Delete Face(s).

l Right-click on one of the selected faces and select Delete Face(s) from the context menu

l Press Delete.

To Delete Images:

1. Right-click one or more selected unnamed faces.

2.  Perform one of the following:

l Select Edit | Delete Image(s).

l Right-click on one of the selected faces and select Delete Image(s) from the context menu.

l Press Ctrl + Delete.

Deleting images in Peoplemode will delete them from the hard drive entirely.

Person View

In Peoplemode, the Person view is a display of all faces associated with one person.

The Person view is comprised of two separate areas:

l The Assigned Faces pane, a collection of facial images previously assigned with the person's name.

l The Suggested Faces pane, a collection of faces that AI considers a possible match with the person.

Person view can only be accessed from the Named view.

Assigned Faces Pane

The Assigned Faces pane is populated with facial images previously assigned with the person's name.
Each image in the Assigned Faces pane has a right-click context menu detailed in the following table.

Assigned Faces Pane Context Menu Options
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Menu Item Shortcut Description

Rename Face(s)... F2 Opens the Rename Face(s) dialog where a
new name can be entered. The facial
image is automatically removed from the
current Person view and placed in the
Named view after a new name is applied.

Remove Face(s)... Delete Removes the name from the facial image
and returns the image to the Unnamed
view.

Set as Profile Sets the selected image as the profile
image for the person.

Delete Face(s) Shift + Delete Removes the association with a person and
deletes the facial image from People
mode.

Delete Image(s) Ctrl + Delete Deletes the source image from the hard
drive.

Renaming Faces

To rename faces, you can left-click on a face in Assigned Faces and press F2, or right-click and choose
Rename Face(s)... in the Context menu. This will bring up a Rename Faces dialog where a new name
can be entered. When confirming the new name, the face will be automatically moved to the new
person.

The Suggested Faces Pane

The Suggested Faces pane is populated with faces that AI considers a possible match with the person.

When the AI in Peoplemode considers unnamed faces to be a possible match for a person, a face icon

will appear in the lower left corner of a named face in Named view.

You can manage Suggested Faces by clicking on the green check mark icon to confirm, the red

crossed out circle icon to deny, or by clicking directly into the text field for the name and changing
the namemanually. If you've clicked into the text field for the name, pressing Enterwill confirm your
change and automatically move to the next face in Suggested Faces. Each image in the Suggested
Faces pane has a right-click context menu detailed in the following table.

The total number of suggested faces will display above the face suggestions.

Suggested Faces Pane Context Menu Options
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Menu Item Shortcut Description

Confirm Face(s)... Enter Confirms the AI-generated suggestion as
belonging to the person. The green
check mark icon located in the name

bar beneath the facial image can also be
used to confirm.

Deny Face(s)... Delete Removes the AI-generated suggestion
from the facial image and returns the
image to the Unnamed view. The red
crossed out circle icon located in the

name bar beneath the facial image can
also be used to deny.

Rename Face(s) F2 Opens the Rename Face(s) dialog where
a new name can be entered. The facial
image is automatically removed from the
current Person view and placed in the
Named view after a new name is
applied.

Delete Face(s) Shift + Delete Removes the AI-generated suggestion
from the facial image and deletes the
facial image from People mode.

Delete Image(s) Ctrl + Delete Deletes the source image from the hard
drive.

To confirm or deny all faces in the pane, click the Confirm All Suggestions icon or the Deny

All Suggestions icon located at the far right of the Suggested Faces pane header bar.

Confirming a face by pressing Enterwill move the Suggested Face into Assigned Faces and
highlight the next Suggested Face.
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Chapter 7: 365 Mode
For help with seedrive.acdsee.com, click theWeb tab, then click Support.

You can use 365mode to upload your images to seedrive.acdsee.com, an image sharing and storage
service available to ACDSee Home users. With 365mode and seedrive.acdsee.com, you can upload
and browse through your online images without having to launch an Internet browser. You need to
create a seedrive.acdsee.com account first, before uploading your photos.
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With seedrive.acdsee.com, you can:

l Create Your seedrive.acdsee.com Account

l Upload Images

l Set Privacy Settings for Your Image Folders
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Working in 365 Mode

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

You can use 365mode to upload your images to seedrive.acdsee.com, an image sharing and storage
service available to ACDSee Home users. With 365mode and seedrive.acdsee.com, you can upload
and browse through your online images without having to launch an Internet browser. Or you can
access seedrive.acdsee.com at any time directly from an Internet browser.

365 Mode Has Two Parts: seedrive.acdsee.com and Transfer

To enable the seedrive.acdsee.com and Transfer tabs, you need to create a
seedrive.acdsee.com account.

seedrive.acdsee.com Clicking the seedrive.acdsee.com tab takes you to seedrive.acdsee.com,
where you can browse through images you have uploaded to your online
account, see other users' images, or upgrade your membership level.
seedrive.acdsee.com has the following menus:

l Manage: organize your images into folders.
l Upload: click Upload to switch to Transfer for uploading images.
l Profile: modify your profile and set specific information to public or
private.

l Support: see the Help or FAQs for assistance with seedrive.acd-
see.com.

Transfer Transfer allows you to upload images to your seedrive.acdsee.com
account. In Transfer, the screen splits into two. The bottom of the screen
displays the available images in your computer, and the top of the screen
displays your seedrive.acdsee.com account.

You cannot take an image from 365mode and open it in Edit mode for editing. To edit an
image, select an image in Manage or Viewmode and open it in Edit mode for editing.

Creating an ACDSee 365 Account

Before you can upload your images to seedrive.acdsee.com, you need to create an account.

To Create an ACDSee 365 Account:

1. Click the 365 tab to enter ACDSee 365 mode.

2. Press the Sign Up button.

3. Enter your information into the fields and click Create your account.
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If you already have an account, click the Sign In button.

Uploading Images to ACDSee 365

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

ACDSee 365, or seedrive.acdsee.com, is an image sharing and storage service for ACDSee users. Before
you upload photos, you need to create a seedrive.acdsee.com account. There is no size limit for
uploading images to your seedrive.acdsee.com account.

Depending on your ACDSee 365 account level, you can also upload videos.

To Upload Your Images:

1. In 365 mode, click Sign In.

2. Log in to your account.

3. Click Upload to switch to Transfer.

Your screen splits in two, with the bottom part of the screen displaying images on your
computer, and the top part of the screen representing your images online.

4. Use the drop-down list in the top right corner to select one of the following:

l Upload Original with associated data: upload image in current file format, including any
associated files such as those containing metadata. This option is the best for images you want to
archive.

l Upload Original (as JPG): uploads image as a JPG in its original size.

l Upload 1920 x 1440 JPG: converts the image to JPG and sets the size to 1920 x 1440. This
option is the best for high quality JPGs.

l Upload 1024 x 768 JPG: converts the image to JPG and sets the size to 1024 x 768. This option
results in the fastest upload.

5. Do one of the following to select an image to upload:

l Click and drag an image into the top part of the screen to upload it to your seedrive.acdsee.com
account. To select multiple images, press the Shift or the Ctrl key and click on the images to
select them. You can also click and drag your cursor to select multiple images.

l Drag a folder of your images to the top part of the screen.

l Select images and click the up arrow icon beside Transfer Manager, or click Sync to Web to
upload all the images in the Sync to Web folders.
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When upload is complete, images are displayed in the order they were uploaded. Overlay icons
indicate the file type and if the image has been edited.

You can upload a folder with sub-folders. 365mode respects folder hierarchy when uploading
a folder to your seedrive.acdsee.com account.

Setting Folders to Sync to Web

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

You can set specific folders on your computer to upload all of their images to specific folders on
seedrive.acdsee.com. As you add new images to the folder on your computer, you can quickly sync
the corresponding folder on seedrive.acdsee.com by pressing the Sync to Web button. The sync works
in one direction; images from your computer are uploaded to your seedrive.acdsee.com account.

To Set a Folder to Sync to Web:

1. In 365 mode, click Sign in.

2. Click the Transfer tab.

3. In the Folders pane in the bottom half of the screen, right-click a folder and select Set as "Sync to Web"
Folder or click Alt + A.

4. In the Setup "Sync to Web" Folder dialog box, set the options as described below.

5. Click OK.

You can also set Sync to Web folders by clicking File |Manage Sync to Web Folders.

To Run Sync to Web:

1. In Transfer, on the right side along the screen split, click Sync to Web.

2. Click OK.

To Edit a Folder's Sync to Web Settings:

1. In Transfer, in the Folders pane in the bottom half of the screen, right-click a Sync to Web folder, and
select Edit "Sync to Web" Folder.

2. In the Edit "Sync to Web" Folder dialog box, set the options as described below.

3. Click OK.

Sync to Web Folder Options
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Upload Type Use the drop-down list to select one of the following:

l Upload Original with associated data: uploads images in their current file
format, including any associated files such as those containing metadata.
This option is the best for images you want to archive.

l Upload Original (as JPG): converts the image to JPEG in it's original size.
l Upload 1920 x 1440 JPG: converts the image to JPEG and sets the res-

olution to 1920 x 1440. This option is the best for high quality JPEGs.
l Upload 1024 x 768 JPG: converts the image to JPEG and sets the res-

olution to 1024 x 768. This option is the best for images you want to view
on a Netbook, and results in the fastest upload.

Local Folder Displays the path to the folder you selected. Click the browse button to select a
different folder.

Online Folder Enter a name for the online folder. By default this is set to the same name as the
folder on your computer that you want to sync to Web.

Sync to Web right
away

Check this box to upload the images in the selected folder immediately. If you do
not check this checkbox, you can click Sync to Web to upload all the images in all
the folders you have chosen to sync.

Creating Folders and Setting Privacy

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

In seedrive.acdsee.com and Transfer, you can create folders and make them private or public. When
you make a folder public, anyone can find and see the images in that folder. You can also copy the URL
for your public folders and share it with family and friends.

When you create a new folder, it is set to private by default.

To Create a Folder and Make it Private or Public in Transfer:

1. In 365 mode, click Transfer.

2. In the Folders pane on the top left, right-click your user name, and select New Online Folder...

3. In the New Online Folder dialog box, enter a name for the new folder.

4. Click OK.

By default the new folder is Private.

To change the folder to Public , right-click on the folder, and then click Make Public.

To Share the URL for a Public Folder:



ACDSee Photo Studio Home 2026

Page 409 of 532

1. In 365 mode, click Transfer.

2. In the Folders pane on the top left, right-click on a public folder.

3. Click Copy URL.

4. Paste the URL into an email, instant message, or other application to share it.

Right-click a public folder and select Share folder to share in an email, post on a social
networking site, or to create a widget.

Changing the Rating System

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

Photos that you have rated in Manage mode are rated with a star rating system in 365mode. You can
select how to use stars to rate your photos.

To Change Your Rating System:

1. Click Tools and then select Options.

2. In the Options dialog box, select ACDSee 365.

3. In Ratings, select Convert 'Rating 1' to 5 stars or Convert 'Rating 1' to 1 star.

4. Click OK.

Downloading Images

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

seedrive.acdsee.com is also a storage service for ACDSee Home users. You can download your images
from your seedrive.acdsee.com account to your computer at any time.

To Download Your Images:

1. In 365 mode, click Sign In.

2. Log in to your account.

3. Click the Transfer tab.

Your screen splits in two, with the bottom part of the screen displaying images on your
computer, and the top part of the screen representing your images online.

4. In the top part of the screen, in the Folders pane in the top left, navigate through your
seedrive.acdsee.com folders to the images you want to download.
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5. In the bottom part of the screen, in the Local Computer pane, select a folder that you want to download
your image to.

6. Do one of the following to select an image to download:

l Click and drag an image into the bottom part of the screen to download it to your computer. To
select multiple images, press the Shift or the Ctrl key and click on the images to select them.
You can also click and drag your cursor to select multiple images.

l Drag a folder of your images to the bottom part of the screen.

l Select images and click the down arrow icon beside Transfer Manager.

Using the Transfer Manager

For help with seedrive.acdsee.com, click theWeb tab, then click Support.

The Transfer Manager lets you monitor the progress of your uploads and downloads on your
seedrive.acdsee.com account, and also lets you cancel or pause image transfers. The Transfer
Manager has two tabs: Uploads and Downloads. These two tabs list images that are being uploaded,
downloaded, paused, or canceled.

To Open the Transfer Manager:

Click Tools | Transfer Manager.

You can do the following in Transfer Manager:

Cancel an upload or download.

Retry the image upload or download.

Pause an upload or a download.

Continue the image upload or download.

Selects all images in the list.

Clear uploaded, downloaded or canceled images from the list.
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Chapter 8: Dashboard Mode

Using Dashboard Mode

Dashboard mode provides an easy way to monitor your file, camera, and database statistics in one
place. Camera data is gathered from your image metadata, and file information is analyzed from your
ACDSee database. To see the most accurate information, make sure your files are cataloged.

Cataloging Files

To catalog your files, do one of the following:

l Go to Tools | Database | Catalog.

l Browse your folders in Manage mode.

Dashboard Mode Tabs

Dashboard mode is organized into four tabs, each giving you a different view of your data:

l Overview tab: Provides a high-level summary of your photo activity and database status.

l At the top, a graph shows your photo counts by month or year. Use the drop-down menu to
switch between Yearly and Monthly views, and the Prev and Next buttons to move through
time.

l Below the graph, you will find:

l Database Summary: Total Database Size, Total # of Files and Folders, and Last Backup
Date.

l Cameras Summary: Camera Most Used, Total # of Cameras, and Favorite ISO Setting.

l File Summary: # of Image and Video Files, Favorite File Format, and Favorite Image
Resolution.

This tab is useful for a quick health check of your photo collection and
database.

l Database tab: Displays detailed information about your database so you can track its size, structure, and
backup status.
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l Total Database Size: Includes the database file path.

l File Information: A breakdown of Image Files, Video Files, and Other Files.

l Folder Information: Counts for Folders Browsed, Remote Folders Browsed, and Removable
Folders Browsed.

l Orphan Assets: Shows the number of orphaned Files and Folders.

l ACDSee Database Backup: Displays your last backup date, so you can confirm your data is safe.

l Thumbnail Information: Includes the size of the Thumbnail Cache and how many images have
thumbnails.

Use this tab to monitor database performance and ensure your backups and
thumbnails are up to date.

l Cameras tab: Shows how you use your cameras and lenses.

l The Cameras Summary panel (on the left) highlights your Most Used Camera, Lens, Focal
Length, Aperture, Shutter Speed, and ISO.

l The main display includes:

l Circle graphs showing the number of photos by Camera, Lens, and Focal Length, with
percentage breakdowns.

l Bar graphs showing the number of photos by Aperture, Shutter Speed, and ISO.

l You can toggle these graphs on or off from View | Graphs.

This tab helps you understand your shooting habits, such as which lenses or
settings you use most often.

l Files tab: Displays information about your image and video files.

l The File Summary section (upper left) shows the total number of files, your favorite file format,
and your most common image resolution.

l Two circle graphs provide a breakdown of File Formats and Bit Depths, with percentages
displayed in a legend.

l A bar graph displays the Top 20 Image Resolutions in your collection.

This tab gives you insight into the types of files you work with most frequently.
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Chapter 9: PicaView

About ACDSee PicaView

ACDSee PicaView is a quick and easy file viewer "add-on" for Windows/File Explorer™ that saves you
time by letting you preview files without having to open them in an application. If you right-click, you
can view your image EXIF information or view your image files in various sizes — including RAW files.
You can also view a preview of any other image file format supported by ACDSee. You can access the
ACDSee PicaView preview by right-clicking a file in Windows/File Explorer™.

You can configure a variety of ACDSee PicaView's settings, including the size of the preview, what
information displays, and more. Access these settings by clicking ACDSee PicaView | Options..., or
through ACDSee, by going to Tools | Options... and navigating to ACDSee PicaView in the Options
dialog's menu.

To Adjust the ACDSee PicaView Options:

1. Right-click a file in Windows/File Explorer™ to access the ACDSee PicaView preview.

2. At the top of the preview, click ACDSee PicaView | Options...

3. On the ACDSee PicaView Options dialog, set or change the options as described below.

4. Click OK to apply your changes.

ACDSee PicaView Options

Display Image

Check the Display Image checkbox to display a preview of the right-clicked file on the context menu.

Location l Add image to main menu: when you right-click,
displays preview in the main menu.

l Add image to sub-menu: when you right-click,
displays preview in a sub-menu, available by
clicking the arrow next to ACDSee PicaView.

Size Select the size of the preview that displays when you
right-click.

Show Original Select Show Original to display the pre-edited version
of the image when you right-click.

Show EXIF Information

Check or uncheck the Show EXIF Information checkbox to display the right-clicked photo's EXIF
information.
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Using ACDSee Quick View

ACDSee Quick View is an image viewer that you can use to quickly view images without opening
ACDSee. For example, imagine that you want to view an image that someone sent to you in an email. If
you double-click the image it will open in Quick View, which is like a pared-down version of Viewmode
in ACDSee.

With Quick View you can quickly scroll through your images, temporarily rotate images, and zoom in
and out. If you are viewing a particularly appealing image in Quick View, you can also set the image as
your desktop wallpaper or print the image.

You can easily switch from Quick View to ACDSee. You also have the option to open an image in
Manage, Media, View, or Edit mode.

If you are accustomed to using keyboard and mouse shortcuts in Viewmode you can use most of
those shortcuts in Quick View as well.

To Open an Image in Quick View:

1. With ACDSee Home closed, double-click an image. For example, double-click the image in Windows
Explorer or in an email message.

2. Use the viewing options described below to view the image.

ACDSee Quick View Viewing Options

Previous View the previous image.

Next View the next image.

Rotate Left Rotate the image to the left.

Rotate Right Rotate the image to the right.

Zoom In View the image at a higher magnification.

Zoom Out View the image at a lower magnification.

Delete Move the image to the computer's Recycle Bin.
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You can close ACDSee by pressing Esc.

To Open the Image in ACDSee:

Click Manage, Media, View, or Editmode.

To Set an Image as Your Desktop Wallpaper:

1. Click Previous or Next until the image that you want to make your desktop wallpaper displays in Quick
View.

2. Click Tools | Set Wallpaper and select one of the following:

l Centered: displays the image in the center of the desktop.

l Tiled: displays the image in one or more tiles until the desktop is covered. If the image is small it
may appear in several tiles on the desktop. If the image is large it may appear in only one or two
tiles.

l Stretched: stretches the image proportionally to fill as much of the desktop as possible.

To Restore Your System to the Default Desktop Wallpaper:

Click Tools | Set Wallpaper | Restore.

To Print the Image:

1. Click File | Print.

2. Under Format, choose a print size.

3. On the Printer Options tab, specify the printer you want to use, the paper size, the number of copies
you want, the range of pages that you want to print, and image resolution.

4. On the Page Settings tab, specify the image position on the paper and the margin widths, and specify
the number of prints of each photo.

5. Add captions, headers, or footers.

6. Click Print.

Using Windows Touch Gestures™ with Quick View

If you have a Windows Touch Gestures™-enabled device, you can use it with ACDSee Quick View for
quick, easy viewing of photos.

To Use Windows Touch Gestures™ with Quick View:

Open an image in ACDSee Quick View.
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l Swipe on the image to scroll through images one at a time.

l Hold and swipe slowly in one direction to go through all of the images in the folder.

l Hold down on an image, and then let go to achieve the same results as right-clicking with a mouse.

l Double-tap the image to launch it in ACDSee.

l Move two fingers apart to zoom in, and toward each other to zoom out.

l After zooming in, you can pan the image with your finger. To return, choose View | Zoom | Fit Image.
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Chapter 10: Options and Configuration

Setting the General Options

You can adjust settings in the Options dialog box to display helpful tips, set the format for date
displays, set automatic rotate options, and control the display of certain image types.

To Access the General Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click General.

3. On the General page, set or change any of the options described below.

4. Click OK to apply your changes and return to ACDSee.

General Options

Enable gamma correction Applies the specified amount of gamma correction when viewing or
previewing images.

Automatically stretch wallpaper to
fit screen

Stretches small images to fit the entire desktop when you set them
as your wallpaper.

Disable image animation Displays only the first frame of an animated image in Manage
mode's Preview pane and in View mode.

Automatically rotate JPEG and TIFF
images based on EXIF orientation

Automatically corrects the orientation of TIFF and JPEG images
(based on their EXIF data) when displayed in ACDSee.

Status bar date Specifies the date to display in the status bar for a selected file.

Date/Time output format Select one of the following:

l Default system format: uses the default system format when
displaying the date and time in information overlays.

l Custom format: uses the specified format to display the date
and time in all information overlays. Select a format for both
Date and Time from the drop-down lists.

Show icon in Taskbar Notification
area

Displays the ACDSee Home icon in the Taskbar Notification area.

Show the Mode Switching icons Displays the icons next to the names of each mode.
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Setting the Auto Advance Options

You can control which applied metadata will trigger Auto Advance.

To Adjust the Auto Advance Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click General | Auto Advance.

3. On the Auto Advance page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Auto Advance Options

Enable Auto Advance in l Manage Mode
l View Mode

Deselect to turn off Auto Advance in
either Manage or View mode.

Auto Advance when
applying/clearing

l Tags
l Ratings
l Labels
l Categories
l Keywords

Specifies which applied or removed
metadata will trigger Auto Advance.

Keywords and Categories are
disabled by default.

Setting the Mode Configuration Options

You can control the appearance of the mode buttons to maximize viewing space.

To Set the Mode Button Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, clickMode Configuration.

3. On the Mode Configuration page, hide modes by unchecking their corresponding checkboxes.

You cannot hide Manage mode.

4. Use the modes' corresponding drop-down menus to set them to display icons and labels, labels only, or
icons only.

5. Click Condense the appearance of the mode buttons to conserve space with smaller mode buttons.

6. Click OK.
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Setting the Batch Operation Options

You can control which error logs appear for batch operations including batch rename, batch resize,
and batch convert.

To Adjust the Batch Operation Options:

1. In any mode, click Tools | Options... or press Alt + O.

2. In the Options dialog box, click General | Batch Operations.

3. On the Batch Operations page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Batch Operations Options

Don't show results for
AI Super-Resolution

Check the box to prevent results from being output when AI Super-Resolution
completes.

Don't show results for
Batch Rename

Check the box to prevent results from being output when Batch Rename completes.

Setting the Batch AI Super-Resolution Options

You can enhance multiple images at once using the batch AI Super-Resolution tool.

To Enhance Multiple Images:

1. In Manage mode, select one or more images, and then click Tools | Batch | AI Super-Resolution |
AI Super-Resolution..., or press Shift + S.

2. In the Batch AI Super-Resolution dialog box, you can choose from multiple ways to enhance your
images. Choose either Percentage, Size in Pixels, Print Size, Long Edge, or Short Edge. Follow the
directions in the table below.

3. Click Options to specify how you want to save and store the images.

4. Click Enhance.

You can save your enhance settings as a preset by clicking the save icon beside the preset
drop-down. From there, enter a name and press OK. To delete a preset, press the trash icon.

You can assign shortcuts to speed up your process of enhancing multiple images by following
the directions in the Customizing Keyboard Shortcuts topic.

Resizing Options
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Resize Method Setting Explanation

Percentage

Width Enter a new width for the images as a percentage of
the original image.

Height Enter a new height for the images as a percentage of
the original image.

Preserve original
aspect ratio

Check this box to keep the width-to-height ratio of
the original images.

Size in Pixels

Width Enter a new width for the images in pixels.

Height Enter a new height for the images in pixels.

Preserve original
aspect ratio

Check this box to keep the width-to-height ratio of
the original images.

Fit within Specifies whether the aspect ratio is maintained
based on the specified width. For more information
about how the different combinations affect the
images, see Pixel resize options and resulting action.

Print Size

Width Enter a new width for the images in pixels.

Units Choose from inches, cm (centimeters), mm
(millimeters), or pixels.

Height Enter a new height for the images in pixels.

Resolution Enter a resolution for the images in pixels per inch.

Preserve original
aspect ratio

Check this box to keep the width-to-height ratio of
the original images.

Fit within Specifies whether the aspect ratio is maintained
based on the specified width. For more information
about how the different combinations affect the
images, see Pixel resize options and resulting action.

Long Edge

Size Enter a size in units, and choose the units from the
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Resize Method Setting Explanation

drop-down menu. There, you can choose from
inches, cm (centimeters), mm (millimeters), or
pixels.

Resolution Enter a resolution for the images in pixels per inch.

Short Edge

Size Enter a size in units, and choose the units from the
drop-down menu. There, you can choose from
inches, cm (centimeters), mm (millimeters), or
pixels.

Resolution Enter a resolution for the images in pixels per inch.

Options

Output Location Choose an output location from the options:

l Same as source folder: pastes the enhanced
files in the folder they originated.

l Specific folder: use the folder icon to
navigate to a specific folder for the output
files.

l Create subfolder: with an output location
selected, check this checkbox to create a
subfolder for your enhanced images. Enter a
name in the box. This is useful if you are
making multiple batch resizes to specific
dimensions. You can save your enhanced files
in separate folders.

File options Overwrite Existing Files: Sets the default action when
overwriting files.

l Ask: Asks for confirmation before overwriting
any files.

l Skip: Skips any files that would be
overwritten.

l Rename: Prompts a renaming dialogue for
the new file when output is complete.

l Replace: Replaces the original file with the
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Resize Method Setting Explanation

new enhanced one.

Preserve last-modified dates: Toggles whether the
last-modifed dates are saved into the enhanced file
output.

Preserve metadata: Toggles whether metadata is
saved into the enhanced file output.

Preserve database information: Toggles whether
database information is saved into the enhanced file
output.

Setting the Manage Mode Options

You can use the Options dialog box to set various options for Manage mode, including the default
start folder.

To Set Manage Mode Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, clickManage Mode.

3. On the Manage mode page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Manage Mode Options
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Startup Behavior

On Startup Opens Manage mode on launch with one of four startup behaviors:
Open ACDSee Home Page, Open Start Folder, Reopen Last Active
Tab, or Reopen All Previous Tabs.

Start Folder Designates where new tabs will open. Click the Browse button to
locate a starting folder on your hard drive. If Open Start Folder is
selected for On Startup, always opens Manage mode to the specified
start folder on startup.

Display theme

Specifies the color scheme to use in ACDSee.

Clear path history on exit

Clears the list of recently-accessed folders whenever you exit ACDSee.

Show full path in title bar

Displays the full path of an image in the ACDSee title bar.

Show database filename in title bar

Displays the name of the database that ACDSee is currently running in the title bar.

Folder Tree

Display Density Sets how condensed the Folder tree appears.

Use plus signs to expand
folder tree

Displays plus signs next to items on the Folder tree that can be
expanded.

Error Reporting

Select this option if you do not want to see a system error report if there is an error in ACDSee.

Scanning Destination

Click the Browse For Folder button to specify the destination for your scanned images.

Setting the ACDSee Home Page Options

You can adjust settings in the ACDSee Home Page Options dialog to control how Recently Modified
and Recently Added searches work in your database.

To Access the ACDSee Home Page Options:
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1. In any mode, click Tools | Options...

2. In the Options dialog box, click ACDSee Home Page.

3. On the ACDSee Home Page Options page, set or change any of the options described below.

4. Click OK to apply your changes and return to ACDSee.

ACDSee Home Page Options
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Recently Modified in the Last: Select a time frame to display Recently Modified files.

Options include:

l 1 day

l 3 days

l 1 week

l 2 weeks

l 1 month

l 3 months

l 6 months

l 1 year

Recently Added in the Last: Select a time frame to display Recently Added files.

Options include:

l 1 day

l 3 days

l 1 week

l 2 weeks

l 1 month

l 3 months

l 6 months

l 1 year

Search by: Specify how Recently Added searches are calculated.

Options include:

l Date Taken: Uses the EXIF Date/Time Original, or the
Windows Date Created for files that don't have EXIF
Date/Time Original.

l Date Added to Database: Uses the ACDSee Imported Date.

Setting the Quick Search Options

You can use the Quick Search options to refine your search.



ACDSee Photo Studio Home 2026

Page 426 of 532

To Set Quick Search Options:

1. In Manage mode, click Tools | Options...

2. In the Options dialog box, clickManage Mode | Quick Search.

3. On the Quick Search page, set or change any of the Quick Search options described below.

4. Click OK to apply your changes and return to ACDSee.

Search Fields Description

Include file names Searches for file and folder names that begin with the search term.

Include ACDSee
Metadata and
IPTC fields

Searches for ACDSee Metadata fields such as Caption, Author, Notes, and Color
Labels, in addition to IPTC fields such as Title, Headline, Description, People,
Keywords, Creator, City, Location, State/Province, Country, and Instructions.

Include ACDSee
Categories

Searches for ACDSee Categories that match the search term, and returns any files
assigned to those categories. Subcategories are not included.

Include ACDSee
Keywords

Searches for ACDSee Keywords that match the search term, including subkeywords.

Include people Searches for people detected in images and named using Face Detection in View
mode.

Search for People Description

Assigned names When you search using the Quick Search bar, ACDSee will return photos with names
assigned using Face Detection.

Suggested names: When you search using the Quick Search bar, ACDSee will return photos with names
suggested by ACDSee, (but not confirmed by you).

Both assigned and
suggested names:

When you search using the Quick Search bar, ACDSee will return photos with both
assigned and suggested names.

Search Results Description

Return contents of
folders

Checks the search results for folders and adds folders' contents to the results when
selected.

You must select at least one search field to save changes to these options.

Setting the Face Detection and Recognition Options

You can toggle Face Detection on and off, trigger Face Detection to rerun, or allow the ACDSee Indexer
to undertake Face Detection while your computer is idle.
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To Set the Face Detection Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click Face Detection.

3. On the Face Detection page, set or change the options as described below.

4. Click OK.

Face Detection Options
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Face Detection

Enable Face Detection Toggle this option to turn on Face Detection. With this option
enabled, Face Detection will run on files encountered during
browsing in Manage mode. In View mode, Face Detection
will run on the open image only.
Once Face Detection has been run on an image, that
information is stored in the database. Therefore, with this
option disabled, previously detected faces will still display
face outlines and names (if named) in View mode. You will
also be able to search using the names you have assigned to
faces.

Allow Face Detection to detect faces
while your computer is idle using the
ACDSee Indexer.

You can enable Face Detection to be undertaken by
the ACDSee Indexer. The ACDSee Indexer will allow the Face
Detection process to be done when your computer is idle
and ACDSee is not running. This allows you to avoid having to
browse all of your folders.

While browsing, automatically rerun
Face Detection on images that have
changed since Face Detection last
ran.

Toggle this option to allow Face Detection to be rerun
automatically on images that have changed since the last time
Face Detection was run while you browse or edit your
images.

Facial Recognition

Enable Facial Recognition Toggle this option to turn on Facial Recognition. With this
option enabled, ACDSee will attempt to recognize individuals
based on the faces you have named in previous images.

Use the slider to set how similar two faces need to be in
order for ACDSee to identify them as the same individual.

Moderate: the default setting is optimized to name most
faces without adding too many incorrect names.

Aggressive: faces need to be less similar in order to be
recognized. This option is useful if your photo collection
consists of just a few people in a wide variety of poses,
lighting, and film quality. You may experience more incorrect
names.

Conservative: faces need to be more similar in order to be
recognized. This option is useful if your photo collection
consists of a large number of different people, especially if
those people are physically similar, such as close family
members. You will experience fewer incorrect names, but
may have to manually name people more frequently.
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If the Enable Auto Naming option is enabled, all
three settings can result in incorrect names,
especially when Facial Recognition encounters a
person for the first time. If you experience more
incorrect names than you can reasonably
correct by hand, disable Facial Recognition and
manually name several faces for each person in
your photo collection. Then, re-enable Facial
Recognition, and, if necessary, rerun Facial
Recognition on a selection of files, or your entire
library.

Enable Auto Naming Toggle this option to turn on or off Auto Naming.

Disabled: When disabled, Photo Studio will not automatically
assign names to faces, giving you full control over naming.
Face Detection will provide suggestions based on faces that
you've already named.

Enabled: When enabled, Photo Studio will automatically
assign names to faces based on faces that you've already
named.

Remove All Face Data

Removes all data related to Face Detection and Recognition from the database, including face outlines,
names, and information relating to whether Face Detection has been run on files. This action will require
ACDSee to restart.

Rerun Recognition

In order to correct names mistakenly assigned to faces by ACDSee, you can rerun facial recognition on faces
you have not manually named. This clears all names assigned by ACDSee's facial recognition, but leaves
manually entered names. ACDSee will then attempt to recognize unnamed faces based on names you have
entered manually.

Faces can only be auto named if the Enable Auto Naming option is enabled.

Setting the File List Pane Options

You can use the Options dialog box to set options for the File List pane to suit your preferences, such
as grouping archive files with subfolders, or highlighting image types with different background colors.
You can also customize your thumbnails, the file types ACDSee Home displays, and adjust how
ACDSee Home handles files and thumbnails in the File List pane.

To Adjust the File List Pane Options:

file:///private/var/mobile/Containers/Data/Application/87FEB746-6753-4670-802A-1839F879044A/tmp/com.apple.coherence/%23enable-auto-faces
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1. In any mode, click Tools | Options...

2. In the Options dialog box, click File List.

3. On the File List page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

File List Options
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File List

Automatically select new files Automatically selects new files when they
are added to the folder displayed in the File
List pane.

Group archives with folders Treats archive files as folders when sorting
items in the File List pane.

Use embedded thumbnails Displays the RAW files embedded thumbnail
if the RAW file has them.

Generate high quality thumbnails Creates a high-quality thumbnail of the RAW
file in the background while the embedded
thumbnail is displayed, then replaces the
poorer quality thumbnail once it is ready.

Show thumbnails on folders Displays thumbnails of a folder's contents on
the folder icon in the File List pane.

Remember each folder's sort settings Select this option if you want ACDSee Home
to remember the sort settings that you used
in specific folders.

<Ctrl> key activates hot-tracking Activates hot-tracking when holding the Ctrl
key. Hot-tracking means that when you hold
down Ctrl and hover over an image in
Manage mode, the contents of the Preview
and Properties panes will update, without
you having to click on each individual image.

Use animations Activates or deactivates animation for some
features as they close or open. For example,
group headers.

Configure Filters

Show all files Shows image files, folders, media files and
archive files in the File List.

Apply filtering criteria Shows any of the following that you select,
and hides any that are not selected.

l Show image files

l Show folders

l Show media files
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l Show archive files

Show hidden files and folders Shows system and other files and that are
normally hidden for safety.

Show THM files Shows Canon THM files in the File Fist.

Show XMP files Shows XMP sidecar files in the File List.

Highlight image files

Don't highlight image files Does not highlight image files in Details and
Thumbs+Details views.

Use a single color to highlight image files Uses a single color to highlight all image file
types in Details and Thumbs+Details views.

Use multiple colors to highlight image files Uses a different color to highlight each image
type in Details and Thumbs+Details views.

Pop-ups

Mouse cursor hover activates pop-ups Activates or deactivates the animated pop-up
preview that displays when you hover over
thumbnails in the File List.

Settings below allow you to include text
and/or an image in the pop-up, or if you turn
this option off, to activate the pop-up only
when you hold down the Shift key.

<Shift> key activates pop-ups Activates the pop-up only if you hold down
the Shift key while hovering over a thumbnail
in the File List. You can turn this option off if it
interferes with Shift selection.

Auto hide pop-ups Hides pop-ups after 5 seconds, even if you
are still hovering over the image.

Show thumbnail in pop-ups Shows a pop-up preview of images in the File
List when you hover over them with a
mouse.

Show information in pop-ups Includes text file information in the mouse-
over pop-up. You can select the information
to display by clicking the Configure file
information...button and selecting your
desired pop-up information.
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Configure file information

Opens the Choose Pop-up Information dialog where you can select what information to display in the pop-
up when you hover over a thumbnail in the File List. The default is file name, location, size, modified date,
and image dimension, but you can select other ACDSee Metadata, EXIF, file, image, IPTC, or multimedia
attributes.

Show the Windows Explorer shell context menu as the default right-click menu

Displays the default Windows Explorer context menu instead of the ACDSee Home context menu.

Setting the Thumbnail Info Options

You can use the Options dialog box to change the information that displays with thumbnails of images
in the File List pane. These options are set under File List | Thumbnail Info.

To Adjust the Thumbnail Info Options:

1. In Manage mode, click Tools | Options...

2. In the Options dialog box, click File List | Thumbnail Info.

3. On the Thumbnail Info page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Thumbnail Info Options
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Information

File name Displays the name of each file on the thumbnail in the
File List pane.

Choose Thumbnail Info Opens a dialog box where you can select the information
to display on each thumbnail in the File List pane.

Choose Tiles Info Opens a dialog box where you can select the information
to display on each tile in Tiles view mode.

Show unrated, untagged, and unlabeled
overlay icons on hover

Shows unrated, untagged, and unlabeled overlay icons
when you hover over them.

Overlay icons

To view the overlay icons, go to Browsing Files in the File List Pane.

Rating Displays a rating overlay icon on thumbnails if the file has
been rated in the ACDSee Home database.

Embed Pending Displays a database overlay icon on the thumbnails of
files that have had metadata information added and
stored in the ACDSee Home database, but have not yet
been written to the files. This icon indicates that a file
and the database are out of sync.

Icon Displays a file format overlay icon on thumbnails in the
File List pane.

Category Displays a category overlay icon on thumbnails if the file
has been categorized.

Collection Displays a collection overlay icon on thumbnails if the file
has been added to a collection.

Shortcut Displays a shortcut overlay icon on thumbnails if the item
is a shortcut to another file.

Offline Displays an offline overlay icon on thumbnails if the file is
stored on an offline device.

Excluded items Displays an excluded file icon on thumbnails if the file is
excluded from the ACDSee Home database.

Tagged items Displays a tagging overlay icon on thumbnails. If the file is
tagged, a checkmark displays in the icon.

Auto-rotate Displays an auto-rotate overlay icon on thumbnails if the
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file was automatically rotated.

Edited Displays an Edit overlay icon on thumbnails if the file has
been edited.

Geotagged Displays a marker overlay icon on thumbnails if the file
has been pinned on the map.

Label Displays a color label overlay icon on thumbnails if the
file has been labeled.

Setting the Thumbnail Style Options

You can use the Options dialog box to change how the thumbnails of images display in the File List
pane. These options are set under File List | Thumbnail Style.

To Adjust the Thumbnail Style Options:

1. In Manage mode, click Tools | Options...

2. In the Options dialog box, click File List | Thumbnail Style.

3. On the Thumbnail Style page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Thumbnail Style Options
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Thumbnail frame

Show drop shadow Shows thumbnails with a 3D drop shadow.

Show slide background Displays a shaded background behind the thumbnail and
its information.

Folder style

XP style folder Displays folders as an XP-style image.

3D style folder Displays folders as a 3D folder with transparency.

Thumbnail ratio

Custom Specifies a custom height-to-width ratio for the shape of
the thumbnails in the File List pane. Drag the slider under
the preview to set the ratio. The preview shows you the
shape as you move the slider.

Portrait Specifies a standard 3:4 portrait ratio for the shape of the
thumbnails in the File List pane.

Landscape Specifies a standard 4:3 landscape ratio for the shape of
the thumbnails in the File List pane.

Thumbnail spacing

Slider Increases or decreases the space between each
thumbnail.

High-quality scaling

Uses high-quality thumbnail scaling in the File List pane.

Setting the Details View Options

You can use the Options dialog box to change how thumbnails display in the File List pane.

To Adjust the Details View Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click File List | Details View.

3. On the Details View page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Details View Options
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Show grid lines Separates each row and column in Details view mode with a
grid line.

Full row select Selects the entire row when you click a column entry in that
row.

Column auto-width Automatically resizes each column to fit its contents.

Highlight sort column Highlights the column used to sort files when you click on
the column's title.

Choose Details Specifies the columns you want to use to sort files in Details
view mode.

Setting the Preview Pane Options

You can specify how ACDSee Home displays previews of your images, and configure settings to play
audio and video files automatically, as soon as you view them in the Preview pane.

To Set the Preview Options:

1. Do one of the following:

l In Manage mode, click Tools | Options | Preview...

l In Manage mode, right-click in the Preview pane and select Preview Options.

2. On the Preview options page, set or change the options as described below.

3. Click OK to apply your changes and return to ACDSee.

Preview Options
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Delay Specifies how quickly the Preview pane displays an image after
you select it in the File List pane.

Size Specifies the size of the previewed image in relation to the
selected image.

Preview audio and video clips Previews media files as you select them in the File List pane.

Autoplay audio and video clips Automatically starts playing audio and video files in the Preview
pane.

Instant image preview Displays an instant preview that improves in quality as the
image is decoded.

Image and Information Select one of the following:

l Show image: displays a preview of the selected image
in the Preview pane.

l Show information: displays information about the
selected image in the Preview pane.

Choose Preview Info Specifies the type of information you want to display in the
Preview pane. For more information, see Previewing Images.

Setting the Folders Pane Options

You can customize the Folders pane by showing or hiding the Easy-Select bar, displaying archives, and
identifying excluded folders.

To Customize the Folders Pane:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click Folders.

3. On the Folders page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Folders Pane Options
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Easy-Select

Show Easy-Select Displays the Easy-Select bar in the Folders pane, which you can
use to select multiple folders.

Enable Easy-Select tooltip Displays a tool-tip when you place your cursor over the Easy-
Select bar.

Folder display

Show archives in Folder Pane Lists archive files in the Folders pane.

Confirm drag & drop move
within folder views

Prompts you for confirmation of folder movements within the
Folders pane.

Show overlay for excluded
folders

Displays an overlay icon on folders that are excluded from the
ACDSee Home database.

Setting the Catalog Pane Options

You can customize the Catalog pane to specify which confirmations you want to be prompted for while
working with categories, and choose whether to show the Easy-Select bar.

To Set the Catalog Pane Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click Catalog.

3. On the Catalog page, set or change the options as described below.

4. Click OK.

Catalog Options
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Category deletion

Confirm if category has assigned files Prompts you for confirmation when deleting a
category with assigned files.

Confirm if category has sub-categories Prompts you for confirmation when deleting a
category containing sub-categories.

File removal

Confirm file removal from category Prompts you for confirmation when un-
assigning files from a category.

Easy select

Show Easy-Select Displays an Easy-Select bar in the Catalog pane,
which you can use to select multiple categories,
special items, and ratings.

Enable Easy-Select tooltip Displays a tool-tip when you place your cursor
over the Easy-Select bar.

Icons

Show icons for categories, ratings, color labels,
and special items

Displays icons so you can easily identify
categories, ratings, color labels, and special
items.

Enable setting categories, keywords, ratings, and
color labels

Allows you to set categories, ratings, and color
labels in the Catalog pane.

Setting the Calendar Pane Options

You can customize the ACDSee Home Calendar to start each week on a specific day, to use a 12 or 24-
hour clock format, and to use one of four date types when sorting files.

To Set the Calendar Pane Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click Calendar.

3. On the Calendar page, set or change any of the options described below.

4. Click OK to accept your changes and return to ACDSee.

Calendar Pane Options
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Date types

Database date Sorts files in the Calendar pane based on the date stored in the
ACDSee Home database.

Date taken Sorts files in the Calendar pane based on the EXIF date of each
item.

File modified date Sorts files in the Calendar pane based on the last-modified date of
each item.

File created date Sorts files in the Calendar pane based on the date each file was
created on your computer.

Filters

Apply Advanced File List Filters
(excluding folders)

Filters the items displayed in the Calendar pane based on the
current File List pane filter settings.

Show image and media files only Displays only image, audio, and video files in the Calendar pane.

Start of week

Specifies the first day of each week in the Calendar pane.

Clock formats

12 hour Uses a 12-hour clock in the Calendar pane.

24 hour Uses a 24-hour clock in the Calendar pane.

Setting the CD/DVD Management Options

You can use the Options dialog box to set the preferred method for identifying Photo Discs.

To Change the Photo Disc Identification Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click CD/DVDManagement.

3. On the CD/DVD Management page, set or change any of the options described below.

4. Click OK to apply your changes and return to ACDSee.

CD/DVD Management Options
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Photo Disc Identification

Use disc volume label Attempts to identify a Photo Disc by its volume label. This
setting is recommended if you are working with multi-
session Photo Discs.

Use disc serial number Attempts to identify a Photo Disc by its serial number.
This setting is preferred when working with single-
session Photo Discs, or importing or converting Photo
Discs from a previous version of ACDSee.

Setting the Properties Pane Options

You can use the Options dialog box to customize the information available on the Metadata tab in the
Properties pane.

To Customize the Metadata Tab in the Properties Pane:

1. In Manage mode, click Tools | Options...

2. In the Options dialog box, click Properties Pane.

3. On the Properties Pane page, hide the Tagged, Rating, and Color Labels, by unchecking the
corresponding checkbox.

4. Hide the Categories by unchecking the checkbox.

5. ClickManage Metadata Views to open the Choose Metadata to Display dialog box.

6. Click the plus signs to expand the tree and select your preferences.

7. Click OK.

8. Click OK to apply your changes and return to ACDSee.

You can also click the Metadata View drop-down list in the Properties paneMetadata tab and
selectManage Metadata Views.

Setting the File Management Options

You can specify how ACDSee Home handles renaming and deleting files and folders, and whether
ACDSee Home sends deleted files to the desktop Recycle Bin by default.

To Set the File Management Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click File Management.
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3. On the File Management page, set or change any of the options as described below.

4. Click OK to accept your changes and return to ACDSee.

File Management Options

Confirmations

You can use the following options to display confirmation dialogs upon folder or file deletion.

In order for the settings in this dialog to take effect, you must enable them in your Recycle Bin Properties
settings.

l Enabled: A confirmation prompt will be displayed if the Recycle Bin setting "Display delete
confirmation dialog" is enabled.

l Disabled: No confirmation prompt will be displayed regardless of the Recycle Bin setting.

Overwriting duplicate files

Ask Prompts you for confirmation when overwriting duplicate files.

Rename Automatically resolves any naming conflicts when moving or
copying files by renaming the source files. In the Separator
character field, type a character to use to separate file names in
the automatic renaming system.

Replace Automatically overwrites files in the target folder without
prompting for confirmation.

Skip Does not move, copy, or overwrite any files that result in naming
conflicts.

Save Originals

Saves a copy of the original file when it is edited using one of the batch editing tools. This makes it possible
to restore the original file later. Turning this option off means that originals are not saved during batch
editing, and so cannot be restored.

In Edit mode, a copy of the original file is always saved, whether or not this option is selected.

Other

Click to edit file name Specifies that file names can be edited by clicking the file name in
the File List pane.

Use Recycle Bin Sends files to the Desktop Recycle Bin. If not selected, deleted files
are permanently removed from your hard drive.

Preserve database information
when files are copied

Copies database information with files when you copy them to
another location.
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Control confirmations for folder delete, file delete, and read-only rename and delete actions in
your operating system settings.

Setting the Database Options

You can adjust settings in the Options dialog box to display reminders, control database information,
and specify a location on your hard drive where you want to store your database files and cached
thumbnails.

To Set the Database Options:

1. In any mode, click Tools | Options...

2. In the Options dialog, click Database.

3. On the Database page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Database Options



ACDSee Photo Studio Home 2026

Page 445 of 532

Database file

Displays the location on your hard drive where the ACDSee Home database is stored.

Display backup reminder

Automatically reminds you to back up your ACDSee Home database. Click the Every drop-down list and select
how often you would like to be reminded.

Manage excluded folders

Opens the Excluded Folders List dialog box, where you can specify which folders you want to exclude from
the ACDSee Home database.

Set database date to EXIF date

Automatically adds the EXIF date to the ACDSee Home database when you catalog the contents of a folder.

Note: if the database date is changed, the Embed Pending icon does not show up.

Metadata

Import EXIF
and IPTC
metadata
from
cataloged
files

Automatically imports EXIF and IPTC information into the ACDSee Home database
whenever you catalog the contents of a folder.

If this option is not selected, ACDSee Home does not import the EXIF and IPTC
information, but does set aside space within the database records. To remove the empty
records, be sure to optimize your database frequently.

Set "Embed
Pending"
when
tagging files

Displays a database overlay icon on thumbnails if the file has been tagged, but this
metadata has not yet been written to the file. This icon indicates that the file and the
database are out of sync. When this option is disabled, tagged images will not show up
under Embed Pending in the Special Items section of the Catalog pane.

IPTC conflicts

Show
separator
conflict
dialog for
IPTC
keywords

Displays the IPTC Keywords dialog box when a separator conflict occurs. You can specify
a method of handling conflicts within the dialog and select not to display it again. Select
this option to change or adjust those settings the next time a separator conflict occurs.

Show
separator
conflict
dialog for
IPTC

Displays the IPTC Supplemental Categories dialog box when a separator conflict occurs.
You can specify a method of handling conflicts within the dialog and elect not to display it
again. Select this option to change or adjust those settings the next time a separator
conflict occurs.
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al categories

Setting the Media Options

You can change what application handles your audio and video files when launched from ACDSee.

To Customize the Default Media Player for Files Launched from ACDSee:

1. In any mode, click Tools | Options...

2. In the Options dialog box, clickMedia.

3. To launch audio and video files in your system's default media player, check the Use default media
player to open audio and video files checkbox.

4. Click OK to apply your changes.

Setting the Embed ACDSee Metadata Options

You can adjust settings in the Options dialog box to set options for auto-embedding ACDSee
Metadata, choosing what metadata is embeded, how files and drives interact with it, and prompt
settings.

To Set the Embed ACDSee Metadata Options:

1. In any mode, click Tools | Options...

2. In the Options dialog, click Embed ACDSee Metadata.

3. On the Embed ACDSee Metadata page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Embed ACDSee Metadata Options
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Auto-Embed ACDSee Metadata

l Do not auto embed metadata: [Set by Default] Selecting this will disable auto-embedding of ACDSee
Metadata.

l Embed metadata on shutdown: Selecting this will embed pending ACDSee Metadata on program
shutdown.

l Display embed reminder every: Selecting this will embed pending ACDSee Metadata on the day
selected in the dropdown.

Choose Metadata to Embed

l Embed ACDSee Metadata: Selecting this allows ACDSee Metadata to be embedded to images.

l Embed Categories into IPTC: Selecting this will allow ACDSee to automatically embed
categories into IPTC when embedding metadata.

l Embed Keywords into IPTC: Selecting this will allow ACDSee to automatically embed keywords
into IPTC when embedding metadata.

l IPTC Write Behavior: When selecting to embed Keywords or Categories into IPTC metadata, you
can choose how the data is saved alongside previously saved metadata.

l Merge: Keywords or Categories will be added to any existing IPTC Keywords and/or
IPTC Supplemental Categories.

l Overwrite: Keywords or Categories will replace any existing IPTC Keywords and/or
IPTC Supplemental Categories.

l Embed ACDSee Face Data: Selecting this will allow ACDSee to automatically embed pending Face Data
to images when embedding metadata.

Files and Drives

l Write sidecar files for formats that do not support embedded XMP: Selecting this will create sidecar
files for formats that do not support directly embedded XMP.

l Download and include online OneDrive files: Selecting this will include files from connected
OneDrives.

l Include files on network drives: Selecting this will include files on connected network drives.

Prompts

l Do not prompt when embedding ACDSee Metadata: While selected, the initial prompt before
embedding ACDSee Metadata will not be displayed.

l Do not show the summary page after embedding metadata: While selected, the summary page will not
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appear after embedding ACDSee Metadata.

Setting the View Mode Options

You can use the Options dialog box to adjust the behavior of Viewmode to suit your preferences, and
increase the speed with which images are displayed.

To Set the View Mode Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click View Mode.

3. On the View mode options page, set or change any of the View mode options described below.

4. Click OK to accept your changes and return to ACDSee.

View Mode Options
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Decoding and caching

Decode next image in advance Automatically decodes the next image in
sequence in View mode, resulting in shorter
load times.

Keep previous image in memory Keeps the previously decoded image in
memory for quick display in View mode.

Startup files

Replace images in list Does not open a new View mode window if an
image is opened from another application.

Images in new window Opens a new View mode window to display
images opened from another application.

Dropped files

Replace images in list Replaces the list of images open in View mode
with images dropped into View mode from
another application.

Add images to list Adds any images dropped into View mode by
another application to the list of images
already open.

Always on top

Keeps the ACDSee Home window as the top window in a stack of windows.

Full-screen

Opens images in View mode in full-screen mode. (Press F to exit full-screen mode.)

Hide mouse cursor in full-screen

Hides the cursor in full-screen mode.

Instant image preview

Displays an instant preview in View mode that improves in quality as the image is decoded.

Use ACDSee Home Quick View

If selected, ACDSee Home Quick View is set as the default viewer for images when ACDSee Home is closed.

Show pixels when zoomed past 100%
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Resampling is not applied to images zoomed past 100%. When the box is unchecked, images zoomed past
100% are resampled to produce smooth transitions, but this may result in excessive blurring.

Always open in selected Auto Lens

On startup, opens images in the Auto Lens last selected prior to closing ACDSee.

Exit after delete/move

Automatically returns to Manage mode after moving or deleting an image in View mode.

View all images in folder

Adds all images in a folder to the current image list when viewing any file from that folder.

Show full image file path

Displays the image's full file path in View mode title and status bars.

Sharpen subsampled images

Automatically sharpens the view for images zoomed in at less than 100%.

Setting the People Mode Options

Select Tools | Options... from the main menu to open theOptions dialog and select "People Mode"
from the left-hand list.

The options in the People Mode pane include four field sets:

l Confirmation Prompts
l Thumbnail Style
l Folder Pane Style
l Unnamed View Style

Confirmation Prompts Options

Do not prompt when confirming all suggestions
Enable to turn off prompts when
confirming all suggestions.

Do not prompt when denying all suggestions
Enable to turn off prompts when
denying all suggestions.

Do not prompt when deleting faces
Enable to turn off prompts when
deleting faces.

Thumbnail Style Options
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Face Thumbnail Enable to use thumbnails featuring
the person's face.

Asset Thumbnail Enable to use thumbnails featuring
the entirety of the asset's original
dimensions.

Folder Pane Style Options

List
Enable to use the List view as the
default for the Folders pane.

Tree
Enable to use the Tree view as the
default for the Folders pane.

Unnamed Style Options

Ungrouped Enable to use the Ungrouped cat-
egory as a default for sorting the
Unnamed view results.

Grouped Enable to use the Grouped cat-
egory as a default for sorting the
Unnamed view results.

Pop-ups Options
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Mouse cursor hover activates pop-ups Enable to allow amouse cursor
hover to activate pop-ups.

<Shift> key activates pop-ups Enable to allow the pressing of the
Shift key to activate pop-ups.

Auto hide pop-ups Enable to auto-hide pop-ups.

Show thumbnail in pop-ups Enable to show thumbnail images
of the original image in the pop-
up.

Show information in pop-ups Enable to show image-related
information in the pop-up.

Configure Information... If the Show information in pop-
ups check box is enabled, click the
Configure information... button to
open the Choose Pop-up Inform-
ation dialog. Available details can
be added or removed from the list
of currently displayed details
which can also be moved up or
down in the list.

Setting the Display Options

You can use the Options dialog box to change the window background and specify how images are
zoomed.

To Set the Display Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click Display.

3. On the Display options page, set or change the options described below.

4. Click OK to accept your changes and return to ACDSee.

Display Options
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Zoom options

Default zoom mode Specifies the default zoom level for images in
View mode.

Reset zoom mode to default on every image
change

Resets the zoom mode to the selected default
when the displayed image changes.

Resize Resizes the image based on the selected
option. For more information about how these
choices affect the Viewer, see Automatically
shrinking or enlarging images.

Pan tool

Enable click-zooming Deselect to turn off the one click image toggle
between Default view and Actual Size view.

Pan speed

Slow - Fast Specifies the speed when panning an image.

Background

Default color Uses the default ACDSee Home color for the
background in View and Edit mode.

Custom color Specifies a color to use as the background in
View and Edit mode.

Tiled image Uses a tiled image as the background for View
and Edit mode. Click Browse to locate an image
on your hard drive.

The background color and tiled image options do not affect full screen mode.

To change the background color in ACDSee Quick View, open an image in Quick View, and then
click Tools | Options.

Setting the Edit Mode Options

You can use the Options dialog box to show icons in Edit mode.

To Show Icons in the Edit Pane:
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1. In any mode, click Tools | Options...

2. In the Options dialog box, click Edit Mode.

3. Set the options as described below.

4. Click OK to apply your changes and return to ACDSee.

Edit Show icons on filter
menu pane

Displays icons next to the tools in Edit.

AutoSave all changes Toggles AutoSave on and off. AutoSave saves your changes in Edit
mode automatically, without prompting the Save Changes dialog.

GPU selection In order to ensure optimum performance, parts of Edit mode
run off of your GPU. ACDSee Home automatically chooses the
best GPU in your system. This option —Let ACDSee decide — is
enabled by default. When Let ACDSee decide is enabled, GPU
model text displays next to the option, specifying whether Edit
mode is running off of your primary GPU or another, more
superior GPU that ACDSee Home has detected. In most cases, the
GPU detected and identified as the best by ACDSee Home will be
one and the same: your primary GPU.

l Use primary: you can enable this option if you prefer to use
your primary GPU over the GPU ACDSee Home has chosen.

l Let ACDSee decide: select this option to enable using the
superior GPU found by ACDSee.

Setting the ACDSee 365 Options

You can use the Options dialog box to set options for ACDSee 365, such as the temporary folder
location and what to do with uploads and downloads when you close ACDSee.

To Set the ACDSee 365 Options:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click ACDSee 365.

3. On the ACDSee 365 page, set or change any of the options described below.

4. Click OK to accept your changes and return to ACDSee.

ACDSee 365 Options



ACDSee Photo Studio Home 2026

Page 455 of 532

Folder locations

Temporary folder Click the Browse button to change the folder
where ACDSee Home temporarily keeps files
during uploads and downloads.

Uploads/Downloads

On shutdown, always pause all transfers Pauses all transfers when you close ACDSee.

On startup, always automatically resume all
paused transfers

Resumes all transfers when you reopen
ACDSee.

Number of concurrent uploads (1-10) Select the number of files to be uploaded at
the same time.

Number of concurrent downloads (1-10) Select the number of files to be downloaded at
the same time.

Ratings

Convert 'Rating 1' to 5 stars Converts a numeric rating of 1 to five stars.

Convert 'Rating 1' to 1 star Converts a numeric rating of 1 to one star.

Setting the ACDSee Showroom Options

You can customize the ACDSee Showroom desktop slideshow in a number of ways, including changing
the slide duration, order, and transition or changing the frame opacity, size, and frame style.

To Customize the ACDSee Showroom Desktop Slideshow:

1. Start ACDSee Showroom by doing one of the following:

l In any mode, click Tools | Create | ACDSee Showroom.

l Click Start | Programs | ACD Systems | ACDSee Showroom.

2. Right-click anywhere in the ACDSee Showroom window and select Options.

3. Set or change the options as described below.

4. Click Set As Default to use the currently selected options as the default for new Showroom windows.

5. Click OK to apply your changes.

ACDSee Showroom Options
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Picture Folder

Include subfolders Select this option if you want to include photos from
subfolders in the slideshow.

Skip hidden folders Select this option to skip hidden folders such as the [Originals]
folders that are created when you process images.

Slide

Duration Drag the slider to the left to decrease the display time for
each photo and to the right to increase the display time for
each photo.

Order From the Order drop-down list select Sequential to display
photos in order or Random to display photos randomly.

Transition From the Transition drop-down list select None if you do not
want any special transition effects, Slide if you want photos to
enter the window from the right and exit to the left, and Fade
if you want to reduce photo opacity during the transition from
one photo to another.

Apply to all Select Apply to all if you want to apply these changes to all
slideshows.

Showroom Window

Opacity Drag the Opacity slider to the left to reduce the opacity of the
Showroom window and to the right to increase opacity.

Size From the Size drop-down list select either a Small,Medium,
or Large Showroom window frame.

Frame From the Frame drop-down list select a frame style.

Always on top Select Always on top if you want the Showroom window to
display on top of all other application windows.

Apply to all Select Apply to all if you want to apply these changes to all
Showroom windows.

Run at startup

Select Run at startup if you want to start ACDSee Showroom automatically when you start your computer.
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Setting the ACDSee Quick View Options

You can customize ACDSee Quick View in a number of ways, including displaying Quick View on top of
any open windows, displaying Quick view at full screen, or even changing the background color in the
Quick Viewwindow.

To Customize ACDSee Quick View:

1. Double-click on an image. For example, double-click on the image in Windows Explorer or in an email
message.

2. Click Tools | Options...

3. Set or change the options as described below.

4. Click OK to apply your changes.

ACDSee Quick View Options
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Use ACDSee Quick View

If selected, ACDSee Quick View is set as the default viewer for images when ACDSee Home is closed.

Enable gamma correction

Applies the specified amount of gamma correction when viewing images.

Disable animation

Displays only the first frame of an animated image.

Always on top

Keeps the Quick View window as the top window in a stack of windows.

Full screen

Opens images in the Quick View window in full screen mode.

Hide mouse cursor in full screen

Hides the cursor in full screen mode.

Default zoom mode

Fit image Displays the image at the largest magnification that fits in the Quick
View window. Images that are smaller than the Quick View window dis-
play at their original size.

Actual size Displays the image at its actual size in the Quick View window.

Background

Default color Uses the ACDSee Home background color in Quick View.

Custom color Specifies a color to use as the background in the Quick View window.
Click the color swatch to select a different color.

Setting the Media Options

You can change what application handles your audio and video files when launched from ACDSee.

To Customize the Default Media Player for Files Launched from ACDSee:

1. In any mode, click Tools | Options...

2. In the Options dialog box, clickMedia.
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3. To launch audio and video files in your system's default media player, check the Use default media
player to open audio and video files checkbox.

4. Click OK to apply your changes.

Setting the ACDSee Indexer Options

You can use the Options dialog to customize the functionality of the ACDSee Indexer.

To Customize the ACDSee Indexer:

1. In any mode, click Tools | Options...

2. In the Options dialog box, click ACDSee Indexer.

3. On the ACDSee Indexer page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

ACDSee Indexer Options

Auto index folders or
images when computer is
idle for

Enables the indexing of folders or images while the computer is idle. Set the
slider to indicate how long your computer should be idle before indexing begins.

Index image files only Deselect to index all file types supported by ACDSee.

Current database Displays which database will be indexed.

Folders to monitor Displays which folders will be indexed.

Add Folder... Click the Add Folder... button to add additional folders to be indexed.

Remove Folder Select a folder from the list and click the Remove Folder button to remove it
from the folders to be indexed.

Include Microsoft
OneDrive

Enables the indexing of your OneDrive folder.

Setting the ACDSee PicaView Options

You can use the Options dialog box to change your ACDSee PicaView settings, as well as toggling it on
and off.

To Adjust the ACDSee PicaView Options:

1. In Manage mode, click Tools | Options...

2. In the Options dialog box, click ACDSee PicaView.
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3. On the ACDSee PicaView page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

ACDSee Picaview Options

Enable ACDSee Picaview

This checkbox enables or disables ACDSee PicaView. When enabled, ACDSee PicaView appears when an
ACDSee-supported file is right-clicked anywhere on your hard drive. You have the option of displaying a
preview of the file or image, and its EXIF information, or one or the other.

Display Image

Check the Display Image checkbox to display a preview of the right-clicked file.

Location: l Add image to main menu: when you right-click,
displays image in the main menu.

l Add image to sub-menu: when you right-click, displays
image in a sub-menu, available by clicking the arrow
next to ACDSee PicaView.

Size: Select the size of the preview that displays when you right-
click.

Show Original Select Show Original to display the pre-edited version of the
image when you right-click.

Show EXIF Information

Check or uncheck the Show EXIF Information checkbox to show or hide the right-clicked photo's EXIF
information.

Setting the ACDSee Mobile Sync Options

You can use the Options dialog box to change your ACDSeeMobile Sync settings.

To Set the ACDSee Mobile Sync Options:

1. In any mode, click Tools | Options...

2. In the Options dialog, click ACDSee Mobile Sync.

3. On the ACDSee Mobile Sync page, set or change the options as described below.

4. Click OK to apply your changes and return to ACDSee.

ACDSee Mobile Sync Options
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Root Folder Click the Browse For Folder button to specify the destination for your sent images
and videos.

Server Name To customize the name of the target server (ACDSee on your PC), enter text in
the field. This name will appear in your list of targets in the ACDSee Mobile Sync
app.

Show ACDSee Mobile
Sync Root Folder on
Folder Tree

Displays the ACDSee Mobile Sync folder in the Folders pane.

Import Options

Use the Import Options tool to seamlessly migrate settings from the previous version of ACDSee
starting with 2022.

The Import Options tool will import all settings in every Options page, with the exception of Mode
Configuration.

If a previous version of ACDSee Photo Studio is installed (beginning with 2022), ACDSee Photo
Studio Home 2026 will automatically import your options upon the first time the program is
run.

To Use the Import Tool:

While options are imported automatically, there may be times where you need to import your options
again. For example, if you were to install a newer version of ACDSee Photo Studio Home 2026 and then
went back to a previous version and made a few changes to the settings. Manually importing the
options will allow you to bring over your most recent settings, no matter when your software was
installed.

1. Click on Tools | Options…

2. In the dialog box, click on Import Options under General

3. Click Import…

4. Click OK on the confirmation dialog

5. Click OK when prompted to restart ACDSee

If the previous version of ACDSee has not been launched on this machine the option will not
appear.

The import tool is only available when importing from a previous year and within the same
product model. (e.g. ACDSee Photo Studio Home 2026 can only import options from ACDSee
Photo Studio Home 2022 or newer.)
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The import tool will always import from the most recent previous version that can be found.
(e.g. ACDSee Photo Studio Home 2022 and ACDSee Photo Studio Home 2023 are both
installed, only the settings from ACDSee Photo Studio Home 2023 will be imported.)

When importing Search options, only the Quick Search options will be affected.

Auto-hiding Panes and Panels

You can use the Auto Hide button to automatically hide some panes and panels in ACDSee. When a
pane is set to auto-hide, it rolls away when you click outside of it, leaving a tab displayed. You can
access the pane by moving the cursor over the tab. When a pane or panel is floating, the auto-hide
feature is not available. You cannot move the pane to a new location if it is set to auto-hide.

The Auto Hide button's appearance on the pane’s title bar reflects its current setting:

A horizontal pushpin indicates that the pane is set to automatically hide when you click
outside of it.

A vertical pushpin indicates that the pane is fixed and will remain visible even if you click
outside of it.

To Set or Remove Auto-Hide:

Click the Auto Hide button on the title bar so that it displays a slanted or horizontal pushpin.

Using the Task Pane

The Task Pane displays groups of often-used tasks from the menus and toolbars based on your
current location and selections in ACDSee. By default, the Task Pane opens on the right side of the
Manage mode window.

To Open or Close the Task Pane:

In Manage mode, click Panes | Task Pane.

The menus in the Task Pane change depending on what area of the Manage mode window you are
working in and what items you select. For example, if you select more than a folder in the File List
pane, the Task Pane displays different menus than it does if you select a photo or media file.

The options on the Task Pane menus also change dynamically. For example, if you select multiple
images in the File List, the options in the Fix and Enhance Photos menu change to list options that you
can use with multiple images.
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Customizing Toolbars

You can customize the appearance and organization of toolbars in Manage mode and Viewmode by
selecting which toolbars to display, and specifying each toolbar’s buttons or commands. You can also
discard your changes and reset the toolbars to their default layout at any time.

Displaying and Hiding Toolbars

You can choose to display or hide the specific toolbars in Manage mode and Viewmode.

To Display or Hide a Toolbar:

l In Manage or View mode, click View | Toolbars, and then select the toolbar you want to display or hide.

Customizing Toolbar Contents

You can customize the following toolbars:

l In Manage mode: the Main toolbar and the File List toolbar.

l In View mode: the Bottom toolbar.

You can add, remove, and rearrange buttons on these toolbars. You can also display or hide text
labels and tool tips for the buttons on these toolbars. All toolbar customization options are in the
Customize dialog box.

To Display the Customize Dialog Box:

Do one of the following:

l In Manage mode, click View | Toolbars and then select Customize.

l In Manage mode, click the drop-down arrow, located to the right of the Main toolbar or File List toolbar,
select Add or Remove Buttons, and then select Customize.

l In View mode, click the drop-down arrow, located to the right of the Bottom toolbar, select Add or
Remove Buttons, and then select Customize.

To Add or Remove Toolbar Buttons in Manage Mode:

Main toolbar:

1. Click the drop-down arrow located on the right side of the Main toolbar.

2. Select Add or Remove Buttons |Main Toolbar, then select the name of the button you want to add or
remove.

File List toolbar:
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l With the Customize dialog box open, on the Commands tab, drag items from the Commands field to the
toolbar to add buttons.

l To remove buttons, drag them from the toolbar to the Customize dialog box.

To Add or Remove Toolbar Buttons in View Mode:

Bottom toolbar:

1. Click the drop-down arrow, located to the right of the Bottom toolbar.

2. Select Add or Remove Buttons | Bottom Toolbar, then select the name of the button you want to add
or remove.

To Rearrange Toolbar Buttons:

With the Customize dialog box open, drag buttons to your desired toolbar location.

To Display or Hide Text Labels Below Toolbar Buttons:

1. Display the Customize dialog box.

2. Click the Toolbars tab.

3. In Manage mode: select File List Toolbar or Main Toolbar.

In Viewmode: select Bottom Toolbar.

4. Check the Show text labels checkbox to display text labels, or clear the Show text labels checkbox to
hide text labels.

5. Click Close.

To Display or Hide Tool Tips for Toolbar Buttons:

1. Display the Customize dialog box.

2. Click the Options tab.

3. Select Show ScreenTips on toolbars to display tool-tips, or clear Show ScreenTips on toolbars to hide
tool-tips. If you select this option, you can also select Show shortcut keys in ScreenTips to show
keyboard shortcuts in the tool-tips.

4. Click Close.

Resetting Toolbars

You can discard all of your changes, and return the toolbars and buttons to their default states.

To Reset the Toolbars:

1. Display the Customize dialog box.

2. Click the Toolbars tab, and then click Reset All.
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3. Click Yes to reset the toolbars.

4. Click Close.

Customizing Toolbar and Pane Locations

You can hide, resize, float, move, and dock most toolbars and panes to suit your preferences. To learn
about all the ways you can customize your experience in Manage mode, see Using ManageMode.

Hiding Panes

At the top right corner of Manage, View, and Edit mode, you can use the Hide/Unhide buttons to hide
and reveal panes on the left, right, or bottom of the screen.

Hide/Unhide Left Panels

Hide/Unhide Bottom Panels

Hide/Unhide Right Panels

Moving Panes and Toolbars in View and Edit Mode

You can move a pane or toolbar from a docked or floating position to a new location.

Some toolbars do not activate the Docking Compass.

To Move a Pane or Toolbar:

1. Drag the pane or toolbar's title bar and hold your cursor over any of the arrows of the Docking Compass.

2. When the shaded marquee displays the position of the pane or toolbar you want, release the mouse
button.

3. To return a pane to its previous location, double-click its title bar.

To Move a Docked or Floating Pane or Toolbar:

Do one of the following:

l Drag the pane or toolbar's tab to a new location.

l Drag the pane or toolbar's title bar to a new location.

l If you use dual monitors, you can move the panes and toolbars to your second monitor to free up space
on your main monitor.
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Docking Panes and Toolbars in View and Edit Mode

When you select a pane or toolbar, the Docking Compass activates to help you place the pane
precisely. The Docking Compass consists of an outer and inner ring of arrows. When you hold your
cursor over any of the arrows, a shaded marquee displays the potential position of the pane.

Some toolbars do not activate the Docking Compass.

To Dock a Pane or Toolbar:

Drag the pane or toolbar's title bar or tab to activate the Docking Compass. To dock a pane around
the outer edge of the window, hold your cursor over any of the outer arrows of the Docking
Compass, and then release the mouse button.

Resizing Panes

You can resize all the panes and toolbars, whether they are docked or floating.

To Resize a Docked Pane:

1. Hold your cursor over the edge of the pane or toolbar until the cursor changes to arrows and lines.

2. Drag the edge of the pane or toolbar to the size you want.

To Resize a Floating Pane:

Hold your cursor over the edge or corner of the pane or toolbar and then drag the pane to the size
you want.

You can enlarge the Filmstrip in View and Edit mode to expedite browsing your folder. To
resize the Filmstrip, drag one of its edges.

You can move the Drawing and Selections Toolbar, as well as the ACDSee Actions bar.

Creating a Custom Menu

You can create a newmenu in Manage mode with custom commands for easy access. You can also
customize the name and location of your newmenu.

To Create a New Menu:
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1. Do one of the following:

l In Manage mode, click View | Toolbars and then select Customize.

l In Manage mode, click the drop-down arrow located to the right of the Main toolbar or File List
toolbar, select Add or Remove Buttons, and then select Customize.

2. In the Customize dialog, on the Commands tab, select New Menu from the Categories field.

3. In the Commands field, select New Menu and drag it to your desired toolbar location.

To Add Commands to a New Menu:

1. In the Customize dialog, on the Commands tab, select any option from the Categories field.

2. In the Commands field, select your command and drag it over to your new menu on the toolbar. The
new menu will expand down. Drop the command on the menu.

To Delete a New Menu or Command:

The Customize dialog must be open to delete a newmenu or command.

Right-click the newmenu or command and choose Delete from the context menu.

To Name a New Menu:

The Customize dialog must be open to name a newmenu.

1. Right-click the new menu and choose Button Appearance... from the context menu.

2. In the Button Appearance dialog, with Text only selected, enter a name in the Button text field.

3. Press OK.

Configuring External Editors

To open images in external editing applications from within ACDSee, configure ACDSee Home to work
with a variety of image editors, such as LUXEA Pro Video Editor 7, and specify which image editor
ACDSee Home uses by default.

An external editor must be configured before it can be assigned a shortcut key or used as a
button on the toolbar.

To configure an External Editor in ACDSee:

1. In Manage mode, select Tools | External Editors | Configure Editors from the main menu.

2. In the Configure Photo Editors dialog box, click the Add... button.

3. Browse to the hard drive folder containing an image editing application.



ACDSee Photo Studio Home 2026

Page 468 of 532

4. Select the executable file of the editing application. For example, LUXEA Pro Video Editor 7.exe.

5. Click Open.

6. Enter an editor name in the Name field, then click OK.

To create a shortcut to the default External Editor:

1. Select Tools | Customize Shortcuts... from the main menu.

2. In the Customize Shortcuts dialog box, select "Tools" from the Category drop-down menu.

3. From the Commandsmenu, select Default External Editor.

4. Enter a shortcut key into the Enter new shortcut key field.

5. Click Assign and close the dialog box.

A new keyboard shortcut has been set for the default external editor.

To create a shortcut to an individual External Editor:

1. Select Tools | Customize Shortcuts... from the main menu.

2. In the Customize Shortcuts dialog box, select "External Editors" from the Category drop-down menu.

3. From the Commandsmenu, select the desired external editor.

4. Enter a shortcut key into the Enter new shortcut key field.

5. Click Assign and close the dialog box.

A new keyboard shortcut has been set for an individual external editor.

To add an External Editor to the FileList toolbar in Manage mode:

1. Click the Toolbar Options drop-down arrow, to the right of the Editors and Actionsmenu options, and
select Add or Remove Buttons | Customize.

2. In the Customize dialog box, in the Commands tab, select "Tools" from the Category list.

3. Click and drag an External Editor from the list onto the FileList toolbar.

4. Close the dialog box.

An External Editor is added to the FileList toolbar.

To add an External Editor button to the toolbar in View mode:

1. Click the Toolbar Options drop-down arrow, to the right of the tools, and select Add or Remove Buttons
| Customize.

2. In the Customize dialog box, in the Commands tab, select "Tools" from the Category list.

3. In the Commands list, select Default External Editor, and click and drag it onto the toolbar.

4. Close the dialog box.
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The default External Editor is added to the toolbar.

To manage image editors:

1. In Manage mode, select Tools | External Editors | Configure Editors from the main menu.

2. In the Configure Photo Editors dialog box, in the Editors list, select an application to change.

3. Do any of the following:

l To change the location of the executable file or the name of the application displayed in the
Editors list, click Edit. Set the location and name of the application, and then click OK.

l To set the application as the default external editor for ACDSee, click Set As Default.

l To specify whether the application can handle multiple images at the same time, check or
uncheck the checkbox in the Supports Multiple Images column.

l To remove the application from the list, click Remove.

4. Click OK to accept your changes and return to ACDSee.

To open an image in an external image editor:

1. In Manage or View mode, select an image to open in an external editor.

2. Do one of the following:

l Select Tools | External Editors | Default External Editor or the name of an editor.

l Press Ctrl + Alt + X to open the image in the default external editor.

Customizing Keyboard Shortcuts

There are pre-defined keyboard shortcuts for commands that you use frequently. You can change pre-
defined shortcuts, or create keyboard shortcuts for commands that do not currently have shortcuts.
The options available in the Customize Shortcut dialog will be mode-specific, depending on which
mode you opened the dialog from.

Keyboard shortcuts customized in one mode will not take effect in the other modes, even if
the defined command name is the same.

If a shortcut is already assigned to a command, then assigning it to another command will
unassign it from the original command.

To Customize Keyboard Shortcuts:

In Manage, View, Edit, and People mode:
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1. Click Tools | Customize Shortcuts... or press Ctrl + Shift + Alt + S.

2. From the Category drop-down menu, select a category, such as File, Edit, or View. The commands
available from that menu display in the Commands list box.

3. Select a command in the Commands list box.

l If a keyboard shortcut has been defined for that command, it displays in the Current Keys box.

l If a keyboard shortcut has not been defined for that command, the Current Keys box will be
empty.

To remove an existing keyboard shortcut, select the keyboard shortcut in the Current Keys box, and
then click Remove.

To Define a New Keyboard Shortcut:

1. Click in the Enter a new shortcut key text box.

2. Press the keys on your keyboard that you want to use for the keyboard shortcut.

The keys display in the Enter a new shortcut key text box. The Currently assigned to field will
display the function your entered shortcut is assigned to, if applicable.

3. Click Assign.

The new keyboard shortcut displays in the Current keys box.

4. Click Close.

To remove all custom keyboard shortcuts and restore the default keyboard shortcuts, click Reset All.

Changing the Display Theme

In ACDSee Home you can change the display theme to change the background color of the panes and
toolbars.

To Change the Display Theme:

1. In Manage mode, click Tools | Options.

2. In the Options dialog box, clickManage Mode.

3. In the Display theme drop-down list, select a theme.

4. Click OK to apply your changes and return to ACDSee.

Setting JPEG Options

You can change the settings in the Options dialog box to control the quality of the JPEG image,
encoding method, color subsampling method, and whether to update or create embedded
thumbnails in the JPEG image.
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JPEG Options

Image quality Drag the slider to determine the quality of the JPEG image.

Encoding l Progressive: select to enable progressive encoding.
l Optimize Huffman codes: select to optimize Huffman codes to increase

compression.

Color component
sampling

l 2:1 Horizontal: select to subsample color channels on the horizontal axis
by a factor of 2:1.

l 2:1 Vertical: select to subsample color channels on the vertical axis by a
factor of 2:1.

Embedded thumbnails l Only update existing thumbnails: select to update any existing embedded
thumbnails.

l Always add/update thumbnails: select to update any existing embedded
thumbnails, or create embedded thumbnails.

l Never add/update thumbnails: select if you do not want to update any
existing embedded thumbnails, or if you do not want to create embedded
thumbnails.

l Generate DCF compatible thumbnails: select to generate thumbnails that
meet the Digital Camera Format (DCF) specification and are compatible
with the thumbnail view on the LCD of a digital camera. This option forces
a fixed resolution of 160 x 120 and pads any extra space with black.

Save these settings as
the defaults

Select this option to use these JPEG settings by default for all JPEGs.
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Chapter 11: Shortcuts

Manage Mode Keyboard Shortcuts

You can use the following keyboard shortcuts while working in Manage mode. There are also shortcuts
that can be used specifically in the Calendar pane.

To print this page for easy reference, right-click and select Print...
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This Shortcut Has This Result

Alt + F4 Closes ACDSee.

Ctrl + Shift + Alt + S Opens the Customize Shortcuts dialog box,
in which you can customize keyboard
shortcuts.

Alt + O Opens the Options dialog box.

F1 Opens the Help file.

Enter Opens the selected item in View mode.

Delete Deletes the selected items.

Using ACDSee Tabs

Ctrl + T Opens a new tab.

Alt + D Duplicates the currently selected tab.

Ctrl + W Closes the currently selected tab.

Ctrl + Page Down

Ctrl + Tab

Activates the next tab to the right of your
currently selected one.

Ctrl + Page Up

Ctrl + Shift + Tab

Activates the previous tab to the left of
your currently selected one.

Using Manage Mode
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This Shortcut Has This Result

\ (backslash) Tags or untags the image.
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This Shortcut Has This Result

` (grave accent) Toggles image audio on or off.
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This Shortcut Has This Result

Alt + C Copies one or more selected files to a
folder you specify.

Alt + Comma Opens the previous tab in the Properties
pane.

Alt + Period Opens the next tab in the Properties pane.

Alt + Enter Opens or closes the Properties pane.

Alt + G Opens the Import dialog box.

Alt + I Opens the Filters dialog box where you can
specify the types of files displayed in the
File List pane.

Alt + K Places the cursor in the Keyword section of
the IPTC group in the Metadata tab of the
Properties pane.

Alt + M Moves one or more selected files to a
folder you specify.

Ctrl + 0 Clears the rating.

Ctrl + 1 Assigns a rating of 1.

Ctrl + 2 Assigns a rating of 2.

Ctrl + 3 Assigns a rating of 3.

Ctrl + 4 Assigns a rating of 4.

Ctrl + 5 Assigns a rating of 5.

Alt + 0 Clears the color label.

Alt + 1 Assigns a red color label.

Alt + 2 Assigns a yellow color label.

Alt + 3 Assigns a green color label.

Alt + 4 Assigns a blue color label.

Alt + 5 Assigns a purple color label.
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This Shortcut Has This Result

Alt + Shift + F Maximizes the File List pane.
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This Shortcut Has This Result

F2 Renames one or more selected files.
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This Shortcut Has This Result

Alt + W Restores your desktop wallpaper to the
settings you were using before you applied
an ACDSee Home wallpaper.

Alt + X Removes currently displayed item from
the active Image Basket.

Backspace Moves up one level in the current drive's
folder structure.

Ctrl + \ (backslash) Selects the tagged images.

Ctrl + A Selects the entire contents of the current
folder.

Ctrl + B Adds the selected items to the active
Image Basket.

Ctrl + E Opens the currently selected image in Edit
mode.

Ctrl + G Generates a file listing as a text document.

Ctrl + I Selects all images in the current folder.

Ctrl + Alt + D Opens the Edit Caption dialog box.

Ctrl + K Places the cursor in the Keywords field of
the Organize tab in the Properties pane.

Ctrl + N Creates a new folder in the File List pane.

Ctrl + O Opens the Open Files dialog box, in which
you can select one or more images to open
in View mode.

Ctrl + P Opens the currently selected image or
images in the ACDSee Home Print utility.

Ctrl + X Cuts the currently selected items to the
Clipboard.

Ctrl + C

Ctrl + Insert

Copies the selected items to the Clipboard.

Ctrl + V Pastes the contents of the Clipboard.
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This Shortcut Has This Result

Shift + Insert



ACDSee Photo Studio Home 2026

Page 481 of 532

This Shortcut Has This Result

Ctrl + F Puts the focus in the Quick Search bar so
that you can begin typing your search
query.

F5 Refreshes Manage mode.

F3 Opens the Advanced Search pane.

Ctrl + Alt + E Opens the Export dialog box.

F4 Displays the Contents bar drop-down list.

F6 Changes the File List to Thumbs+Details
view.

F7 Changes the File List to Filmstrip view.

F8 Changes the File List to Thumbnails view.

F9 Changes the File List to Tiles view.

F10 Changes the File List to Icons view.

F11 Changes the File List to List view.

F12 Changes the File List to Details view.

Shift + Alt + S Opens the AI Super-Resolution dialog box.

Shift + Delete Removes the selected item from your hard
drive.

Shift + F5 Refreshes the File List pane.

Shift + Tab Moves the focus of the Manage mode
window to the previous pane or tool in
sequence.

Tab Moves the focus of the Manage mode
window to the next pane or tool in
sequence.

Ctrl + Alt + R Opens the selected images in the Compare
Images viewer.

Ctrl + Alt + W Sets the selected image as a stretched
desktop wallpaper.
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This Shortcut Has This Result

Ctrl + Alt + X Opens the current image in the default
external editor.

Ctrl + Right-Click Opens Windows Explorer context menu.

Ctrl + Shift + 1 Opens or closes the Folders pane.

Ctrl + Shift + 2 Opens or closes the Catalog pane.

Ctrl + Shift + 3 Opens or closes the Advanced Search
pane.

Ctrl + Shift + 4 Opens or closes the Calendar pane.

Ctrl + Shift + 5 Shows or hides all Image Baskets.

Ctrl + Shift + 6 Opens or closes the Activity Manager.

Ctrl + Shift + 7 Opens or closes the Task Pane.

Ctrl + Shift + 9 Creates a new Image Basket.

Ctrl + Shift + - Deletes the active Image Basket.

Ctrl + Shift + A Selects all files in the current folder.

Ctrl + Shift + B Shows or hides the status bar.

Ctrl + Shift + C Copies the currently selected image to the
Clipboard.

Ctrl + Shift + D Clears your current selection.

Ctrl + Shift + E Opens the current file in the default
system application or opens a dialog box
where you can select an application.

Ctrl + Shift + F Toggles the full-screen view for the File List
pane.

Ctrl + Shift + I Inverts your current selection.

Ctrl + Shift + L Opens or closes the Selective Browsing
panel.

Ctrl + Shift + M Opens or closes the Map pane.

Ctrl + Shift + N Opens a second instance of the ACDSee
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This Shortcut Has This Result

program.

Ctrl + Shift + O Opens the file using the system application
associated with its file extension.

Ctrl + Shift + T Displays or hides the Manage mode Main
toolbar.

Ctrl + Shift + W Sets the selected image as a tiled desktop
wallpaper.

Ctrl + Shift + Alt + W Sets the selected image as a centered
desktop wallpaper.

Viewing

Alt + Left Arrow Returns to the previous folder you
browsed in the File List pane.

Alt + Right Arrow Returns to the folder you last moved back
from in the File List pane.

Ctrl + S Creates a slideshow from the currently
selected images.

Ctrl + Shift + P Opens or closes the Preview pane.

Batch Editing

Shift + S Opens the Batch AI Super-Resolution dialog
box.

Ctrl + R Opens the Batch Resize Images dialog box.

Ctrl + Alt + F Opens the Batch Convert File Format dialog
box.

Ctrl + J Opens the Batch Rotate/Flip Images dialog
box.

Ctrl + Alt + T Opens the Batch Adjust Time Stamp dialog
box.

Ctrl + L Opens the Batch Adjust Exposure dialog
box.

Mode Switching
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This Shortcut Has This Result

Ctrl + F2 Switches to Media mode.

Ctrl + F3 Opens the image in View mode.

Ctrl + F5 Opens the image in Edit mode.

Ctrl + F6 Switches to People mode.

Ctrl + F7 Switches to 365 mode.

Ctrl + F8 Switches to Dashboard mode.

Manage Mode Mouse Shortcuts

You can use the following mouse shortcuts in Manage mode.

To print this page for easy reference, right-click and select Print...

Shortcut Resulting Action

Double-click Opens the selected image in View mode.

Right-click Opens the Manage mode context menu.

Shift + click Selects a group of images.

Click + drag Selects a group of images. Be sure to click on a blank area of the
screen, not on an image or folder, before you drag, so you can draw
a selection box around the group of images.

Ctrl + click Selects images you click on.

Ctrl + right-click Opens the Windows Explorer context menu.

Ctrl + Wheel up Increases the magnification of the thumbnail (zooms in).

Ctrl + Wheel down Decreases the magnification of the thumbnail (zooms out).

Calendar Pane Shortcuts

Once you are familiar with the basic calendar pane options, consider using the following shortcuts:
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l Click the title bar on a year, month, or day table to display all available images for that year, month, or
day.

l Right-click the title bar on a year, month, or day table to scroll through and select from adjacent years,
months, or days.

l In Year view double-click any month to switch to Month view. Or, in Month view, double-click any date
to switch to Day view.

l In Month view click the letter indicating a day of the week to display all available images for that day of
the week. For example, click F to select all Fridays in that month.

l In Day view click AM or PM to select the first or second half of a day.

l In Event view press and hold the Ctrl key and click any month or day to display all available images for
those months or days.

l Click on the title of any month calendar, to select all the photos in that month.

l Click the name of the week, to select all the photos in those weeks of the month.

l Drag and select any days in the calendar to select all the photos in those days.

Media Mode Keyboard Shortcuts

You can use the following keyboard shortcuts while working in Media mode.

To print this page for easy reference, right-click and select Print...
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Shortcut Resulting Action

Alt + F4

Ctrl + W

Closes ACDSee.

Alt + O Opens the Options dialog.

Ctrl + P Prints the selected image.

Ctrl + L Rotates the selected image left.

Ctrl + R Rotates the selected image right.

F5 Refreshes.

Ctrl + F Show/Hide Folder pane.

Ctrl + G
ALT + ENTER

Show/Hide Group/Properties pane.

SPACE, RIGHT, DOWN Next image in Full Screen

BACKSPACE, LEFT, UP Previous image in Full Screen

DELETE Delete selected file

Mode Switching

Ctrl + F1 Switches to Manage mode.

Ctrl + F3 Opens the currently selected image in
View mode.

Ctrl + F5 Opens the currently selected image in Edit
mode.

Ctrl + F6 Switches to People mode.

Ctrl + F7 Switches to 365 mode.

Ctrl + F8 Switches to Dashboard mode.

View Mode Keyboard Shortcuts

You can use the following keyboard shortcuts while working in Viewmode.

To print this page for easy reference, right-click and select Print...
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If you would like to define your own keyboard shortcuts, see Customizing Keyboard
Shortcuts.
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Shortcut Resulting Action

Alt + F4 Closes ACDSee.

` (grave accent) Toggles the display of the full file path in the Status bar.

Enter

Esc

Switches to the previous mode.

Shift + Esc Minimizes ACDSee in View and Edit mode.

Ctrl + Shift + Alt
+ S

Opens the Customize Shortcuts dialog box, in which you can customize
keyboard shortcuts.

Alt + O Opens the Options dialog box.

F1 Opens the Help file.

File Menu

Ctrl + O

Insert

Opens the Open files dialog box.

Shift + F4 Closes the current item.

Ctrl + Shift + F4 Closes all images.

Ctrl + S Opens the Save Image As dialog box, in which you can save your image
with a different name or file format.

Shift + L Opens the file using the system application associated with its file
extension.

Shift + E Opens the current file in the default system application or opens a
dialog box where you can select an application.

Ctrl + P Opens the current image in the ACDSee Home Print utility.

Ctrl + Shift + P Prints all currently selected images, or all images in the current folder.

Alt + L Opens the Flickr Uploader dialog box.

Alt + U Opens the SmugMug Uploader dialog box.

Alt + Z Opens the Zenfolio Uploader dialog box.

Customizing the Interface
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Shortcut Resulting Action

Ctrl + Shift + H Toggles the Histogram open and closed.

Ctrl + Shift + M Toggles the Magnifying Glass pane open and closed.

Ctrl + + (plus) Zooms in on the Magnifying Glass pane.

Ctrl + - (minus) Zooms out on the Magnifying Glass pane.

Ctrl + Shift + S Toggles the Navigator open and closed.

Alt + Enter Toggles the Properties pane open and closed.

Alt + , Switches to the tab to the left on the Properties pane.

Alt + . Switches to the tab to the right on the Properties pane.

Ctrl + Shift + F Toggles the Filmstrip open and closed.

Ctrl + Shift + I Toggles the Info palette open and closed.

T

Ctrl + Shift + T

Toggles the Toolbar open and closed.

B

Ctrl + Shift + B

Toggles the Status bar open and closed.

Ctrl + Shift + V Toggles the Page View panel open and closed for multi-page images.

Managing
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Shortcut Resulting Action

Ctrl + X Cuts the current item to the Clipboard.
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Shortcut Resulting Action

Ctrl + C Copies the currently displayed file to the Clipboard.
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Shortcut Resulting Action

Ctrl + V Pastes the contents of the Clipboard.
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Shortcut Resulting Action

Alt + C Opens the Copy To Folder dialog box.
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Shortcut Resulting Action

Alt + M Opens the Move To Folder dialog box.
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Shortcut Resulting Action

Delete Deletes the selected image.
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Shortcut Resulting Action

F2

Alt + R

Opens the Rename File dialog box.

Ctrl + B Adds the selected image to the active Image Basket.

Alt + X Removes the selected image from the active Image Basket.

Alt + A Opens the Add Shortcut dialog box.

Ctrl + Alt + D Opens the Edit Caption dialog box.

\ (back slash) Tags or untags the image.

Ctrl + M Opens the Manage Metadata Presets dialog box.

Ctrl + 0 Clears the rating.

Ctrl + 1 Assigns a rating of 1.

Ctrl + 2 Assigns a rating of 2.

Ctrl + 3 Assigns a rating of 3.

Ctrl + 4 Assigns a rating of 4.

Ctrl + 5 Assigns a rating of 5.

Alt + 0 Clears the color label.

Alt + 1 Assigns a red color label.

Alt + 2 Assigns a yellow color label.

Alt + 3 Assigns a green color label.

Alt + 4 Assigns a blue color label.

Alt + 5 Assigns a purple color label.

Ctrl + K Opens the Keywords section of the Properties pane.

Alt + K Opens the Metadata tab of the Properties pane.

Ctrl + Shift + Alt
+ W

Sets the selected image as the desktop wallpaper, centered.

Ctrl + Shift + W Sets the selected image as the desktop wallpaper, tiled.
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Shortcut Resulting Action

Ctrl + Alt + W Sets the selected image as the desktop wallpaper, stretched.

Alt + W Restores your desktop wallpaper to the settings you were using before
you applied an ACDSee Home wallpaper.

Viewing

Page Arrow
Right

Page Down

3 (numeric
keypad)

Spacebar

Displays the next image.

Page Arrow
Left

Page Up

9 (numeric
keypad)

Backspace

Displays the previous image.

End Switches to the last image in the Filmstrip.

Home Switches to the first image in the Filmstrip.

Ctrl + Right-
click

Opens the Windows Explorer context menu.

+ (plus) Zooms in.

- (minus) Zooms out.

Shift + Z Zooms in to the area you select.

/ (forward
slash)

Zooms the image to its actual size.

* (numeric
keypad
asterisk)

Shift + 8

Fits the image to the viewing area.

Alt + Page
Arrow Right

Fits image width to the display area.
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Shortcut Resulting Action

Alt + Page
Down

Fits image height to the display area.

Alt + \ Toggles the zoom lock on and off.

L Toggles the pan lock.

Z Opens the Set Zoom Level dialog box.

Page Arrow
Right

Pans right when zoomed into the image.

Page Arrow
Left

Pans left when zoomed into the image.

Page Down Pans down when zoomed into the image.

Page Up Pans up when zoomed into the image.

F Toggles full screen mode.

Ctrl + Page
Arrow Right

Toggles the right pane open and closed.

Ctrl + Page
Arrow Down

Toggles the bottom pane open and closed.

O Displays saved version of the image.

E Toggles the exposure warning on and off.

Shift + F1 Activates the Hand tool after zooming in with the Zoom tool.

Shift + F2 Activates the Select tool.

Ctrl + Q Clears the current selection.

Shift + F3 Activates the Zoom tool.

Shift + F Activates the Face tool.

Shift + B Toggles face outlines.

Ctrl + N Opens the Face Detection pane and puts the cursor in the first name
field.

TAB Moves the cursor between name fields on the image, as well as on the
Face Detection pane.
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Shortcut Resulting Action

Ctrl + Shift + D Toggles the Face Detection pane.

Ctrl + F Redetects faces.

F5 Refreshes the View mode window and reloads the current image.

Ctrl + 6 Toggles the Light EQ button on and off.

Alt + S Automatically advances to the next image every 1 to 2 seconds.

Ctrl + Alt + S Launches the slideshow.

Ctrl + A Displays or hides headers and footers.

Ctrl + Shift + Q Opens the View Header/Footer dialog box, in which you can specify
the text to display on your images in View mode.

Alt + Ctrl + S Starts or stops the slideshow.

Shift + Page
Arrow Down

Advances to the next page of a multi-page image.

Shift + Page
Arrow Up

Switches to the previous page of a multi-page image.

Shift + Home Switches to the first page of a multi-page image.

Shift + End Switches to the last page of a multi-page image.

Editing

Ctrl + Shift +
Page Arrow
Left

Rotates the current image 90° counterclockwise.

Ctrl + Shift +
Page Arrow
Right

Rotates the current image 90° clockwise.

Alt + E Opens the image in the default editor.

Shift + O Restores an edited image to the original version.

Shift + S Commits the changes.

Shift + Alt + S Opens the AI Super-Resolution dialog box.
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Shortcut Resulting Action

Ctrl + Alt + F Opens the Batch Convert File Format dialog box.

Ctrl + J Opens the Batch Rotate/Flip Images dialog box.

Ctrl + R Opens the Batch Resize Images dialog box.

Ctrl + L Opens the Batch Adjust Exposure dialog box.

Ctrl + Alt + T Opens the Batch Adjust Time Stamp dialog box.

Ctrl + Alt + R Opens the Batch Rename dialog box.

Ctrl + Shift + 1 Changes the image color depth to Black and White.

Ctrl + Shift + 2 Changes the image color depth to 16 grays.

Ctrl + Shift + 3 Changes the image color depth to 256 grays.

Ctrl + Shift + 4 Changes the image color depth to 16 colors.

Ctrl + Shift + 5 Changes the image color depth to 256 colors.

Ctrl + Shift + 6 Changes the image color depth to Hicolor.

Ctrl + Shift + 7 Changes the image color depth to Truecolor.

Ctrl + Shift + 8 Converts the image to a 16-bit grayscale palette.

Ctrl + Shift + 9 Converts the image to a 48-bit color palette.

Mode Switching

Ctrl + F1 Switches to Manage mode.

Ctrl + F2 Switches to Media mode.

Ctrl + F5 Opens the currently selected image in Edit mode.

Ctrl + F6 Switches to People mode.

Ctrl + F7 Switches to 365 mode.

Ctrl + F8 Switches to Dashboard mode.

View Mode Mouse Shortcuts

You can use the following mouse shortcuts while working in Viewmode.
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To print this page for easy reference, right-click and select Print...

Shortcut Resulting Action

Double-click Closes View mode and returns to the previous mode.

Right-click Opens the View mode context menu.

Middle click Toggles full screen mode (on 3-button mouse).

Wheel click Toggles full screen mode.

Wheel up Displays the previous item.

Wheel down Displays the next item.

Ctrl + Right-click Opens the Windows Explorer context menu.

Ctrl + Wheel up Increases the magnification of the image (zooms in).

Ctrl + Wheel down Decreases the magnification of the image (zooms out).

Shift + Wheel up Displays the previous page of a multiple-page image.

Shift + Wheel down Displays the next page of a multiple-page image.

Edit Mode Keyboard Shortcuts

Use the following keyboard shortcuts in Edit mode.

To print this page for easy reference, right-click and select Print...

If you would like to define your own keyboard shortcuts, see Customizing Keyboard
Shortcuts.

Edit Mode Keyboard Shortcuts
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Shortcut Resulting Action

Alt + F4 Closes ACDSee in all modes.

Shift + Esc Minimizes ACDSee in View and Edit mode.

Ctrl + Shift + Alt + S Opens the Customize Shortcuts dialog box,
in which you can customize keyboard
shortcuts.

Alt + O Opens the Options dialog box.

F1 Opens the Help file.

` (grave accent) Toggles the display of the full file path in
the Status bar.

File Menu

Page Arrow Right

Page Down

3 (numeric keypad)

Opens the next image.

Page Arrow Left

Page Up

9 (numeric keypad)

Opens the previous image.

Ctrl + S Saves the image.

Ctrl + Alt + S Saves a copy.

Ctrl + Alt + E Opens the Export dialog.

End Switches to the last image in the Filmstrip.

Home Switches to the first image in the Filmstrip.

Esc

Enter

Switches to the previous mode.

Edit Menu
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Shortcut Resulting Action

Ctrl + Y Redo.

Ctrl + Z Undo.

Ctrl + Shift + Z Undo all.

Ctrl + C Copy.

Ctrl + V Paste.

Delete Delete.

Managing
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Shortcut Resulting Action

Alt + 0 Clears the color label.

Alt + 1 Assigns a red color label.

Alt + 2 Assigns a yellow color label.

Alt + 3 Assigns a green color label.

Alt + 4 Assigns a blue color label.

Alt + 5 Assigns a purple color label.

Ctrl + 0 Clears the rating.

Ctrl + 1 Assigns a rating of 1.

Ctrl + 2 Assigns a rating of 2.

Ctrl + 3 Assigns a rating of 3.

Ctrl + 4 Assigns a rating of 4.

Ctrl + 5 Assigns a rating of 5.

Ctrl + K Opens the Keywords section of the
Properties pane.

Alt + K Opens the Metadata tab of the Properties
pane.

\ (back slash) Tags the photo.

Ctrl + M Opens the Manage Metadata Presets dialog
box.

Ctrl + Alt + D Opens the Edit Caption dialog box.

Viewing
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Shortcut Resulting Action

Ctrl + Page Arrow Right Toggles the right pane open and closed.

Ctrl + Page Arrow Left Toggles the left pane open and closed.

Ctrl + Page Arrow Down Toggles the bottom pane open and closed.

/ (forward slash) Zooms the image to its actual size.

Shift + 8

* (numeric keypad asterisk)

Fits the image to the viewing area.

+ (plus) Zooms in.

- (minus) Zoomed out.

F Displays the image full screen.

' Toggles Navigator open and closed when
zoomed into the image.

Z Displays saved version of the image.

Page Arrow Right Pans right when zoomed into the image.

Page Arrow Left Pans left when zoomed into the image.

Down Arrow Pans down when zoomed into the image.

Up Arrow Pans up when zoomed into the image.

Customizing the Interface
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Shortcut Resulting Action

F2 Toggles the Filter Menu open and closed.

F4

Alt + Enter

Toggles the Properties pane open and
closed.

F5 Toggles the Filmstrip open and closed.

F6 Toggles the Info palette open and closed.

F7

Ctrl + Shift + H

Toggles the Histogram open and closed.

F10 Toggles the Colors pane open and closed.

Alt + F1 Toggles the Toolbar open and closed.

Alt + F2 Toggles the Filters toolbar open and closed.

Selecting

Alt + A Selects all.

Alt + D Deselects.

Alt + I Inverts selection.

Shift + Alt + S Saves the selection.

Shift + Alt + L Opens the Load Selection dialog box.

Shift + Alt + M Opens the Manage Selections dialog box

Filters

Y Opens the Red Eye Reduction tool.

Alt + P Opens the Repair tool.

K Opens the Skin Tune tool.

X Opens the Text tool.

Alt + W Opens the Watermark tool.

Alt + B Opens the Border tool.

V Opens the Vignette tool.
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Shortcut Resulting Action

Alt + S Opens the Special Effects panel.

T Opens the Tilt-Shift tool.

Alt + G Opens the Grain tool.

Alt + R Opens the Rotate tool.

Alt + F Opens the Flip tool.

C Opens the Crop tool.

J Opens the Resize tool.

Alt + X Opens the Exposure tool.

L Opens the Levels tool.

Alt + J Opens the Auto Levels tool.

U Opens the Tones Curves tool.

Q Opens the Light EQ™ tool.

H Opens the Dehaze tool.

A Opens the White Balance tool.

W Opens the Convert to Black & White tool.

Alt + M Opens the Color LUTs tool.

Alt + N Opens the Sharpen tool.

Alt + U Opens the Blur tool.

N Opens the Noise Reduction tool.

Alt + C Opens the Clarity tool.

Working Inside Filters
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Shortcut Resulting Action

B Toggles Brush controls open and closed.

S Toggles the brush stroke display when
working inside a filter.

G Toggles Gradient controls open and closed.

R Toggles Radial Gradient controls open and
closed.

Spacebar Switches to the Hand tool when working
with the Brush or Gradients inside a filter.

E Toggles the exposure warning on and off in
the Exposure tool.

Tools

Ctrl + Q Activates the Hand tool.

Ctrl + Shift + R Activates the Rectangle tool.

Ctrl + Shift + E Activates the Elliptical tool.

Ctrl + Shift + L Activates the Line tool.

Ctrl + A Activates the Arrow tool.

Ctrl + Shift + P Activates the Polygon tool.

Ctrl + Shift + B Activates the Curve tool.

B Activates the Brush tool.

Ctrl + F Activates the Fill tool.

Ctrl + G Activates the Gradient tool.

Ctrl + Shift + I Activates the Eyedropper tool.

Color Tools
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Shortcut Resulting Action

Ctrl + [ Opens the Foreground Color dialog box.

Ctrl + ] Opens the Background Color dialog box.

Ctrl + X Switches the foreground and background
color.

Selection Tools

Ctrl + R Activates the Rectangle Selection tool.

Ctrl + I Activates the Ellipse Selection tool.

Ctrl + L Activates the Lasso Selection tool.

Ctrl + W Activates the Magic Wand Selection tool.

Mode Switching

Ctrl + F1 Switches to Manage mode.

Ctrl + F2 Switches to Media mode.

Ctrl + F3 Opens the image in View mode.

Ctrl + F7 Switches to 365 mode.

Ctrl + F8 Switches to Dashboard mode.

Edit Mode Mouse Shortcuts

Use the following mouse shortcuts in Edit mode to make quick image adjustments.

To print this page for easy reference, right-click and select Print...
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Shortcut Resulting Action

Shift + click Turns off the auto-collapse feature in the pane as you open
groups.

Shift + mouse wheel Makes large adjustments to the sliders.

Ctrl + mouse wheel Makes small adjustments to the sliders.

Right-click Resets any slider to its default value.

Mouse wheel over slider Makes fine adjustments to a slider. Place your cursor over
the slider and scroll up or down.

Mouse wheel over image Adjusts brush size. Place your cursor over the image and
scroll up or down to adjust nib width.

Shift + mouse wheel Adjusts feathering. Place your cursor over the image and
scroll up or down to adjust feathering.

365 Mode Keyboard Shortcuts

Use the following keyboard shortcuts in the Transfer mode.

To print this page for easy reference, right-click and select Print...

If you would like to define your own keyboard shortcuts, see Customizing Keyboard
Shortcuts.
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Shortcut Resulting Action

Alt + A Sets selected folder as an Upsync folder.

Alt + D Downloads selected files and folders.

Alt + Enter Displays Properties pane in the lower screen of Transfer mode.

Alt + Num + Group forward files and folders in the lower screen of Transfer mode.

Alt + Num - Group backward files and folders in the lower screen of Transfer mode.

Alt + O Displays Options dialog.

Alt + U Uploads selected files and folders.

Alt + Shift + U Upsyncs all files.

Ctrl + \ Selects tagged files.

Ctrl + A Selects all files and folders.

Ctrl + F8 Changes the view in the upper screen in Transfer mode to thumbnail view
of images in your account.

Ctrl + F12 Changes the view in the upper screen in Transfer mode to a detailed view
of images in your account.

Ctrl + Shift + D Clears image selection.

Ctrl + Shift + I Inverts image selection.

Ctrl + Shift + 1 Displays Folders pane in the lower screen of Transfer mode.

Ctrl + Shift + 2 Displays Catalog pane in the lower screen of Transfer mode.

Ctrl + Shift + 3 Displays Advanced Search pane in the lower screen of Transfer mode.

Ctrl + Shift + 4 Displays Calendar pane in the lower screen of Transfer mode.

Ctrl + Shift + 5 Shows or hides all Image Baskets.

Ctrl + W Closes ACDSee.

Delete Deletes files or folders.

Enter Opens the selected item in View mode.

F2 Renames files and folders.
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Shortcut Resulting Action

F5 Refreshes the view.

F6 Displays thumbnails and details of folders and files in the lower screen of
Transfer mode.

F7 Displays filmstrip view of folders and files in the lower screen of Transfer
mode.

F8 Displays thumbnails of folders and files in the lower screen of Transfer
mode.

F9 Displays tile view of folders and files in the lower screen of Transfer mode.

F10 Displays icon view of folders and file types in the lower screen of Transfer
mode.

F11 Displays a list of folder and file types in the lower screen of Transfer mode.

F12 Displays a detailed view of folders and files in the lower screen of Transfer
mode.

Num + Sort forward files and folders in the lower screen of Transfer mode.

Num - Sort backward files and folders in the lower screen of Transfer mode.

Shift + Alt + A Displays seedrive.acdsee.com mode.

Shift + Alt + C Copies URL.

Shift + Alt + T Displays Transfer mode.

365 Mode Mouse Shortcuts

Use the following mouse shortcuts in Transfer mode.

To print this page for easy reference, right-click and select Print...

Shortcut Resulting Action

Click + drag Selects a group of images.

Ctrl + click Selects images you click on.

Shift + click Selects a group of images.
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ACDSee PicaView Keyboard Shortcuts

You can use the following shortcut with ACDSee PicaView.

This Shortcut Has This Result

Shift + right-click an
image

l If you have Display Image enabled: the image will not display in the main
context menu.

l If you have Display Image disabled: the image will display in the main con-
text menu.
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Chapter 12: File Formats

Supported File Formats in ACDSee Home

Files that can be read by ACDSee:
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ABR Adobe™ brush format

ACDC ACDSee Home ACDC Image

AFPHOTO Affinity Thumbnails only.

ANI Windows animated cursor Shows cursor animation.

ARW Sony RAW

AVIF AV1 Image File Format Animated AVIF files are not supported. IPTC metadata is
supported for AVIF files with XMP.

BMP Windows Bitmap Windows and OS/2;2/8/16/24/32 bpp; RLE and
uncompressed.

CNV Canvas Thumbnails only.

CR2 Canon RAW CR2

CR3 Canon RAW CR3 To see applicable cameras, please refer to the supported
RAW format page on the ACDSee website.

cRAW Sony cRAW

CRW Canon RAW CRW

CS1 Sinar RAW In the Image Type metadata field, this file format is
referred to as "RAW".

CUR Windows cursor

CVX Canvas Thumbnails only.

DCR Kodak RAW DCR

DCX Multi-page PCX All sub-types and multiple pages supported.

DNG Digital Negative An open-source archival format for RAW files.

EMF Enhanced Metafile Format Win32 enhanced placeable metafiles.

ERF Epson RAW

FFF Hasselblad RAW FFF In the Image Type metadata field, this file format is
referred to as "RAW".

GIF Graphics Interchange Format Single page animated; 87a and 89a.

https://r.acdsee.com/otgxS
https://r.acdsee.com/otgxS
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GPR GoPro RAW

GSD Gemstone Document Layers only supported in Gemstone Photo Editor.

HDR Creo RAW

HEIC/HEIF High Efficiency Image File
Format

Includes support for HIF files. Supports EXIF only. IPTC
metadata is not supported for HEIC files.

ICN AT&T ICN

ICO Windows icon Shows multiple resolutions as separate pages.

JBR Corel brush format

JP2 JPEG 2000 48-bit support.

JPC JPEG 2000 48-bit support.

JPG JPEG JFIF JFIF and Adobe CMYK.

JXL JPEG-XL IPTC metadata is supported for JPEG-XL files with XMP.

MOS Creo RAW In the Image Type metadata field, this file format is
referred to as "RAW".

MRW Konica Minolta RAW

NEF Nikon RAW

ORF Olympus RAW

PBR Corel PaintShop Pro brush
format

Up to 3072×2048 resolution (16BASE).

PCX ZSoft Publishers Paintbrush All sub-types supported.

PEF Pentax RAW PEF, Samsung RAW

PCT Macintosh PICT

PNG Portable Network Graphics All sub-types supported.

PSD Adobe PhotoShop Document RGB, grayscale, duotone, paletted and bi-level Lab color
interpreted as grayscale only.

RAF FujiFilm RAW

RAW Pentax RAW, Leica RAW, Contax
RAW, Casio RAW, Panasonic
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RAW

RWL Leica RAW

sRAW Canon sRAW

SRW Samsung SRW

SVG Scalable Vector Graphics

TGA Targa TGA All sub-types supported.

TIFF Tag Image File Format Bilevel / RGB / Paletted / CMYK / YCrCb / LOGL / LOGLUV;
Uncompressed / PackBits / LZW / ThunderScan / SGILog /
CCITT / ZIP / NEXT / New-JPEG (no v6.0 JPEG support)
Support for multiple-page documents Kodak RAW TIFF,
Canon RAW TIFF

WBMP Wireless Bitmap

WEBP Google WebP Format Includes support for animated and transparent WebP files.

WMF Windows Metafile Format Win 3.x placeable metafiles.

Files that can be written by ACDSee:
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ACDC ACDSee Home ACDC Image Not supported on ACDSee Pro or ACDSee Home.

AVIF AV1 Image File Format Supports EXIF only. IPTC metadata is not supported for
AVIF files.

BMP Windows Bitmap Windows 1/8/24 bpp.

GIF Graphics Interchange Format Non-interlaced GIF 89a only.

GPR GoPro RAW

JP2 JPEG2000

JPEG JPEG JFIF

PCX ZSoft Publishers Paintbrush 8 and 24 bpp; RLE compressed.

PNG Portable Network Graphics 1/4/8 bpp colormapped; 24 bpp RGB.

PSD Adobe PhotoShop Document RGB, grayscale, duotone, paletted and bi-level Lab color
interpreted as grayscale only.

WBMP Wireless Bitmap

WEBP Google WebP Format

TGA Targa TGA 8 and 24 bpp. RLE and uncompressed top-down and
bottom-up.

TIFF Tag Image File Format 1/8/24 bits per pixel, single-page; uncompressed, CCITT3,
CCITT4, LZW, Deflate (ZIP), and JPEG compression;
Adjustable DPI tags.

Archive read support formats:

ARJ ARJ archive ARJ format.

CAB CAB archive Microsoft CAB file format.

GZ GZ archive Unix GZIP (GnuZIP).

RAR RAR archive RAR format (RAR5 is not supported).

TAR TAR archive Unix TAR format.

TGZ TGZ archive TAR format compressed with GZIP.

ZIP ZIP archive Store and deflate.

Archive write support formats:
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ZIP ZIP archive Store and deflate.

Video and audio read support formats:

AAC Audio Data Transport Format

ADST Audio Data Transport Stream

ASF Active Streaming File – HotMetaL Pro

AVI AVI movie format

M4A MPEG-4

M4V MPEG-4

MOV MPEG-4

MP3 MPEG Layer III compressed audio

MP4 MPEG-4

WAV Sound file

VMA Sound file

WMV Windows Metafile

About RAW Files

A RAW file is like a negative. RAW files contain all of the data that was collected by your digital camera's
sensor when you took a photo. If you tried to view a RAW file without processing, it would appear
almost completely black. It is therefore necessary to process your RAW files to produce a photo.

In ACDSee, you can view RAW files using the embedded thumbnail image created by your camera. If
you want to process RAW images, you must use a photo editing program such as ACDSee Professional
or ACDSee Ultimate, which includes tools for developing RAW images.

ACDSee will automatically apply geometry corrections to DNG files that include geometric
distortion correction tags. DNG files created from the Adobe DNG Converter© will often
generate geometric distortion tags for micro 4/3rds cameras.
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Associating Files

ACDSee Home can work with a large number of file formats. ACDSee Home can be set as the default
application for opening certain file types. This process is called associating files. When you associate
file types, you set ACDSee Home as the default program to open these kinds of files when you double-
click them.

To Set File Association Options in ACDSee:

1. Click Tools | File Association Settings.

2. In the four format sections, check the checkboxes of the file formats you would like to associate with
ACDSee Home for image formats, RAW formats, media formats, and archive formats.

3. Click Save.

To Disassociate a File Type with ACDSee:

1. Click Tools | File Association Settings.

2. In the four format sections, uncheck the checkboxes of the file formats you would like to disassociate
with ACDSee Home for image formats, RAW formats, media formats, and archive formats.

3. Click Save.



Glossary



A
Absolute Colorimetric

Colors that fall outside the range of what the output device can render are adjusted to the closest color that can be
rendered.

Actions, ACDSee Actions

You can record the steps you take when editing images in Edit mode. You can then save them as "ACDSee Actions". Once
saved, you can apply the actions to other images. This is particularly useful for batch editing.

Album

Collection of images, often organized by theme or event. In ACDSee, albums contain shortcuts to where the images are
stored on your hard drive.

Aliasing

Jagged edges caused by pixels. Occurs most often in low resolution images or images that have been enlarged. See jaggies.

Antialiasing, Anti-Aliasing

Software technique for reducing jagged lines, or ‘jaggies’. Uses shades of gray and color to smooth out the contrast
between adjacent pixels.

Aspect Ratio

An image’s width-to-height ratio. For example, an image with an aspect ratio of 3:1 has a width 3 times larger than its
height.

Azimuth

Angle of shadows that extend from the edges of image details. In ACDSee Home you can control azimuth when applying
the Emboss effect to an image.

B
Background Processing

Tasks or programs that function without user interaction.

Barrel Distortion

In barrel distortion the photo appears to bulge outwards from the center.

Batch Editing

Any operation or tool, such as resizing, converting, or renaming, that can be used to adjust multiple images or files
simultaneously.

Bit



Bits are small units of computer memory. The color depth of your image is constrained by the number of bits available to
store color information. For example, it is possible to store 256 different color values per color channel in 8-bit RGB images.
Similarly, it is possible to store 65,536 different color values per color channel in 18-bit images.

Blackpoint

An image’s darkest area. You can control the intensity of the black in an image by adjusting its blackpoint.

Blend Modes

Filters that change the effect of a tool or the appearance of a selected object.

Brightness

Light intensity of an image. You can make an image appear brighter or darker by adjusting its brightness.

Brush

A tool that you can use in Edit mode to isolate or indicate pixels you want to apply effects or adjustments to. The Brush in
Drawing Tools can be used to draw in color on your image.

C
Cache

High-speed storage mechanism. The ACDSee Database is a cache.

Caption

Text associated with a file, or a comment or description added to a printed image.

Cataloging

Adding file information to the ACDSee Home database.

Category

Assign categories to photos to help sort and manage them more easily.

Chromatic Aberration

A lens artifact that can result in fringes in high contrast areas of some photos.

CMYK

Color model that uses cyan, magenta, yellow, and black (key) as its primary colors.

Color Cast

A color cast is a visible color tint that affects your image. For example, many digital cameras produce pictures with a
slightly blue color cast. ACDSee Home includes a tool that removes an unwanted color cast.

Color Channel Value

Contains all pixel information for a single color. A grayscale image has one channel, while an RGB image has three
channels. You can adjust RGB values when editing a color.



Color Gamut

Range of colors that a device such as a printer or monitor can produce or display.

Color Management

Process of adjusting your computer settings so that the color output from your printer matches the colors you see on
your monitor.

Color Space

There are two types of color spaces: device-independent or device-dependent. A device-independent color space, such as
RGB, describes all possible colors. A device-dependent color space describes the subset of colors (from the device-
independent color space) that a particular device can reproduce. Device-dependent color spaces are used to map colors
between devices (for example, from a monitor to a printer) to ensure that colors are reproduced accurately.

Compression

Process that converts data to a storage format requiring less space than the original data.

Contact Sheet

Physical or digital page that contains a series of small images, usually in a grid format.

Context Menu

Menu that appears when you right-click within a program.

Contrast

Measure of an image’s color and brightness differences.

Convert

Change a file from one format to another. For example, you might convert a file from a bitmap (.bmp) to a JPEG (.jpg) to
reduce the file size.

Cropping

Removing unwanted image areas.

D
Database

Electronic filing system that provides fast access to stored data. The ACDSee Database contains two parts: a cached
thumbnail file and an information file. The cached thumbnail file contains small copies (thumbnails) of the images on your
system. The information file contains details about the files on your system, such as descriptions, dates, authors, notes,
keywords, and categories.

Database Date

Date that you apply to the properties of a file and save in the ACDSee Database.

Descriptions



ACDSee Home stores descriptions in a hidden file named descript.ion. Descriptions such as file name and captions for an
image will be included in the descript.ion files.

Dock

Attaching a toolbar, window, or pane to different screen areas.

DPI (dots per inch)

Measurement of an image’s resolution. For example, 92 DPI means 92 dots horizontally and 92 dots vertically, which
equals 8,464 dots per square inch. More dots per inch result in higher resolution and image quality.

Dynamic Range

The dynamic range of an image is directly related to the dynamic range of your digital camera's sensor. If your digital
camera's sensor has a large dynamic range it can capture the darkest shadows and brightest highlights at the same time,
without clipping the shadows or highlights. (RAW images preserve the dynamic range of your digital camera's sensor.)
Adjusting the tonal range of the image changes how the dynamic range of the image is represented on a monitor or in a
photo.

E
Elevation

Height of an imaginary light source over an image. The elevation of the light source works in conjunction with azimuth to
generate a three-dimensional emboss effect.

Encode

Writing (or saving) a file format.

Encryption

Method of converting data into a secure format. You need a digital password or key to read an encrypted file.

EXIF (Exchangeable Image File)

Standard for storing information, primarily with images that use JPEG compression. Most digital cameras create EXIF
information and embed it in the image file. For example, EXIF information can include details about shutter speed and
whether a flash was used.

Export

Moving data from one application to another. The exporting application places the data in a format that the other
application understands.

Exposure

Exposure is the amount of time that your digital camera's sensor is exposed to light.

F
Face Detection, Facial Recognition



Face Detection will detect the faces of individuals in your images. You can assign names to the faces, and ACDSee will
recognize the individuals going forward. You can search for images using the names of the people in them.

Feather

Softening image edges to blend them into the background.

File Listing

In ACDSee, a report of the files currently displayed in Manage mode.

File Format

Medium for encoding information in a file. Each type of file has a different file format that specifies how it organizes the
information it contains.

Filter

Program that can apply an effect to an image, such as an embossed appearance or a sepia tone.

Fisheye Distortion

In fisheye distortion, the photo appears to bulge outwards from the center, as if the photo were wrapped around a
sphere.

G
Gamma

Range of color values a monitor, scanner, or printer can display. Adjusting this value increases or decreases the intensity
of the light spectrum.

Grayscale Image

Image composed of different shades of gray.

H
Highlights

Highlights are the brightest or whitest parts of an image.

Histogram

A histogram is a graph that displays the dynamic range of shadows and highlights in an image.

Hue

Predominant color in an image.

I
Image Editor

Program that you can use to create and edit images. ACDSee Home is an image editor.

Image Resolution



Quality of image details and colors. Also used to describe the quality of monitors and printer output.

Image Viewer

Program that displays images. ACDSee Home is an image viewer.

Import

Bringing data into an application from another using a format that the receiving application understands.

Interpolation

Process that uses nearby pixels to estimate the color of new pixels added to the larger image. For example, interpolation
might be used when enlarging a digital image.

IPTC

Standard method of encoding information within image files so that items such as descriptive comments and copyright
information can be transmitted with the image.

J-K
Jaggies

Individual pixels displayed in an image with low resolution. The appearance of pixels in an image causes lines and curves to
appear jagged.

L
Lens Vignetting

Unusual darkness in the corners of images as a result of an inability of the lens to distribute light into the corners of the
image.

Lossless Compression

Form of compression that retains all image data and quality.

Lossless Rotation and Flipping

Rotation of a JPEG image without loss of image quality. This works best on images with dimensions that are a multiple of 8
or 16.

Lossy Compression

Form of compression that attempts to remove unnecessary data. This data loss can affect image quality.

M
Marquee

Dashed-line frame that identifies a selected portion of an image. Depending on the tool, you can resize or move a marquee
with or without changing the underlying image.

Metadata



Information about an image and how it was taken. This can be stored within the image itself or in a sidecar file. For
example, the metadata of digital camera images can contain the date and time the picture was taken, the shutter speed,
the exposure settings of the camera, and whether a flash was used.

Monochrome Image

Image containing a single color.

N
Noise

Effect produced when a variety of pixel colors are used in the same color region. Noise often occurs in images with high ISO
setting or slow shutter speed.

O
Opacity

Determines how visible an effect is when applied to an image or a selection. High opacity produces a more solid effect,
while low opacity results in a nearly invisible effect.

Overexposed

Images that are overexposed have too many highlights, and tend to look faded. You typically overexpose images by
exposing your digital camera's sensor to light for too long.

P-Q
Panning

Moving zoomed images vertically, horizontally, and diagonally across the display area to view specific areas of the image.

PDF

An acronym for Portable Document Format. You can view PDFs on any computer using the free Adobe Reader® software.

Perceptual

Rendering intent that scales all of the colors within one gamut to fit within another gamut. Best used for photographic
images, as it maintains the relationship between the colors more accurately than the colors themselves.

Photo Album

See album.

Photo Editor

See image editor.

Pincushion Distortion

In pincushion distortion the photo appears to shrink inwards toward the center.

Pixel (or Picture Element)

Smallest visible portion of a digital image, arranged in rows and columns.



Plug-in

Software module that adds functionality to a larger program.

PPI (pixels per inch)

Measurement of how an image is displayed. More pixels per inch result in higher image quality.

Presets

A preset contains image correction settings. You can create and use presets to ensure that settings you apply are the same
and consistent across all images.

Primary Colors

Colors that can produce other colors when blended. For example, in the RGB color model, red, green, and blue are
primary colors.

R
Raster Image

Image composed of a rectangular grid of pixels. Each pixel contains a defined value about its color, size, and location in the
image. As a result, resizing the image can affect its quality.

Rasterize

To convert a vector layer to pixels, defining the resolution. To rasterize a layer can be seen as finalizing a layer, as it is no
longer editable.

Rating

Assign ratings (1, 2, 3, 4, 5) to photos to help sort and manage them more easily.

RAW

An image file format. RAW files contain all of the image data that was captured by your digital camera's sensor. RAW files
are not processed by your camera; instead, you must process RAW images using a photo editing program such as ACDSee
Home.

Recursive

Program or task that can repeat itself indefinitely, such as a slideshow.

Red Eye

Red eye occurs when the light from your digital camera's flash reflects off the retinas in the subject's eyes. The subject's
eyes look red instead of their normal color.

Relative Colorimetric

Rendering intent that maps the colors that fall exactly within the color gamuts of both the input and output devices. Best
used for single- or limited-color images as colors outside of both gamuts may be mapped to a single color.

Render



Drawing images to your screen.

Rendering Intent

Approach used to map colors from one color gamut to another. There are four rendering intents available: Perceptual,
Relative Colorimetric, Saturation, and Absolute Colorimetric.

Resolution

Quality and clarity of an image, measured in pixels, dots per inch, or pixels per inch.

RGB

Color model that uses red, green, and blue as its primary colors.

Ringing Artifacts

Distortion around the edges of image subjects, caused by compressing or resizing an image.

S
Saturation

Purity of a color. Higher color saturation results in more gray.

Saturation (rendering intent)

Rendering intent that maintains color saturation from one gamut to another. Best suited for images in which the actual
color represented is less important than the color’s vividness.

Selection

Portion of an image that you define with a selection tool. A marquee surrounds any selection made.

Sepia

Sepia-toned images are composed of shades of brown. Many old photographs have a sepia tone.

Sharpen

The sharpen tool is for sharpening images. The original image is blurred slightly. This blurred version of the image is
subtracted from the original image, revealing the edges in the original image. These edges can then be sharpened by
increasing contrast.

Sharpness

The sharpness in an image is determined, primarily, by your digital camera's lens and sensor. You can also create the
illusion of sharpness by increasing the contrast between edges within an image.

Shortcut Menu

Menu that appears when you right-click within a program. Sometimes referred to as a context menu.

Slideshow



Automated sequential display of images. You can use slideshow software such as ACDSee Home to display slideshows of
your images.

Soft Proofing

Using your computer's monitor as a proofing device. The monitor displays a simulation of how colors will appear when
rendered by the printer.

T
Tagging

Tagging, like categories and ratings, is a great way to organize and group your photos without moving the files into
different folders. You can tag a photo with one click. Similarly, you can display all tagged photos with one click.

Thumbnails

Small preview of a full-sized image.

Timestamp

Date and time associated with a file.

Transitions

Special effects used between images or video segments in slideshows, screensavers, and videos.

U
Underexposed

Images that are underexposed have too many shadows. Images typically become underexposed if you don't expose your
digital camera's sensor to light long enough.

V
Vector Image

Image consisting of individual objects rather than pixels. Mathematical equations define the objects. You can adjust the
size of a vector image and the image will retain its clarity and quality.

W
Watermark

Background text or graphics added to an image, usually to provide copyright protection.

White Balance

Removes color cast to create a photo that is correctly lit. You can use your camera settings to apply the correct white
balance before taking an image, or correct the white balance in ACDSee.

Whitepoint

Lightest image area. You can control the intensity of the white in an image by adjusting its whitepoint.



X-Z
XML (Extensible Markup Language)

Standard language for Web documents.

Zoom

In ACDSee, zoom refers to the process of increasing or decreasing the display scale for an image. Increase the display scale
to view a portion of an image or a specific image detail. Decrease the display scale to viewmore or all of the image.
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